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Notice 

While reasonable efforts have been made to ensure that the information 
in this document is complete and accurate at the time of printing, Avaya 
assumes no liability for any errors. Avaya reserves the right to make 
changes and corrections to the information in this document without the 
obligation to notify any person or organization of such changes. 

Documentation disclaimer 

“Documentation” means information published in varying mediums 
which may include product information, operating instructions and 
performance specifications that are generally made available to users of 
products. Documentation does not include marketing materials. Avaya 
shall not be responsible for any modifications, additions, or deletions to 
the original published version of Documentation unless such 
modifications, additions, or deletions were performed by or on the 
express behalf of Avaya.  End User agrees to indemnify and hold 
harmless Avaya, Avaya's agents, servants and employees against all 
claims, lawsuits, demands and judgments arising out of, or in 
connection with, subsequent modifications, additions or deletions to 
this documentation, to the extent made by End User. 

Link disclaimer 

Avaya is not responsible for the contents or reliability of any linked 
websites referenced within this site or Documentation provided by 
Avaya. Avaya is not responsible for the accuracy of any information, 
statement or content provided on these sites and does not necessarily 
endorse the products, services, or information described or offered 
within them. Avaya does not guarantee that these links will work all the 
time and has no control over the availability of the linked pages. 

 

Warranty 

Avaya provides a limited warranty on Avaya hardware and software. 
Refer to your sales agreement to establish the terms of the limited 
warranty. In addition, Avaya’s standard warranty language, as well as 
information regarding support for this product while under warranty is 
available to Avaya customers and other parties through the Avaya 
Support website: 
http://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091
120112456651010 under the link “Warranty & Product Lifecycle” or such 
successor site as designated by Avaya.  Please note that if You acquired 
the product(s) from an authorized Avaya Channel Partner outside of the 
United States and Canada, the warranty is provided to You by said 
Avaya Channel Partner and not by Avaya.  

“Hosted Service” means an Avaya hosted service subscription that You 
acquire from either Avaya or an authorized Avaya Channel Partner (as 
applicable) and which is described further in Hosted SAS or other 
service description documentation regarding the applicable hosted 
service.  If You purchase a Hosted Service subscription, the foregoing 
limited warranty may not apply but You may be entitled to support 
services in connection with the Hosted Service as described further in 
your service description documents for the applicable Hosted Service.  
Contact Avaya or Avaya Channel Partner (as applicable) for more 
information.   

Hosted Service  

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN Avaya 
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA 
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE FOR 
HOSTED SERVICES ARE AVAILABLE ON THE AVAYA WEBSITE, 
http://support.avaya.com/LicenseInfo under the link “Avaya Terms of 
Use for Hosted Services” or such successor site as designated by 
Avaya, AND ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES 
THE HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED 
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF 
YOURSELF AND THE ENTITY FOR WHOM YOU ARE DOING SO 
(HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND 
“END USER”), AGREE TO THE TERMS OF USE.  IF YOU ARE 
ACCEPTING THE TERMS OF USE ON BEHALF A COMPANY OR OTHER 
LEGAL ENTITY, YOU REPRESENT THAT YOU HAVE THE AUTHORITY 
TO BIND SUCH ENTITY TO THESE TERMS OF USE.  IF YOU DO NOT 
HAVE SUCH AUTHORITY, OR IF YOU DO NOT WISH TO ACCEPT THESE 
TERMS OF USE, YOU MUST NOT ACCESS OR USE THE HOSTED 
SERVICE OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED 
SERVICE.   

Licenses THE SOFTWARE LICENSE TERMS AVAILABLE ON THE 
AVAYA WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO, UNDER 
THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya Products)” or 
such successor site as designated by Avaya, ARE APPLICABLE TO 
ANYONE WHO DOWNLOADS, USES AND/OR INSTALLS AVAYA 
SOFTWARE, PURCHASED FROM AVAYA INC., ANY AVAYA AFFILIATE, 
OR AN  AVAYA CHANNEL PARTNER (AS APPLICABLE) UNDER A 
COMMERCIAL AGREEMENT WITH AVAYA OR AN  AVAYA CHANNEL 
PARTNER. UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING, 
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS 
OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA 
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA RESERVES 

THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU AND ANYONE ELSE 
USING OR SELLING THE SOFTWARE WITHOUT A LICENSE. BY INSTALLING, 
DOWNLOADING OR USING THE SOFTWARE, OR AUTHORIZING OTHERS TO 
DO SO, YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU 
ARE INSTALLING, DOWNLOADING OR USING THE SOFTWARE 
(HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND “END 
USER”), AGREE TO THESE TERMS AND CONDITIONS AND CREATE A 

BINDING CONTRACT BETWEEN YOU AND AVAYA INC. OR THE 
APPLICABLE AVAYA AFFILIATE (“AVAYA”). 

Avaya grants You a license within the scope of the license types described 
below, with the exception of Heritage Nortel Software, for which the scope of 
the license is detailed below. Where the order documentation does not 
expressly identify a license type, the applicable license will be a Designated 
System License as set forth below in Section M(i)1 or 2 as applicable. The 
applicable number of licenses and units of capacity for which the license is 
granted will be one (1), unless a different number of licenses or units of 
capacity is specified in the documentation or other materials available to 
You.  “Software” means computer programs in object code, provided by 
Avaya or an Avaya Channel Partner, whether as stand-alone products, pre-
installed on hardware products, and any upgrades, updates, patches, bug 
fixes, or modified versions thereto.  “Designated Processor” means a single 
stand-alone computing device. “Server” means a set of Designated 
Processors that hosts (physically or virtually) a software application to be 
accessed by multiple users. “Instance” means a single copy of the Software 
executing at a particular time: (i) on one physical machine; or (ii) on one 
deployed software virtual machine (“VM”) or similar deployment.   

License types 

Designated System(s) License (DS). End User may install and use each copy 
or an Instance of the Software only: 1) on a number of Designated 
Processors up to the number indicated in the order; or 2) up to the number of 
Instances of the Software as indicated in the order, Documentation, or as 
authorized by Avaya in writing. Avaya may require the Designated 
Processor(s) to be identified in the order by type, serial number, feature key, 
Instance, location or other specific designation, or to be provided by End 
User to Avaya through electronic means established by Avaya specifically for 
this purpose. 

Concurrent User License (CU). End User may install and use the Software on 
multiple Designated Processors or one or more Servers, so long as only the 
licensed number of Units are accessing and using the Software at any given 
time as indicated in the order, Documentation, or as authorized by Avaya in 
writing. A "Unit" means the unit on which Avaya, at its sole discretion, bases 
the pricing of its licenses and can be, without limitation, an agent, port or 
user, an e-mail or voice mail account in the name of a person or corporate 
function (e.g., webmaster or helpdesk), or a directory entry in the 
administrative database utilized by the Software that permits one user to 
interface with the Software. Units may be linked to a specific, identified 
Server or an Instance of the Software. 

 

Heritage Nortel Software 

“Heritage Nortel Software” means the software that was acquired by Avaya 
as part of its purchase of the Nortel Enterprise Solutions Business in 
December 2009.  The Heritage Nortel Software  is the software contained 
within the list of Heritage Nortel Products located at 
http://support.avaya.com/LicenseInfo/ under the link “Heritage Nortel 
Products,” or such successor site as designated by Avaya. For Heritage 
Nortel Software, Avaya grants Customer a license to use Heritage Nortel 
Software provided hereunder solely to the extent of the authorized activation 
or authorized usage level, solely for the purpose specified in the 
Documentation, and solely as embedded in, for execution on, or  for 
communication with Avaya equipment. Charges for Heritage Nortel Software 
may be based on extent of activation or use authorized as specified in an 
order or invoice. 

 

Copyright 

Except where expressly stated otherwise, no use should be made of 
materials on this site, the Documentation, Software, Hosted Service, or 
hardware provided by Avaya. All content on this site, the documentation, 
Hosted Service, and the product provided by Avaya including the selection, 
arrangement and design of the content is owned either by Avaya or its 
licensors and is protected by copyright and other intellectual property laws 
including the sui generis rights relating to the protection of databases. You 
may not modify, copy, reproduce, republish, upload, post, transmit or 
distribute in any way any content, in whole or in part, including any code and 
software unless expressly authorized by Avaya. Unauthorized reproduction, 
transmission, dissemination, storage, and or use without the express written 
consent of Avaya can be a criminal, as well as a civil offense under the 
applicable law. 

Virtualization  

The following applies if the product is deployed on a virtual machine.  Each 
product has its own ordering code and license types.  Unless otherwise 
stated, each Instance of a product must be separately licensed and ordered. 
For example, if the end user customer or Avaya Channel Partner would like to 
install two Instances of the same type of products, then two products of that 
type must be ordered.  

Third Party Components  

http://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
http://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
http://support.avaya.com/LicenseInfo
http://support.avaya.com/LICENSEINFO


“Third Party Components” mean certain software programs or portions 
thereof included in the Software   or Hosted Service may contain 
software (including open source software) distributed under third party 
agreements (“Third Party Components”), which contain terms regarding 
the rights to use certain portions of the Software (“Third Party Terms”). 
As required, information regarding distributed Linux OS source code (for 
those products that have distributed Linux OS source code) and 

identifying the copyright holders of the Third Party Components and the 
Third Party Terms that apply is available in the products, Documentation 
or on Avaya’s website at: http://support.avaya.com/Copyright or such 
successor site as designated by Avaya.   The open source software 
license terms provided as Third Party Terms are consistent with the 
license rights granted in these Software License Terms, and may contain 
additional rights benefiting You, such as modification and distribution of 
the open source software.  The Third Party Terms shall take precedence 
over these Software License Terms, solely with respect to the applicable 
Third Party Components, to the extent that these Software License 
Terms impose greater restrictions on You than the applicable Third Party 
Terms. 

The following applies only if the H.264 (AVC) codec is distributed with 
the product.   THIS PRODUCT IS LICENSED UNDER THE AVC PATENT 
PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR 
OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) 
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD ("AVC 
VIDEO") AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A 
CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS 
OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC 
VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY 
OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM 
MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM 

Service Provider   

THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S HOSTING 
OF AVAYA PRODUCTS OR SERVICES.  THE PRODUCT OR HOSTED 
SERVICE MAY USE THIRD PARTY COMPONENTS SUBJECT TO THIRD 
PARTY TERMS AND REQUIRE A SERVICE PROVIDER TO BE 
INDEPENDENTLY LICENSED DIRECTLY FROM THE THIRD PARTY 
SUPPLIER.  AN AVAYA CHANNEL PARTNER’S HOSTING OF AVAYA 
PRODUCTS MUST BE AUTHORIZED IN WRITING BY AVAYA AND IF 
THOSE HOSTED PRODUCTS USE OR EMBED CERTAIN THIRD PARTY 
SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT 
SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS 
REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE 
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE, 
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.  

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL PARTNER IS 
HOSTING ANY PRODUCTS THAT USE OR EMBED THE  H.264 CODEC 
OR H.265 CODEC, THE AVAYA CHANNEL PARTNER ACKNOWLEDGES 
AND AGREES THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR 
ANY AND ALL RELATED FEES AND/OR ROYALTIES.    THE H.264 (AVC) 
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES IN 
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE VIDEO 
IN COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEO") AND/OR (II) 
DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A 
VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO.  NO LICENSE IS 
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.   ADDITIONAL 
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE 
OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.    

Compliance with Laws 

You acknowledge and agree that it is Your responsibility for complying 
with any applicable laws and regulations, including, but not limited to 
laws and regulations related to call recording, data privacy, intellectual 
property, trade secret, fraud, and music performance rights, in the 
country or territory where the Avaya product is used. 

Preventing Toll Fraud 

“Toll Fraud” is the unauthorized use of your telecommunications system 

by an unauthorized party (for example, a person who is not a corporate 
employee, agent, subcontractor, or is not working on your company's 
behalf). Be aware that there can be a risk of Toll Fraud associated with 
your system and that, if Toll Fraud occurs, it can result in substantial 
additional charges for your telecommunications services. 

Avaya Toll Fraud intervention 

If You suspect that You are being victimized by Toll Fraud and You need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1-800-643-2353 for the United States and 
Canada. For additional support telephone numbers, see the Avaya 
Support website: http://support.avaya.com, or such successor site as 
designated by Avaya.  

Security Vulnerabilities 

Information about Avaya’s security support policies can be found in the 
Security Policies and Support section of  
https://support.avaya.com/security 

Suspected Avaya product security vulnerabilities are handled per the 
Avaya Product Security Support Flow 
(https://support.avaya.com/css/P8/documents/100161515). 

Downloading Documentation 

For the most current versions of Documentation, see the Avaya Support 
website: http://support.avaya.com, or such successor site as designated by 
Avaya. 

Contact Avaya Support 

See the Avaya Support website: http://support.avaya.com for product or 
Hosted Service notices and articles, or to report a problem with your Avaya 
product or Hosted Service. For a list of support telephone numbers and 
contact addresses, go to the Avaya Support website: 
http://support.avaya.com (or such successor site as designated by Avaya), 
scroll to the bottom of the page, and select Contact Avaya Support. 
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Trademarks 

The trademarks, logos and service marks (“Marks”) displayed in this 
site, the Documentation, Hosted Service(s), and product(s) provided by 
Avaya are the registered or unregistered Marks of Avaya, its affiliates, its 
licensors, its suppliers, or other third parties. Users are not permitted to 
use such Marks without prior written consent from Avaya or such third 
party which may own the Mark. Nothing contained in this site, the 
Documentation, Hosted Service(s) and product(s) should be construed 
as granting, by implication, estoppel, or otherwise, any license or right in 
and to the Marks without the express written permission of Avaya or the 
applicable third party. 

Avaya is a registered trademark of Avaya Inc. 

All non-Avaya trademarks are the property of their respective owners. 

Linux® is the registered trademark of Linus Torvalds in the U.S. and 
other countries.  
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Chapter 1: Introduction 
 
 
 
 

 

Purpose 

The Avaya Interaction Center for Siebel integration combines Avaya Interaction Center (IC) 
Release 7.3.x with the Siebel 8.1.1.x, 8.2.2.x, and 15 applications. The integration of Avaya IC 

with Siebel facilitates you to use the customer management features in the Siebel software and 

the features in Avaya IC that automate the processing of customer contacts. 
 
 
 
 

Intended audience 

This guide is for the technicians who integrate Avaya IC with Siebel application. 
 
 
 
 

Document changes since last issue 

The following sections are added to this document since the last issue: 

● Customizing events on page 247 

● OnCallConnect on page 376 

● OnCallIncoming on page 378 

● OnNewWorkItem on page 388 

● OnWorkItemRemove on page 392 

● Enabling Siebel Open UI in IC 7.3.3 or later on page 234 

● PromptForLogin parameter in Agent/Desktop/Voice on page 308 

● Changes required for using Siebel 8.1.1.11 and 8.2.2.4 with IC Release 7.3.2 on page 48 

● Advanced ASIS Server parameters in the env.properties file on page 167 

● Installing and configuring Siebel on Linux on page 250 
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Related resources 
 
 
 

Documentation 

See the following related documents at http://support.avaya.com. 

 

Title Description Audience 

The Siebel Bookshelf for the 
product documentation set for 
Siebel eBusiness Applications 

The purpose of this document is 
to provide detailed information 
about Siebel installation and 
configuration. 

Siebel Administrators. 

IC Installation and 
Configuration 

The purpose of this guide is to 
provide detailed information about 
how to install and configure an 
out-of-the-box Avaya Interaction 
Center. 

Application consultants 

Integration consultants 

Avaya Business 
Partners 

Customers. 

IC Installation Planning and 
Prerequisites 

The purpose of this guide is to 
provide detailed information about 
the planning and third-party 
software required to deploy an 
Avaya Interaction Center, Release 
7.3.x system. 

Application consultants 

Integration consultants 

Avaya Business 
Partners 

Customers. 

 

Finding documents on the Avaya Support website 

Use this procedure to find product documentation on the Avaya Support website. 

1. Use a browser to navigate to the Avaya Support website at http://support.avaya.com. 

2. At the top of the screen, enter your username and password and click Login. 

3. Click Documents. 

4. In the Enter your Product Here search box, type the product name and then select the 
product from the drop-down list. 

5. If there is more than one release, select the appropriate release number from the Choose 

Release drop-down list. 

6. Use the Content Type filter on the left to select the type of document you are looking for, 

or click Select All to see a list of all available documents. 

For example, if you are looking for user guides, select User Guides in the Content Type 

filter. Only documents in the selected category will appear in the list of documents. 

mailto:infodev@avaya.com
http://support.avaya.com/
http://support.avaya.com/


15 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

August 2022 

Chapter 1: Introduction 

 

 

 

 
7. Click Enter. 

 

 

Training 

The following courses are available on the Avaya Learning website at www.avaya-learning.com. 

In the Search field, enter the course code, and click Go to search for the course. 

 

Course Code Course Title 

ATC01175WEN IC and OA Overview 

ATC01176IEN Interaction Center Administration and Configuration 

AUCC100010695 IC-Siebel Integration 

ATC100011017 IC-Siebel Integration, Installation and Troubleshooting 

 

 

Viewing Avaya Mentor videos 

Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot 

Avaya products. 

Videos are available on the Avaya Support website, listed under the video document type, and 
on the Avaya-run channel on YouTube. 

● To find videos on the Avaya Support website, go to http://support.avaya.com and perform 
one of the following actions: 

- In Search, type Avaya Mentor Videos to see a list of the available videos. 

- In Search, type the product name. On the Search Results page, select Video in the 

Content Type column on the left. 

● To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and 

perform one of the following actions: 

- Enter a key word or key words in the Search Channel to search for a specific product 
or topic. 

- Scroll down Playlists, and click the name of a topic to see the available list of videos 

posted on the website. 

Note: 
Videos are not available for all products. 
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Support 

Go to the Avaya Support website at http://support.avaya.com for the most up-to-date 

documentation, product notices, and knowledge articles. You can also search for release notes, 

downloads, and resolutions to issues. Use the online service request system to create a service 

request. Chat with live agents to get answers to questions, or request an agent to connect you 

to a support team if an issue requires additional expertise. 
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Chapter 2: Integration overview 

 

This section provides a high-level overview of how the Avaya IC Siebel integration works and 

includes the following topics: 

● Differences in terminology on page 26 

● System description on page 27 

● Selecting an integration between Avaya IC and Siebel on page 27 

● Media features on page 29 

● Architecture overview on page 32 

● Interaction between Avaya IC and Siebel on page 34 

● Multisite configurations on page 39 
 
 
 
 

Differences in terminology 

Avaya IC and Siebel use the following terms that are applied differently in the two systems. This 

document uses the Avaya IC terminology except when referring to Siebel components. 

 

Avaya IC term Siebel term Description 

Customer Contact Person initiating the interaction with the agent. 

Contact Work item A single interaction with an Avaya IC customer, in any of 
the following media channels: 

● Voice (telephone call) 

● Email 

● Chat (Web chat) 

Because of the continuous exchange of data between 
the two systems, this document uses the terms contact 
and work item interchangeably. 

Available 

Not Available 

Ready 

Not Ready 

Terms that describe agent availability for receiving work 
items. 

Name-value 
couple 

Key-value 
parameter 

Data that represents information about a contact or work 
item. The key, or name, is the name of the parameter 
being conveyed. For more information, see Key-value 
parameters on page 313. 

mailto:infodev@avaya.com


August 2022 18 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

System description 
 

 

 
 

 
 

System description 

The Avaya Interaction Center for Siebel integration combines Avaya Interaction Center (IC) 

release 7.3.x with the Siebel applications. The integration of Avaya IC with Siebel allows you to 

use the customer management features in the Siebel software and the features in Avaya IC that 

automate the processing of customer contacts. This integration has agents interact with a 

customer in an individualized manner because agents can: 

● Receive work items that are appropriate for the set of skills. 

● Perform contact work in multiple media channels. 

● Access any historical data about work previously performed for a specific customer. 

 
Related topics 

For more information about how agents process work items, see Avaya IC for Siebel User 

Guide. 
 
 
 
 

Selecting an integration between Avaya IC and Siebel 

This section describes how to select the appropriate integration between Avaya IC and Siebel 
for a specific contact center. This section includes the following topics: 

● Types of Avaya IC Siebel integrations on page 27 

● Guidelines for deploying the Hybrid Siebel integration on page 28 

● Guidelines for deploying the Native Siebel integration on page 28 
 

 

Types of Avaya IC Siebel integrations 

Avaya IC supports the following types of Avaya IC Siebel integrations: 

Hybrid Siebel integration: In an Avaya IC Siebel integration, the desktop user interface 
consists of a Siebel call center Internet browser window and an Avaya Agent task bar window. 

The integration of Avaya IC with Siebel facilitates you to use the customer management 

features in the Siebel software and the features in Avaya IC that automate the processing of 

customer contacts. This integration supports all channels, voice, email, and chat. 

The Avaya Agent task bar interface, and the integrated component the Web Agent, are installed 

on the agent desktop as part of the Avaya IC software. With Avaya Agent and Web Agent, 

agents can interact with customers of the contact center and handle contacts on all channels. 

For more information, see Avaya Agent components on page 70. 
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Native Siebel integration: Thin-client Siebel provides the entire desktop user interface for an 

Avaya IC Siebel integration. Avaya IC provides voice and email work item routing and data 

collection reporting that occurs in the background. 

The agent interface for the Native Siebel integration runs in a web browser on the agent 

desktop. The Native Siebel integration does not require the installation of the Avaya Agent task 

bar interface on the agent desktop. 
 

 

Guidelines for deploying the Hybrid Siebel integration 

For the Hybrid Siebel integration, every agent desktop includes the Siebel agent application 

running in a browser window and the Avaya Agent task bar installed on the desktop. 

Deploy the Hybrid Siebel integration if the contact center requires the features supported by the 
Avaya Agent task bar. For example, deploy this integration if agents need to: 

● Handle web-based interactions, such as chats. 

● Have access to the Avaya Agent EDU viewer and customer history viewer. 

● Have access to the Avaya Agent work item viewer and work item selection tools. The 

viewer and tools enable agents to easily view and select accepted work items. 

 

Related topic 

For more information, see Media features on page 29. 
 

 

Guidelines for deploying the Native Siebel integration 

For the Native Siebel integration, every agent desktop includes the Siebel agent running in a 
browser window. 

Deploy the Native Siebel integration if the contact center: 

● Must handle only voice and email interactions. The Native Siebel user interface does not 
support web-based interactions. 

● Does not need agents to have access to the Avaya Agent EDU viewer and customer 

history viewer that are not supported in the Native Siebel user interface: 

● Does not need agents to have access to the Avaya Agent work item viewer and work item 

selection tools that enable agents to easily view and select accepted work items. The 

Native Siebel user interface does not display this information. 

● Does not install and run the Avaya Agent task bar on the agent desktop. 

 
Related topic 

For more information, see Media features on page 29. 
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Media features 

This section includes the following topics: 

● Features supported on the voice channel on page 29 

● Features supported on the email channel on page 29 

● Features supported on the web channel on page 30 

● Features supported for Avaya IC for Native Siebel on page 31 

● Features not supported for Avaya IC for Native Siebel on page 31 
 

 

Features supported on the voice channel 

The Avaya IC Siebel integration supports the following voice channel features: 

Heterogeneous switch support: Agents can transfer and conference telephone calls 

regardless of switch type or location. 

Interactive Voice Response (IR) support: Callers can choose from a list of prerecorded voice 

messages. 

Business Advocate support: Business Advocate is used for switch and host-based 

call-routing support. 

Multimedia work items: Agents can associate a phone call or a Voice over Internet Protocol 

(VoIP) call with a Web chat session. 

Screen pop into the Siebel agent desktop: Screen pops display customer information in the 

Siebel desktop when agents accept a work item or activate a work item. 

Siebel Communications Toolbar for phone functions: Agents use the toolbar for softphone 

functions, such as answer, hold, take off hold, conference, transfer. 
 

 

Features supported on the email channel 

The Avaya IC Siebel integration email channel functions as follows: 

● Avaya IC for email receipt and routing on page 30 

● Siebel for email response and Siebel Content Analysis on page 30 

● Siebel desktop receives the email on page 30 
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Avaya IC for email receipt and routing 

Avaya IC provides for the receipt and the routing of email. Avaya IC uses the following features: 

● Post Office Protocol 3 (POP3) 

● WebACD routing 

● Avaya Business Advocate routing 

● Push mode delivery of customer email contacts to agent desktop 

● Blended delivery to a common desktop interface for emails blended with other work items 

 
Siebel for email response and Siebel Content Analysis 

Siebel provides the email responses and Content Analysis that includes: 

● Auto-acknowledgements 

● Suggested responses 

● Auto-responses 

● Email presentation to the agent through the Siebel user interface 

 
Siebel desktop receives the email 

The Siebel desktop receives the email work item that can include: 

● Siebel templates so that agents can use messages that have already been created and 

approved for specific situations. 

● Email history stored in the Siebel database and linked to the customer. 

Note: 
When the Avaya IC Web Agent is set to Siebel mode, the email controls are 

removed from the interface. 
 

 

Features supported on the web channel 

Note: 
Only Hybrid Siebel integrations currently support a Web channel. 

The Avaya IC Siebel integration supports the following Web channel features: 

● Avaya IC Web automatic call distributor (ACD) for logic and agent selection 

● The Internet Call Manager (ICM) server enables the following communication and 

collaboration functionality: 

- Web chat 
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- VoIP 

- Public Switched Telephone Network (PSTN) callback 

- Collaboration, such as page push, forms assist, transcript 

- Downloadable caller-side applet for customer Web chat interface 

● DataWake for tracking customer activity within a website 

● Web Agent Client interface 

● Web chat transcript saved in the Siebel database 

● Integrated with Siebel Web engine for Web applications 

● Web Scheduled Callback has customers schedule a date and time for an agent to call 

them 
 

 

Features supported for Avaya IC for Native Siebel 

Avaya IC provides the following features and functions in an Avaya IC for Native Siebel 

integration: 

● Inbound voice contact handling, routing, and reporting. 

● Email work item routing to an agent in response to a request from Siebel. 

● Work item control functions using the Siebel Communications Toolbar. 
 

 

Features not supported for Avaya IC for Native Siebel 

The following features and functions are not supported in an Avaya IC for Native Siebel 
integration: 

● Web channel support 

● Outbound Contact - also not supported for Hybrid Siebel 

● Per channel login and logout - agents can only login and logout 

● Manual control of channel loads - agents cannot manually control channel loads 

● Manual task load settings - agents cannot control task load settings 

● Channel indicators that describe the status of the channel, such as failed, suspended. 

Buttons display the status of the channel to the agent. 

● Agent-selectable manual-in or autoin modes for voice work items 

● Selectable voice autoanswer - autoanswer is automatically turned off 

● Email resources normally supported by Avaya IC, such as preformatted emails 
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● Out-of-the-box agent unavailable reason codes 

 
 
 
 

Architecture overview 

This section includes the following topics: 

● Architecture for Hybrid Siebel on page 32 

● Architecture for Native Siebel on page 33 

● Communications infrastructure on page 33 

● Avaya IC servers on page 34 

● Siebel servers on page 34 

● Clients on page 34 
 

 

Architecture for Hybrid Siebel 

The following figure shows the major parts of a Hybrid Siebel integrated system. 
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Architecture for Native Siebel 

The following figure shows the major parts of a Native Siebel integrated system. 
 
 

 

 

Communications infrastructure 

The communications infrastructure includes the PBX, Avaya Interactive Response (IR), email, 

fax, and web servers. These servers: 

● Support the delivery of various media-channel communications to the contact center 

● Can run Avaya-provided switch software 

● Can run software from other vendors, such as Microsoft Exchange 

The software on these servers is provided separately from the Avaya IC Siebel integration 
software. 
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Avaya IC servers 

The Avaya IC servers refer to all the servers that comprise the Avaya IC system. For example, 

the Telephony Server links Avaya IC to computer telephony integration products, such as 

private branch exchanges. The Directory Server maintains an accurate list of agents and 

servers on the system. 

You must enhance this software to support the Avaya IC Siebel integration. 

 
Related topic 

For more information about Avaya IC servers, see: 

● AICD and Avaya IC interfaces on page 88 

● IC Administration Guide 
 

 

Siebel servers 

The Siebel servers refer to all the servers on the Siebel system. To support the Avaya IC Siebel 

integration, Avaya provides software that runs on the Siebel application servers. 

 

Related topic 

For more information about Siebel servers, see the Siebel documentation. 
 

 

Clients 

Clients refer to all the client machines in the system. 

Software from both Siebel and Avaya might reside on the client. With Siebel, only a browser is 

required at the client to interact with the system. For Avaya IC, you must install software on the 

client. This part of the system also includes any physical communication devices used by 

agents, such as telephone sets. 
 
 
 
 

Interaction between Avaya IC and Siebel 

Three main types of interactions between Avaya IC and Siebel are as follows: 

● Data exchange on page 35 

● Work delivery and control on page 36 
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● Email response on page 38 

 

 

Data exchange 

Data exchange is the movement of information between Avaya IC and the Siebel databases. 

 
Data exchange figure 

The following figure shows the data exchange software architecture. 

 

 
Data exchange description 

The data exchange process works as follows: 

1. A voice, email, or web chat customer contact arrives in Avaya IC and a workflow starts to 

process that contact. 

2. The workflow calls EAI-specific blocks to interact with Siebel. For example, an EAI Get 
Data block retrieves a previous contact record from the Siebel database that is associated 

with the current customer contact. 

3. The EAI block calls the EAI server to request the data transfer. The EAI server maintains 

HTTP and XML-based EAI sessions with Siebel to perform the transfer. 

4. On the Siebel side, the Siebel EAI adapter processes the inbound HTTP request. The 

requested data is retrieved from the Siebel database and sent back to Avaya IC through 

the EAI server. 
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5. The Avaya IC workflow processes the data. For example, the workflow might determine 

how the contact must be routed. The workflow can optionally store the data in the EDU. 

6. For more sophisticated types of data transfer operations, Siebel workflows might need to 

be called to perform special operations on the data. 

 

Related topics 

For more information about data exchange components, see any of the following topics: 

● Integration workflows on page 96 

● EAI server on page 64 
 

 

Work delivery and control 

The work delivery and control function coordinates the delivery of work to the agents. This 

coordination includes synchronizing the Siebel desktop with Avaya Agent or ASIS during the 

following events: 

● Delivering work initially, such as a screen-pop 

● Completing work 

● Switching between work items 

● Transferring work items 
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Delivery and control for Hybrid Siebel 

The following figure shows the overall work delivery and control architecture for Hybrid Siebel 
integration. 
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Delivery and control for Native Siebel 

The following figure shows the overall work delivery and control architecture for Native Siebel 
integration. 

 
 

 
Related topics 

See one of the following topics for more information about the work delivery and control 

components: 

● AICD on page 86 

● SCAPI interface on page 90 
 

 

Email response 

Email response refers to all Siebel email response functionality, including email presentation, 

Siebel Content Analysis, email autoacknowledgements, autoresponses, and email suggested 

responses. 

 

Related topic 

For more information, see Email entry method on page 60. 
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Multisite configurations 

In an integrated Avaya IC and Siebel environment, the entire integrated system is designed to 
operate in a multisite environment. 

This section includes the following topics: 

● Multisite configuration for Hybrid Siebel on page 40 

● Multisite configuration for Native Siebel on page 41 

● Centralized Siebel complex on page 42 

● The database in multisite configurations on page 42 

● EAI in multisite configurations on page 42 

● Email in multisite configurations on page 42 

● Agents, sites, and Siebel Communications servers on page 43 

● Associating a Siebel agent with a communications session on page 44 
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Multisite configuration for Hybrid Siebel 

The following figure shows an example of a multisite Avaya IC for a Hybrid Siebel integration. 
While only three sites are shown in this figure, your system can contain many more sites. 
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Multisite configuration for Native Siebel 

The following figure shows an example of a multisite Avaya IC for a Native Siebel integration. 
While only three sites are shown in this figure, your system can contain many more sites. 
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Centralized Siebel complex 

Siebel requires that all application servers are colocated with the Siebel database and Siebel 

Web server. Therefore, customers need to set up a centralized Siebel complex that all agents 

access through the web browser. Usually, the centralized Siebel complex must reside at one of 

the contact center sites, but the Siebe complex is not required. Reliable, high-speed Wide Area 

Network (WAN) connectivity between sites and to the centralized Siebel complex are required. 
 

 

The database in multisite configurations 

In Siebel, only one logical instance of the Siebel database exists, even in a multisite 

environment. This database facilitates easy access to all customer data in the database 

regardless of where the agent is located. Also, Avaya IC workflow blocks can access customer 

information from any site. 

Similarly for Avaya IC, only one database for customer and agent information for the entire 

system is available. With EDU and ADU servers, the system already facilitates multiple 

instances of the servers to exist within a single system. These servers implement mechanisms 

whereby a must interact with only one server, but might get information that is actually resident 

in another instance of the server. That is, the ADU and EDU servers in the system are 

knowledgeable about and share the information with all other ADU and EDU servers in the 

entire system. 
 

 

EAI in multisite configurations 

Each site that must access Siebel EAI data must have an EAI server. All access to EAI servers 

must be available throughout the Wide Area Network (WAN). Also, you must have high 

bandwidth and stable connections through the network connection to the centralized Siebel 

complex. 
 

 

Email in multisite configurations 

Configure one of the sites in the complex as the entry point for email. You can colocate the IC 
Email server with Siebel in a Siebel data center or centralized complex. 
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Agents, sites, and Siebel Communications servers 

A multisite system configuration usually involves multiple Siebel Communications server 

instances running across multiple Siebel servers. Agents at each site can be fixed to particular 

Communication server instance using Siebel administration, or the agents can be configured to 

use one of many Communication server instances. Use of load balancing software facilitates 

assignment of agents to the most appropriate Communication server dynamically on login. The 

selection of a Communication server for a particular agent login session also determines the 

AICD driver instance that is associated with the session. 

The Avaya IC Siebel integration is flexible in terms of how to associate agents at different sites 

across multiple Siebel Communication servers and associated AICD instances. Plan carefully to 

ensure that the chosen configuration is appropriate for your particular customer implementation 

and application. 

 
Using fixed agent-to-Communication server assignments 

You can choose to use fixed agent-to-Communication server assignments to associate 

Communication server instances with particular sites. Use this method for the following 

reasons: 

● Reduces the number of proxies incurred by the ADU and EDU servers and facilitates the 

AICD to use the best available ADU and EDU servers for servicing the agents and 

contacts at a particular site. 

● Helps define appropriate failover paths for requests to these servers made by the AICD. 

To associate a Communication server instance with a site, configure agents from only one site 
to use that Communication server instance. If multiple Avaya IC agent domains are associated 

with a site, configure the Communication servers in accordance with the individual Avaya IC 

agent domains, if possible. 

 

Related topic 

For more information, see the Siebel documentation. 

 
Not using fixed agent-to-Communication server assignments 

You can choose not to use fixed agent-to-Communication server assignments. With this 

method, you need not associate Communication server instances with particular sites. Agents 

at any site can use any Communication server and AICD instance to log in and perform work. 

However, since there are more EDU and ADU proxy servers in such configurations, the 

performance of the Avaya IC system can be slightly reduced. However, these configurations are 

more flexible compared to configurations requiring a one-to-one relationship between 

Communication server and sites. For example, these types of configurations can use load 

balancing software to better balance the load across multiple Siebel servers. 
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Associating a Siebel agent with a communications session 

Normally, Siebel uses the Communications Session Manager that runs on the same machine as 

the agent Application Object Manager. However, if this default association is changed, create 

multiple Siebel communication configurations by modifying the following Computer Telephony 

Interface (CTI) parameters: 

● GatewayAddress - Specify the Siebel Gateway. For example, specify a value such as 

gateway-host for this parameter. 

● EnterpriseServer - Specify the Siebel Enterprise Server. For example, specify a value such 
as siebel for this parameter. 

● RequestServer - Specify the Siebel Request Server, the Siebel Server. For example, 
specify a value such as server-host for this parameter. 

● CommSessionMgr - Specify the Communications Session Manager. For example, specify 

a value such as CommSessionMgr for this parameter. This parameter is optional. 
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Chapter 3: Planning and prerequisites 

 

This section describes the information and materials you must plan for an Avaya IC Siebel 

integration and the prerequisite tasks. Avaya Interaction Center supports integration with the 

following: 

● Integration with Siebel 8.1.1.x, 8.2.2.x, and Siebel 15.0.0.0. 

● On AIX 6.1, IC 7.3 Siebel integration is only supported with Siebel 8.1.1.3 and later. 

● If Siebel is installed on Windows 2008 Server, the Siebel side IC integration components 

must be installed on Windows 2008. In no other circumstances, any of the IC components 

must be installed on Windows 2008. 

● On Linux 6.5, IC 7.3 Integration is only supported with Siebel Innovation Pack 14 and 15. 

● If Siebel is installed on Linux Server 6.5, then the Siebel side IC integration components 

must be installed on the Siebel Linux Server (ICSideLinux package as ORB server and 

SiebelSideLinux package as AICD). The other IC Server components must be installed 

either on Windows or Solaris. 

Note: 
In the previous Siebel version number, "x" represents the minor release number. 

Avaya supports integration with all the minor releases of 8.1.1.x if no changes on 

the Siebel side exist that impact the functioning of integration components. 

This section includes the following topics: 

● Supported platforms on page 46 

● Supported languages on page 49 

● Prerequisites for installing localized systems on page 50 

● Avaya IC domain deployment guidelines on page 50 

● Hybrid Siebel login IDs and passwords on page 56 

● Native Siebel login IDs and passwords on page 57 

● The installation CDs on page 57 

● Security on page 59 
 
 
 
 

Supported platforms 

All the software described in this section must be bought separately. 
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This section includes the following topics: 

● Avaya IC server platforms on page 47 

● Databases on page 48 

● Switches and switch software on page 48 

● Media channels for Hybrid Siebel configurations on page 48 

● Media channels for Native Siebel configurations on page 49 

● Avaya Agent Web Client on page 49 
 

 

Avaya IC server platforms 

For Avaya IC server platforms and Avaya IC prerequisites see the section Required software for 

Avaya IC for Siebel 8.1.1.x, 8.2.2.x, and 15 in the IC Installation Planning and Prerequisites. For 

Siebel 8.1.1.x, 8.2.2.x, and 15 prerequisites, and the hardware and software requirements for 

Siebel server platforms, see the Siebel documentation. 

 
Important: 

 
● For IC-Siebel integration on Linux platform, see Installing and configuring Siebel 

on Linux on page 250. 

● For IC-Siebel integration on AIX platform, supported Siebel versions are 8.1.1.3 
and later. 

● In Interaction Center Release 7.3.3 and later, if Siebel is installed on AIX platform, 

then the IC Server Component on AIX platform must be at 7.3.2 and the Siebel 

side IC integration component is at the latest version. The latest IC Server 

components must be installed on Microsoft Windows or Oracle Solaris. For 

example if Siebel 8.1.1.14 is installed on AIX 6.1 and you want to integrate with IC 

7.3.4 then following table shows the combination of the integration component Vs 

IC Version with package name for the installation. 
 

 

Integration Components IC Versions (package Name) 

IC Server on AIX Siebel Server 7.3.2 (IC732AixServer) 

IC Server on Windows or Solaris 7.3.4 (IC734WinServer or IC734SolServer) 

IC Server on Windows or Solaris 7.3.4 (ICSide734win or ICSide734sol) 

Siebel Side Component on AIX Siebel Server 7.3.4 (SiebelSide734aix) 

! 
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Note: 
IC 7.3.x with Siebel 8.1.1.x, 8.2.2.x, and 15 integration supports VMWare ESX 

and VMWARE ESXi. 

 
Changes required for using Siebel 8.1.1.11 and 8.2.2.4 with IC Release 7.3.2 

You must modify the AICD.def file to use IC release 7.3.2 with Siebel 8.1.1.11 and 8.2.2.4. 

1. Stop the Siebel services. 

2. Open the AICD.def file. The default location is: <Siebel Server Home>\bin 

3. Add the following FilterSpec in the AICD.def file. 

[Command:SetCurrentWorkItem] 

DeviceCommand = "SetCurrentWorkItem" 

FilterSpec = [@SelectedWorkItem:DriverWorkTrackID] IS NOT NULL 

CmdData = "ChangedWorkItemData" 

Hidden = "TRUE" 

4. Save the AICD.def file. 

5. Import the AICD.def file configuration using Siebel Administrator. 
 

 

Databases 

For information about supported Avaya IC and Siebel databases, see: 

● IC Installation Planning and Prerequisites 

● The Siebel documentation 
 

 

Switches and switch software 

For more information about switches and switch software, see Telephony Connectors 

Programmer Guide. 
 

 

Media channels for Hybrid Siebel configurations 

The following media channels are supported in an Avaya IC for Hybrid Siebel integration: 

● PBX voice - includes support for Interactive Voice Response (IVR) interaction 

● Voice over Internet Protocol (VoIP) 
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● IP text chat 

● Assisted Web browsing - includes agent and customer interactive Web forms 

● Web callbacks 

● Email - These emails are supported as email attachments only, not as separate channels: 

- Fax 

- Documents 

- Web forms - not interactive 
 

 

Media channels for Native Siebel configurations 

The following media channels are supported in an Avaya IC for Native Siebel integration: 

● PBX voice - includes support for Interactive Voice Response (IVR) interaction 

● Voice over Internet Protocol (VoIP) 

● Email - these emails are supported as email attachments only, not as separate channels: 

- Documents 

- Web forms - not interactive 
 

 

Avaya Agent Web Client 

The Avaya IC for Native Siebel integration does not support the Avaya Agent Web Client. 
 
 
 
 

Supported languages 

Release 7.3.x of Avaya IC for Siebel Siebel 8.1.1.x, 8.2.2.x, and 15 supports the following 
languages: 

● Simplified Chinese 

● English 

● German 

● French 

● Italian 

● Spanish 
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● Portuguese 

● Japanese 

● Korean 

● Thai 

Thai language support does not include the following: 

● Document searches in Web Self-Service 

● Spell checking 

● Content Analyzer 

● AIX operating systems 

● Thai B. E. (Buddhist Era) Date Formats 

● Thai wordwrap on the Website 
 
 
 
 

Prerequisites for installing localized systems 

You can install Siebel on a supported operating system written in any supported language. 
Consider the following prerequisites before installing a localized system: 

1. Install Siebel using English as the base language and add the local customer language as 
an additional language. For more information, see the Siebel documentation. 

2. Setup Avaya IC for the localized language as described in IC Installation and 

Configuration. 
 
 
 
 

Avaya IC domain deployment guidelines 

This section provides suggestions for creating effective domains for the Siebel integration 

servers. The AICD and EAI are considered Siebel integration servers. Each Siebel integration 

server is administered as an Avaya IC VESP server and assigned to an Avaya IC domain. 

These guidelines must help you choose the best Avaya IC domain. 

This section includes the following topics: 

● About domains on page 51 

● AICD domain guidelines on page 51 

● EAI domain guidelines on page 53 

● ASIS domain guidelines on page 54 
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About domains 

Installers create Avaya IC domains to partition Avaya IC servers into groups that can improve 

communication paths between clients and servers. Proper domain structure can improve 

performance by avoiding unnecessary communication hops between servers and clients. 
Performance is enhanced when unnecessary Wide Area Network (WAN) hops are avoided. 

When Avaya IC domains are created, you can also use the domains to specify failover 

communication paths between servers and clients. During Avaya IC installation, each domain is 

administered with a set of failover domains. If communications are broken, either because the 

network path is lost, or because the server has stopped, the servers in the failover domains are 

tried in the order in which the domains were prescribed. 

For most integrations, except for integrations that use load balancing software, you do not have 
to create any new Avaya IC domains. 

 
Related topic 

For a description of the deployment guidelines for the Avaya IC domains, see IC Installation 

Planning and Prerequisites. 
 

 

AICD domain guidelines 

A single Adaptive Interaction Center Driver (AICD) might service many agents, and there might 

be more than one AICD in a Siebel system. Within the AICD, a unique AICD agent session 

services a single agent. 

For all types of configurations, use the AICD driver parameters, ServerUUID, ServerDomain, 
and ConfigurationName meticulously to suit your specific site needs. 

 
Related topic 

For more information, see AICD driver parameters on page 421. 

mailto:infodev@avaya.com


August 2022 42 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

Avaya IC domain deployment guidelines 
 

 

 

Single-site configurations 

The following table provides a list of the AICD domain guidelines for single-site configurations. 

 

Guideline Reason 

If you have one AICD server for your site, 
configure the AICD server to reside in the 
primary agent domain. 

● Ensures that the AICD uses the same 
EDU and ADU server as Avaya Agent 
or ASIS 

● Eliminates the proxy of requests and 
events between EDU servers and 
between ADU servers 

● Ensures that the AICD uses the same 
failover domain path as Avaya Agent 
or ASIS 

If you have more than one AICD server for your 
site, configure each AICD server to be in a 
separate agent domain. For example, configure 
the AICD so that Siebel agents in domain A use 
the AICD for domain A. 

For integrations using load balancing software 
create separate domains for each AICD server. 

The load balancing software must 
automatically direct an agent login request 
to the appropriate server to balance the 
load across the Siebel servers. 

 

Multi-site configurations 

The following table provides a list of the AICD domain guidelines for multisite configurations. 

 

Guideline Reason 

Configure a separate AICD for each primary 
agent domain where you have one primary agent 
domain at each Avaya IC site. Administer the 
Siebel server to segregate the agents among 
each multisite domain. This Siebel administration 
ensures that agents at site X use the AICD 
server for Avaya IC domain X. 

● Ensures that the AICD uses the same 
EDU and ADU server as Avaya Agent 
or ASIS 

● Eliminates the proxy of requests and 
events between EDU servers and 
between ADU servers 

● Ensures that the AICD uses the same 
failover domain path as Avaya Agent 
or ASIS 

For integrations using load balancing software 
create a separate domain for the AICD servers. 

The load balancing software must 
automatically direct an agent login request 
to the appropriate server to balance the 
load across the Siebel servers. 

 

Related topics 

For more information, see the following topics: 

● Configuring the AICD on page 151 

● AICD on page 86 
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EAI domain guidelines 

The following table provides a list of the Enterprise Application Integration (EAI) domain 
guidelines. 

 

Guideline Reason 

Configure only one instance of 
a particular type of EAI server 
for each domain. For example, 
do not put two EAIWorkflow 
servers in the same domain. 

VESP uses the Avaya IC domain and VESP interface type 
to unambiguously resolve Avaya IC workflow requests to 
the EAI server. If an EAI server of the same type is 
duplicated in an Avaya IC domain, the duplicated EAI server 
must never be used. 

Install an EAI and EAIWorkflow 
server in every Avaya IC 
domain that contains an Avaya 
IC Workflow server. These 
domains contain Telephony 
Server (TS), WebACD, and IC 
Email servers. 

● Ensures that the Avaya IC workflows associated with 
each media type use a unique set of EAI servers. This 
server enhances performance by segregating requests 
for each media type. 

● Ensures that Avaya IC workflow requests failover to 
another set of EAI servers if EAI and EAIWorkflow 
servers are configured in the failover domains. 

 

Related topics 

For more information, see the following topics: 

● EAI server types on page 66 

● Adding EAI servers to IC Manager on page 170 
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ASIS domain guidelines 

The following table provides a list of the Agent Server for Integration with Siebel (ASIS) domain 
guidelines for Native Siebel configurations. 

 

Guideline Reason 

If you have one ASIS server for your site, 
configure the ASIS server to reside in the 
primary agent domain. 

● Maximizes performance by avoiding 
unnecessary message proxies and 
network hops between ASIS and other 
Avaya IC services. 

● Ensures that ASIS uses the same 
failover domain path as the AICD. 

If you have more than one ASIS server for 
your site, configure each ASIS server to reside 
in a separate agent domain. For example, 
configure ASIS so that Siebel agents in 
domain A use ASIS for domain A. 

● Ensures that ASIS locates the correct 
AICD within the same domain. 

● Ensures that ASIS follows the same 
failover path as the AICD and the other 
Avaya IC servers in the same domain. 

● Ensures that the AICD uses the domain 
of the agent for the session and thus 
connects to ASIS for that domain. The 
AICD makes a request to ASIS on a 
session that causes a connection to a 
server from that domain. 

If you have two domains (A and B), use the 
servers in domain B for domain A agents if the 
servers in domain A fail, and vice versa. 

AICD (n) - (m) ASIS - The AICD to ASIS 
relationship is many to many. For more 
information, see AICD (n) - (m) ASIS 
relationship on page 55. 

For multiple-site configurations, perform the 
following: 

● Configure a separate ASIS for each 
primary agent domain where you have one 
primary agent domain at each Avaya IC 
site. 

● Set up your system so that failovers are 
contained within each site. Avaya does not 
recommend having failovers across sites. 

● Maximizes performance by avoiding 
unnecessary message proxies and 
network hops between ASIS and other 
Avaya IC services. 
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AICD (n) - (m) ASIS relationship 

This relationship is an example of the AICD (n) - (m) ASIS relationship that shows eight agents 

logging in from Siebel using four AICDs. Siebel selects each agent’s AICD. The AICDs forward 

the login requests to two ASIS servers. By using domain impersonation1, the AICDs forward the 

login requests to an ASIS in each agent domain. This relationship maximizes performance by 

avoiding unnecessary message proxies and network hops between ASIS and other Avaya IC 

services. 

 

Domain Server/User Failover domain 

A AICD_A1 B 

A AICD_A2 B 

A ASIS_A B 

A USR_A1 B 

A USR_A2 B 

A USR_A3 B 

A USR_A4 B 

B AICD_B1 A 

B AICD_B2 A 

B ASIS_B A 

B USR_B1 A 

B USR_B2 A 

B USR_B3 A 

B USR_B4 A 

 
 
 
 
 
 
 
 
 
 

1. Domain impersonation - The system selects an ASIS from the user domain using the generic interface name of 

ASIS. 
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Hybrid Siebel login IDs and passwords 

Ensure that the Siebel and Avaya IC agent login IDs and passwords match. Matching login IDs 

are required for the Avaya IC Siebel integration to work. Matching passwords make it possible 

to launch Avaya Agent and automatically log in to the Siebel thin client. Ensure that the Avaya 

IC login ID does not have any uppercase letters. 
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Native Siebel login IDs and passwords 

In a Native Siebel configuration, the Login command passes the Avaya IC agent password from 

Siebel to Avaya IC through the AICD. You can set up the Avaya IC password in any of the 

following ways: 

● Configure each Avaya IC password in Siebel. 

● Build an applet to prompt the agent for the password when the agent presses the Login 

button on the toolbar. 

● Using the AgentPassword parameter, configure all agents with the same Avaya IC 

password in Siebel so that the password is passed automatically when each agent logs in 

to Siebel. 
 
 
 
 

The installation CDs 

For this integration, you must need two installation CDs: 

● Avaya IC 7.3 Siebel 8 Integration CD on page 58 

● The Avaya IC CD on page 59 
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Avaya IC 7.3 Siebel 8 Integration CD 

The Avaya IC 7.3 Siebel 8 Integration CD contains integration components that you must install 
on either Avaya IC or Siebel. 

The following diagram shows the structure of the integration CD of Siebel. 

 

 
 

Components installed on Avaya IC 

The following components are installed only on Avaya IC: 

● Avaya Agent design components for the Siebel integration - not used for Native Siebel 

integrations 

● Avaya workflows for the Siebel integration 

● The EAI server - installed either on Avaya IC or Siebel 

● ASIS for Native Siebel configurations 
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Components installed on Siebel 

The following components are installed only on Siebel: 

● AICD 

● The Siebel integration components and Siebel workflows 

● The EAI server - installed either on Avaya IC or Siebel 
 

 

The Avaya IC CD 

The Avaya IC CD contains the core system that you must install on both Avaya IC and Siebel. 

For example, the Object Request Broker (ORB) server is installed on the Siebel server also as 

the Avaya IC servers. 
 
 
 
 

Security 

The same security policies for Avaya IC also apply to the Avaya IC Siebel integration. The 

following security policies are unique for an Avaya IC Siebel integration: 

● Siebel authenticates clients before the client interacts with the AICD. 

● The EAI servers authenticate with Siebel using a Siebel login and password. However, the 

login and password are passed as clear text to Siebel using HyperText Transfer Protocol 

(HTTP). Customers will need to ensure that the EAI servers and Siebel servers are 

connected over a private network and not accessible to the outside. 

 

Related topics 

For detailed security information about Avaya IC or Siebel, see the appropriate Avaya IC 

documentation or the Siebel documentation. 
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Chapter 4: Email entry method 

 

This section contains the following topics: 

● Overview of email entry method on page 60 

● Email entry process on page 60 

● How email replies are handled on page 62 
 
 
 
 

Overview of email entry method 

This integration supports the Siebel-first entry method where email enters through Siebel. If 

Siebel decides that the email must be sent to an agent, Siebel passes an email notification to 

Avaya IC. Avaya IC routes the email to the agent. 

The following figure shows the Siebel-first email entry method. 
 
 

 
 
 

 

Email entry process 

The following process describes the Siebel-first email entry method: 

1. Email enters Siebel through the POP3 email server. 

2. Siebel runs an email response workflow. 

3. The email response workflow determines how to process the email. One of the following 
actions occurs: 
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● Siebel dismisses the email and the email process ends. For example, Siebel 

dismisses the email because it detects junk email. 

● Siebel performs Content Analysis on the email and the resulting confidence level 

exceeds the administered threshold. An autoresponse is sent without agent 

involvement. In this case, an autoacknowledgement is usually not sent. 

● Siebel performs Content Analysis on the email and the resulting confidence level is 

under the administered threshold. The email is routed to an agent using the process 

described in Steps 4 through 9. Usually, an auto acknowledgement is sent to the 

customer because agents cannot always respond immediately to customer email. This 

is optional. 

4. Siebel composes an email with new information encoded in the body and sends this 

notification email to a mailbox on a POP3 email server. The email includes the following 

information: 

● The To, From, and Subject information of the original email 

● Language as determined by Siebel Content Analysis 

● Content Analysis results from Siebel 

● ActivityID of the original Siebel email 

5. Avaya IC reads the email from the POP3 server and starts a Siebel-first email workflow to 

process it. 

6. The workflow processes the email so that Avaya IC can route the email using the email 
routing workflow. 

7. When the work item or email displays on the agent desktop, the original email is popped in 

the Siebel screen using the Activity ID that was passed from Siebel. 

8. When the agent has replied to or forwarded the email, the agent releases the work item 

from the Siebel toolbar. The agent can also dismiss the email without forwarding or 

replying. 

9. The AICD receives a message to release the work item and passes a disconnect email 

message to Avaya Agent or ASIS. The way Avaya Agent or ASIS handles a disconnect 

message is similar to handling a dismiss message. If a response is then sent to the 

customer, the dismiss is transparent to the agent on the Avaya Agent or ASIS side. In 

other words, the agent must not see a dialog box asking for a dismiss reason. Instead, 

Avaya Agent or ASIS must use a special preconfigured dismiss reason. 

If the agent has dismissed the email without replying or forwarding, the agent is asked for 
a dismiss reason. 

10. Siebel sends out the email response composed by the agent. 

mailto:infodev@avaya.com


August 2022 52 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

How email replies are handled 

 

 

 
 

 

Related topics 

See one of the following topics: 

● For more information about how Content Analysis works within Siebel, see the Siebel 

documentation. 

● For more information about email workflows, see Siebel-first email workflow on page 119. 
 
 
 
 

How email replies are handled 

In the Siebel-first email method, tracking for the reply thread is done within Siebel. The routing 

for reply emails is identical to the routing of original emails in the out-of-the-box Avaya IC Siebel 

integration. However, you can customize this behavior by modifying the email workflow in Siebel 

and the Siebel-first email workflows in Avaya IC. 
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Chapter 5: Components within Avaya IC 

 

This section describes the integration components within Avaya IC and includes the following 

topics: 

● ASIS on page 64 

● EAI server on page 64 

● Avaya IC management tools on page 67 

● ORB Servers on page 68 

● Web Agent on page 69 
 
 
 
 

ASIS 

Agent Server for Integration with Siebel (ASIS) is a Siebel-specific component of Avaya IC. 

ASIS: 

● Is used in only the Native integration with Siebel 

● Is used instead of the Avaya Agent application 

● Is available only in Avaya IC 7.1 or later 

● Handles requests and event communication for all agents 

● Can be installed on the Siebel server or on the Avaya IC server 

Note: 
Ensure to set the Native-specific parameters in the Siebel configuration. 

 
 
 
 

EAI server 

This section includes the following topics: 

● About the EAI server on page 65 

● EAI figure on page 65 

● HTTP/MIME/XML interface on page 66 

● EAI server types on page 66 
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● Server type limitations on page 66 

 

 

About the EAI server 

The Enterprise Application Integration (EAI) server is a Siebel-specific component of Avaya IC. 

The EAI server accepts requests from blocks on the Avaya IC to perform Get Data and Put Data 

operations. 

 

Related topics 

For more information, see any of the following topics: 

● Configuring the Avaya EAI servers on page 169 

● EAI in multisite configurations on page 42 

● EAI server errors on page 294 

● EAI Get and Put operations on page 400 

● For more information about the EAI on Siebel, see the Siebel documentation. 
 

 

EAI figure 

The following figure shows how the EAI interfaces with Siebel. 
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HTTP/MIME/XML interface 

The Avaya IC EAI server and Siebel use the HTTP/MIME/XML interface to transfer encoded 

messages. The EAI server on Avaya IC works as a client to the Siebel EAI server through the 

Siebel Web server. 
 

 

EAI server types 

The Avaya EAI servers provide the communication links between Avaya IC and Siebel so that 

Avaya IC workflows can read and write customer data. Each of the two EAI server types use 

different protocols to communicate with Siebel, and each protocol supports different integration 

capabilities and overhead. 

The two types of EAI servers are described in the following table. 

 

Server type Description 

EAI Supports the Avaya IC Get Data block in the out-of-the-box voice 
qualification workflow, incomingcall_sbl. 

EAIWorkflow Supports the Avaya IC Put Data block in the out-of-the-box voice 
qualification workflow, incomingcall_sbl. 

 

Related topics 

For more information, see the following topics: 

● Siebel palette blocks on page 99 

● Adding the EAI server on page 171 

● Adding the EAIWorkflow server on page 172 
 

 

Server type limitations 

The differences in EAI server type limitations are described in the following table. 

 

EAI server type Operation Attachments1 allowed? Returns 

Siebel ID 

record? 

EAI Get No Yes 

Put No No2
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EAI server type Operation Attachments1 allowed? Returns 
Siebel ID 

record? 

EAIWorkflow Get No Yes 

Put Optional attachments configured in IC 
Manager and IC Workflow 

Yes 

1. The MIME layer facilitates attachments to be added to the request. For example, an attachment is 

required when creating a Web chat record with the transcripts. 

2. Use EAIWorkflow for Put operations. 

 

Example of a limitation 

The EAI server type interacts directly with the EAI on Siebel. Because Siebel integration objects 

do not return a record ID on a Put request, the record ID cannot pop a Siebel screen to the 

agent with a newly created record. If the EAIWorkflow server type is used for Put operations, 

the newly created record ID is returned by Siebel. 
 
 
 
 

Avaya IC management tools 

You must use the following Avaya IC management tools to install, configure, and customize the 

Avaya IC Siebel integration: 

● Database Designer on page 67 

● IC Manager on page 68 

● Workflow Designer on page 68 
 

 

Database Designer 

The Database Designer is a tool used to configure databases, set database connections, 

customize, or generate out-of-the-box applications, and push applications and IC Scripts to the 

database. Use Database Designer to configure the Avaya Agent or ASIS databases to work 

with the integration. 

 

Related topic 

For more information about Database Designer, see IC Database Designer Application 

Reference. 
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IC Manager 

Use Interaction Center (IC) Manager to: 

● Add new Siebel property values and modify existing Avaya IC property values 

● Install an Avaya IC server on Siebel and configure a secondary ORB server 

● Create, install, and monitor the AICD 

● Install and monitor the EAI server 

● Configure workflow servers to use Siebel voice, Web, and email workflows 

● Modify the Website to use Customer Management workflows for Web 

● Configure Avaya IC Resolve Status so that Avaya Agent or ASIS can release email work 

without first responding to the e-mail sender 

 

Related topic 

For more information about IC Manager, see IC Administration Guide. 
 

 

Workflow Designer 

Use Workflow Designer to install, configure, and customize the workflows that are specific to an 
Avaya IC Siebel integration. Specifically, you must use Workflow Designer to: 

● Add the out-of-the-box workflows for the integration 

● Install and compile the Siebel incoming-call and Transcript Added workflows on Avaya IC 

 
Related topic 

For more information about Workflow Designer, see Avaya Workflow Designer User Guide. 
 
 
 
 

ORB Servers 

The Avaya IC ORB Server controls and maintains servers. Every machine that runs servers 

must have an ORB Server. The ORB Server can start, stop, and monitor the status of any 

server. 

ORB Servers on different machines communicate with each other to find the correct resource 

for a client request. If the requested service is not on the ORB Server machine, the request is 

rerouted to the correct ORB Server. If a server is not yet started, the ORB Server starts it. 
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Related topics 

For more information, see the following topics: 

● Installing and configuring an Avaya IC secondary ORB server on Siebel on page 141 

● Avaya IC Core Services Programmer Guide. 
 
 
 
 

Web Agent 

Note: 
This section applies only to Hybrid Siebel integrations. If you have a Native Siebel 

integration, skip this section. 

This section includes the following topics: 

● Definition of Web Agent on page 69 

● Changes for the integration on page 69 
 

 

Definition of Web Agent 

In a non-integrated system, the Web Agent is a window in the GUI desktop that agents use to 

handle the email and Web chat contacts after selecting these contacts from the Avaya Agent 

task lists. 
 

 

Changes for the integration 

In a Siebel integration, all email, work transfer, and work completion options are disabled in the 

Avaya Web Agent window because these functions are now performed through the Siebel 

Application window. 

The Web Agent application still performs the following tasks in the background: 

● Supports a mode where the application is the source of events and methods for emails, 

though it does not display emails in the Avaya Web Agent window. The properties files for 

Web Agent were modified to accomplish the display of emails in the Avaya Web Agent 

window. 

● Programs the wrap-up and completion of an email task 

● Transfers emails or chats using the Unified Agent Directory (UAD) 
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Chapter 6: Avaya Agent components 
 
 
 
 

 
Important: 

Avaya Agent integrations are applicable only for Hybrid Siebel integrations. If you 

have a Native Siebel integration, see Customizing Native Siebel on page 302. 

This section describes the integration components that reside within Avaya Agent and includes 
the following topics: 

● Avaya Agent architecture on page 70 

● Avaya Agent layout file on page 72 

● About IC Scripts on page 74 

● Integration hooks on page 75 

● Customizing AUX reason codes on page 77 

● AICDEngine on page 78 

● Wrap-up on page 80 

● Agent properties on page 82 
 
 
 
 

Avaya Agent architecture 

This section includes the following topics: 

● Avaya Agent architecture figure on page 71 

● Areas of functionality on page 71 

● Avaya Agent interactions on page 72 

! 
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Avaya Agent architecture figure 

The following figure shows a high-level diagram of the Avaya Agent architecture as it applies to 
the Siebel integration. 

 
 

 

 

Areas of functionality 

Avaya Agent has the following areas of functionality within an Avaya IC Siebel integration. 

Base Avaya Agent controls: Existing, out-of-the-box ActiveX controls that reside in Avaya 
Agent 

Base IC Scripts: Existing set of IC Scripts shipped with Avaya IC 

Siebel integration IC Scripts: IC Scripts written directly for the Siebel integration. These 

scripts must handle the actual requests from the AICD by calling methods on the Avaya Agent 

controls. When events occur in Avaya Agent, the Siebel integration IC Scripts must notify the 

AICD. 
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AICDEngine: ActiveX control that serves as bridge between Avaya Agent and the AICD 

 

 

Avaya Agent interactions 

Avaya Agent has the following interactions within an Avaya IC Siebel integration. 

Siebel integration IC Scripts -> Siebel thin client: The Siebel thin client is launched using an 

Internet Explorer (IE) browser. This script is accomplished by the Siebel integration IC Scripts. 

AICDEngine <-> AICD: The AICDEngine is assigned to the AICD that is servicing the agent 

logged into Siebel. This servicing has a two-way communication path. The AICDEngine makes 

requests to the AICD, and the AICD triggers events that are picked up and propagated by the 

AICDEngine. 

AICDEngine <-> ADU: One of the responsibilities of the Avaya Agent integration is to notify the 

AICD when certain ADU fields change value. The AICDEngine assigns to the ADU server for 

change events and sends these values to the AICD. 

AICDEngine <-> EDU: The AICDEngine assigns to the EDU server so that the EDU server can 

receive broadcast message requests, as well as propagate EDU Change events for certain 

fields that are relevant to the AICD. 

AICDEngine <-> Siebel integration IC Scripts: Siebel integration IC Scripts send requests to 

the AICD through the AICDEngine. Vice versa, all messages sent by the AICD come in the form 

of events to the AICDEngine. The AICDEngine then starts an event that is handled by the 

Siebel integration IC Scripts. 

Base IC Scripts <-> Siebel integration IC Scripts: This interaction occurs through integration 

hooks. The Siebel integration IC Scripts take appropriate action based on integration hooks that 

are being sent from the base IC Scripts. 

Siebel integration IC Scripts -> Base Avaya Agent controls: When the AICD makes a 
request to Avaya Agent by triggering an event to the AICDEngine, the Siebel integration IC 

Scripts call methods on the base Avaya Agent control. 
 
 
 
 

Avaya Agent layout file 

This section includes the following topics: 

● CDL file description on page 73 

● The Siebel integration CDL file on page 73 

● Differences in the Avaya Agent taskbars on page 73 
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CDL file description 

The CDL (Console Definition Language) file specifies the Avaya Agent screen layout and is 

written in XML (eXtensible Markup Language). During the Avaya Agent installation, the CDL 

was saved to the database after the file was customized. 

When an agent logs in, the system accesses the stored layout from the CDL file and configures 
the client machine accordingly. 

 

 

The Siebel integration CDL file 

The following list describes how the Siebel integration CDL file differs from the out-of-the-box 

Avaya CDL file. The Siebel integration CDL file: 

● Has a set of Siebel-specific EDU fields in the EDUFields QSection of the 
QPropertyDictionary. 

● Has a Siebel QSection in the QPropertyDictionary. 

● Contains only a bottom frame and a different arrangement of controls. 

● Has all the call-handling controls removed from the layout. 

● Does not contain a Status Dialog for handling conferences and transfers. 

● Still has status control, but the control is not visible to the agent. Status control supports 
only the dialogs for restoring Blender server failures, and Siebel performs the status 

functions. 

● Includes the AICDEngine in the layout 
 

 

Differences in the Avaya Agent taskbars 

The following figures show how the out-of-the-box Avaya Agent taskbars differ between a non 
integrated system and an Avaya IC Siebel integration. 

mailto:infodev@avaya.com


63 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

August 2022 

Chapter 6: Avaya Agent components 
 

 

 
 

Note: 
The equivalent to the Prompter pane resides in the avaya_agent_sbl_*.cdl file, 

but the pane is hidden unless you change the out-of-the-box configuration. 
 

Avaya Agent taskbar in a non 

integrated system 

Avaya Agent taskbar in an Avaya IC 

Siebel integration 

 

 
 

Related topics 

● For information about the Avaya Agent taskbar in an Avaya IC Siebel integration, see 

Avaya IC for Siebel User Guide. 

● For more information about the Avaya Agent CDL file in a non-Siebel-integrated system, 
see Avaya Agent Integration. 

● For more information about installing the CDL file, see Generating the Windows 

application on page 131. 
 
 
 
 

About IC Scripts 

Avaya IC Scripts are Visual Basic for Applications (VBA)-based subroutines that the system 
runs, either explicitly or when an event is raised. Events can be raised by: 

● Controls 

● Pane activation or deactivation 

● Mouse clicks 

● Key presses 
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These subroutines can do many tasks, from displaying an alert for the agent to saving 

information into the database. 

The Avaya IC Siebel integration includes a set of IC Scripts that are shipped with the Siebel 

integration. Do not customize these IC Scripts. Instead, use the integration hooks that are built 

in to the IC Scripts specifically for customizing the Siebel integration. 

 

Related topic 

For more information, see Integration hooks on page 75. 
 
 
 
 

Integration hooks 

Integration hooks can customize Avaya Agent to accomplish more advanced custom 

implementations without changing the base Avaya Agent IC Scripts. You can use integration 

hooks to handle any of the following advanced implementations: 

● Handle the reason codes sent with the AgentUnavailable and ChangeAuxReasonCode 

AICD commands 

● Handle the wrap codes sent with the ReleaseWork AICD command for Siebel wrap-up 

● Handle OnNewOpenData broadcasts 

● Implement custom AICD commands 

 
Related topics 

For more information, see the following topics: 

● For a complete description of integration hooks, see Avaya Agent Integration. 

● For a description of commands, see AICD commands on page 312 
 

 

Integration hook handlers 

A set of integration hook handlers are in the Siebel integration. These integration hooks are in 

the integration to provide you with examples so that you can create custom integration hooks for 

your site. This set of integration hook handlers are located on the design machine in 

<AVAYA_IC73_HOME>\design\qconsole\siebel\custom. 

The following integration hooks are included with the integration: 

● SiebelAICDEngine_AICDEngineStateChanged on page 76 

● SiebelAICDEngine_BroadcastMsgReceived on page 76 

● SiebelAICDEngine_RequestReceived on page 76 
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● Siebel_AICD_AgentUnavailable on page 76 

● Siebel_AICD_ChangeAuxReasonCode on page 76 

● Siebel_AICD_ReleaseWork on page 77 

● Siebel_ResolveDestination on page 77 

 
SiebelAICDEngine_AICDEngineStateChanged 

This integration hook is called when the state of the AICDEngine has changed. Use this 
integration hook to determine when the AICDEngine is establishing or losing the connection to 

the servers. 

 

SiebelAICDEngine_BroadcastMsgReceived 

This integration hook is called anytime the AICD generates a BroadcastEDU request from the 
AICDEngine. Use this integration hook to customize the OnNewOpenData broadcast message 

that reads data from the EDU. 

 
SiebelAICDEngine_RequestReceived 

This integration hook is called anytime the AICDEngine receives a request from the AICD. Use 

this integration hook to customize the AvayaAgentCommand request to create new functions. 

The AvayaAgentCommand is a generic request that can be triggered from Siebel. 

 
Siebel_AICD_AgentUnavailable 

This integration hook is called when the AICD sends the AgentUnavailable request. You can 
customize this integration hook to send a reason code with the AgentUnavailable request. The 

reason code is passed into the integration hook in the sReasonCode variable. For this to work, 

you must create a true sReasonCode and sReasonDigit to send back. The sReasonCode is a 

pkey of a classification code record in the IC Repository. The sReasonDigit is a 0 - 9 value that 

is sent to the Telephony Server (TS) for voice-enabled agents. 

 

Siebel_AICD_ChangeAuxReasonCode 

This integration hook is called when the AICD sends the ChangeAuxReasonCode request. 

Rules about what must be done here mirror the information explained in 

Siebel_AICD_AgentUnavailable. 
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Siebel_AICD_ReleaseWork 

This integration hook is called when the AICD sends the ReleaseWork request. The 

ReleaseWork request is sent only when wrap-up is enabled, and the WrapUpType is Siebel. 

When these conditions are met, you can choose to send data in the wrap codes parameter. You 

can then use this data to customize the storage of these wrap-up codes in the Avaya IC system 

using this script. 

 

Siebel_ResolveDestination 

This integration hook is called when the system tries to resolve a destination that was passed 

from Siebel into a MakeCall, InitConsultTransfer, InitConference, or InitMuteTransfer request. 

Use this integration hook if you change the way the out-of-the-box destination resolution is 

performed. 
 
 
 
 

Customizing AUX reason codes 

This section includes the following topics: 

● Using Avaya IC AUX reason codes on page 77 

● Using Siebel AUX reason codes on page 78 
 

 

Using Avaya IC AUX reason codes 

In the out-of-the-box Siebel integration, if you configure and enable AUX reason codes in Avaya 

IC, Avaya Agent automatically prompts the agent for the codes. When the agent chooses 

Unavailable from the Siebel toolbar, the Aux Reason Dialog window pops up and prompts the 

agent to choose a code. This code is written to the ADU the same way as in a non-Siebel 

integrated environment. A numeric reason digit (0-9) associated with the AUX reason code is 

also passed to the Telephony Server (TS) for voice-enabled agents. 

If you use AUX reason codes with your own dialog window, you must customize Avaya Agent 

using the integration hooks provided. Use integration hooks Siebel_AICD_AgentUnavailable or 

Siebel_AICD_ChangeAuxReasonCode. For a description of how the out-of-the-box integration 

hook works for Unavailable, see the custom samples shipped with the code at 
<AVAYA_IC73_HOME>\design\qconsole\siebel\custom. These samples have examples and 

notations that might be useful. 
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Using Siebel AUX reason codes 

If you prompt for AUX reason codes in Siebel using an applet and pass them to Avaya IC, 

customize the AICD.def file and Avaya Agent. You must also either build a custom Siebel applet 

or use a predefined applet, such as the Transfer Multiple LOV Popup Applet. 

An AUX reason code can be passed from Siebel to Avaya IC using the Reason parameter to 

the AICD’s AgentUnavailable or ChangeAuxReasonCode driver commands. 

The out-of-the-box AICD.def file does not pass a Reason parameter on AgentUnavailable. 

However, for the ChangeAuxReasonCode command under the Siebel NotReadyWithPopup 

menu, the out-of-the-box code invokes the Siebel Transfer Multiple LOV Popup Applet and 

passes the selected Reason value to Avaya Agent using the sReasonCode parameter. For 

Siebel Hybrid mode, you must customize the code in the appropriate Avaya Agent integration 

hook handler to translate the sReasonCode parameter to a true sReasonCode and 

sReasonDigit for each description on Siebel_AICD_AgentUnavailable on page 76. You may 

also need to change the AICD.def to associate the correct buttons and menus with your reason 

code applet. You might also need change the AICD.def to pass the appropriate reason code 

values to the AICD AgentUnavailable or ChangeAuxReasonCode commands. 
 
 
 
 

AICDEngine 

The AICDEngine is an integral part of the Avaya IC Siebel integration. When implementing 

more advanced customizations, you can send a request to the AICD to trigger events in Siebel. 

Therefore, importance is laid to understand the API on the AICDEngine that sends requests to 

the AICD. 
 

 

SendRequest 

Description 

This method causes the AICDEngine to make a request to the AICD through VESP. 
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Syntax 

 
SendRequest (sRequest As String, oRequestDataSeqCouple As Object) As Boolean 

 

Argument Description 

sRequest The request you can send to the AICD 

oRequestDataSeqCouple A Core SeqCouple of the name value pairs to send with 
your request 

 

Returns 

If successful, the function returns a value of True. 
 

 

Usage example 

The following IC Script code is an example of the OnAvayaAgentEvent request. This request 

triggers an event within Siebel. 
 

Sub Sample_OnAvayaAgentEvent_Request() 

Dim iApp As Application 

Dim iSiebelAICDEngine As Object 

Dim iOutRequestDataSeqCouple As Object 

 
Set iApp = GetApp 

Set iSiebelAICDEngine = iApp.GetActiveXControl("SiebelAICDEngine") 

Set iOutRequestDataSeqCouple = _ 

CreateObject(iApp.GetProperty("ObjectClasses", "CoreSeqCouple")) 

 
iOutRequestDataSeqCouple.AddCoupleByNameValue "event_name", "LookHere" 

iOutRequestDataSeqCouple.AddCoupleByNameValue "foo", "bar" 

iOutRequestDataSeqCouple.AddCoupleByNameValue "abc", "xyz" 

bResult = iSiebelAICDEngine.SendRequest("OnAvayaAgentEvent", 

iOutRequestDataSeqCouple) 

 
Set iOutRequestDataSeqCouple = Nothing 

 
End Sub 

This code created OutRequestDataSeqCouple that contains the data that must be passed to 

the event. You can then enhance the Siebel definition file to work with the requests you make. 
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Wrap-up 

This section includes the following topics: 

● Description of wrap-up on page 80 

● Integration wrap-up methods on page 80 

● Avaya IC wrap-up vs. Siebel wrap-up figure on page 81 
 

 

Description of wrap-up 

Wrap-up is the state the agent enters after contact with a customer ends. Wrap-up gives an 

agent time to finish tasks related to the contact and also to enter reason codes for the contact. 

On most Avaya IC systems, an agent does not receive new contacts on a channel that is in a 

wrap-up state. 
 

 

Integration wrap-up methods 

In the Siebel integration, two ways to perform a wrap-up is as follows: 

● Avaya IC wrap-up - The Avaya Agent implementation completes the wrap-up. Avaya IC 

wrap-up is done through the WrapUp Dialog or Prompter Scripting. 

● Siebel wrap-up - The Siebel implementation completes the wrap-up. 

In both cases, the Agent/Desktop.WrapUpEnabled property enables or disables wrap-up. If 

wrap-up is enabled, the Agent/Desktop.WrapUpType property is used to determine what type of 

wrap-up is performed. If this property is set to Siebel, the system uses the Siebel wrap-up. 
Otherwise, the system enforces the out-of-the-box Avaya IC wrap-up method. 

 
Related topic 

For more information about enabling or disabling wrap-up, see Setting Avaya IC properties on 

page 137. 
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Avaya IC wrap-up vs. Siebel wrap-up figure 

The following figure shows how the logic for wrap-up differs between the out-of-the-box Avaya 
IC implementation and the Siebel integration. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When Siebel wrap-up is enabled, the contact is completed only after the ReleaseWork 
command is sent from the AICD. The ReleaseWork command might include a 

comma-separated list of WrapUpCodes. 
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Related topics 

For more information, see the following topics: 

● ReleaseWork on page 358 

● Siebel_AICD_ReleaseWork on page 77 
 
 
 
 

Agent properties 

This section describes how agent properties are used for an Avaya IC Siebel integration and 

includes the following topics: 

● Description of agent properties on page 82 

● Siebel integration agent properties on page 82 
 

 

Description of agent properties 

Properties are options that define the behavior of agent business applications. Properties are 

defined in IC Manager and then assigned to Avaya IC tenants, workgroups, or agents. 

IC Manager stores these properties in the database so that Avaya IC business applications can 

retrieve the property settings. Storing properties in the database also means that no matter what 

machine an agent uses, Avaya Agent always looks and behaves the same way. 

 

Related topics 

For information for how to set agent properties or for more detailed conceptual information, see 

IC Administration Guide. 
 

 

Siebel integration agent properties 

The following table lists the Siebel integration properties. 

 

Property path Property name Description 

Agent/Desktop/WAC AlwaysOnTop Determines whether to set the 
Web Agent Client (WAC) window 
on top. 

AppMode Determines the mode of the Web 
Agent Client application. 
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Property path Property name Description 

Agent/Desktop/Siebel AutoLoginEnabled Determines whether to 
automatically log in to Siebel. 

Agent/Desktop ContactSuspensionEnabled Displays the Contact Suspension 
dialogs when an agent suspends a 
contact. 

IntegratedApplication Determines which third-party 
application is integrated with 
Avaya Agent. 

Agent/Desktop/Siebel LaunchURL 1 Determines the URL that opens 
the Siebel application from Internet 
Explorer. 

Agent/Desktop Layout Specifies which layout, or CDL file, 
to use for Avaya Agent. 

Agent/Desktop/Siebel/ 
AutoLogin 

PasswordFormat Determines how to change the 
case-sensitivity of the Avaya IC 
password so that Siebel accepts 
the password during AutoLogin. 

Agent/Desktop/ 
ScreenPop 

PopOnAllArrivingContacts If screen pops are enabled, screen 
pops occur for all contacts arriving 
in Avaya Agent. 

PopOnContactActivation If screen pops are enabled, screen 
pops occur when contacts are 
activated in Avaya Agent. 

PopOnFirstArrivingContact If screen pops are enabled, screen 
pops occur in absence of any 
contacts in Avaya Agent. 

Agent/Desktop ScreenPopEnabled Enables and disables screen 
pops. 

Agent/Desktop/Siebel/ 
Email 

SendFlowName Specifies the name of the email 
workflow that runs in the 
WorkFlowServerName workflow 
server. 

Agent/Desktop/ 
Directory 

ShowAgentsOnStartup Shows agents during startup in the 
Unified Agent Directory (UAD). 

ShowAllAgents Shows all agents in the entire 
Agent Directory Tree in the UAD. 
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Property path Property name Description 

Agent/Desktop/WAC ShowOnChatActivate Determines whether to show the 
WAC window when a Web chat is 
activated. 

ShowOnChatSelect Determines whether the Web 
Agent client displays when an 
agent selects a Web chat task. 

ShowOnEmailActivate Determines whether to show the 
WAC window when an email 
message is opened. 

ShowOnEmailSelect Determines whether the Web 
Agent client displays when an 
agent selects an email task. 

Agent/Desktop/Siebel/ 
AutoLogin 

UserNameFormat Determines how to change the 
case-sensitivity of the Avaya IC 
user name so that Siebel accepts 
the name during AutoLogin. 

WaitTime Determines the number of 
seconds that the system waits for 
the Siebel login page to display 
before prompting a skip message. 

Agent/Desktop/Siebel/ 
Email 

WorkFlowServerName Specifies the workflow server 
name for email. 

Agent/Desktop WrapUpEnabled Enables and disables wrap-up. 

WrapUpType If wrap-up is enabled, determines 
the type of wrap-up. 

1. When LaunchURL is configured, Internet Explorer is launched, and it opens the Siebel Application 

automatically. If it is required to use another Internet browser (for example, Google Chrome), leave 

LaunchURL empty. In this case, the user needs to start AARC, then launch the Internet browser and 

open the Siebel application in that Internet browser manually. 

 

Related topics 

For more information, see the following topics: 

● Wrap-up on page 80 

● Setting Avaya IC properties on page 137 

● For more detailed conceptual information, see IC Administration Guide. 
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Chapter 7: Components within Siebel 

 

This section describes the integration components that reside within Siebel and includes the 

following topics: 

● AICD on page 86 

● Integration objects on page 90 

● SCAPI interface on page 90 

● Siebel activity records on page 91 

● Siebel user interface on page 92 

● Siebel Communications Server on page 92 

● Siebel definition file on page 93 

● Siebel Tools on page 95 

● Smart Answer and Smart Answer Manager on page 95 
 
 
 
 

AICD 

This section includes the following topics: 

● Overview of the AICD on page 86 

● AICD and Siebel interfaces on page 88 

● AICD and Avaya IC interfaces on page 88 

● AICD and interfaces to Avaya Agent on page 89 

● Multiple AICDs on page 89 
 

 

Overview of the AICD 

This section includes the following topics: 

● What the AICD does on page 87 

● AICD architecture for Hybrid Siebel on page 87 

● AICD architecture for Native Siebel on page 88 
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What the AICD does 

The Adaptive Interaction Center Driver (AICD) is a new integration component that is located on 

a Siebel Application server. The AICD supplies out-of-the-box integration between Avaya IC 

and Siebel that: 

● Facilitates Avaya IC to pass work notifications and work-related events to Siebel 

● Facilitates Siebel to pass work-related control commands to Avaya IC 

● Synchronizes various agent actions and states between the Siebel browser-based 

desktop and the Avaya Agent desktop 

Note: 
Avaya IC for Native Siebel does not have an Avaya Agent desktop. 

● Manages some Siebel user interface tasks, such as updating the state of the Siebel 
toolbar buttons 

The AICD runs on a Siebel server as a Dynamic Link Library (DLL) on windows or a shared 
library on Solaris/AIX under the Siebel Communications Server. 

 
AICD architecture for Hybrid Siebel 

The following figure shows how the AICD functions within a Hybrid Siebel system. 
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AICD architecture for Native Siebel 

The following figure shows how the AICD functions within a Native Siebel system. 
 
 

 
 
 

AICD and Siebel interfaces 

The AICD is a Siebel Communications Server driver that communicates to Siebel through the 

Siebel Adaptive Communications API (SCAPI) interface. The SCAPI interface passes work item 

events from the AICD to Siebel, and passes work item commands from Siebel to the AICD. 
 

 

AICD and Avaya IC interfaces 

The AICD uses the following components to communicate with Avaya IC: 

VESP: The AICD uses the Avaya IC Voice Enhanced Services Platform (VESP) to 
communicate with the Avaya IC servers, and uses the Avaya IC Multi Threaded Toolkit (MTT) to 

accomplish these communications. 

TS: The AICD uses the Telephony Server (TS) to monitor the telephone extension of each 

agent. The AICD also sends commands to the TS in response to actions taken by the agent 

through the Siebel toolbar - for example, when an agent puts a call on hold. 

ADU: The AICD uses the Agent Data Unit (ADU) server to locate Avaya Agent or ASIS to 

establish a direct communication link between the AICD and Avaya Agent or ASIS. 

mailto:infodev@avaya.com


77 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

August 2022 

Chapter 7: Components within Siebel 
 

 

 

 
EDU: The AICD uses the EDU server to: 

● Extract information about a work item and pass it on to Siebel - To extract information is 
the primary function 

● Send broadcast-type communications with respective agents associated with the same 

contact 

● Pass customer-specific data from Avaya IC workflows to Siebel 

● Pass customer-specific data between different Siebel agents handling the same work item 

Alarm server: The AICD uses the Alarm server to report abnormal events or conditions that 

require human intervention to resolve. For example, the inability to startup or communicate with 

an Avaya IC server causes an alarm. 

ASIS: The Agent Server for Integration with Siebel (ASIS) is used only for Native Siebel 

integrations and is used instead of the Avaya Agent application. ASIS handles requests and 

event communication for all agents. 
 

 

AICD and interfaces to Avaya Agent 

The need occurs for the AICD to send requests to Avaya Agent because most toolbar actions, 
especially for email and web contacts, need to be passed to Avaya Agent for execution. 

The AICD and Avaya Agent share a communication protocol that coordinates the Siebel 
desktop and Avaya Agent interfaces when an agent handles work items. 

Note: 
Avaya IC for Native Siebel configurations do not use Avaya Agent. Processing is 

controlled through ASIS. 
 

 

Multiple AICDs 

You can configure an Avaya IC Siebel integration to have multiple instances of the AICD. 

Specifically, you can one or more AICDs at each of several Siebel Application servers that run 

the Siebel Communications Server. Each AICD can support a number of Siebel agent sessions. 
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Integration objects 

Siebel integration objects facilitates integration metadata for Siebel business objects and 

eXtensible Markup Language (XML) to be represented as common structures that the Siebel 

EAI framework can operate. Because these integration objects adhere to a set of structural 

conventions, the objects can be traversed and transformed programmatically. 

A typical integration project includes transporting data from one application to another. For 

example, integrators can use integration objects to synchronize the data in a legacy system with 

the data in the Siebel application. Integration objects synchronize the external system so that 

the software can write data from the external system into the Siebel database. Likewise, the 

software can write data in the Siebel database into the external system. 

Avaya-specific integration objects are available that you must import for the out-of-the-box 

integration to work. EAI Get and Put operations on page 400 describes the out-of-the-box 

Avaya-specific integration objects. Import the Avaya-specific Siebel workflow, Avaya IC EAI 

MIME for Put operations. 

 

Related topics 

For more information, see one of the following topics: 

● EAI Get and Put operations on page 400 

● Installing a custom integration object on page 173 

● For more information about integration objects, see the Siebel documentation. 
 
 
 
 

SCAPI interface 

The AICD communicates to Siebel through the Siebel Adaptive Communications API (SCAPI) 
interface. The SCAPI interface is a programmable software layer located between Siebel and 

Avaya IC that passes work item events from the AICD to Siebel, and work item commands from 

Siebel to the AICD. 

The SCAPI interface is located on the Siebel system. 

 
Related topic 

For a detailed description of the SCAPI, see the Siebel documentation. 
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Siebel activity records 

A Siebel activity record tracks each interaction with a customer. A siebel activity can record any 
of the following data: 

● Time and date of interaction 

● Brief customer data 

● Duration of interaction 

Activity records are associated with a master record, such as an account, and are used to track 

interaction history. 

The Avaya IC Siebel integration provides two mutually exclusive ways to create a Siebel activity 

record: 

● Using EAI on page 91 

● Using Siebel event logs on page 91 
 

 

Using EAI 

You can use the example out-of-the-box integration Avaya IC workflows to create the Siebel 
activity record. The example workflows, ts_sbl.incomingcall_sbl and 

wacd_sbl.qualifychat_sbl use Enterprise Application Integration (EAI) to create the Siebel 

activity. However, the examples do not update the following Siebel activity fields; Start Time, 

Duration, and Status. If you update these fields, update the example out-of-the-box Avaya IC 

workflows or consider using Siebel event logs to create activities. 
 

 

Using Siebel event logs 

You can use Siebel event logs to create the activity record. Siebel provides definition file 

examples for using Siebel event logs. If you use Siebel event logs, you must do one of the 

following tasks: 

● Use the standard Avaya IC ts.incomingcall and wacd.qualifychat workflows to route the 
contact. These workflows do not create Siebel activities. 

● Edit the out-of-the-box Avaya IC ts_sbl.incomingcall_sbl and 

wacd_sbl.qualifychat_sbl workflows to remove the activity creation block. 

The most likely put to trigger activity creation is from the event handler for the OnNewWorkItem 

event. 
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Related topics 

For more information, see the following topics: 

● For a description of and for examples for creating Siebel event logs, see the Siebel 

Communications Server Administration Guide. 

● For information about the OnNewWorkItem event, see OnNewWorkItem on page 388. 
 
 
 
 

Siebel user interface 

Use the Siebel user interface to administer the AICD and to modify Siebel workflows. 

To use to the Siebel user interface: 

1. Start the Siebel server components, if the components do not automatically start. 

2. Start the client machine in Internet Explorer, and type the values shown in the following 

table. 

 

Field Value 

Login SADMIN 

Password Type the client password. 

3. Go to the Site Map by pressing Ctrl+Shift+A. 

Result: A large, alphabetized, multi column list of hyperlinks to the Siebel windows opens. 
 
 
 
 

Siebel Communications Server 

The Siebel Communications Server is a server located within Siebel that provides an 

infrastructure to support several kinds of communications activities for Siebel application users. 

The Communications Server supports: 

● Multichannel interactive communications so that call center agents can make or receive 

voice calls and receive inbound email messages 

● The integration of third-party email servers to process inbound email 

● The integration of third-party communications systems, such as email servers, to send 
outbound communications 

In this integration, the main function of the Siebel Communications Server is to exchange 

commands and events with the AICD to provide communication integration with Avaya IC. 
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Related topic 

For more information, see the Siebel documentation. 
 
 
 
 

Siebel definition file 

This section includes the following topics: 

● Description of the definition file on page 93 

● Commands and events on page 93 

● About customizing the definition file on page 94 

● Coordinating customizations on page 94 

● Customizing the definition file on page 94 
 

 

Description of the definition file 

The Siebel definition file contains a Siebel proprietary language that processes the commands 

and events passed between Siebel and the AICD. The definition file: 

● Determines Siebel desktop behavior, such as what Siebel screen to pop to the agent 

● Controls the commands and events passed between Siebel and the AICD 

You can modify the definition file to change either of these behaviors. 

The out-of-the-box definition file is configured for a Hybrid Siebel desktop. If you have a Native 
Siebel configuration, make modifications for each comments in the AICD.def file. 

 

 

Commands and events 

The Siebel definition file translates the commands and events so that the AICD and the Siebel 

Communications Server can communicate. Every Siebel driver has its own and often unique, 

set of commands and events. The Siebel definition file translates these into standard Siebel 

operations. A typical operation is to pop a Siebel screen based on the event data. 

 

Related topics 

For more information, see the following topics: 

● AICD commands on page 312 

● AICD events on page 370 
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About customizing the definition file 

The AICD comes with an out-of-the-box Siebel definition file that performs out-of-the-box 

operations when work is delivered through events. The Siebel definition file maps the Siebel 

toolbar buttons to specific AICD commands. You can customize the out-of-the-box Siebel 

definition file for each customer installation. 

You must know which commands and events are supported by the AICD to customize the 

system configuration through the definition file. 

 

Related topics 

For more information, see one of the following topics: 

● AICD commands on page 312 

● AICD events on page 370 

● Customizing the definition file on page 94 
 

 

Coordinating customizations 

You must coordinate the customization of the definition file with other customizations, such as: 

● Avaya IC properties that control the behavior of Avaya Agent 

● Avaya IC workflows 

Example: An Avaya IC workflow that is activated with the arrival of a call might create a service 

request in Siebel using the EAI server. The workflow must insert the row ID of the newly created 

service request into the EDU open data container for the call. The event handler for the 

OnNewWorkItem event in the definition file might then pop the service request record at an 

agent desktop, as the call is routed to the agent. 
 

 

Customizing the definition file 

To modify a definition file: 

1. Get a copy of the Siebel definition file. Get either the original file commented on, or export 

an uncommented file from Siebel. 

The original commented file is located at SIEBEL_INSTALL_DIR\siebsrvr\objects\ 

enu. 
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2. Configure the file to change the behavior of the system. You can edit the file with any text 

editor, such as Notepad. 

For more information about how to configure the definition file, see the Siebel 

documentation. 

3. Import the file into the Siebel Communication Server. 
 
 
 
 

Siebel Tools 

Siebel Tools is a declarative software development tool developed by Siebel that allows you to 

configure the underlying data and data presentation of your Siebel application without making 

changes to the program source code. Siebel Tools creates and maintains a custom Siebel 

Repository File (SRF) to store your custom configurations. 

During installation and configuration, use Siebel Tools to add custom integration objects to 
Siebel and configure email. 

 
Related topic 

For more information about Siebel Tools, see the Siebel documentation. 
 
 
 
 

Smart Answer and Smart Answer Manager 

Smart Answer is a Siebel feature that analyzes the content of unstructured emails and either 
sends an automatic response or suggests an email response. 

Smart Answer Manager is a server used by Siebel Smart Answer to detect the meaning or the 

intent of incoming emails. 

 

Related topics 

See one of the following topics: 

● Configuring Smart Answer Manager on page 220 

● For more information about Smart Answer Manager, see the Siebel documentation. 
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Chapter 8: Integration workflows 

 

This section includes the following topics: 

● Avaya IC and Siebel workflows on page 96 

● Siebel Advocate workflows on page 98 

● Siebel palette blocks on page 99 

● Voice qualification workflow on page 112 

● Chat qualification workflows on page 115 

● Siebel-first email workflow on page 119 

 
Related topic 

For information about customize workflows, see Avaya Workflow Designer User Guide. 
 
 
 
 

Avaya IC and Siebel workflows 

For example, to get a customer record for a voice contact, configure this block to use - Get 

Contact as the Avaya IC integration object and one of the query keys as the Automatic Number 

Identification (ANI) for the voice contact. The following table describes the locations of the 

workflows. 

 

Workflows Location 

Avaya IC workflows <AVAYA_IC73_HOME>\design\IC\Flows\Avaya 

Siebel integration workflows <AVAYA_IC73_HOME>\design\IC\Flows\Siebel 
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Project and workflow names for new Siebel workflows 

The project and workflow names for Siebel-first and Siebel-Advocate workflows are described 
in the following table. These workflows are new for the Avaya IC for Siebel integration. 

 

Siebel project 

name 

Siebel workflow name More information 

Siebel-first 

icemail_sbl_first. 
prj 

analyze_sbl Siebel-first email workflow on page 119 

Siebel-Advocate 

advocate_sbl.prj qualifyvoice_adv_sbl Siebel Advocate workflows on page 98 

qualifyemail_adv_sbl 

qualifychat_adv_sbl 

 
Project and workflow names for existing Siebel integration workflows 

The Avaya IC and Siebel project names and workflow names for workflows that are modified for 

the integration are described in the following table. 

 

Avaya IC 

project name 

Avaya IC workflow 

name 

Siebel project 

name 

Siebel workflow name 

icm.prj transcriptadded icm_sbl.prj transcriptadded_icm 

ts.prj incomingcall ts_sbl.prj incomingcall_sbl 

webcenter.prj addcustomer webcenter_sbl.prj addcustomer_sbl 

webcenter.prj deletecustomer webcenter_sbl.prj deletecustomer_sbl 

webcenter.prj getauthenticated 
customer 

webcenter_sbl.prj getauthenticatedcustomer_sbl 

webcenter.prj getcustomer webcenter_sbl.prj getcustomer_sbl 

webcenter.prj getcustomer webcenter_sbl.prj getcustomerlist_sbl 

webcenter.prj getregions webcenter_sbl.prj getregions_sbl 

webcenter.prj schedulecallback webcenter_sbl.prj schedulecallback_sbl 

webcenter.prj undeletecustomer webcenter_sbl.prj undeletecustomer_sbl 
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Avaya IC 
project name 

Avaya IC workflow 
name 

Siebel project 
name 

Siebel workflow name 

webcenter.prj updatecustomer webcenter_sbl.prj updatecustomer_sbl 

wacd.prj qualifychat wacd_sbl.prj qualifychat_sbl 

wacd.prj qualifyemail wacd_sbl.prj qualifyemail_sbl 
 

Related topics 

For more information about these workflows, see the following topics: 

● Voice qualification workflow on page 112 

● Chat qualification workflows on page 115 
 
 
 
 

Siebel Advocate workflows 

This section contains the following topics: 

● Siebel Advocate email and chat workflows on page 98 

● Siebel Advocate voice workflow on page 99 
 

 

Siebel Advocate email and chat workflows 

The Siebel Advocate email and Web chat workflows, qualifyemail_adv_sbl, and 

qualifychat_adv_sbl, determine a collection of Business Advocate qualifiers that describe the 

email and Web chat contacts. Later the email contacts and the web chat contacts deliver this 

information to the Business Advocate system for routing. 

The Web Advocate Adapter (WAA) server starts these workflows when the WAA server detects 

a new incoming email contact or chat contact. These workflows are not triggered by a Voice 

Enhanced Services Platform (VESP) event. The qualifyemail_adv_sbl can be run on workflow 

servers with a WAA:email.qualify channel association. The qualifychat_adv_sbl can be run on 

workflow servers with a WAA:chat.qualify channel association. 

If the Avaya IC system includes the Siebel Advocate workflows, do not use the 

wacd.qualifyemail_sbl or wacd.qualifychat_sbl workflows. 
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Siebel Advocate voice workflow 

The Siebel Advocate voice workflow, qualifyvoice_adv_sbl, determines a collection of 

Business Advocate qualifiers that describes the voice contacts and then delivers this 

information to the Business Advocate system for routing. 

This workflow is started by the Telephony Server Adapter (TSA) server when the TSA server 
detects a new incoming voice request. This workflow can run on any workflow server that has 

the channel association TSA:voice.qualify. 

 

Related topic 

For more information about Business Advocate workflows, see Avaya IC Media Workflow 
Reference. 

 
 
 
 

Siebel palette blocks 

The modified integration workflows and the new integration workflows include some unique 

blocks that are available on the Siebel palette in Workflow Designer. These blocks use the EAI 

interface to: 

● Support the data exchange between Avaya IC and Siebel 

● Request content analysis of email 

● Request auto response functions from Siebel 

This section describes the blocks on the Siebel palette and provides information about other 

new blocks that are used in Siebel integration workflows. This section includes the following 

topics: 

● Create Agent Desktop Data block on page 100. 

● EAI Get Data block on page 102. 

● EAI Put Data block on page 105. 

● EAI Put Data with Attachments block on page 108. 

● Additional new blocks in Siebel integration workflows on page 111 

 
Related topics 

For more information, see the following topics: 

● EAI server types on page 66 

● EAI Get and Put operations on page 400 
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Create Agent Desktop Data block 

The Siebel version of the block uses the EDU information to create the containers and data that 

Avaya Agent uses for screen pops. Create Agent Desktop Data in all the routing workflows after 

the Siebel contact is looked up. 

This block assigns values in $scContactData and $VduData to the EDU couples. The values 

provide information about the customer and the contact that is immediately stored in the EDU 

record. 

 
Sample workflow 

For an example of how Create Agent Desktop Data can be used in a workflow, see Sample 
Incoming Call flow on page 114. 

 
Basic properties 

The Basic tab of Create Agent Desktop Data includes the properties in the following table. 

 

Property Default Value Description 

ContactData $scContactData Script variable that stores the information 
retrieved from the Siebel Contact database 
through an EAI Get Data block. 

This retrieved information can include: 

● Customer information, including full 
name and ID 

● Chat contacts only, user name from 
website 

● Email contacts only, sender of email 

● Voice contacts only, primary ANI 
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Advanced properties 

The Advanced tab of Create Agent Desktop Data includes the properties in the following table. 

 

Property Default Value Description 

blockDebug off Debug level of the block. 

Before changing the default value, see 
Avaya IC Media Workflow Reference. 

start Create Agent 
Desktop Data 

Block IC Script. 

VduData $VduData Script variable where sequence of couples 
returned by EDU server is stored. 

 

Alarms 

Generates the alarms described in the following table: 

 

Alarm Description 

Failed to determine Media Type! This High alarm is generated when the EDU data 
stored in the $VduData variable does not contain the 
type field. 

An EDU must always include a value in the type field. 
Therefore, this alarm indicates that the EDU record 
identified by the EDU ID delivered in the event to 
activate the workflow no longer exists or is lost. 

No Customer Info for this Contact! This High alarm is generated when the 
$scContactData variable does not contain the field 
Contact.FullName. 

This alarm usually indicates that the EAI Get Data 
block did not return a unique, matching Contact record 
from Siebel. 

 

Connections 

Accepts the following connections: 

● Input: 1 or more 

● Output: 1 
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EAI Get Data block 

The EAI Get Data block retrieves records from the Siebel database. This block: 

1. Uses an integration object to identify the type of information that is to be retrieved from the 

Siebel database. 

2. Sends a query key to Siebel based on the media type of the contact, that is, voice, email, 
or chat. 

3. Siebel returns a predefined set of data related to the key. 

For example, to get a customer record for a voice contact, configure this block to use Avaya IC 

- Get Contact as the integration object and one of the query keys as the Automatic Number 

Identification (ANI) for the voice contact. The Siebel database returns customer and account 

information associated with that ANI. 

 

Related topic 

For more information, see EAI Put Data block on page 105. 

 
Sample workflow 

For an example of how EAI Get Data can be used in a workflow, see the EAI Get Data (Look for 

Contact) block in Sample Incoming Call flow on page 114. 
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Basic properties 

The Basic tab of EAI Get Data includes the properties in the following table. For more 

information about Get Action integration objects and the types of records that the objects 

retrieve from Siebel, see EAI Get and Put operations on page 400. 

 

Property Default Value Description 

IntegrationObject empty A Get Action integration object retrieves 
information from the Siebel database about 
actions that agents took in response to previous 
contacts with this customer. 

Type the exact name of a custom integration 
object or select a preconfigured integration 
object. 

● Avaya IC - Get Account 

● Avaya IC - Get Action 

● Avaya IC - Get Contact 

● Avaya IC - Get Order Entry 

● Avaya IC - Get Quote 

● Avaya IC - Get Service Request 

To use a custom integration object, create the 
object before you type the name in this field. 

QueryKeyName_N empty Name of the query key in the integration object 
that the block must use to retrieve data from the 
Siebel database. For example, the Avaya IC - 
Get Contact integration object includes the 
following out-of-the-box query keys: 

● Contact.Id 

● Contact.FullName 

● Contact.EmailAddress 

● Contact.HomePhone 

You can specify up to 5 query keys. 

QueryKeyValue_N empty Target where the block must store values that is 
retrieved by the queries. 

For example, if you specify a query key in 
QueryKeyName_01, enter the target for the data 
in QueryKeyValue_01. 
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Advanced properties 

The Advanced tab of EAI Get Data includes the properties in the following table. 

 

Property Default Value Description 

BaseTag <default> Name of the base "List of" tag to be used in 
the xml document. 

If you do not specify a tag, the block uses 
ListOf"<integrationobject> for the 
tag name. 

<default> is the typical value for this 
property. 

blockDebug off Debug level of the block. 

Before changing the default value, see 
Avaya IC Media Workflow Reference. 

DTD Name <default> Name of the DTD used in the integration 
object. <default> indicates that the 
integration object uses the same DTD as the 
preconfigured integration objects. 

MaxRecords 0 Specifies the maximum number of records to 
be returned by the search. 

A value of "0" returns all matching records. 

NumberOfRecords 
Retrieved 

$sNumberOf 
RecordsRetrieved 

Script variable that holds the number of 
records retrieved from the Siebel database. 

OutData $sscOutData Script variable that holds the results returned 
from the query of the Siebel database. 

ReturnCode $sReturnCode Script variable that holds the value of the 
return code that is returned by the 
EAI.GetData() method. 

A value other than "0" indicates an error. 

Server EAI Name of the EAI server. 

start EAI Get Data Block IC Script. 

validateDTD false Determines whether the block must validate 
the DTD used in the integration object before 
querying the Siebel database. 
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Alarms 

Generates the alarms described in the following table: 

 

Alarm Description 

ObjectName property not set!! This High alarm is generated when the IntegrationObject 
property is empty. 

To correct, configure the IntegrationObject property in the 
block with a value that represents a valid integration object, 
then recompile and reload the workflow. 

ValidateDTD turned on, but 

DTDName property not set!! 

This High alarm is generated when the ValidateDTD 
property is set to true and the DTDName property is empty. 

To correct, do one of the following tasks: 

● Configure the DTDName property with the name of the 
DTD of the xml file then recompile and reload the 
workflow. 

OR 

● Change the value of the ValidateDTD property to false 
then recompile and reload the workflow. 

EAI.GetData() Failed!! This High alarm is generated when the EAI.GetData() 
method returns with a return code that has a value of greater 
than “0”. The alarm also contains the exact error and 
suberror codes returned by the EAI server. 

 

Connections 

Accepts the following connections: 

● Input: 1 or more 

● Output: 1 
 

 

EAI Put Data block 

The EAI Put Data block writes new records or updates existing records in the Siebel database. 

The blocks sends the "put data" action through the EAI Workflow server. The EAI Put Data 

block can perform the following tasks: 

1. Send a request to Siebel to create new Siebel records. Siebel returns the ID of the newly 
created record back to Avaya IC. Avaya IC can then use the ID to pop a screen to the 

agent. 

2. Reference an existing Siebel record by including the ID for the Siebel record with the 
request. In this case, Siebel updates the existing record. 
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Related topic 

For more information, see EAI Put Data with Attachments block on page 108. 

 
Sample workflow 

For an example of how EAI Put Data can be used in a workflow, see the EAI Put Data (Create 

Activity Record) block in Sample Incoming Call flow on page 114. 

 
Basic properties 

The Basic tab of EAI Put Data includes the properties in the following table. All properties in the 

Basic tab are mandatory. 

 

Property Default Value Description 

InputData $scInputData Script variable that holds the data to be sent to 
Siebel. 

IntegrationObject Avaya IC - Put Action The name of the integration object used to send 
information to Siebel. 

Note: Do not change this field unless you have 
created a custom integration object to perform 
this task. 

 

Advanced properties 

The Advanced tab of EAI Put Data includes the properties in the following table. 

 

Property Default Value Description 

BaseTag <default> Name of the base "List of" tag to be used in the xml 
document. 

If you do not specify a tag, the block uses 
ListOf"<integrationobject> for the tag name. 

<default> is the typical value for this property. 

blockDebug off Debug level of the block. 

Before changing the default value, see Avaya IC Media 
Workflow Reference. 

DTD Name <default> Name of the DTD used in the integration object. 
<default> indicates that the integration object uses the 
same DTD as the preconfigured integration objects. 

OutData $sscOutData Script variable that holds the results returned from the 
attempt to send information to Siebel. 
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Property Default Value Description 

ReturnCode $sReturnCode Script variable that holds the value of the return code that is 
returned by the EAI.PutData() method. A value other 
than "0" indicates an error. 

Server EAIWorkflow Name of the Workflow server that runs the workflow which 
includes this block. 

start EAI Put Data Block IC Script. 

validateDTD false Determines whether the block must validate the DTD used 
in the integration object before sending information to 
Siebel. 

 

Alarms 

Generates the alarms described in the following table: 

 

Alarm Description 

ObjectName property not set!! This High alarm is generated when the IntegrationObject 
property is empty. 

To correct, configure the IntegrationObject property in the 
block with a value that represents a valid integration object, 
then recompile and reload the workflow. 

ValidateDTD turned on, but 

DTDName property not set!! 

This High alarm is generated when the ValidateDTD 
property is set to true and the DTDName property is 
empty. 

To correct, do one of the following tasks: 

● Configure the DTDName property with the name of the 
DTD of the xml file then recompile and reload the 
workflow. 

OR 

● Change the value of the ValidateDTD property to false 
then recompile and reload the workflow. 

EAI.PutData() Failed!! This High alarm is generated when the EAI.PutData() 
method returns with a return code that has a value of 
greater than “0”. The alarm also contains the exact error and 
suberror codes returned by the EAI Workflow server. 

 

Connections 

Accepts the following connections: 

● Input: 1 or more 
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● Output: 1 

 

 

EAI Put Data with Attachments block 

The EAI Put Data with Attachments block uses a Siebel integration object and the EAI Workflow 

server to save one or more files to the Siebel database. For example, you can use this block to 

save a transcript of a Web chat session to the database. The EAI Put Data with Attachments 

block is similar to the EAI Put Data block. 

 

Related topic 

For more information, see EAI Put Data block on page 105. 

 
Sample workflow 

For an example of how EAI Put Data with Attachments can be used in a workflow, see the EAI 

Put Data with Attachments block in the Transcript Added workflow on page 116. 

 
Basic properties 

The Basic tab of EAI Put Data with Attachments includes the properties in the following table. 

 

Property Default Value Description 

Attachment $sAttachment Script variable that holds the attachment to 
be sent to the Siebel database. 

Attachments $ssAttachments Script variable that identifies an attachment. 

Caution: For Siebel integration, do not 
change the value of this property. 

AttachmentTag ?Action.ListOf 
ActionAttachment.Action 
Attachment 

Mandatory. 

Required for attachment. 

Caution: For Siebel integration, do not 
change the value of this property. 

FileExtTag ActivityFileExt Mandatory. 

Determines the type of Siebel object to 
which the file attachments belong. For 
example, a chat transcript belongs to an 
Activity object. 
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Property Default Value Description 

FileIDTag AttachmentId Mandatory. 

One part of a couple required for the 
attachment. 

Caution: For Siebel integration, do not 
change the value of this property. 

FileNameTag ActivityFileName Mandatory. 

One part of a couple required for the 
attachment. 

Caution: For Siebel integration, do not 
change the value of this property. 

InputData $scInputData Script variable that holds the data to be sent 
to Siebel. 

IntegrationObject Avaya IC - Put Action The name of the integration object used to 
send information to Siebel. 

Note: Do not change this field unless you 
have created a custom integration object to 
perform this task. 

 

Advanced properties 

The Advanced tab of EAI Put Data with Attachments includes the properties in the following 

table. 

 

Property Default Value Description 

BaseTag <default> Name of the base "List of" tag to be used in the 
xml document. 

If you do not specify a tag, the block uses 
ListOf"<integrationobject> for the tag 
name. 

<default> is the typical value for this property. 

blockDebug off Debug level of the block. 

Before changing the default value, see Avaya IC 
Media Workflow Reference. 

DTD Name <default> Name of the DTD used in the integration object. 
<default> indicates that the integration object 
uses the same DTD as the preconfigured 
integration objects. 

OutData $sscOutData Script variable that holds the results returned from 
the attempt to send information to Siebel. 
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Property Default Value Description 

OutputID $sOutputId Unused script variable. 

Do not change the value of this property. 

ReturnCode $sReturnCode Script variable that holds the value of the return 
code that is returned by the EAI.PutData() 
method. A value other than "0" indicates an error. 

Server EAIWorkflow Name of the Workflow server that runs the 
workflow which includes this block. 

start EAI Put Data with 
Attachments 

Block IC Script. 

validateDTD false Determines whether the block must validate the 
DTD used in the integration object before sending 
information to Siebel. 

 

Alarms 

Generates the alarms described in the following table: 

 

Alarm Description 

ObjectName property not set!! This High alarm is generated when the IntegrationObject 
property is empty. 

To correct, configure the IntegrationObject property in the 
block with a value that represents a valid integration object, 
then recompile and reload the workflow. 

ValidateDTD turned on, but 
DTDName property not set!! 

This High alarm is generated when the ValidateDTD 
property is set to true and the DTDName property is 
empty. 

To correct, do one of the following tasks: 

● Configure the DTDName property with the name of the 
DTD of the xml file then recompile and reload the 
workflow. 

OR 

● Change the value of the ValidateDTD property to 
false then recompile and reload the workflow. 
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Alarm Description 

EAI.PutData() Failed!! This High alarm is generated when the EAI.PutData() 
method returns with a return code that has a value of 
greater than “0”. The alarm also contains the exact error 
and suberror codes that is returned by the EAI Workflow 
server. 

No Attachments specified!! This High alarm is generated when no attachments is given 
to the block in the script variable assigned to the 
Attachments property. 

 

Connections 

Accepts the following connections: 

● Input: 1 or more 

● Output: 1 
 

 

Additional new blocks in Siebel integration workflows 

The following workflow blocks used in the Siebel integration workflows are also new for the 

Siebel integration. These blocks are not available on the Siebel palette. 
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  Tip: 

Siebel integration workflows also use blocks that are available on other Workflow 

Designer palettes. For more information about those blocks, see Avaya IC Media 
Workflow Reference. 

 

Block name Description 

Create External Contact 
Mapping 

Maps the records of an external contact, that is, Siebel to the 
contact record in Avaya IC. This mapping creates an association 
between the Avaya IC contact and the Siebel business objects 
associated with that contact. 

For example, you can use the Create External Contact Mapping 
block to link an order, task, or other object that was either used 
or created because of the contact. The object can then be used 
to provide a link back into Siebel for historical and reporting 
purposes. 

All of the Siebel qualification workflows use this block, including 
the workflows in the following projects: 

● TS 

● wacd 

● Advocate 

For more information about ex*map tables, see Avaya Agent 
Integration. 

Get CA Results from EDU Retrieves the results of the Email Content Analysis of the Siebel 
from the EDU and stores the results in workflow variables. 

 

Related topic 

Siebel integration workflows also use blocks that are available on other Workflow Designer 
palettes. For more information about those blocks, see Avaya IC Media Workflow Reference. 

 
 
 
 

Voice qualification workflow 

The voice qualification workflow for the Siebel integration with standard routing is the Incoming 

Call flow. The Incoming Call flow is sometimes called the call-routing workflow or the voice 

contact routing workflow. 

This section describes the Incoming Call workflow. This section includes the following topics: 

● Description of the Incoming Call flow on page 113 

● Process of the Incoming Call flow on page 113 

● Sample Incoming Call flow on page 114 
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Description of the Incoming Call flow 

The Incoming Call flow retrieves customer information, routes inbound voice contacts, and can 

also, if desired, create, update, or delete a work item record. The version of the Incoming Call 

flow provided with the Siebel integration retrieves the customer information from the Siebel 

system through the EAI Get Data block. 

During the installation and configuration of the Siebel integration, you replace the standard 

Avaya IC Incoming Call flow with the Incoming Call flow for Siebel. 

Facts about the Incoming Call flow are in the following table. 

 

Siebel project name ts_sbl.prj 

Siebel filename incomingcall_sbl 

How launched TS.IncomingCall event 

Default workflow server WorkFlow_Voice 

 

Related topics 

For related information, see the following topics: 

● Configuring workflow servers to use Siebel voice workflows on page 181 

● Building the Avaya voice qualification workflow on page 180 

● Siebel Advocate workflows on page 98 
 

 

Process of the Incoming Call flow 

The sample Incoming Call flow works as follows: 

1. When a call comes in, the Incoming Call flow uses the ANI information to query Siebel for 

a matching contact record. The Siebel query is done through the EAI server using the EAI 

Get Data block. 

2. The Incoming Call flow uses the EAI Put Data block to create a Call Incoming activity 

record in Siebel. 

3. If a contact record was found by the EAI Get Data block, the activity record is associated 
with the contact. 

4. The Incoming Call flow writes some of the information that it received from the EAI Get 

block to the EDU. 

5. This information is used to populate the EDU viewer, or to pop a particular screen in 
Siebel. 
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6. The AICD.def file uses the contact ID placed in the EDU by the workflow to pop the 

Contact Detail View. If no matching contact was found by the workflow, the activity ID is 

used to pop the Activity Detail View. 
 

 

Sample Incoming Call flow 

The following figure shows the sample Incoming Call flow provided with the Siebel integration. 

 

 

Related topic 

For a description of the non-Siebel blocks in this workflow, see Avaya IC Media Workflow 
Reference. 
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Chat qualification workflows 

The chat qualification workflows for the Siebel integration with standard routing, include the 
Qualify Chat flow and other workflows required for Avaya IC with Web Management.. 

This section describes the chat qualification workflows. This section includes the following 

topics: 

● Qualify Chat flow on page 115 

● Customer Management workflows for Web on page 116 

● Transcript Added workflow on page 116 
 

 

Qualify Chat flow 

The Qualify Chat flow retrieves customer information, routes inbound chat contacts, and can 

also, if desired, create, update, or delete a work item record. The version of the Qualify Chat 

flow provided with the Siebel integration retrieves the customer information from the Siebel 

system through the EAI Get Data block. 

The Qualify Chat flow is sometimes called the chat contact routing workflow. 

During the installation and configuration of the Siebel integration, you replace the standard 

Avaya IC Qualify Chat flow with the Qualify Chat flow for Siebel. 

Facts about the Qualify Chat flow are in the following table. 

 

Siebel project name wacd_sbl 

Siebel filename qualifychat_sbl 

How launched WACD.QualifyChat event 

Default workflow server WorkFlow_Chat 

 

Related topic 

For more information, see Configuring workflow servers to use Web chat workflows on 
page 189. 
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Customer Management workflows for Web 

Customer Management workflows for Web manage customer records for chat contacts. For 

example, these workflows associate customers who log in to the Website with information about 

the customer in the Siebel database. In the agent applications, a screen pop displays this 

information to the agent. 

Some customer management workflows require file-based IC Scripts. By default, the include 

property of the workflows contains the names of the required file-based IC Scripts. If you 

encounter any difficulties in these workflows, you must ensure that the IC Scripts specified by 

the include property are available. 

 
CAUTION: 

These workflows are system workflows that are automatically installed. Do not 

alter or customize the Customer Management workflows for Web. 

Facts about the Customer Management workflows for Web are in the following table. 

 

Siebel project name webcenter_sbl.prj 

Siebel filenames ● addcustomer_sbl 

● deletecustomer_sbl 

● getauthenticatedcustomer_sbl 

● getcustomer_sbl 

● getcustomerlist_sbl 

● getregions_sbl 

● schedulecallback_sbl 

● undeletecustomer_sbl 

● getcustomerlist_sbl 

● updatecustomer_sbl 

How launched MultiTenancy Admin & Chat Escalation login window 

Default workflow server The WorkFlow_System server of the primary domain where 
the Avaya IC chat user is located 

 

Related topic 

For more information, see Modifying Customer Management workflows for Web on page 188. 
 

 

Transcript Added workflow 

The Transcript Added workflow is also called the chat-transcript workflow. 
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This section includes the following topics: 

● Description of the Transcript Added workflow on page 117 

● Location of the Workflow server and EAIWorkflow server on page 117 

● Process of the Transcript Added workflow on page 117 

● Sample Transcript Added workflow on page 118 

 
Description of the Transcript Added workflow 

The Transcript Added workflow puts a copy of the transcript from a chat contact into the Siebel 

system through an EAI server. 

Facts about the transcript-added workflow are in the following table. 

 

Siebel project name icm_sbl.prj 

Siebel filename transcriptadded_sbl 

How launched Called by the ICM server if ICM is configured to run this 
workflow when a transcript is added to the database 

Default workflow server The WorkFlow_System server of the primary domain where the 
Avaya IC Web chat user is located 

 

Location of the Workflow server and EAIWorkflow server 

Host and configure the Workflow server and the EAIWorkflow server on the same physical 

machine to avoid potential permission problems. 

 

Related topic 

For more information, see EAI server cannot read a file attachment on page 294. 

 
Process of the Transcript Added workflow 

The Transcript Added workflow process works as follows: 

1. When a chat session is wrapped up, Avaya IC writes a transcript of the session in raw form 
to a disk location. 

2. The ICM server polls this location. When the ICM server finds the transcript, it reads and 

writes the transcript to IC Repository. 

3. If the ICM server is configured, the ICM server triggers the Transcript Added workflow. 

4. The Transcript Added workflow: 

a. Receives the chat transcript in raw XML format as an input parameter. 
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b. Transforms the chat transcript into an HTML file, by default. 

c. Puts the HTML file into a location specified in the workflow. 

d. Makes a request to the EAI server to receive the HTML file and put the file into Siebel. 

 
Related topic 

For more information, see Installing the Web chat qualification workflow on page 193. 

 
Sample Transcript Added workflow 

The following figure shows the sample Transcript Added workflow provided with the Siebel 
integration. 
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Siebel-first email workflow 

The Siebel-first email workflow is the Analyze workflow. 

This section includes the following topics: 

● Description of the Analyze workflow on page 119 

● Sample Analyze workflow on page 120 
 

 

Description of the Analyze workflow 

The analyze workflow receives a notification email from Siebel, parses it, and determines route 

parameters. Parsing the email includes pulling Siebel-supplied information out of the email 

body. This information includes the Content Analysis results, email language, and the Siebel 

email ActivityID of the original email. The original e-mail is not copied to Avaya IC and remains 

only in Siebel. This workflow uses the parsed information to determine routing hficinitatesthat 

allow the email to be routed to the appropriate agent. 

Facts about the analyze workflow are in the following table. 

 

Siebel project name icemail_sbl_first.prj 

Siebel filename analyze_sbl 

How launched ICEmailAnalyze event 

Default workflow server The workflow server that handles the ICEmail.Analyze 
event. The IC Email server must have the Analyze event 
turned on and the OutboundEmail event turned off. 
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Sample Analyze workflow 

The following figure shows the Analyze workflow. 
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Chapter 9: Overview of tasks for Hybrid 
Siebel 

 

Perform the following tasks for a Hybrid Siebel integration. 

 
Important: 

Perform the following steps in the order shown. 

 

Task Where performed 

1. Installing integration components on Avaya IC on page 127 Avaya IC 

2. Designing Avaya Agent databases on page 129 

3. Deploying the Avaya Agent task bar (Hybrid Siebel only) on 

page 135 

4. Configuring Avaya IC on page 136 

5. Installing and configuring an Avaya IC secondary ORB server on 

Siebel on page 141 

Siebel 

6. Creating a Siebel AICD server on page 144 Avaya IC 

7. Installing the AICD on page 147 Siebel 

8. Configuring the AICD on page 151 

9. Checking the AICD environment (optional) on page 158 

10. Importing a custom eScript for Siebel Universal Agent on 

page 161 

11. Configuring the Avaya EAI servers on page 169 ● Avaya IC 

● Siebel 

12. Configuring one or more of the following workflows or channels: 

● Configuring voice qualification workflows on page 180 

● Configuring Web chat qualification workflows on page 186 

● Configuring an email channel on page 198 

Avaya IC 

! 
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Related topics 

For more information about the Hybrid Siebel integration, see Selecting an integration between 
Avaya IC and Siebel on page 27 and Media features on page 29. 

For more information about the architecture, see Architecture for Hybrid Siebel on page 32. 
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Chapter 10: Overview of tasks for Native 
Siebel 

 

Perform the following tasks for a Native Siebel integration. 

 
Important: 

Perform the following steps in the order shown. 

 

Task Where performed 

1. Installing integration components on Avaya IC on page 127 Avaya IC 

2. Designing Avaya Agent databases on page 129 (optional for 

Native Siebel) 

3. Configuring Avaya IC on page 136 

4. Installing and configuring an Avaya IC secondary ORB server on 

Siebel on page 141 

Siebel 

5. Creating a Siebel AICD server on page 144 Avaya IC 

6. Installing the AICD on page 147 Siebel 

7. Configuring the AICD on page 151 

8. Checking the AICD environment (optional) on page 158 

9. Importing a custom eScript for Siebel Universal Agent on 

page 161 

10. Configuring ASIS (Native Siebel integration only) on page 162 Avaya IC or Siebel 

11. Configuring the Avaya EAI servers on page 169 ● Avaya IC 

● Siebel 

12. Configuring one or more of the following workflows or channels: 

● Configuring voice qualification workflows on page 180 

● Configuring an email channel on page 198 

Avaya IC 

! 

mailto:infodev@avaya.com


August 2022 112 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

 

 

 

 

Related topics 

For more information about the Native Siebel integration, see Selecting an integration between 
Avaya IC and Siebel on page 27 and Media features on page 29. 

For more information about the architecture, see Architecture for Native Siebel on page 33. 
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Chapter 11: Installation and configuration 

tasks for all channels 

 

This section describes the tasks required to install and configure the Avaya IC Siebel integration 
system. Use these procedures when installing and configuring any type of channel. 

 
Important: 

Always see the latest Siebel documentation when performing any of the 

procedures that use Siebel Tools or the Siebel windows. Avaya cannot guarantee 

the accuracy of these procedures. 

This section includes the following topics: 

● Installing integration components on Avaya IC on page 127 

● Designing Avaya Agent databases on page 129 

● Deploying the Avaya Agent task bar (Hybrid Siebel only) on page 135 

● Assigning Administrative privileges for Avaya Agent Rich Client (Hybrid Siebel only) on 

page 135 

● Configuring Avaya IC on page 136 

● Installing and configuring an Avaya IC secondary ORB server on Siebel on page 141 

● Creating a Siebel AICD server on page 144 

● Installing the AICD on page 147 

● Configuring the AICD on page 151 

● Checking the AICD environment (optional) on page 158 

● Importing a custom eScript for Siebel Universal Agent on page 161 

● Configuring ASIS (Native Siebel integration only) on page 162 

● Configuring the Avaya EAI servers on page 169 

! 
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Working with Siebel Tools 
 
 

Important: 

The Siebel procedures in this guide ensures that you are working in a non 

production environment. Adapt the procedures in this guide to conform to your 

company practices for modifying the Siebel object repository and Siebel database 

in your production environment. Test all changes to the Siebel object repository in 

a non production environment before deploying them in your production 

environment. 

Always create a backup copy of the Siebel Server object repository before making 

any changes using Siebel Tools. 
 

 

Prerequisites 

Verify the following conditions before you begin: 

● The Avaya IC and Siebel systems must be installed and functional before proceeding. 

Read Planning and prerequisites on page 46 for more information. 

● Siebel is incompatible with the Sun Java Virtual Machine (JVM) and you might need to 

change browser settings on the Siebel client machines. For more information, see the 

Siebel Website. 

● The Siebel thin client does not perform correctly on early versions of Internet Explorer. For 
more information, see the Siebel Website. 

 
 
 
 

Installing integration components on Avaya IC 

This section includes the following topics: 

● Where to perform this procedure on page 128 

● Before you begin on page 128 

● Installing the integration components on Avaya IC (Windows) on page 128 

● Installing the integration components on Avaya IC (Solaris or AIX) on page 129 

! 
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Where to perform this procedure 

Perform this procedure on the Avaya IC system. 
 

 

Before you begin 

Shut down Avaya IC. Avaya IC must not be running when you install the integration. 
 

 

Installing the integration components on Avaya IC (Windows) 

To install the Avaya IC components when you have a Windows operating system: 

1. Insert the integration CD. 

2. Run the installer AICServers_for_Siebel.exe. 

You can find the installer at the following location: 

\SiebelAllPlatforms\AICSiebelNT\InstData\Windows\VM 

The Avaya Interaction Center 7.3.x Servers for Siebel window displays. 

3. Click Next to continue with the installation. 

4. Select one or both boxes. 

 

Select Description 

Interaction Engine Servers Installs the Siebel integration EAI server on this machine. 
You can install the Siebel integration EAI servers on an 
Avaya IC server or Siebel server. An Avaya IC ORB 
server must be installed on the machine for the EAI server 
to work. 

Design & Admin Installs the workflows and database files. These files must 
be installed on the machine where the Avaya IC Workflow 
Designer and Database Designer interfaces reside. The 
machine is where you must design your agent, build your 
workflows, and generate your database. 

5. Follow the instructions in the installation wizard for accepting the license agreement and 
browsing to the correct directory. Click Next when prompted. 

6. Click Finish to complete the installation. 

7. Continue to Designing Avaya Agent databases on page 129. 
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Installing the integration components on Avaya IC (Solaris or AIX) 

To install the Avaya IC components when you have a Solaris or AIX operating system: 

1. Insert the integration CD. 

2. Do one of the following tasks: 

● On Solaris, browse to, and run /SiebelAllPlatforms/AICSiebelSol/ 

InstData/sparc/VM/AICenter_for_Siebel.bin 

● On AIX, browse to, and run /SiebelAllPlatforms/AICSiebelAIX/InstData/ 
AIX/VM/AIC_for_Siebel.bin 

This process installs the Avaya servers, EAI server, Avaya workflows, and other design 

files. 

3. Follow the instructions in the installation wizard for accepting the license agreement and 

browsing to the correct directory. Click Next when prompted. 

4. Click Finish to complete the installation. 

5. Continue to Designing Avaya Agent databases on page 129. 
 
 
 
 

Designing Avaya Agent databases 

Note: 
This section is optional if you have an Avaya IC for Native Siebel configuration. 

Before you can install any agents, you must design the Avaya Agent databases. You must 

design the Avaya Agent databases only when on the Avaya IC system. A system administrator 

performs these tasks. 

This section includes the following topics: 

● Where to perform these procedures on page 130 

● Changing the ADL Include Path for ccq.adl on page 130 

● Generating the Windows application on page 131 

● Changing the ADL Include Path for repository.adl on page 133 

● Reconfiguring the IC Repository on page 134 
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Where to perform these procedures 

Perform these procedures at the location shown in the following table. 

 

Interface System 

Database Designer Avaya IC 

 

 

Changing the ADL Include Path for ccq.adl 

To change the ADL Include Path to match your design machine: 

1. Go to Database Designer by navigating to Start > Programs > Avaya Interaction Center 

7.3 > Database Designer. 

2. In the Workflow Designer, browse to the ccq.adl file and open it. 

Example: c:\<AVAYA_IC73_HOME>\design\CallCenterQ\ccq.adl 

3. In the ccq.adl - Database Designer window, select the ccq path name in the left 

navigation pane of Database Designer. 

Example: 

 

4. Click the ellipsis (…) button to the right of the Upload scripts from these directories area 

in the middle of the window. 

Example: 
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5. In the ADL Include Path window, add the qconsole\siebel path. 

Example: e:<AVAYA_IC73_HOME>\design\qconsole\siebel 

Additional information: To add a path, press the Add button, and browse to the path you 

must add. 

Note: 
If you do not see this directory, verify that you have performed the Avaya 

installation described in Installing integration components on Avaya IC on 

page 127. 

6. Click OK. 

 
Important: 

Do not omit saving this file in the next step, although you must reopen it. 

7. Press Ctrl+S to save the file. 

8. Select File > Close. 

9. Reopen the ccq.adl file. 

Reference: See Steps 1 and 2. 

10. Continue to Generating the Windows application on page 131. 
 

 

Generating the Windows application 

To generate the Windows application: 

1. Reopen the ccq.adl file. 

2. Select File > Generate Windows Application… 

3. On the Generate Windows Application window, select only the following fields: 

● Messages 

● IC Scripts 

● Avaya Agent Layout 

● EDU Layout 

! 
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4. In the field next to Avaya Agent Layout, select the appropriate layout file for the language 

you must install. 

 

Language Filename 

English * avaya_agent_sbl_en.cdl 

Spanish avaya_agent_sbl_es.cdl 

German avaya_agent_sbl_de.cdl 

French avaya_agent_sbl_fr.cdl 

Italian avaya_agent_sbl_it.cdl 

Portuguese avaya_agent_sbl_pt.cdl 

Chinese avaya_agent_sbl_zh.cdl 

Traditional Chinese avay_agent_sbl_zt_cdl 

Korean avaya_agent_sbl_ko.cdl 

Japanese avaya_agent_sbl_ja.cdl 

Thai avaya_agent_sbl_th.cdl 

* Default 

Example: 

e:\<AVAYA_IC73_HOME>\design\qconsole\siebel\avaya_agent_sbl_es.cdl 
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5. In the field next to EDU Layout, select the appropriate eXtensible Stylesheet Language 

(XSL) file. 

 

Language Filename 

English eduviewer_en_US.xsl 

Spanish eduviewer_es_CO.xsl 

German eduviewer_de_DE.xsl 

French eduviewer_fr_FR.xsl 

Italian eduviewer_it_IT.xsl 

Portuguese eduviewer_pt_BR.xsl 

Chinese eduviewer_zh_CN.xsl 

Traditional Chinese eduviewer_zt_TW.xsl 

Korean eduviewer_ko_KR.xsl 

Japanese eduviewer_ja_JP.xsl 

Thai eduviewer_th_TH.xsl 

Example: e:\<AVAYA_IC73_HOME>\design\qconsole\eduviewer_en_US.xsl 

6. In the Name field, select interaction_center. 

7. Enter your Login Id and Password. 

8. Click OK. 

9. If you get the following message, click Yes: 
 

Directory <directory path> is already present and files in that directory may be 

replaced. Do you want to proceed? 

 

10. Select File > Close. 

11. Continue to Changing the ADL Include Path for repository.adl on page 133. 
 

 

Changing the ADL Include Path for repository.adl 

To change the repository.adl to match your design machine: 

1. Browse to the repository.adl file and open it. 

Example: e:\<AVAYA_IC73_HOME>\design\repository\repository.adl 
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2. In the respository.adl - Database Designer window, select the ADL path name in the left 

navigation pane of Database Designer. 

3. Press the ellipsis (…) button to the right of the ADL Include Path area in the middle of the 
window. 

4. In the ADL Include Path window, ensure that only the common and qconsole paths are 
listed. 

Example: 

e:<AVAYA_IC73_HOME>\design\common 

e:<AVAYA_IC73_HOME>\design\qconsole 

Additional information: 

● To add a path, press the Add button and browse to the path you must add. 

● To remove a path, press the Remove button and browse to the path you must 

remove. 

5. If you made any changes, select File > Save. 

6. Select File > Close to close the repository.adl file. 

7. Continue to Reconfiguring the IC Repository on page 134. 
 

 

Reconfiguring the IC Repository 

To reconfigure the IC Repository: 

1. Browse to the repository.adl file again and open it. 

Example: e:\<AVAYA_IC73_HOME>\design\repository\repository.adl 

2. Select File > Database Administration … 

3. Ensure that Reconfigure is selected. 

4. Type the IC Administrator Login Id and Password. 

5. Click Run. 

Result: If you are using Oracle, the command prompts for your database password. 

Wait until the process has completed. 

6. Click Close. 

7. Continue to one of the following steps: 

● For Hybrid Siebel integration, Deploying the Avaya Agent task bar (Hybrid Siebel 
only) on page 135 

● For Native Siebel integration, Configuring Avaya IC on page 136. 
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Deploying the Avaya Agent task bar (Hybrid Siebel only) 

The procedures in this section describe how to deploy the Avaya Agent task bar and associated 
help files. 

Note: 
This section is applicable only if you have a Hybrid Siebel integration. 

For more information about Avaya Agent task bar, see IC Installation and Configuration. 

For detailed procedures on how to install the Avaya Agent task bar, see IC Agent Installation 

guide. 

This section includes the following topic: 

● Installing the Avaya Agent task bar on page 135 
 

 

Installing the Avaya Agent task bar 

For installing the Avaya Agent task bar see the IC Installation and Configuration guide. 
 
 
 
 

Assigning Administrative privileges for Avaya Agent Rich 

Client (Hybrid Siebel only) 

In the hybrid mode, when you have set the AutoLoginEnabled property as Yes in IC Manager 

using group manager from the Agent/Desktop/Siebel path, Avaya Agent Rich Client (AARC) 

fails to open Internet Explorer. AARC requires administrative rights to open Internet Explorer 

(IE). Therefore, you must assign administrative privileges to the agent to log into Siebel and 

open IE. 

1. To assign administrative privileges for the qui.exe file in AARC and choose one of the 
following methods: 

● Set for the qui.exe file in AARC to run as an administrator or 

● Set the security settings to Full Control for the qui.exe file in AARC 

a. To set the qui.exe file in AARC to run as an administrator: 

1. Right click the qui.exe file in AARC and select Properties. 

2. Click the Compatibility tab. 

3. Click Change settings for all users. 

4. Type the administrator credentials. 
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5. On the Compatibility for all users dialog box, in the Privilege Level section, click 

Run this program as an administrator. 

Now, AARC is not run as the specific user "Administrator", but with admin 

privileges. 

6. Click OK. 

7. Click OK. 

b. To set the security settings to Full Control for the qui.exe file in AARC: 

1. Right click the qui.exe file in AARC and select Properties. 

2. Click the Security tab. 

3. To change permissions click Edit. 

The system displays the Permissions for qui.exe file in AARC dialog box. 

4. In the Full control row, click Allow. 

5. Click OK. 

6. Click OK. 

Note: 
This change made to the privileges settings is applicable only for 

non-administrator system users with Administrator privileges. 
 
 
 
 

Configuring Avaya IC 

The procedures in this section describe how to configure the Avaya IC properties to enable the 

Avaya IC Siebel integration. 

This section includes the following topics: 

● About the Commit Property Changes window on page 137 

● Where to perform these procedures on page 137 

● Setting Avaya IC properties on page 137 

● Configuring the home directory for Avaya Agent task bar (Hybrid Siebel only) on page 139 
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About the Commit Property Changes window 

Always click Yes if you see the following window while you are performing these procedures, or 
you lose your changes. 

 

 
 
 

Where to perform these procedures 

Perform these procedures at the location shown in the following table. 

 

Interface System 

IC Manager Avaya IC 

 

 

Setting Avaya IC properties 

Use this section to set the Avaya IC properties to enable the Avaya IC Siebel integration. 

To set the Avaya IC properties: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Select Tools > Groups. 

3. Select IC in the upper left corner of the Groups window. 

4. Select the Properties tab. 
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5. Select a section from the Sections list using the values in the following table. 

 

Section Property Property Value 

All channels 

Agent/Desktop ContactSuspensionEnabled No 

IntegratedApplication Siebel 

Layout avaya_agent_sbl 

ScreenPopEnabled Yes 

WrapUpEnabled Yes (optional) 

WrapUpType Siebel 

Agent/Desktop/Directory ShowAgentsOnStartup Yes (optional) 

Controls agents that are viewed in 
the UAD. ShowAllAgents 

Agent/Desktop/ScreenPop PopOnAllArrivingContacts No 

PopOnContactActivation Yes (required) 

PopOnFirstArrivingContact Yes 

Agent/Desktop/Siebel AutoLoginEnabled Yes 

LaunchURL URL for Siebel thin client 

Agent/Desktop/Siebel/ 
AutoLogin 

PasswordFormat None (optional) 

UserNameFormat Upper 

WaitTime 10 

Agent/Desktop/WAC AlwaysOnTop Yes 

AppMode siebel 

Email channel only 

Agent/Desktop/WAC ShowOnEmailActivate No 

ShowOnEmailSelect No 

Web chat channel only 

Agent/Desktop/WAC ShowOnChatActivate Yes 

ShowOnChatSelect No 
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For more information, see the following topics: 

● Wrap-up on page 80 

● Siebel integration agent properties on page 82 

6. Select a property from the Name and Value fields in the right pane using the table in Step 

5. 

7. Click the Edit server button to edit this property. 

8. Change the value of the property in the Value field to the suggested value in the table. 

9. Click Ok. 

10. Return to Step 3 and repeat this procedure until you have edited all of the properties in the 

table. 

11. Click Ok to close the Group Manager window. 

12. Continue to Installing and configuring an Avaya IC secondary ORB server on Siebel on 

page 141. 
 

 

Configuring the home directory for Avaya Agent task bar (Hybrid 

Siebel only) 

Note: 
This section is applicable only if you have a Hybrid Siebel integration. 

The procedures in this section describe how to configure the home directory property for agents 

who use the Avaya Agent task bar. This section includes the following topics: 

● Where to perform these procedures on page 139 

● Configuring the home directory property on page 140 

 
Where to perform these procedures 

Perform these procedures at the location shown in the following table. 

 

Interface System 

IC Manager Avaya IC 
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Configuring the home directory property 

The home directory property is always configured from the perspective of the Avaya Agent task 

bar. The syntax that you use to configure the home directory property depends on how the 

machine that hosts the Avaya Agent task bar. Because Windows supports the Avaya Agent task 

bar, the syntax for the home directory must be in a format that Windows can use to access 

another network machine. 

For more information about the home directory property, see IC Administration Guide. 

To configure the home directory: 

1. If home directory does not already exist, create the shared directory for the home directory 

on a network machine. 

2. Ensure that all agent workstations that host the Avaya Agent task bar: 

● Can access the shared directory for the home directory through either a mapped drive 

or UNC notation in Windows Explorer. 

● Have the required read, write, and execute permissions for that directory. 

3. Configure the Agent/Desktop/WAC.HomeDir . 

The following table provides examples of the syntax used to configure the home directory 
property. These examples use the AgentResource directory on a machine named 

resource.xyzcorp.com as the shared directory. 

 

Avaya Agent access to shared directory Syntax for home directory 

You map the Z: drive on each agent 
workstation to the shared directory folder 
hosted on a Windows network machine. 

Note: Do not use this syntax if the shared 
directory is on a UNIX machine. 

Z:\AgentResource 

Each agent workstation uses UNC notation in 
Windows Explorer to access the shared 
directory. 

Note: You can use this syntax if the shared 
directory is on a Windows or UNIX machine. 

\\resource.xyzcorp.com\ 
AgentResource 
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Installing and configuring an Avaya IC secondary ORB 

server on Siebel 
 

Important: 

For more detailed procedures and for cautions and tips, see IC Installation and 

Configuration. 

This section includes the following topics: 

● Where to perform this procedure on page 141 

● Before you begin on page 141 

● Solaris and AIX operating systems on page 141 

● Procedure for Windows on page 142 
 

 

Where to perform this procedure 

Perform the following procedure on the Siebel system. You must also need to use IC Manager 
on your primary Avaya IC system for some of the steps. 

 

 

Before you begin 

Before you can install the AICD Siebel server, you must install Avaya IC on the Siebel server, 

and configure a secondary ORB Server. 

 

Related topic 

For more information, see ORB Servers on page 68. 
 

 

Solaris and AIX operating systems 

This procedure assumes that you are installing the Avaya IC secondary ORB Server on 

Windows. For information about installing and configuring a secondary ORB Server when you 

have a Solaris or AIX operating system, see IC Installation and Configuration. 

! 
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Procedure for Windows 
 

Important: 

Repeat this procedure for every Siebel Communications Server in your 
environment. 

To install an Avaya IC server on the Siebel Communications Server: 

1. Log in to the machine with an account that has the required Administrator privileges. 

2. Insert Avaya IC Release 7.3.x CD-ROM 1. 

The Avaya IC installer starts automatically. If the Autorun is disabled on the computer, 

navigate to the Servers directory on the CD-ROM and run install.bat. 

3. When the Avaya IC installer opens, read the entire Avaya IC license agreement carefully, 
then accept the terms of the agreement. Select Next, and then follow the prompts in the 

installer. 

The Avaya IC installer exits if you do not agree to the terms of the agreement. 

4. In the Product Installation screen, click Core Servers. 

5. Continue to follow the prompts in the Avaya IC Windows installer. 

The Avaya IC installer can take several minutes to copy the requested files to the machine. 

If the target machine does not have sufficient space to install the components, the Avaya 

IC installer displays an error message. 

6. After the successful IC installation, run the configure.bat file to start the Configuration 

tool. The configuration tool is located at: <Avaya Install Dir>\bin 

7. When the Configuration Tool window opens, select the values in the following table. 

 

Field Value 

Select Mode Select Secondary 

IP Address Confirm that the IP address is the correct IP address for the target 
machine. 

Important: If the secondary ORB server runs on a machine with 
multiple network interface cards, you must select the IP address 
for the first network interface card on the machine. The ORB 
server cannot run on any other network interface card. 

Secondary ORB Port Confirm that the port assignment is an available port on the target 
machine. Type a new port assignment if needed. 

Primary Host Name Type the IP Address or the fully qualified domain name of the 
machine that hosts the primary ORB server. 

! 
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Field Value 

Primary ORB Port Confirm that the port is the one you configured for the primary 
ORB server. 

IC Login Type the administrative login ID that runs the Avaya IC servers. 

For more information, see IC Installation and Configuration. 

IC Password Type the password associated with the IC Login. 

IC Domain Type the name of the Avaya IC domain that includes the primary 
ORB server. This usun is typically the Default domain. 

Start ORBServer Cleared 
 

8. If the Avaya IC system includes an Oracle database: 

a. Select and check the Oracle Setup box. 

b. Type the NLS Lang parameter in the NLS Lang field to specify the character set of the 
database. 

The NLS Lang setting must match the value used to create the Oracle database. This 

value must include UTF8. For more information, see IC Installation and Configuration. 

c. Type the home directory of the Oracle client on the machine that hosts the core 
servers in the Oracle Home field. 

For example, type /opt/oracle/Ora_ic 

9. Click Apply Settings. 

If you get a message that says your Oracle Home is not valid, click OK. 

10. Click OK in the Success dialog box. 

11. Click Exit. 

The Configuration Tool closes and returns you to the installer. 

12. In the Avaya IC installer, follow the prompts. 

 
CAUTION: 

You must restart your computer for the changes to take effect. 

Restarting your Siebel Server is service affecting. 

13. Restart your computer. 

14. Go to your primary Avaya IC system and run IC Manager to check your secondary ORB 
Server installation. 

  Tip: 

Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 
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15. Check for a new ORB Server in your default domain that must be named after the Siebel 

server on which you installed your secondary ORB Server. 

Example: In the following figure, the secondary ORB Server is installed on a machine 

called jag_sbl1. 
 
 
 

16. Continue to Creating a Siebel AICD server on page 144. 
 
 
 
 

Creating a Siebel AICD server 

Now that you have the secondary Avaya IC ORB installed on the Siebel server, you must create 
a Siebel AICD server by administering a new server component using IC Manager. 

This section includes the following topics: 

● Where to perform this procedure on page 144 

● Procedure on page 145 
 

 

Where to perform this procedure 

Perform this procedure at the location shown in the following table. 

 

Interface System 

IC Manager Primary Avaya IC 
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Procedure 

To create a Siebel AICD server: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select the Server tab, and select All Domains. 

4. Right-click inside the pane with the list of servers. 

Example: 

 

 
Note: 

Unlike this example, your window must display data. 

5. Select New… from the right-click list. 

6. In the Server Type field, select SiebelAICD. 

7. Click Ok. 

8. In the Server Editor window, type or select the following values. 

 

Field Description 

Name Type a name that identifies both the AICD and the Siebel host where the AICD 
resides. 

Example: AICD_Jaguar2 

Host Select the IP address of the Siebel host where the AICD resides. 

Most other servers have the IP address of the Avaya IC system. The Siebel 
AICD server has the IP address of the Siebel host. 

Port Type a port number that does not conflict with an existing TCP/IP port on the 
Siebel host. 
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Field Description 

Domain For instructions on how to configure domains, see Avaya IC domain 
deployment guidelines on page 50. 

Directory This field is not used, but select a valid directory name anyway. 

Executable This field is not used, but select something anyway. 
 

9. Ensure that the Auto Start check box is unchecked. 

The Avaya IC ORB Server does not start the AICD server. Instead, the AICD server is 
started and shut down by the Siebel Communications server. 

10. Select the SiebelAICD tab. 

11. Ensure that the Allow ORB to start AICD field is unchecked. 

12. Select the Debug tab from the Server Editor window. 

13. Click the ellipsis (…) button next to the Trace Levels field. 

Result: The Trace Levels window opens. 

14. Choose one of the choices shown in the following table: 

 

For minimal logging, select the following 
field: 

For maximum logging, select the following 
fields: 

idl ● usr1 

● usr2 

● usr3 

● usr4 

● flush 

● idl 

Reference: For more information about logging levels, see Log files on page 277. 

 
Important: 

Do not set your logging level to flush for normal operating conditions. The flush 

setting slows down all AICD processes. For normal system operations, the log 

level must not be set at a level greater than usr2. 

15. Click Ok to accept the trace level changes you made. 

16. Click Ok to complete the Siebel AICD server creation. 

17. You must reproduce your recent changes on the other Avaya IC components and servers. 

To do this, navigate to Manager > Refresh. 

! 
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18. Select Manager > Update ORB Servers. 

If errors are reported, your vesp changes might not be properly updated on the servers. 
Isolate and correct the problems and return to Step 17. 

19. Continue to Installing the AICD on page 147. 
 
 
 
 

Installing the AICD 

This section includes the following topics: 

● Before you begin on page 147 

● Upgrading Avaya IC on page 147 

● Where to perform these procedures on page 148 

● Installing the AICD (Windows) on page 148 

● Installing the AICD (Solaris or AIX) on page 149 
 

 

Before you begin 

Before you can install the AICD, you must install a secondary ORB on the Siebel server, and 
create the Siebel AICD server in IC Manager. 

 
Related topics 

For more information, see one of the following topics: 

● Installing and configuring an Avaya IC secondary ORB server on Siebel on page 141 

● Creating a Siebel AICD server on page 144 
 

 

Upgrading Avaya IC 

This procedure automatically backs up the following directory so that you can save your 

customizations during an upgrade. 
 

 

Source directory Backup directory 

<SIEBEL_HOME>\siebel\siebsrvr\bin\enu <SIEBEL_HOME>\backup\siebel\siebsrvr\bin\ 
enu 
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Important: 

Only the AICD.def and AICDStrings.txt files are saved. 
 

 

Where to perform these procedures 

Perform these procedures on the Siebel system. 
 

 

Installing the AICD (Windows) 

To install the AICD when you have a Windows operating system: 

1. Insert the integration CD. 

2. Run the installer SiebelNT.exe. 

The path looks as follows: 

/Siebel_All_Platforms/SiebelNT/InstData/Windows/VM 

3. Follow the instructions in the installation wizard for accepting the license agreement and 

browsing to the Siebel installation directory. Click Next when prompted. 

Example: Browse to 

c:\sba81 for Siebel 8.1.1.x 

C:\Siebel\8.1.1.11.0\ses for Siebel 8.1.1.11 

C:\Siebel\8.2.2.4.0\ses for Siebel 8.2.2.4 

Result: Progress gauges display. 

4. Click Finish. 

This process installs the integration components on the Siebel server. This includes the 
AICD, AICD definition file, and the AICDStrings.txt file. 

5. Continue to Verifying the Windows environment variable on page 148. 

 
Verifying the Windows environment variable 

The Windows installer automatically adds an environment to the Windows system path to add 

%AVAYA_IC73_HOME%\bin. This path is used by the AICD to find the supporting files. 

To update the Windows system path: 

Note: 
This procedure assumes you have Microsoft Windows Server 2008 R2 

Enterprise. You must make adjustments to these procedures if you have any 

other Windows version. 

! 
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1. Navigate to Start > Control Panel > System. 

2. Click on Advanced system settings. 

3. Select Environment Variables. 

4. Double-click Path in the System variables field. 

5. Verify that the Variable Value field, includes the following: 

%AVAYA_IC73_HOME%\bin 

6. If the Variable Value field includes the correct system variable, click Cancel and continue 

with step 8. 

7. If the Variable Value field does not include the correct system variable 

a. Add the following text to the existing path: 

%AVAYA_IC73_HOME%\bin 

  Tip: 

Use ; to separate the entries. 

 
Important: 

Ensure that no extra spaces or other extra characters in the path including 

immediately before or after the ; separator exist. 

b. Click OK. 

c. Restart the Siebel server. 

8. Return to Installing the AICD (Windows) on page 148 and repeat this procedure for every 

Siebel Communications Server in your environment. 

9. After all AICDs have been installed and configured, continue to Configuring the AICD on 

page 151. 
 

 

Installing the AICD (Solaris or AIX) 

To install the AICD when you have a Solaris or AIX operating system: 

1. Insert the integration CD. 

2. Do one of the following tasks: 

● On Solaris, browse to, and run: 

/SiebelAllPlatform/SiebelSolaris/InstData/Solaris/VM/ 

SiebelSolaris.bin 

! 
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● On AIX, browse to, and run: 

/SiebelAllPlatform/SiebelAIX/InstData/AIX/VM/SiebelAIX.bin 

This installs the integration components on the Siebel server. This includes the AICD, 

AICD definition file, and the AICDStrings.txt file. 

3. Follow the instructions in the installation wizard for accepting the license agreement and 
browsing to the correct directory. Click Next when prompted. 

Example: Browse to \opt\siebel\ 

 

CAUTION: 

If you select a path other than $SIEBEL_ROOT, the AICD might not start. 

Result: Progress gauges display. 

4. Click Finish. 

5. Continue to Modifying Solaris and AIX variables on page 150. 

 
Modifying Solaris and AIX variables 

You must modify or define three Solaris and AIX environment variables to integrate Avaya IC 

with Siebel. The variables are PATH, AVAYA_IC73_HOME, and LD_LIBRARY_PATH. 

To modify the Solaris and AIX path variables: 

1. Navigate to your siebenv.sh file for the Siebel server. This file must be located under a 

subdirectory called siebsrvr. 

Ensure you do not use the siebenv.sh file for the Siebel Gateway server. The Gateway 

server is located under a subdirectory called gtwysrvr. 

2. Add the following three environment variables to the siebenv.sh file, preferably at the 

beginning of the file. 

Solaris example: 
 

AVAYA_IC73_HOME=<AvayaHomeDir> 

export AVAYA_IC73_HOME 

LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${AVAYA_IC73_HOME}/lib 

export LD_LIBRARY_PATH 

PATH=$PATH:${AVAYA_IC73_HOME}/bin 

export PATH 
 

AIX example: 
 

AVAYA_IC73_HOME=<AvayaHomeDir> 

export AVAYA_IC73_HOME 

 

mailto:infodev@avaya.com


August 2022 138 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

Configuring the AICD  
 

 

LIBPATH=${LIBPATH}:${AVAYA_IC73_HOME}/lib 

export LIBPATH 

PATH=$PATH:${AVAYA_IC73_HOME}/bin 

export PATH 
 

Replace <AvayaHomeDir> with the full path to your Avaya Home Directory. Depending on 

the shell you use, syntax might be different, so use the syntax appropriate to the shell you 

use for your Siebel server. 

3. Restart the Siebel server. 

4. Return to Installing the AICD (Solaris or AIX) on page 149 and repeat this procedure for 

every Siebel Communications Server in your environment. 

5. Continue to Configuring the AICD on page 151. 
 
 
 
 

Configuring the AICD 
 

Important: 

The order of the configuration steps is significant. Information provided in earlier 

steps is used in later steps. Do not try to perform the steps in an order that is 

different from the order presented here unless you are familiar with how Siebel 

communication drivers are administered. 

! 
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This section includes the following topics: 

● Before you begin on page 152 

● Where to perform these procedures on page 152 

● AICD Siebel administration on page 152 

● Importing the AICD Siebel configuration on page 153 

● Associating Siebel agents with the AICD on page 155 

● Creating a teleset on page 156 

● Adding at least one extension on page 156 

● Adding responsibilities to lists on page 157 
 

 

Before you begin 

The following conditions must be true before you begin these procedures: 

● The AICD is installed. 

● Your employees have already been administered in the Siebel database. 
 

 

Where to perform these procedures 

Perform these procedures at the following location. 

 

Interface System 

Siebel windows Siebel 

 

Related topic 

For more information, see Siebel user interface on page 92. 
 

 

AICD Siebel administration 

You can administer the AICD to support multiple AICD configurations and multiple AICD profiles 

as along as each AICD configuration has only one AICD profile and each agent is part of only 

one configuration. 
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Creating a communication configuration 

You must run the Siebel thin client on the Siebel server, or on another machine that has access 

to the AICD.def file. If running the Siebel thin client on a machine with access to the AICD.def 

file is not possible, use the ftp or copy the AICD.def file to a directory that is accessible. The 

AICD.def file is copied by the setup.exe onto the Siebel server in a subdirectory called bin\ 

enu. 
 

Important: 

Save all entries before leaving a window. 

To create a communication configuration: 

1. Log in to the Siebel thin client as a Siebel administrator. 

2. Go to the Site Map by pressing Ctrl+Shift+A. 

3. Go to Administration - Communications > All Configurations. 

4. Click New on the Configurations window menu bar. 

5. Create an entry for the AICD with the values shown in the following table. 

 

Field Description 

Name You can enter anything with the words Avaya or AICD Configuration in 
the name. 

Comments Type an appropriate comment. 

Example: Avaya IC7.3.x 

 
Important: 

Do not forget to perform the following step. 

6. Press Ctrl+S to save the record. 

7. Continue to Importing the AICD Siebel configuration on page 153. 
 

 

Importing the AICD Siebel configuration 

In this procedure, you are going to import the AICD.def file. It must be available from the 

machine where you are running your Siebel thin client. If you are not running the Siebel thin 

client on the Siebel server, you must copy the AICD.def file to a local directory. You might also 

mount the drive where the AICD.def file is installed. The following directions ensures that you 

are running the Siebel thin client on the Siebel server. 

The AICD.def file is installed in the \bin\enu directory on the Siebel server. 

! 

! 
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Important: 

Save all entries before leaving a window. 

To import the AICD Siebel configuration from the definition file: 

1. Click Import Configuration, located on the right side of the window under the 

Configurations tab. 

Example: 

 

Result: A window with the following text opens. 
 

2. Click Next. 

3. Select all the following boxes: 

● Configuration Parameters 

● Commands 

● Events 

● Drivers & Profiles 

4. Browse to the AICD.def file, or to any other valid definition file. 

Example: 

For Siebel 8.1.1.x: c:\sba8x\siebsrv\bin\enu\AICD.def 

For Siebel 8.1.1.11: c:\Siebel\8.1.1.11.0\ses\siebsrv\bin\enu\AICD.def 

For Siebel 8.2.2.4: c:\Siebel\8.2.2.4.0\ses\siebsrv\bin\enu\AICD.def 

! 

Caution: Importing communications configuration parameters, commands and events, 

or communications drivers and profiles overwrites any existing configuration 

elements that use the same names. Click Next to proceed. 
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5. Click OK. 

Result: You might see the cursor change to an hourglass, and you might have to wait for 
several minutes. There must be no errors. 

6. Set the AICD driver parameters on Avaya IC and Siebel. This step is optional if the default 

values for the driver parameters are adequate for your configuration. 

For example, a Native Siebel integration requires you to change the value of the 

ServerMode parameter to Native. For more information, see ServerMode parameter on 

page 264. 

Reference: For more information, see Driver parameters on page 420. 

7. Continue to Associating Siebel agents with the AICD on page 155. 
 

 

Associating Siebel agents with the AICD 

This section includes the following topics: 

● Before you begin on page 155 

● Procedure on page 155 

 
Before you begin 

You must have already administered your Siebel agents under the Siebel Employee 

Administration window and administered your database. 

 

Related topic 

For more information about administering Siebel agents, see the Siebel documentation. 

 
Procedure 

 

Important: 

Save all entries before leaving a window. 

To associate the Siebel agents with the AICD configuration: 

1. Select the Agents tab located on the bottom third of the window. 

2. Click New under the Agents tab. 

Result: The Add Agents window opens. 

3. Select the agents and click OK. 

4. Continue to Creating a teleset on page 156. 

! 
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Creating a teleset 
 
 

Important: 

Save all entries before leaving a window. 

To create a teleset: 

1. Select All Telesets under the Administration - Communications tab. 

2. Click New in the Telesets window menu bar. 

3. Select the values shown in the following table. 

 

Field Value 

Teleset AICD 

Host AICD 

4. Press Ctrl+S to save the record. 

5. Click New under the Agent tab. 

6. Select the Siebel agents and click OK. 

The All Telesets View displays your selections. 

7. Continue to Adding at least one extension on page 156. 
 

 

Adding at least one extension 
 

Important: 

Save all entries before leaving a window. 

The AICD does not use the extensions that you are adding with this procedure. However, Siebel 

might expect these extensions to be administered. 

To add at least one extension: 

1. Select the Extensions tab located on the bottom third of the window. 

2. Click New under the Extensions tab. 

Result: The Add Agents window opens. 

! 

! 
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3. Select the values shown in the following table. 

 

Field Value 

Extension Type S 

Extension Select a telephone number. 

This number is not validated or used by the AICD. 

 
Important: 

Do not forget to perform the following step. 

4. Press Ctrl+S to save the record. 

5. Continue to Adding responsibilities to lists on page 157. 
 

 

Adding responsibilities to lists 
 

Important: 

Save all entries before leaving a window. 

Perform this procedure so that the agent can view responsibilities from certain pull-down lists, 

and the agent can view the responsibility pop screens. Your site probably requires additional 

views and responsibilities besides the ones described in this procedure. This procedure is 

optional. 

To add new responsibilities: 

1. From the Siebel user interface, go to the Site Map by pressing Ctrl+Shift+A. 

2. Go to Administration - Application > Responsibilities. 

3. In the Responsibilities window menu bar, click New. 

4. Type AICD Responsibility in the Responsibility field. 

5. Press Ctrl+S to save the record. 

6. In the Add Views window menu bar, click New. 

The Views window is located on the lower half of the screen. 

Result: The Add Views window opens. This window adds a view to this responsibility. 

! 

! 
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7.  Select Activity Detail View in the field next to the starting with field. 

Example: 

 

8. Click OK. 

9. Repeat Steps 6 through 8 until you have added all of the following views: 

● Activity Detail View 

● All Activity List View 

● All Contacts across Organizations 

● Communication Detail - Response View 

● Consumer Detail View 

● Contact Detail View 

● Home Page View (WCC) 

10. Click New under the Users tab. This tab associates an agent to this responsibility. 

11. Select an agent, and click OK. 

12. Repeat Step 11 until you have added all the agents. 

13. Continue to Checking the AICD environment (optional) on page 158. 
 
 
 
 

Checking the AICD environment (optional) 

This section includes the following topics: 

● Checking the AICD under Solaris on page 159 

● Checking the AICD under Windows on page 159 
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Checking the AICD under Solaris 

You can use the Solaris command line utility, Ldd to check the AICD dependencies. The Solaris 
Ldd utility lists the dynamic dependencies of executable files or shared objects. 

To check the AICD under Solaris: 

1. On the UNIX command line, navigate to the Siebel Home directory. 

2. Run the Siebel environment file, siebenv.sh. 

You updated the siebenv.sh file in an earlier configuration step. The siebenv.sh file sets 

the UNIX environment variables that are necessary for the AICD to run. 

3. Navigate to the Siebel lib directory. In the Siebel bin directory the AICD is installed. 

4. Run the following command: 

ldd libaicd.so 

Result: The following ldd output shows unresolved dependencies for the files, 

libmttoolkit.so and libmttlogger.so. 
 

libnsl.so.1 => /usr/lib/libnsl.so.1 

libc.so.1 => /usr/lib/libc.so.1 

libmttoolkit.so => (file not found) 

libmttlogger.so => (file not found) 

libpthread.so.1 => /usr/lib/libpthread.so.1 

librt.so.1 => /usr/lib/librt.so.1 

libdl.so.1 => /usr/lib/libdl.so.1 

libmp.so.2 => /usr/lib/libmp.so.2 

libaio.so.1 => /usr/lib/libaio.so.1 

/usr/platform/SUNW,Ultra-4/lib/libc_psr.so.1 

libthread.so.1 => /usr/lib/libthread.so.1 

This unresolved dependencies can be caused by: 

● The libmttoolkit.so and libmttlogger.so files are not installed. These files are 
installed under <AVAYA_IC73_HOME>/bin when you installed Avaya IC on the 

Siebel Server. 

● The LD_LIBRARY_PATH variable is inaccurate. 

5. Continue to Importing a custom eScript for Siebel Universal Agent on page 161. 
 

 

Checking the AICD under Windows 

If your Siebel server has a Windows operating system, you can use a Microsoft tool called 

depends.exe to check the Siebel server configuration. This test ensures that your system path 

setting is accurate and that the Siebel Communications Server can load the AICD.dll. 
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You do not have to perform this procedure if you cannot find a copy of depends.exe. 

This section includes the following topics: 

● Before you begin on page 160 

● Procedure on page 160 

 
Before you begin 

You must have a copy of Microsoft Visual Basic to access depends.exe. 

 

Procedure 

To check the Siebel server AICD environment: 

1. Get a copy of depends.exe from your Visual Basic software. 

2. Run depends.exe on your Siebel server. 

3. Select File > Open and navigate to the Siebel server bin directory. 

Example: 

For Siebel 8.1.1.x: c:\sba8x\siebsrv\bin 

For Siebel 8.1.1.11: c:\Siebel\8.1.1.11.0\ses\siebsrv\bin 

For Siebel 8.2.2.4: c:\Siebel\8.2.2.4.0\ses\siebsrv\bin 

4. Find the AICD.dll, and click Open. 

Result: The Dependency Walker window opens. 

This window lists the AICD.dll and all the DLLs required by the AICD. 

5. Check the entries for MTTOOLKIT.DLL and MTTLOGGER.DLL. 

If the icons next to these filenames display ?, one of the following problems might have 
occurred: 

● The DLL is not installed. 

● The system path variable is inaccurate. 

● You did not reboot your Siebel server after updating the system path. 

6. Continue to Importing a custom eScript for Siebel Universal Agent on page 161. 
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Compiling the SRF 
 
 

Important: 

Test all changes to the Siebel object repository in a non production environment 

before deploying them in your production environment. Create a backup copy of 

the Siebel server object repository before making any changes using Siebel 

Tools. 

For more information, see Working with Siebel Tools on page 127. 

Create a local copy of the SRF file: 

Note: 
You must copy this file only for the first time. For all the successive compilation 

reuse the same local file. 

1. Go to the \siebsrvr\objects\enu directory. 

2. Copy the siebel.srf to local directory accessible to Siebel Tools. 

3. Perform all compilations on this copy of the siebel.srf file. 

To compile the SRF file: 

1. In Siebel Tools, select Tools > Compile Projects. 

2. Result: The Object Compiler window opens. 

3. Select Locked projects. 

4. Browse to the local copy of siebel.srf file. 

5. Select Compile. 
 
 
 
 

Importing a custom eScript for Siebel Universal Agent 

This section includes the following topics: 

● Where to perform this procedure on page 161 

● Procedure on page 162 
 

 

Where to perform this procedure 

Perform this procedure on the Siebel system using Siebel Tools. 

! 
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Related topic 

For more information, see Siebel Tools on page 95. 
 

 

Procedure 

To import a custom eScript for the Siebel Universal Agent: 

1. From Siebel Tools, select Application from the Object Explorer pane. 

2. Select the Siebel Universal Agent application. 

3. Select Tools > Lock Project. 

4. In the Applications pane, right-click Siebel Universal Agent. 

5. Select Edit Server Scripts. 

6. If you see the Scripting Language pop-up, ensure that eScript is selected and click OK. 

Result: The Script Editor window opens. 

7. Go to File > Import. 

8. Select the \Integrations\...\SiebelUniversalAgent.js file from the integration 

CD and click ok. 

Example: 

\Integrations\sba80\Email\SiebelFirst\SiebelUniversalAgent.js 

This imports the eScript. 

9. Press Ctrl+S to save. 

10. Close the window. 

11. For Compilation, see Compiling the SRF on page 161. 

12. Continue to Configuring ASIS (Native Siebel integration only) on page 162. 
 
 
 
 

Configuring ASIS (Native Siebel integration only) 

Perform these procedures for Avaya IC for Native Siebel integrations only. You must configure 

an Agent Server for Integration with Siebel (ASIS) for a Native Siebel integration. For more 

information about ASIS, see ASIS on page 64. 

This section contains the following topics: 

● Where to perform this procedure on page 163 

● Prerequisites on page 163 
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● Adding ASIS to IC Manager on page 163 

● ASIS parameters on page 164 
 

 

Where to perform this procedure 

The directions in this section are for configuring ASIS on the Avaya IC server. 
 

 

Prerequisites 

ASIS is installed as part of the Avaya installation on the Avaya Components for Siebel 
Integration CD. You must have already installed the Avaya IC integration as described in 

previous chapters. ASIS is installed as part of the Interaction Engine Servers. 
 

 

Adding ASIS to IC Manager 

To add an ASIS server to your Avaya IC environment: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3.x > IC Manager. 

2. Log in to IC Manager. 

3. Select Server > New. 

4. Select ASIS in the Server Type field. 

5. Click OK. 

6. Select the General tab. 

7. Type or select the following values. 

 

Field Description 

Name Enter a name for your server. 

Host Select the IP address of the IC Server host where ASIS must reside. 

Domain For instructions on how to configure domains, see ASIS domain 
guidelines on page 54. 

8. Select the ASIS tab. 

mailto:infodev@avaya.com


151 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

August 2022 

Chapter 11: Installation and configuration tasks for all channels 
 

 

 

 
9. On the ASIS screen, add the password in the avaya.ic.sysuser.pwd field. 

The ASIS screen contains parameters that are necessary for ASIS to start up. You can 

accept the default values when the values are not site dependent. A brief explanation of 

the parameters on this screen are in ASIS parameters on page 164. 

10. Click Apply. 

11. Under the Configuration tab, verify that the avaya.ic.webclient.url parameter is set to: 

http://127.0.0.1 

If you must set this parameter, perform the following steps: 

a. In IC Manager, select the Server tab. 

b. Select the Configuration tab. 

c. In the CTI Type Editor window, set the following fields: 

 

Field Value 

CTI Type Couple 

Name avaya.ic.webclient.url 

Value http://127.0.0.1 

d. Click Apply. 

12. Open the group manager window and set the Agent/Desktop/Webclient/ 

ServiceConnections.ServiceConnection_1 property to: 

com.avaya.ic.integrations.siebel.asis.services.AsisServiceConnecti 

on 

13. Click OK. 

14. Go to Tools > Groups and set the Agent/Desktop/WebClient - WorkingDirectory 

property to where your Avaya IC is installed. 

 

Windows environments UNIX environments (Solaris or AIX) 

Example: 

C:\Avaya\IC73\working_dir 

Example: 

/opt/Avaya/IC73/working_dir 

Ensure that the working_dir folder has write permission. 
 

 

ASIS parameters 

Use these ASIS parameters when performing Adding ASIS to IC Manager on page 163, Step 9. 
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This section includes the following topics: 

● Optional ASIS parameters on page 165 

● ASIS > UOM parameters on page 165 

● ASIS > JVM parameters on page 166 

● Advanced ASIS Server parameters in the env.properties file on page 167 

 
Optional ASIS parameters 

The following list is not meant to be a comprehensive list of optional ASIS parameters. You can 

add any other parameters on the configuration screen. For more information about parameters 

not shown in this table, consult Avaya support. Set these parameters on the configuration tab in 

IC Manager as JVM system properties set by the Jloader or ASIS. 

 

Parameter Value and description 

AICD Recovery Timeout 300 

The minimum time in seconds the system waits before timing out and 
logging out an agent session, because of any kind of AICD 
connection failure. 

ThreadPool Size Use the default value of: 

8 

This property sets the size of the thread pool. 

 

ASIS > UOM parameters 

The parameters listed in the following table are used by ASIS to communicate with UOM 

through VespBridge. For more information about parameters not shown in this table, consult 

Avaya support. Set these parameters on the configuration tab in IC Manager as JVM system 

properties set by the Jloader or ASIS. 

 

Parameter Value and description 

avaya.ic.datasource interaction_center 

The Avaya IC application database. 

avaya.ic.dco.networkpoolsize 100 (initially) 

The size of the network pool. 

avaya.ic.home The value of the AVAYA_IC73_HOME system variable. 

avaya.ic.sysuser.name dcobridge1 

The value of an administrator account in Avaya IC. 
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Parameter Value and description 

avaya.ic.sysuser.pwd Leave blank. 

The password for the account specified for avaya.ic.sysuser.name. 

avaya.ic.sysuser.mode 2 

The system user mode as either client mode (1) or server mode (2). 

avaya.ic.vesp.interface ASIS 

The interface name you use for VespBridge. 

avaya.ic.vesp.factoryclassname com.avaya.ic.vesp.VespFactoryImpl 

The class that serves VespProxy objects. 

avaya.ic.vesp.localorb True or False 

This property sends a signal to ASIS to check a local Object Request 
Broker (ORB) Server exists. 

avaya.ic.vesp.requesthandler com/avaya/ic/integrations/siebel/asis/core/ 
AsisRequestHandler 

The Java class name for handling inbound VESP requests. 

avaya.ic.vesp.orbuuid The actual UUID of the ORB Server in this environment. 

Avaya.ic.vesp.sendorbready True 

This property tells ASIS to send a ready event to the ORB Server 
after initialization. 

jloader.server.main.class Use the default value of: 

com/avaya/ic/integrations/siebel/asis/core/Asis 

This property tells jloader which class to start. 

 

ASIS > JVM parameters 

To improve the performance of ASIS certain JVM options can be passed to the jloader which 

accordingly loads the JVM for running the ASIS inside it. 

To add the JVM parameters: 

1. Login to IC Manager. 

2. Edit the ASIS server. 

3. Click the Configuration tab. 

4. Click New. 

5. In the CTI Type Editor window, select the CTI Type as Couple. 

6. In the Name field, add the JVM parameter. For example: jvm:-Xrs 

7. Leave the Value field blank. 

8. Click Ok. 
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Perform the steps 1 to 8 for all the required JVM parameters. Examples of the JVM parameters 

are: 

● jvm:-Xrs 

● jvm:-Xms128m 

● jvm:-Xmx256m 

● jvm:-Xgcpolicy:subpool 

Note: 
After adding the parameters, restart the ASIS server, update the directory server, 

and refresh the IC Manager to apply the JVM parameters. 

 
Advanced ASIS Server parameters in the env.properties file 

To improve the performance of ASIS, you can modify certain parameter values by specifying 

them in the env.properties file. 

You can create a env.properties file in AVAYA_IC_HOME\etc. on the machine which hosts the 
ASIS server. 

In the env.properties file, you can specify the parameters and the respective values in the 

following format: 

<parameter name>=<value> 

The following table provides information pertaining to the properties that you can set in the 

env.properties file. 

 
Important: 

Changing any of the following parameters might have impact on CPU and 

memory utilization of the system. If the parameters are changed, test the 

parameters before deploying. You must restart ASIS server if any of the following 

parameters are changed. 
 

 

Property Name Preferre 
d Value 

Description 

AICDTIMEOUT 30 This time must be used for all worker 
tasks to be completed. Useful to wait 
for dust to settle after activate, 
deactivate. 

application.asyncwork.poolsize 50 Specifies number of threads that must 
handle the Asynchronous tasks at the 
application layer. 

! 
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Property Name Preferre 
d Value 

Description 

application.asyncwork.queue.maxsize 2048 Specifies the size of queue for 
en-queuing Asynchronous task, 
applicable at application layer 

basicservices.cachereadytimeout 60000 Specifies time, in millisecond, to wait 
for requests against a basic service to 
be ready, before returning potentially 
stale data 

basicservices.initialwaittimeout 2000 On application startup, this time is, in 
millisecond, to wait between retries for 
the cache to be ready. 

basicservices.initialwaittries 10 Specifies number of retry attempts for 
a request to basic services on 
application startup. 

queuesizelogger.enabled FALSE Specifies whether queues/work items 
must be monitored 

queuesizelogger.polltimeout 5000 Specifies how many times a polling 
thread writes the current queue sizes 
to the log. Zero means do not write to 
the log. Time is in Milliseconds. 

queuesizelogger.queuesizethreshold 1 Specifies the size that must be met 
before a queue size must be written to 
the log. 

queuesizelogger.trackperuser FALSE Specifies whether per-user queues 
must be logged 

uom.asyncwork.poolsize 50 Specifies Minimum size of thread for 
handling Asynchronous tasks in the 
UOM layer. Maximum thread poolsize 
is twice this value. 

uom.asyncwork.queue.maxsize 2048 Specifies the size of queue for 
en-queuing Asynchronous task at 
UOM layer. 

uom.event.queue.poolsize 50 Specifies the size of thread pool for 
handling UOM events, applicable at 
UOM layer only. 

uom.executor.pollinterval 250 Specifies the time when the thread 
picks next available task from queue 
for processing. Time specified in 
Milliseconds. 
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Property Name Preferre 
d Value 

Description 

uom.scheduler.queue.poolsize 50 Specifies the Minimum thread pool 
size for handling scheduled task in 
queue, applicable at UOM layer only. 
For ex. Rona Timeout. Maximum 
thread poolsize is twice this value. 

vesp.alarm.unrecoverable.reportthresh 
old 

3600 Minimum number of seconds to wait 
before repeating an unrecoverable 
alarm for an IC interfaces. Time in 
Seconds. 

vesp.event.queue.poolsize 20 Specifies the size of thread pool for 
handling VESP events in queue. 

vesp.event.queuesize 1024 Specifies the size of queue for 
en-queuing VESP events. 

vesp.event.waittime 60000 How long to wait before retrying to 
enqueue an event. An event is tried to 
be requeued at one time. No indication 
of failure if en-queuing fails. Time in 
milliseconds 

vesp.taskpool.maxsize 70 Maximum number of threads to create 
to handle Assigns and De-assigns (for 
VespConnection) request. 

vesp.taskpool.minsize 20 Minimum number of threads to create 
for handling Assigns and De-assigns 
(for VespConnection) request. 

 
 
 
 

Configuring the Avaya EAI servers 

Use the procedures in this section to configure the Avaya Enterprise Application Integration 

(EAI) servers. You can install the EAI server on any server that has an ORB server, including 

the Siebel server or another Avaya IC server. 

This section includes the following topics: 

● Adding EAI servers to IC Manager on page 170 

● Importing the Siebel certificate on page 161 

● Installing a custom integration object on page 173 

● Modifying the eai.cfg file on page 177 

● Shutting down and restarting the EAI Object Manager component on page 177 

● Starting the Avaya IC EAI servers on page 178 
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Related topic 

For more information about the EAI servers, see EAI server on page 64. 
 

 

Adding EAI servers to IC Manager 

This section includes the following topics: 

● Where to perform these procedures on page 170 

● Before you begin on page 170 

● About configuring the Workflow and EAIWorkflow servers on page 170 

● Adding the EAI server on page 171 

● Adding the EAIWorkflow server on page 172 

 
Where to perform these procedures 

Perform these procedures at the following location. 

 

Interface System 

IC Manager Avaya IC 

 

Before you begin 

Read the following sections before proceeding: 

● EAI domain guidelines on page 53 

● EAI server types on page 66 

 
About configuring the Workflow and EAIWorkflow servers 

Configure the Workflow server and the EAIWorkflow server on the same physical machine to 
avoid potential permission problems. 

 

Related topic 

For more information, see EAI server cannot read a file attachment on page 294. 
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Adding the EAI server 

To add the Avaya EAI server to IC Manager: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select Server > New. 

4. In the Server Type field, select EAI. 

5. Select the General tab, and select the values shown in the following table. 

 

Field Value 

Name Select EAI 

Domain For instructions on how to configure domains, see Avaya IC domain 
deployment guidelines on page 50. 

Host Select the appropriate Avaya IC host where this EAI server must run. 

Directory For Windows,Solaris, and AIX installation - Select AVAYA_IC73_HOME/etc 

6. Select the EAI tab, and type or select the values shown in the following table. 

 

Field Value 

Siebel Web Server Select the name of your Siebel server. 

Siebel User Name Type the [Siebel login name]. The default Siebel 
login name is SADMIN. 

Siebel Password Type the [Siebel password]. The default Siebel 
password is SADMIN. 

Siebel Interface Type Select eai 

Active Session Count Leave the default values. 

HTTP response Timeout(sec) 

Heartbeat 

SWEExtSource Enter SiebelExecute 

Language Code For English, type enu 

See the Siebel documentation for other language 
codes. 
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7. If the Siebel IP17 or later is used, configure the serverurl property (available since IC 7.3.9) 
containing the URL of the Siebel EAI application. It is required, because the format of the 
URL was changed in Siebel IP17. 

a. Select the Configuration tab. 

b. Click New to open the CTI Type Editor. 

c. Provide the following values: 

• CTI Type: Couple 

• Name: serverurl 

• Value: https://<SIEBEL_SERVER>:<PORT>/siebel/app/eai/enu 

Where <SIEBEL_SERVER> is the FQDN of the Siebel Server (for example, 
mysiebel.server.com), <PORT> is the Siebel Application Interface’s HTTPS Redirect 
Port. 

d. Click Ok to close the CTI Type Editor. 

8. Select the Debug tab to set the trace levels to usr1 - user 4 depending on the amount of 
information needed in the EAI server log files. 

Reference: For more information about logging levels, see Log files on page 277. 

 
Important: 

Do not set your logging level to flush for normal operating conditions. The flush 

setting slows down all EAI processes. For normal system operations, the log level 

must not be set at a level greater than usr2. 

9. Click Ok. 

10. Continue to Adding the EAIWorkflow server on page 172. 

 
Adding the EAIWorkflow server 

To add the Avaya EAIWorkflow server to IC Manager: 

1. From IC Manager, select Server > New. 

2. In the Server Type field, select EAIWorkflow. 

3. Select the General tab, and select the values shown in the following table. 

 

Field Value 

Name Select EAIWorkflow 

Domain For instructions on how to configure domains, see Avaya IC domain 
deployment guidelines on page 50. 

Host Select the appropriate Avaya IC host where this EAI server must run. 

! 
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Directory For a Windows,Solaris, and AIX installation - Select AVAYA_IC73_HOME/ 
etc 

4. Select the EAI Workflow tab, and type or select the values shown in the following table. 

 

Field Value 

Siebel Web Server Select the name of your Siebel server. 

Siebel User Name Type the [Siebel login name]. The default Siebel login 
name is SADMIN. 

Siebel Password Type the [Siebel password]. The default Siebel 
password is SADMIN. 

Siebel Interface Type Select workflow 

Use MIME Layer Check this field to use Multipurpose Internet Mail 
Extensions (MIME) 1. 

Active Session Count Leave the default values. 

HTTP response Timeout(sec) 

Heartbeat 

SWEExtSource Enter AvayaICEAIAdapter 

Language Code For English, type enu 

See the Siebel documentation for other language 
codes. 

1. You can configure EAIWorkflow without MIME if you do not require any attachments on a Put operation. 

For example, attachments are required when creating a Web chat record with the transcripts. 

 

5. If the Siebel IP17 or later is used, configure the serverurl property (available since IC 7.3.9) 
containing the URL of the Siebel EAI application. It is required, because the format of the 
URL was changed in Siebel IP17. 

a. Select the Configuration tab. 

b. Click New to open the CTI Type Editor. 

c. Provide the following values: 

• CTI Type: Couple 

• Name: serverurl 

• Value: https://<SIEBEL_SERVER>:<PORT>/siebel/app/eai/enu 

Where <SIEBEL_SERVER> is the FQDN of the Siebel Server (for example, 
mysiebel.server.com), <PORT> is the Siebel Application Interface’s HTTPS Redirect 
Port. 

d. Click Ok to close the CTI Type Editor. 

6. Select the Debug tab to set the trace levels to usr1 - user 4 depending on the amount of 

information needed in the EAI server log files. 
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Reference: For more information about logging levels, see Log files on page 277. 

 
Important: 

Do not set your logging level to flush for normal operating conditions. The flush 

setting slows down all EAI processes. For normal system operations, the log level 

must not be set at a level greater than usr2. 

7. Click Ok. 
 

 

Importing the Siebel certificate 

If the Siebel IP17 or later and IC 7.3.9 or later are used, import the Siebel Server certificate in the 
Java keystore on the machine hosting the EAI/EAIWorkflow servers. 

1. Copy the Siebel Server certificate from the Siebel server machine to the 
%AVAYA_IC73_HOME%\Java\lib\security folder on the machine hosting the 
EAI/EAIWorkflow servers. 

2. Open the command prompt and run the following commands to import above certificate: 

a. cd %AVAYA_IC73_HOME%\Java\lib\security 

b. %AVAYA_IC73_HOME%\Java\bin\keytool.exe -import -file <Siebel Server 
Certificate> -alias <Certificate Alias Name> -keystore cacerts -storepass changeit 

c. When prompted to trust the certificate, type Yes. 

d. Verify that the certificate was successfully imported in cacerts keystore by checking 
the output of the following command: 

%AVAYA_IC73_HOME%\Java\bin\keytool.exe -list -alias <Certificate Alias Name> -
keystore cacerts -storepass changeit 

Note: The default password for cacerts keystore is changeit. Use the appropriate 
password if it is changed. 

 
 

Installing a custom integration object 

This section includes the following topics: 

● Purpose on page 173 

● Where to perform this procedure on page 174 

● Where to perform this procedure on page 174 

 
Purpose 

! 
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The Avaya IC EAI server requires integration objects to exchange Get and Put Data with Siebel. 

 
Related topics 

For more information, see the following topics: 
 

● Integration objects on page 90 

● EAI Get and Put operations on page 400 

 
Where to perform this procedure 

Perform this procedure at the following location. 

 

Interface System 

Siebel Tools Siebel 

 

Related topic 

For more information, see Siebel Tools on page 95. 

Procedure to install the out-of-the-box integration objects on the Siebel server, and import  the 
Siebel integration objects from a Siebel SIF file: 

1. Start Siebel Tools. 

2. Select Tools > Import from Archive. 

If you get a message saying that you must be connected to the local database, ignore it. 

3. Browse to the \Integrations\...\eai\Avaya IC EAI Objects.sif file on the 

integration CD, and click Open. 

4. Ensure that Merge the object definition from the archive file with the definition in the 
repository is selected. 

5. Click Next. 

Result: The Review Conflicts and Actions window opens. This window shows the Siebel 
integration objects in the SIF file that you must import. 

6. Click Next. 

The following message displays: 
 

The operation is going to modify your repository as follows: 

XXXX objects will be inserted 

0 objects will be deleted 

0 attributes will be updated 

Do you wish to proceed? 

7. Select Yes to get Siebel to import the integration object into the database. 

Note: 
This operation might take 5 to 20 minutes to complete. 
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8. Select Project from the Object Explorer located in the upper-left pane. 

Example: 

 

9. Select Avaya IC in the Projects pane. 

Example: 

 

 

10. Select the Locked column to lock the project. 

Result: 

 

11. Continue to Importing and deploying the Siebel 8.1.1.x or 8.2.2.x workflows on page 176. 
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Importing and deploying the Siebel 8.1.1.x or 8.2.2.x workflows 

Perform this procedure only if you have Siebel 8.1.1.x or 8.2.2.x. 

To import and deploy the Siebel workflow: 

1. Start Siebel Tools. 

2. If the Workflow Process is not visible in the Siebel Object Explorer window, perform the 
following steps: 

a. Go to View > Options. 

b. Click Object Explorer. 

c. Check Workflow Process. 

3. Click the Workflow Process object. 

4. Right-click the Workflow Processes window and select Import Workflow Process. 

5. Import the \integrations\...\eai\Avaya IC EAI MIME.xml workflow. 

6. Query for the Avaya IC EAI MIME workflow. 

Result: The status shows: 

In Progress 

7. Right-click the Avaya IC EAI MIME workflow that has the In Progress status. 

8. Select Validate. 

Result: The Validate window opens. 

9. Click Start. 

Result: The total tests failed must be 0. 

10. Ensure the Avaya IC EAI MIME workflow with the In Progress status is selected. 

11. If the WF/Task Editor Toolbar is not visible, perform the following steps: 

a. Go to View > Toolbars. 

b. Select WF/Task Editor Toolbar. 

c. The WF/Task Editor Toolbar must appear. 

12. Click Publish/Activate button. This button deploys the workflow and also activate it. 

The status changes to Completed. 

13. Write down the version number of the deployed workflow. 

14. Compile the SRF. 

For more information, see Compiling the SRF on page 161. 

15. Restart Siebel. 
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16. Continue to Modifying the eai.cfg file on page 177. 

 
 
 
 

Modifying the eai.cfg file 

To modify the eai.cfg file: 

1. Open the eai.cfg file and add the values shown in the following table. 

● For Windows, browse to <SiebelHomeDir>\siebsrvr\bin\enu\eai.cfg 

● For Solaris or AIX, browse to <SiebelHomeDir>/siebsrvr/bin/enu/eai.cfg 

 

Pane Field Value 

[HTTP Services] AvayaICEAIAdapter AvayaICEAIAdapter 

[AvayaICEAIAdapter] Mode Document 

Method RunProcess 

Service Avaya IC Integration 
Business Service 

2. Continue to Shutting down and restarting the EAI Object Manager component on 
page 177. 

 

 

Shutting down and restarting the EAI Object Manager component 

This section includes the following topics: 

● Where to perform this procedure on page 177 

● Procedure on page 178 

 
Where to perform this procedure 

Perform this procedure at the following location. 

 

Interface System 

Siebel windows Siebel 
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Related topic 

For more information, see Siebel user interface on page 92. 

 
Procedure 

You must restart a Siebel Server components for the eai.cfg file changes to take effect. 

To shut down and to restart the Siebel Server components: 

1. From the Siebel user interface, go to the Site Map by pressing Ctrl+Shift+A. 

2. In the Component field, type: 

EAI Object Manager 

3. Click Go. 

 
CAUTION: 

On a production system, restarting the Siebel Server component is service 
affecting. 

4. Click Shutdown. 

5. Select Startup. 

6. Continue to Starting the Avaya IC EAI servers on page 178. 
 

 

Starting the Avaya IC EAI servers 

This section includes the following topics: 

● Where to perform this procedure on page 178 

● Before you begin on page 179 

● Procedure on page 179 

 
Where to perform this procedure 

Perform this procedure at the following location. 

 

Interface System 

IC Manager Avaya IC 
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Before you begin 

The Avaya IC EAI servers depend on the Siebel changes that you made earlier. You must have 
successfully completed the following steps on your Siebel server: 

● Installing a custom integration object on page 173 

● Importing and deploying the Siebel 8.1.1.x or 8.2.2.x workflows on page 176 

 
Procedure 

To start the Avaya IC EAI servers: 

1. Start the Siebel EAI servers by selecting each server in IC Manager and selecting the 

Start server icon. 

Example: 

 

The EAI servers must initialize with no alarms or problems. 

2. If you encounter problems, perform the following steps: 

● Check your configuration for passwords, directory, host, and executable. 

● Verify that the eaisrv executable is present on your server and has permissions that 
enable it to be executed. 

● Check the settings and configuration you established in this section, Configuring the 

Avaya EAI servers. 

3. What type of channel are you installing? 

Note: 
If you are installing more than one type of channel, perform one procedure at a 

time. 

 

If Then 

Voice Continue to Configuring voice qualification workflows on page 180. 

Web chat Continue to Configuring Web chat qualification workflows on page 186. 

Email - 
Siebel-first 

Continue to Configuring an email channel on page 198. 
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Chapter 12: Configuring voice qualification 

workflows 
 
 
 
 

 

Important: 

Use these procedures only if you are installing a voice channel on your system. 

The integration software includes out-of-the-box voice workflows. These out-of-the-box 

workflows does not work until you customize the workflows for your location using these 

procedures. 

This section includes the following topics: 

● Building the Avaya voice qualification workflow on page 180 

● Configuring workflow servers to use Siebel voice workflows on page 181 
 
 
 
 

Building the Avaya voice qualification workflow 

The Incoming Call flow, or voice qualification workflow, uses Automatic Number Identification 

(ANI) information to query Siebel for matching records. 

 

Related topic 

For more information, see Process of the Incoming Call flow on page 113. 
 

 

Where to perform this procedure 

Perform this procedure at the location shown in the following table. 

 

Interface System 

Workflow Designer Avaya IC 

 

 

Procedure 

To build the Avaya voice qualification workflow: 

! 
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1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > Workflow Designer. 

2. Select File > Open Project. 

3. Do one of the following tasks: 

● If you use Business Advocate, open the advocate_sbl.prj file. 

Example: 

<AVAYA_IC73_HOME>\Design\IC\flows\Siebel\Advocate\advocate_sbl 

Double-click the qualifyvoice_adv_sbl workflow. 

● If you do not use Business Advocate, open ts_sbl.prj file. 

Example: 

e:\<AVAYA_IC73_HOME>\Design\IC\flows\Siebel\TS\ts_sbl.prj 

Double-click the incomingcall_sbl workflow. 

4. Select the Format ANI to be 10-digits block in the workflow chart. 

5. Enter the telephone number format in the Format property of the Basic tab. 

For more information about how to create a format string for telephone numbers, see IC 

Scripts VBA Scripting Reference. 

6. Select Project > Settings. 

7. Select the Database tab. 

8. Type the Login Id and Password. 

9. Click OK. 

10. Select Build > Build Flowset to compile and store the workflow. 

The default settings for the blocks, EAIGetData, and EAIPutData, must work with the EAI 
server configuration described in this document. 

Reference: For more information, see Adding EAI servers to IC Manager on page 170. 

Continue to Configuring workflow servers to use Siebel voice workflows on page 181. 
 
 
 
 

Configuring workflow servers to use Siebel voice 

workflows 

You must replace the Avaya IC Incoming Call flow with the Siebel incomingcall_sbl flow. 

 
Related topic 

For more information, see Voice qualification workflow on page 112. 
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Where to perform this procedure 

Perform this procedure at the following location. 

 

Interface System 

IC Manager Avaya IC 

 

 

Procedure 

To configure the Avaya IC Workflow server to run a Siebel voice workflow when the 

TS.IncomingCall event is raised: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select the Server tab. 

4. Select All Domains. 

5. If not already created, create a Workflow server to run the Siebel-first workflow. The server 

must be in the Voice domain. 

For instructions on how to create a Workflow server, see IC Installation and Configuration 

6. Select the Channels tab of the Voice Workflow server. 

7. Do one of the following tasks: 

● If you do not use Business Advocate: 

a. Edit the workflows for the incoming call events. 

b. Set the workflow to ts_sbl.incomingcall_sbl. 
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c. Click Ok. 

Result: 

 

● If you use Business Advocate: 

a. Select New Channel Association. 

b. In the Channel Editor window, select TSA in the Service drop-down list. 

c. Type Criteria field as voice.qualify. 

d. Click Ok. 

e. Open TSA Server and select TSA tab. 

f. Click Contact Handling .... 

g. In the Contact Handling window, set qualification flow as 

advocate_sbl.qualifyvoice_adv_sbl 

h. Click Ok. 

8. Stop and start the Workflow server if the server has already started by doing the following: 

a. Select the Server tab on the IC Manager window. 

b. Select the server from the list on the right side of the window. 

c. Select the Start or Stop button in the toolbar. 

9. Ensure contact routing is set up for the voice channel. 

Reference: For more information, see one of the following documents: 

● For basic information, see Avaya IC Media Workflow Reference 

● For more information about setting up contact routing, see IC Installation and 

Configuration 
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● For Business Advocate contact routing, see Business Advocate Configuration and 

Administration 

10. What channel are you also installing? 

 

If Then 

Web chat Continue to Configuring Web chat qualification workflows on page 186. 

Email - 
Siebel-first 

Continue to Configuring an email channel on page 198. 
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Chapter 13: Configuring Web chat 
qualification workflows 

 
 
 
 

 
Important: 

Use these procedures only if you are installing a Web chat channel on your 
system. 

Web chat is currently not supported in a Native Siebel configuration. 

The integration software includes out-of-the-box Web chat workflows. These out-of-the-box 

workflows does not work until you use these procedures to customize the workflows for your 

location. 

This section includes the following topics: 

● Building the Avaya Web chat qualification workflows on page 186 

● Modifying Customer Management workflows for Web on page 188 

● Configuring workflow servers to use Web chat workflows on page 189 

● Installing the Web chat qualification workflow on page 193 
 
 
 
 

Building the Avaya Web chat qualification workflows 

This section contains the following topics: 

● Where to perform this procedure on page 186 

● Procedure on page 187 
 

 

Where to perform this procedure 

Perform this procedure at the location shown in the following table. 

 

Interface System 

Workflow Designer Avaya IC 

! 
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Procedure 

To build out-of-the-box Web chat workflows: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > Workflow Designer. 

2. Select File > Open Project. 

3. Browse to one of the following files: 

● icm_sbl.prj 

● webcenter_sbl.prj 

Do one of the following task: 

● If you use Web Automatic Call Distributor (WACD), open the wacd_sbl.prj file. 

● If you use Business Advocate, open the advocate_sbl.prj file. 

Example: 

e:\<AVAYA_IC73_HOME>\design\IC\Flows\Siebel\ICM\icm_sbl.prj 

4. Select Project > Settings. 

5. Select the Database tab. 

6. Type the Login Id and Password. 

Result: The Project Settings window opens. 

7. Are you currently building the webcenter_sbl.prj? 

 

If Then 

Yes Go to Step 8. 

No Go to Step 10. 

8. Select the Directories tab. 

9. Click the New Folder button to add the Webcenter directory. 

Example: 

e:\<AVAYA_IC73_HOME>\design\IC\Flows\Siebel\Webcenter 

 

10. Click OK. 

11. Select Build > Build Flow Set. 

There must be no errors. 
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12. Close the project. 

13. Return to Step 3 and repeat this procedure until you have added all the workflows. 

14. Exit Workflow Designer. 

15. Continue to Modifying Customer Management workflows for Web on page 188. 
 
 
 
 

Modifying Customer Management workflows for Web 

Use this procedure to modify the Website that uses the Siebel versions of the Customer 

Management workflows for Web. The Customer Management workflows for Web are also 

called the customer management workflows. 
 

 

Where to perform this procedure 

Perform this procedure at the following location. 

 

Interface System 

IC Manager Avaya IC 

 

 

Procedure 

To modify the Customer Management workflows for Web: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select Services > Multi-Tenancy Administration. 

You might need to select the Ic Website Multi-Tenant Administration service. You can 
also reach this page by going to http://<yourserver>/website/admin. 

4. In the left navigation pane, select Tenant Properties. 

5. In the right content pane select, Default Tenant. 

6. Select Customize Tenant. 

7. In the right content pane, select flows. 
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8. Add _sbl to every flowset and workflow. 

Example: 

 

9. Click Update Data. 

10. Exit the Multi-Tenancy Administration windows. 

11. Continue to Configuring workflow servers to use Web chat workflows on page 189. 
 
 
 
 

Configuring workflow servers to use Web chat workflows 

To configure the Avaya IC Workflow server to run a Siebel Web chat workflow when the 
WACD.QualifyChat event is raised: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 
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3. Select the Server tab. 

4. Select All Domains. 

5. If not already created, create a Workflow server to run the Chat workflow. 

For instructions on how to create a Workflow server, see IC Installation and Configuration. 

6. Double-click the Workflow server for Web chats in IC Manager. 

7. Select the Channels tab of the appropriate Workflow server. 

8. Right-click and select New Channel from the list. 

● If you use Business Advocate, skip to Creating and configuring an Avaya IC workflow 
for Business Advocate for Chat on page 191. 

● If you do not use business advocate then continue the following steps. 

9. In the Channel Editor dialog box, select the values shown in the following table. 

 

Field Value 

Service WACD 

Criteria media=chat 

10. Click Ok. 

11. Select New Association. 

12. In the Channel Association dialog box, type the values shown in the following table. 

 

Field Value 

Event WACD.QualifyChat 

Flow wacd_sbl.qualifychat_sbl 

 
Note: 

These fields are case-sensitive. 
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13. Click Ok. 

Result: 
 
 

14. Stop and start the Workflow server if the server has already started by doing the following: 

a. Select the Server tab on the IC Manager window. 

b. Select the server from the list on the right side of the window. 

c. Select the Start or Stop button in the toolbar. 

15. Ensure contact routing is set up for the Web chat channel. 

Reference: For more information, see one of the following documents: 

● For basic information, see Avaya IC Media Workflow Reference 

● For more information about setting up contact routing, see IC Installation and 

Configuration 

● For Business Advocate contact routing, see Business Advocate Configuration and 
Administration 

 

 

Creating and configuring an Avaya IC workflow for Business 

Advocate for Chat 

To create and configure an Avaya IC workflow to run the Siebel-first workflow and the qualify 
workflow: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select the Server tab. 
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4. Select All Domains. 

5. If not already created, create a Workflow server to run the Siebel-first workflow. 

For instructions on how to create a Workflow server, see IC Installation and Configuration. 

6. Select the Channels tab of the email workflow server. 

7. Right-click and select New Channel from the list. 

8. In the Channel Editor dialog box, select the values shown in the following table. 

 

Field Value 

Service WAA 

Criteria chat.qualify 

9. Click Ok. 

10. Stop and start the Workflow server if the server has already started by doing the following: 

a. Select the Server tab on the IC Manager window. 

b. Select the server from the list on the right side of the window. 

c. Select the Start or Stop button in the toolbar. 
 

 

Creating and configuring a WAA Server for Chat 

To create and configure a WAA Server: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select the Server tab. 

4. Select All Domains. 

5. If not already created, create a WAA server. 

For instructions on how to create a WAA server, see IC Installation and Configuration. 

6. Select the WAA tab of the WAA server. 

7. Check the Configure Advocate for Chat Channel option. 

a. In the Chat LRM drop box, select the configured LRM. 

b. In the Chat Qualification Flow field, type "advocate_sbl.qualifychat_adv_sbl". 

8. Click Ok. 

9. Stop and start the Workflow server if the server has already started by doing the following: 
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a. Select the Server tab on the IC Manager window. 

b. Select the server from the list on the right side of the window. 

c. Select the Start or Stop button in the toolbar. 

Continue to Installing the Web chat qualification workflow on page 193. 
 
 
 
 

Installing the Web chat qualification workflow 

The integration software uses the Transcript Added workflow to put a copy of the 

transcript-added file into Siebel through the EAI. 

This section includes the following topics: 

● Changing the location of the Transcript Added workflow output file on page 193 

● Changing the default transcript-added XSL file on page 194 

● Configuring the ICM server to run the Transcript Added workflow on page 195 

 
Related topic 

For more information, see Transcript Added workflow on page 116. 
 

 

Changing the location of the Transcript Added workflow output 

file 

The Transcript Added workflow generates an output file that is located by default at c:\temp. If 

in your case, the workflow and the EAI servers cannot efficiently access this location, then you 

must change the default location. 

 
Where to perform this procedure 

Perform this procedure at the location shown in the following table. 

 

Interface System 

Workflow Designer Avaya IC 
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Procedure 

To change the default location: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > Workflow Designer. 

2. Select File > Open Project. 

3. Browse to the icm_sbl.prj file. 

Example: c:\Avaya\IC\design\IC\flows\Siebel\IC\icm_sbl.prj 

4. Double-click the transcriptadded_sbl workflow to open it. 

5. Select the block labeled Process Transcript. 

Result: The Property Sheet window opens. 

6. Select the location you must use in the OutputFilePath field. 

Note: 
If you specify a Universal Naming Convention (UNC) path in the OutputFilePath, 

add an extra back slash in front of the path. For example, if your path is \\ 
servername\share, type \\\servername\share. Workflow Designer trims the 

first back slash to make \\servername\share. 

Ensure that this directory is configured for full permissions to the administrator - such 

as read, write, delete, modify. 

7. Select Build > Build Flowset to compile and store the workflow changes. 

8. Continue to Changing the default transcript-added XSL file on page 194. 
 

 

Changing the default transcript-added XSL file 

As described in previous sections, the Transcript Added workflow must build an HTML file from 

a raw XML transcript file using an eXtensible Stylesheet Language (XSL) file. If you change the 

resultant HTML file, you must change the XSL file. 

A basic XSL file for transforming the Transcript Added workflow is installed into: 

\<AVAYA_IC73_HOME>\design\IC\flows\Siebel\ICM\transcriptadded_sbl.xsl 

By default, the Transcript Added workflow is configured to read this from the working directory 
of the Workflow server that is running the workflow. This directory is usually the 

<AVAYA_IC73_HOME>\etc directory. 

To copy the transcriptadded_sbl.xsl file to the correct location and change the name of this 
file: 

1. Copy the transcriptadded_sbl.xsl file to the <AVAYA_IC73_HOME>\etc directory. 

mailto:infodev@avaya.com


August 2022 182 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

Installing the Web chat qualification workflow  
 

 

 
 

Note: 
If your EAI and workflow servers are running on UNIX, use ftp to move this file to 

the UNIX system in the appropriate location. 

2. Do you want to change the name of this file or use a different location? 

 

If Then 

Yes To modify the XSLFileName property of the Process Transcript block, go to Step 
3. 

No Continue to Configuring the ICM server to run the Transcript Added workflow on 
page 195. 

3. Navigate to Start > Programs > Avaya Interaction Center 7.3 > Workflow Designer. 

4. Select File > Open Project. 

5. Browse to the icm_sbl.prj file. 

Example: 

c:\Avaya\IC\design\IC\flows\Siebel\IC\icm_sbl.prj 

6. Select the block labeled Process Transcript. 

Result: The Property Sheet window opens. 

7. Enter the location you must use in the XSLFileName field. 

Note: 
If you must use a location other than <AAVAYA_IC73_HOME>\etc, specify the 

full path here. 

8. Select Build > Build Flowset to compile and store the workflow changes. 

9. Continue to Configuring the ICM server to run the Transcript Added workflow on page 195. 
 

 

Configuring the ICM server to run the Transcript Added workflow 

Your Internet Call Manager (ICM) server must already be configured and running. If you have a 

more complex ICM server configuration than what is described in this procedure, you might 

need to do more than the basic steps described in this procedure. 

 

Related topic 

For more information, see IC Installation and Configuration. 
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Where to perform this procedure 

Perform this procedure at the following location. 

 

Interface System 

IC Manager Avaya IC 

 

Procedure 

To configure IC Manager to run the Transcript Added workflow: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select the Configuration tab. 

4. Select Chat > ICM > icm. 

These directories are located in the left navigation pane. 

5. Right-click anywhere in the gray area, and select Show Advanced Properties. 

6. Scroll to the bottom to reveal the Enable Transcript Added Flow and Transcript Added 
Flow Name fields. 

7. Select the Enable Transcript Added Flow field. 

8. In the Transcript Added Flow Name field, type: 

icm_sbl.transcriptadded_sbl 

Note: 
To set the Transcript Added Flow Event parameter to run the icm.transcriptadded 

flow is not necessary. To set this parameter is necessary if additional event data is 

needed in the workflow. 

9. Click Apply. 

10. Restart the Avaya IC ICM Service and Website for changes to take effect. 

11. Continue to Configuring an email channel on page 198. 
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Important: 

Consider the following items: 

● Use these procedures only if you are installing an email channel on your system. 

● Always see the latest Siebel documentation when performing any of the 

procedures that use Siebel Tools or the Siebel user interface. Avaya cannot 

guarantee the accuracy of these procedures. 

This section includes the following topics: 

● Configuring the Avaya IC server on page 198 

● Installing eScripts and English error strings on the Siebel server on page 206 

● Installing localized error strings on the Siebel server (optional) on page 209 

● Importing the CommOutboundItemFormApplet.js file on page 210 

● Importing the CommInboundItemListApplet.js file on page 211 

● Administering the Siebel workflows on page 212 

● Configuring Siebel to poll the mailbox on page 216 

● Configuring Smart Answer Manager on page 220 

● Enabling Communications Outbound Manager on page 220 

● Setting up a communication profile for sending email from Siebel on page 222 
 
 
 
 

Configuring the Avaya IC server 

This section contains the following topics: 

● Where to perform these procedures on page 199 

● Configuring the Avaya IC Email server on page 199 

● Building the Siebel-first workflow on page 200 

● Building the qualify email workflows on page 200 

● Creating and configuring an Avaya IC workflow on page 201 

● Creating a default Email Dismiss Reason code on page 204 

! 
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Where to perform these procedures 

Perform these procedures in the locations shown in the following table. 

 

Procedure Interface System 

Configuring the Avaya IC Email server on page 199 IC Manager Avaya IC 

Building the Siebel-first workflow on page 200 Workflow Designer 

Building the qualify email workflows on page 200 

Creating and configuring an Avaya IC workflow on 
page 201 

IC Manager 

Creating a default Email Dismiss Reason code on 
page 204 

You must manually 
edit the CDL file and 
use Database 
Designer to rebuild 
Avaya Agent. 

 

 

Configuring the Avaya IC Email server 

To configure the Avaya IC Email server: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select the Server tab. 

4. Select All Domains. 

5. Double-click your IC Email server to open the properties. 

6. Select the ICEmail tab. 

7. Perform the following steps: 

a. Select the Run Analyze Flow field. 

b. Clear the Run Outbound Email Flow field. 

8. Click Apply. 

9. Continue to Building the Siebel-first workflow on page 200. 
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Building the Siebel-first workflow 

To build the Siebel-first workflow: 

1. Go to Workflow Designer by navigating to Start > Programs > Avaya Interaction Center 

7.3 > Workflow Designer. 

2. In the Workflow Designer, open the icemail_sbl_first project file. 

This file is located in: 

<AVAYA_IC73_HOME>\Design\IC\flows\Siebel\icemail_sbl_first 

  Tip: 

If you have trouble opening this file, double-click it. 

3. Select Project > Settings. 

4. Select the Database tab. 

5. Type the Login Id and Password. 

6. Click OK. 

7. Compile and store the workflow using Menu Build > Build Flowset. 

8. Continue to Building the qualify email workflows on page 200. 
 

 

Building the qualify email workflows 

To build the Siebel-first and qualify email workflows: 

1. Go to Workflow Designer by navigating to Start > Programs > Avaya Interaction Center 

7.3 > Workflow Designer. 

2. Do one of the following tasks: 

● If you use Web Automatic Call Distributor (WACD), open the wacd_sbl project file. 

Example: 

<AVAYA_IC73_HOME>\Design\IC\flows\Siebel\WACD\wacd_sbl 

● If you use Business Advocate, open the advocate_sbl project file. 

Example: 

<AVAYA_IC73_HOME>\Design\IC\flows\Siebel\Advocate\advocate_sbl 

3. Select Project > Settings. 

4. Select the Database tab. 

5. Type the Login Id and Password. 
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6. Click OK. 

7. Compile and store the workflow using Menu Build > Build Flowset. 

8. Repeat Steps 2 and 7 if you must build the other workflow. 

9. Continue to Creating and configuring an Avaya IC workflow on page 201. 
 

 

Creating and configuring an Avaya IC workflow 

To create and configure an Avaya IC workflow to run the Siebel-first workflow and the qualify 

workflow: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select the Server tab. 

4. Select All Domains. 

5. If not already created, create a Workflow server to run the Siebel-first workflow. 

For instructions on how to create a Workflow server, see IC Installation and Configuration. 

6. Select the Channels tab of the email Workflow server. 

7. Right-click and select New Channel from the list. 

8. In the Channel Editor dialog box, select the values shown in the following table. 

 

Field Value 

Service ICEmail 

Criteria * 

9. Click Ok. 

10. Select New Association. 

11. In the Channel Association dialog box, type the values shown in the following table. 

 

Field Value 

Event ICEmail.Analyze 

Flow icemail_sbl_first.analyze_sbl 

 
Note: 

These fields are case-sensitive. 

12. Click Ok. 
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13. Select the Channels tab of the email Workflow server. 

14. Right-click and select New Channel from the list. 

● If you use Business Advocate, skip to Creating and configuring an Avaya IC workflow 

for Business Advocate for Email on page 205. 

● If you do not use business advocate then continue the steps that follow. 

15. In the Channel Editor dialog box, select the values shown in the following table. 

 

Field Value 

Service WACD 

Criteria media=email 

16. Click Ok. 

17. Select New Association for this service. 

18. In the Channel Association dialog box, type the values shown in the following tables. 

 

Field Value 

Event WACD.QualifyEmail 

Flow wacd_sbl.qualifyemail_sbl 

 
Note: 

These fields are case-sensitive. 

19. Click Ok. 

20. Stop and start the Workflow server if the server has already started by doing the following: 

a. Select the Server tab on the IC Manager window. 

b. Select the server from the list on the right side of the window. 

c. Select the Start or Stop button in the toolbar. 
 

 

Creating and configuring an Avaya IC workflow for Business 

Advocate for Email 

To create and configure an Avaya IC workflow to run the Siebel-first workflow and the qualify 

workflow: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 
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3. Select the Server tab. 

4. Select All Domains. 

5. If not already created, create a Workflow server to run the Siebel-first workflow. 

For instructions on how to create a Workflow server, see IC Installation and Configuration. 

6. Select the Channels tab of the email Workflow server. 

7. Right-click and select New Channel from the list. 

8. In the Channel Editor dialog box, select the values shown in the following table. 

 

Field Value 

Service WAA 

Criteria email.qualify 

9. Click Ok. 

10. Stop and start the Workflow server if the server has already started by doing the following: 

a. Select the Server tab on the IC Manager window. 

b. Select the server from the list on the right side of the window. 

c. Select the Start or Stop button in the toolbar. 
 

 

Creating and configuring a WAA Server for Email 

To create and configure a WAA Server: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select the Server tab. 

4. Select All Domains. 

5. If not already created, create a WAA server. 

For instructions on how to create a WAA server, see IC Installation and Configuration. 

6. Select the WAA tab of the WAA server. 

7. Check the Configure Advocate for Email Channel option. 

a. In the Email LRM drop box, select the configured LRM. 

b. In the Email Qualification Flow field, type "advocate_sbl.qualifyemail_adv_sbl". 

8. Click Ok. 
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9. Stop and start the Workflow server if the server has already started by doing the following: 

a. Select the Server tab on the IC Manager window. 

b. Select the server from the list on the right side of the window. 

c. Select the Start or Stop button in the toolbar. 

Continue to Creating a default Email Dismiss Reason code on page 204. 
 

 

Creating a default Email Dismiss Reason code 

This section includes the following topics: 

● About creating a default Email Dismiss Reason code on page 204 

● The Email Dismiss Reason setting in the CDL file on page 204 

● Creating a new Resolve Status in the Email Response Library on page 205 

 
About creating a default Email Dismiss Reason code 

A default reason code is used for every email handled by Avaya Agent. Although Siebel handles 

the presentation of the email to the agent, Avaya IC actually tracks the status of every email. 

When the agent finishes composing the email and selects the Release Work button from the 

Siebel toolbar, the agent might see an Email Dismiss Reason code dialog. The presentation of 

the reason code dialog depends on the following conditions: 

● If the agent releases an email without replying to it, Avaya Agent provides the agent with a 
list of email dismiss reasons. 

● If the agent sent an email reply, Avaya Agent automatically uses the Email Dismiss 

Reason code configured in the CDL file. The Email Dismiss Reason code dialog is not 

presented to the agent. 

Importance is given to the Email Dismiss Reason code in the CDL file agreeing with a Resolve 

Status configured in the Email Response Library. Use the procedures in this section to configure 

the CDL file and create a new Resolve Status in the Email Response Library. 

 
The Email Dismiss Reason setting in the CDL file 

The Email Dismiss Reason code shown in the following figure is used when an agent replies to 

an email. You can also configure different reason codes besides Replied, if you also configure 

these reason codes in the Email Response Library. 
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If you use the following setting in the CDL file, create a status for this file in the Email Response 

Library using the procedure in Creating a new Resolve Status in the Email Response Library on 

page 205. 
 

<QSection Name="Siebel" 

UserNameFieldname="SWEUserName" 

PasswordFieldname="SWEPassword" 

LoginOnClickCommand="SWEExecuteLogin" 

SiebelFirstEmailDismissReason="Replied" 

/> 

 

Creating a new Resolve Status in the Email Response Library 

To create a new Avaya IC Resolve Status in the Email Response Library: 

1. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

2. Log in to IC Manager. 

3. Select Services > Mail Template Administration. 

4. Enter the Name, Password, and Address. 

The address can be either the name or the IP address of your Avaya IC server. The 
address might default to your exchange server, so ensure to change it. 

5. Select Login. 

Result: The Response Library Configuration tool opens. 

6. Click New. 

7. Select New Status. 

8. Type the Name, and select Messages set to this status should be treated as 
answered. 

Note: 
The Name must be the same as the Email Dismiss Reason that was in the CDL 

file. 

9. Click Apply. 

10. Click OK. 

11. Exit the Response Library Configuration tool. 

12. For the change to take effect, rebuild the Avaya Agent design. Go to Generating the 

Windows application on page 131. Select only Avaya Agent Layout in Step 3. 

13. Continue to Verifying the Invoke Method on the Send button on page 206. 
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Verifying the Invoke Method on the Send button 
 
 

Important: 

Test all changes to the Siebel object repository in a non production environment 

before deploying them in your production environment. Create a backup copy of 

the Siebel server object repository before making any changes using Siebel 

Tools. 

For more information, see Working with Siebel Tools on page 127. 

To verify the Invoke Method on the Send button: 

1. On the left-side of the Siebel Tools window, if not already expanded, expand the tree node 

Siebel Objects > Applets for the Send Communication Applet. 

2. Select Tools > Lock Project. 

3. Open Control. 

4. Select HTML Button3. 

5. Verify that the Method Invoked property is set to EmailSend. 

6. Continue to Installing eScripts and English error strings on the Siebel server on page 206. 
 
 
 
 

Installing eScripts and English error strings on the Siebel 

server 

Use this procedure to: 

● Install eScripts and English error strings on the Siebel server 

● Import eScripts and English error strings from a Siebel SIF file 

 
Important: 

Test all changes to the Siebel object repository in a non production environment 
before deploying them in your production environment. Create a backup copy of 

the Siebel server object repository before making any changes using Siebel 

Tools. 

For more information, see Working with Siebel Tools on page 127. 

To install and import the eScripts and English error strings: 

1. Start Siebel Tools. 

! 

! 
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2. Select Project from the Object Explorer located in the upper left pane. 

Example: 

 

3. Select Avaya IC in the Projects pane. 

Example: 

 

 

4. Select the Locked column to lock the project. 

Result: 

 

5. Return to Step 2, but this time lock the User Defined Errors project. 
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6. Select Tools > Import from Archive. 

If you get a message saying that you must be connected to the local database, ignore it. 

7. Browse to \Integrations\sba80\Email\SiebelFirst\SiebelFirst.sif file on 

the Avaya IC integration CD. 

8. Click Open. 

9. Ensure that Merge the object definition from the archive file with the definition in the 

repository is selected. 

10. Click Next. 

Result: The Review Conflicts and Actions window opens. This window shows the Siebel 

integration objects in the SIF file that you import. 

11. Click Next. 

The following message displays: 
 

The operation is going to modify your repository as follows: 

XXXX objects will be inserted 

0 objects will be deleted 

0 attributes will be updated 

Do you wish to proceed? 

12. Select Yes to get Siebel to import the eScripts and English error strings into the database. 

Note: 
This operation might take 1 to 2 minutes to complete. 

13. Compile the SRF file. For more information, see Compiling the SRF on page 161. 

14. Do you want to install localized error strings? 

 

If Go to 

Yes Installing localized error strings on the Siebel server (optional) on page 209 

No Importing the CommOutboundItemFormApplet.js file on page 210 
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Installing localized error strings on the Siebel server 

(optional) 

Perform this procedure only if you must install localized error strings on the Siebel server. To 
install localized error strings on the Siebel server: 

1. Start Siebel Tools. 

2. Select Project from the Object Explorer located in the upper left pane. 

3. Select Avaya IC in the Projects pane. 

4. Select the Locked column to lock the project. 

5. Return to Step 2, but this time lock the User Defined Errors project. 

6. Select Tools > Import from Archive. 

If you get a message saying that you must be connected to the local database, ignore it. 

7. Instead of Step 7, browse to one of the following files on the Siebel server. 

 

Siebel version Browse to 

8.1.1.x <SIEBEL_HOME>\siebsrvr\bin\Siebel8.1_L10N.sif 

8.2.2.4 <SIEBEL_HOME>\siebsrvr\bin\Siebel8.1_L10N.sif 

8. Click Open. 

9. Ensure that merge the object definition from the archive file with the definition in the 
repository is selected. 

10. Click Next. 

Result: The Review Conflicts and Actions window opens. This window shows the Siebel 

integration objects in the SIF file that you import. 

11. Click Next. 

The following message displays: 
 

The operation is going to modify your repository as follows: 

XXXX objects will be inserted 

0 objects will be deleted 

0 attributes will be updated 

Do you wish to proceed? 

12. Select Yes to get Siebel to import the eScripts and English error strings into the database. 
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Note: 
This operation might take 1 to 2 minutes to complete. 

For more information, see Compiling the SRF on page 161. 

13. Continue to Importing the CommOutboundItemFormApplet.js file on page 210. 
 
 
 
 

Importing the CommOutboundItemFormApplet.js file 
 

Important: 

Test all changes to the Siebel object repository in a non production environment 

before deploying them in your production environment. Create a backup copy of 

the Siebel server object repository before making any changes using Siebel 

Tools. 

For more information, see Working with Siebel Tools on page 127. 

The CommOutboundItemFormApplet.js file is a Siebel eScript file. Siebel eScript is a 

JavaScript-like scripting language used with Siebel Tools, as Siebel Visual Basic is a 

VBScript-like scripting language used with Siebel Tools. 

To import the CommOutboundItemFormApplet.js file: 

1. Log in to Siebel Tools. 

2. In Siebel Tools, select Applet from the Object Explorer navigation pane. 

The Object Explorer navigation pane is located in the upper-left corner of the window. 

3. Do one of the following: 

● For Siebel 8.1.1.x or 8.2.2.4: Select the Comm Outbound Item Form Applet from the 

Applets content pane. The Applets content pane is located in the large right pane of 

the window. 

4. Select Tools > Lock Project. 

This process facilitates you to change this applet. 

5. Do one of the following: 

● For Siebel 8.1.1.x, 8.2.2.4, or 15: Right-click the Comm Outbound Item Form Applet 

and select Edit Server Scripts. 

6. If the Scripting Language window opens, ensure that eScript is selected and click OK. 

Result: The Script Editor window opens. 

7. Select File > Import to import the eScript. 

! 
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8. Select the CommOutboundItemFormApplet.js file from the integration CD. 

Example: Go to: 

\Integrations\sba80\Email\SiebelFirst\CommOutboundItemFormApplet.js 

9. Click OK. 

Result: This imports the eScript. The script editor window shows the following screen after 

import. 
 
 

 
10. Select File > Save to save the script. 

11. Select File > Close. 

12. Continue to Importing the CommInboundItemListApplet.js file on page 211. 
 
 
 
 

Importing the CommInboundItemListApplet.js file 
 

Important: 

Test all changes to the Siebel object repository in a non production environment 

before deploying them in your production environment. Create a backup copy of 

the Siebel server object repository before making any changes using Siebel 

Tools. 

For more information, see Working with Siebel Tools on page 127. 

To import the CommInboundItemListApplet.js file: 

1. Log in to Siebel Tools. 

2. In Siebel Tools, select Applet from the Object Explorer navigation pane. 

The Object Explorer navigation pane is located in the upper-left corner of the window. 

! 
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3. For Siebel 8.1.1.x or 8.2.2.4: 

Select the Comm Inbound Item Form Applet from the Applets content pane. 

The Applets content pane is located in the large right pane of the window. 

4. Select Tools > Lock Project. 

This process facilitates you to make change to this applet. 

5. Right-click the Comm Inbound Item List Applet and select Edit Server Scripts. 

6. If the Scripting Language window opens, ensure that eScript is selected and click OK. 

Result: The Script Editor window opens. 

7. Select File > Import to import the eScript. 

8. Select the CommInboundItemListApplet.js file from the integration CD. 

Example: Go to: 

\Integrations\sba80\Email\SiebelFirst\CommInboundItemListApplet.js 

9. Click OK. 

Result: This imports the eScript. 

10. Select File > Save to save the script. 

11. Select File > Close. 

12. Continue to Compiling the SRF on page 161. 
 
 
 
 

Administering the Siebel workflows 

This section includes the following topics: 

● Administering workflows for Siebel 8.1.1.x and 8.2.2.x on page 212 

● Activating the Siebel workflows on page 215 

Perform these procedures at the following location. 

 

Interface System 

Siebel Tools Siebel 

 

 

Administering workflows for Siebel 8.1.1.x and 8.2.2.x 

This section contains the following topics: 
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● Importing the Siebel 8.1.1.x, 8.2.2.x, or 15 workflows on page 213 

● Entering the Avaya email address on page 214 

● Deploying the imported Siebel 8.1.1.x, 8.2.2.x, and 15 workflows on page 214 

● Activating the Siebel workflows on page 215 

 
Importing the Siebel 8.1.1.x, 8.2.2.x, or 15 workflows 

To import the Siebel 8.1.1.x, 8.2.2.x, and 15 workflows: 

1. Start Siebel Tools. 

2. If the Workflow Process is not visible in the Siebel Object Explorer window, perform the 

following steps: 

a. Go to View > Options. 

b. Click Object Explorer. 

c. Check Workflow Process. 

3. Click the Workflow Process object. 

4. Right-click anywhere on the Workflow Processes window and select Import Workflow 

Process. 

5. Import the \integrations\sba80\Email\Siebel First\eMail Response - Analyze Message 

workflow from the integration CD. 

6. If the Select Project window opens, ensure that eMail Response is selected and then 

click OK. 

7. Query for the eMail Response - Analyze Message workflow. 

Result: The status shows: 

In Progress 

8. Right-click the eMail Response - Analyze Message workflow with the In Progress 

status. 

9. Select Validate. 

Result: The Validate window opens. 

10. Click Start. 

Result: The total tests failed must be 0. 

11. Repeat Steps 4 through 10 for the following workflows: 

 
Important: 

Write down the version number of the imported workflows. 

● eMail Response - Process Message 

! 
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● eMail Response - Route Avaya 

● eMail Response - Route Email 

● eMail Response - Client Send Email 

Note: 
When you import the eMail Response - Route Email workflow and try to validate 

it, you might see the following error message. 
 

This means that you must set the status of the eMail Response - Route Avaya 

workflow to be completed before you can validate the eMail Response - Route Email 

workflow. 

12. Continue to Entering the Avaya email address on page 214. 

 
Entering the Avaya email address 

To enter the Avaya email address in the eMail Response - Process Message workflow: 

1. Query the eMail Response - Process Message workflow with the In Progress status. 

2. Expand the Workflow Process Siebel Object in the Object explorer. 

3. Select WF Process Prop. 

Result: The WF Process Prop window opens. 

4. Query for Avaya Email Address. 

5. In the Default String field, type in the mailbox that is being polled by Avaya IC. 

Example: sales@xyz.com 

6. Press Ctrl+S to save the record. 

7. Continue to Deploying the imported Siebel 8.1.1.x, 8.2.2.x, and 15 workflows on page 214. 

 
Deploying the imported Siebel 8.1.1.x, 8.2.2.x, and 15 workflows 

To deploy the imported Siebel workflows: 

1. Query the eMail Response - Analyze Message workflow with the In Progress status. 

2. Ensure that the workflow is the same version that was imported in previous steps. 

3. If the WF/Task Editor Toolbar is not visible, perform the following steps: 

a. Go to View > Toolbars. 

b. Select WF/Task Editor Toolbar. 

c. The WF/Task Editor Toolbar must appear. 

Step 'Call IC60' has SubProcess ''eMail Response - Route Avaya', which 

doesn't exist or it's status is not Completed 

mailto:infodev@avaya.com
mailto:sales@xyz.com
mailto:es@xyz.com


201 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

August 2022 

Chapter 14: Configuring an email channel 
 

 

 

 
4. Click Publish/Activate button. This process deploys the workflow and activates it. 

To deploy the workflow now and activate it later, click the Publish button and see Activating 
the Siebel workflows on page 215 to activate these workflows. 

The status changes to Completed. 

5. Repeat Steps 1 through 4 for the following workflows: 

eMail Response - Process Message 

eMail Response - Route Avaya 

eMail Response - Route Email 

eMail Response - Client Send Email 

 
 

Activating the Siebel workflows 

To activate the Siebel workflows: 

1. Log in to the Siebel thin client. 

2. From the Siebel user interface, go to the Site Map by pressing Ctrl+Shift+A. 

3. Go to Administration - Business Process > Workflow Deployment. 

4. Click the Query button in the Repository Workflow Process window. 

5. In the Name field, type: 

eMail Response * 

6. Select eMail Response - Append Thread Id. 

7. Click Activate. 

8. Repeat Steps 6 through 7 for the following workflows: 

● eMail Response - Create Activity 

● eMail Response - Get Entitlement Id 

● eMail Response - Identify Language 

● eMail Response - Parse Junk Email 

● eMail Response - Response Workflow 

● eMail Response - SR Help 

● eMail Response - Send Acknowledgement 

● eMail Response - Send Auto Response 

● eMail Response - Update Activity Status 

For Siebel 8.1.1.x you must activate additional work flows which are as follows: 
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● eMail Response - Resume Workflow 

● eMail Response - Save As Draft 

9. Compile SRF. For more information, see Compiling the SRF on page 161. 

10. Do one of the following tasks to stop Siebel services: 

 

If your operating system is: Then 

Windows Stop Siebel services from Control Panel > services. 

Solaris or AIX or Linux Consult the Siebel administration guide for instructions. 

11. Replace the siebel.srf file located on the <SiebelHome>/siebsrvr/objects/enu with 

the local compiled copy of the siebel.srf. 

12. Do one of the following tasks to start Siebel services. 

 

If your operating system is: Then 

Windows Start Siebel services from Control Panel > services. 

Solaris or AIX or Linux Consult the Siebel administration guide for instructions. 

13. Continue to Configuring Siebel to poll the mailbox on page 216. 
 
 
 
 

Configuring Siebel to poll the mailbox 

This section includes the following topics: 

● Where to perform these procedures on page 217 

● Creating a profile on page 217 

● Creating a response group on page 218 

● Associating the profile with the response group on page 218 

● Adding input arguments for the response group on page 219 
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Where to perform these procedures 

Perform these procedures at the following location. 

 

Interface System 

Siebel windows Siebel 

 

 

Creating a profile 

To create a profile: 

1. From the Siebel user interface, go to the Site Map by pressing Ctrl+Shift+A. 

2. Go to Administration - Communications > Communications Drivers and Profile. 

3. Select Internet SMTP/POP3 Server in the Name field of the Communications Drivers 

window. 

4. Select the Profiles tab located under the Communications Drivers window. 

5. Create a new profile by selecting New. 

6. In the Name field, type: 

Siebel First Email Response 

7. In the Responsibilities field, select AICD Responsibility. 

8. In the Profile Parameters Overrides, select New to add the following parameter 
overrides. 

 

Name Value 

From Address Enter the mailbox Siebel must use for sending emails. 

POP3 Account Name Enter the account name of the mailbox where Siebel can poll 
for new emails. 

POP3 Account Password Enter the account password. 

POP3 Server Enter the POP3 server. 

PollingInterval Enter the interval time in seconds that Siebel can check the 
mailbox. 

SMTP Server Enter the SMTP server. 

9. Continue to Creating a response group on page 218. 
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Creating a response group 

To create a response group: 

1. Select All Response Groups located directly under the Administration - 

Communications tab. 

2. Click New in the Response Groups window. 

3. Create a new response group with the values shown in the following table. 

 

Field Value 

Name Siebel First Email Response 

Service Name Workflow Process Manager 

Method Name RunProcess 

Administrator Email 
Address 

Enter the email address for the administrator. 

Server Use the name of the Siebel server, not the host name of the 
machine. 

Startup Active 

4. Press Ctrl+S. 

5. Continue to Associating the profile with the response group on page 218. 
 

 

Associating the profile with the response group 

You must associate a profile with every response group that you create. 

To associate a profile with a response group: 

1. Select the Profiles tab located under the Response Groups window. 

2. Click New under the Profiles tab. 

The Add Communication Profiles applet opens. 
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3. Select the name of your Siebel-first email profile. 

Example: Siebel First Email Response 

 

4. Click OK. 

The Add Communications Profiles applet closes. 

5. Press Ctrl+S. 

6. Continue to Adding input arguments for the response group on page 219. 
 

 

Adding input arguments for the response group 

To add input arguments for the response group: 

1. Select the Input Arguments tab. 

2. Click New. 

3. Add the values shown in the following table. 

 

In the Name field Enter the following values in the Value field 

ProcessName eMail Response - Process Message 

Catalog Name ● If you are configuring Smart Answer Manager, enter the name of 
your knowledge base. Example: KB 

● If you are not configuring Smart Answer Manager, leave this field 
blank. 

Enable Avaya 
Integration 

TRUE 

Enable Smart Answer ● If you are configuring Smart Answer Manager, select TRUE. 

● If you are not configuring Smart Answer Manager, select 
FALSE. 

RowId Leave blank 
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4. Restart Siebel services by doing one of the following tasks: 

 

For Windows For Solaris/AIX/Linux 

Select Control Panel > services See the Siebel administration guide for 
instructions. 

 

5. Continue to Configuring Smart Answer Manager on page 220. 
 
 
 
 

Configuring Smart Answer Manager 

The following list provides suggested actions that you can take to configure Smart Answer 

Manager: 

1. Create a knowledge base. 

2. Import the knowledge base. 

3. Enable the Smart Answer Manager server component. 

4. Administer Smart Answer Manager. 

As an option, add text as one of the settings in Smart Answer Administration. 

5. Add one or more response templates. 

6. Set the response thresholds for the categories in your knowledge base. 

7. Associate templates with categories. 

For the optimal configuration for your company, these steps might not be enough. You must 

carefully read the relevant Siebel documents to learn the capabilities and settings of Siebel 

Smart Answer Manager. 

 

Related topics 

● For basic information about Smart Answer Manager, see Smart Answer and Smart Answer 
Manager on page 95. 

● For a complete description of Smart Answer Manager, see the Siebel documentation. 
 
 
 
 

Enabling Communications Outbound Manager 

This section contains the following topics: 

● Where to perform these procedures on page 221 
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● Procedure on page 221 

 

 

Where to perform these procedures 

Perform these procedures at the location shown in the following table. 

 

Interface System 

Siebel windows Siebel 

 

Related topic 

For more information, see Siebel user interface on page 92. 
 

 

Procedure 

To enable the Comm Outbound Manager: 

1. From the Siebel user interface, go to the Site Map by pressing Ctrl+Shift+A. 

2. Go to Administration - Server Configuration > Enterprises > Synchronize. 

3. Select Synchronize. 

4. Select the Query button and search for the Communications Outbound Manager 

component. 

5. If the Communications Outbound Manager component is not enabled, see the Siebel 
documentation to enable this component. 

6. Restart the Siebel services that are on the Siebel server by doing one of the following 

tasks. 

 

For Windows For Solaris/AIX 

Select Control Panel > services See the Siebel administration guide for 
instructions. 
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Setting up a communication profile for sending email from 

Siebel 

To set up a communication profile: 

1. Navigate to Administration>Communications>Communication Profiles & Drivers. 

2. Search for "Internet SMTP/POP3 Server" under the Communications Drivers applet. 

3. Create a new profile. 

For example, Test Email Profile. 

4. Under the Profile Parameter Overrides applet, add the following parameters: 

● From Address: Any email address (Generally it should be the Siebel email box Id ) 

● SMTP Server: Name of the SMTP Server which will send the email. 

● SMTP Server Port: 25 

5. Click the Menu button on the Profiles applet and click Submit Profile Changes. 

The communication profile you created is now ready for use. However, before proceeding 

further, you must check whether Server Components, responsible for executing the email 

request, are running properly or not. 

6. Navigate to Administration-Configuration>Enterprises>Component Groups and 

search for "Communications Management" under the Component Groups applet and 

then search for "Communications Outbound Manager" component under the 

Components applet. This is the component which is responsible for sending outgoing 

emails from Siebel. 

7. Check if the Enabled on Server flag is checked under the Component Group 
Assignments applet. If not, click the Enable button. 

8. Navigate to Administration-Configuration>Enterprises>Component Definitions and 

search for Communications Outbound Manager. 

9. Set the following two parameters to Test Email Profile (the communication profile created 
in step 3). 

● Comm Profile Override 

● Communication Profile 

10. Click the Synchronize button. 

11. Now restart the Siebel server. 

12. Navigate to Tools>User Preferences>Outbound Communications view and select 

Siebel Email Client in Email Client. Click Save. 

13. To test whether the newly created profile is working, navigate to Service Request >My 
Service Requests view. 
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14. Press F9. 

The system displays a pop-up form to send an email. Enter your email address in the To 

field and fill in the subject and body as per your wish and send it. 

Check your Inbox, you will see the email in a few minutes. 

15. Also drill down on the SR# field and navigate to the Activities view. You will see an activity 

of type Email - Outbound and the contents of the email in the Comments field. This is the 

Siebel OOB functionality of creating activity under Service Request whenever you send an 

email from the Service Request record. 

mailto:infodev@avaya.com


August 2022 210 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

After Call Work (ACW) Feature  

 

 

Chapter 15: Configuring Additional Features 

 

This chapter provides information on the following features: 

● After Call Work (ACW) Feature on page 224 

● Logout In Wrapup Feature on page 216 

● Switch To Caller (STC) Feature on page 217 

● Virtual Free Seating (VFS) Feature on page 230 

● Configure Siebel Browser to view Status text messages on page 231 

● Configure Siebel Browser to enable sound on incoming work item on page 231 

● Configure the IC-Siebel integration Workflows for Japanese Language on page 232 

● Configure minimum log out delay for Siebel Agent on page 234 

● Enabling Siebel Open UI in IC 7.3.3 or later on page 234 
 
 
 
 

After Call Work (ACW) Feature 

The IC - Siebel integration provides Selective After Call Work (ACW) functionality for Agents. 
This feature facilitates the agent to indicate on a call by call basis whether ACW (aka wrap-up in 

IC) must be run. The implementation includes supporting a new AICD driver command, that is 

associated with a custom Siebel toolbar button, which when invoked during a call presets ACW 

for the call. When activated, the button must appear depressed, and the hard phone must 

indicate the pending ACW state on the switch. If the button is clicked again, the pending ACW 

state stands canceled. If pending ACW is run when the call ends, the agent must enter IC 

wrap-up, that is, Siebel wrap-up type. If the agent remains in wrap-up, the agent is not available 

to receive any new ACD calls. This result is enforced by the switch ACD. 

Selective ACW features are only available for IC-Siebel Native configuration and not for Hybrid 

configuration. 

The ACW functionality is implemented only for voice channel. 

● Enabling ACW feature on page 225 

● ACW Configuration Parameters and Settings on page 227 

● Using ACW for localized language on page 230 
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Enabling ACW feature 

You can enable the ACW feature on the toolbar. This section contains the following: 

● Prerequisites for processing and importing the AfterCallWork.sif file on page 225 

● Import the AfterCallWork.sif file on page 225 

 
Prerequisites for processing and importing the AfterCallWork.sif file 

Perform the following steps before you go to importing the AfterCallWork.sif file. 

1. You must stop the Siebel server to write to the SRF. 
 

 

If your operating 
system is: 

Then stop Siebel services by doing the 
following steps: 

Windows Use the Windows services control panel to: 

1. Select Siebel Server. 

2. Select Action > Stop. 

See the Siebel administration guide for more 
information. 

Solaris or AIX See the Siebel administration guide for 
instructions. 

2. Copy the SRF file on your Siebel server (<SiebelHomeDir>\siebsrvr\objects\enu\ 

siebel.srf) to a location accessible to Siebel Tools. 

For example, the path can be C:\siebel.srf 

 
Import the AfterCallWork.sif file 

Perform the following steps on Siebel Server machine to import the AfterCallWork.sif file: 

1. From the Siebel Tools - Siebel Repository window, select Project from the Object 

Explorer located in the upper left pane. 

2. Perform the instructions described for locking the projects as follows: 

a. From the Siebel Tools - Siebel Repository - Project List window, select Query > 

New Query. 

b. Type <project> in the Name field and then select Query > Execute Query. 

where <project> is 

- Bitmap 
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- Command 

- Communication Administration 

- Toolbar 

c. After executing the query, lock the project by clicking in the corresponding field in 

the Locked column. 

Note: 
You must perform the already mentioned steps, that is, step a to step c for all the 

projects mentioned. Step c) for all of the projects described above. 

3. From the Siebel Tools - Siebel Repository - Project List window, select Tools > Import 
from Archive. 

4. If you get the following message This operation must only be performed while connected 

to your local database. Would you like to continue anyway?, click Yes. 

5. Browse to the AfterCallWork.sif file from the SiebelAllPlatforms\integrations\ 

sba80\ACW folder. 

6. Ensure that merge the object definition from the archive file with the definition in the 
repository is selected. 

7. Click Next. 

The Review Conflicts and Actions window is displayed. This window displays the Siebel 
integration objects in the SIF file that you import. 

8. Click Next. The following message is displayed: 

 

 

9. Select Yes to enable Siebel to import the integration object into the database. 

10. From the Siebel Tools - Siebel Repository - Project List window, select Tools > 

Compile Projects. 

11. Browse to the SRF file located at the location specified in Import the AfterCallWork.sif 

file on page 225. 

12. Select Locked projects. You must verify whether the Avaya IC project is locked. 

13. Click Compile. 

14. Copy the compiled siebel.srf file back to the following location: 

<SiebelHomeDir>\siebsrvr\objects\enu 

15. After the compilation is complete copy the icon_acw_disabled.gif and 

icon_acw_enabled.gif files from the 

\SiebelAllPlatforms\integrations\sba80\ACW directory to the images 

folder for the Siebel thin client. See Appendix H on page 405 to determine the 

The operation is going to modify your repository as follows: 

XXXX objects will be inserted 

X objects will be deleted 

X attributes will be updated 
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location of the images folder.  

16. Start Siebel services. 
 

 

ACW Configuration Parameters and Settings 

IC Properties that play a role in the ACW Feature implementation are as follows: 

a. Agent/Desktop/IntegratedApplication = Siebel 

b. Agent/Desktop/WrapUpEnabled = Yes/No 

c. Agent/Desktop/WrapUpType = Siebel 

d. Agent/Desktop/Voice/AutoIn = Yes 

e. Agent/Desktop/Voice/SwitchTimedACWEnabled = Yes/No 

f. Agent/Desktop/WrapUp/EnterWhen = Always/Selective 

g. Agent/Desktop/WrapUp/SelectiveDefault = Requested/Not Requested. 

Behavior of ACW is described as follows for two recommended set of properties: 

A. Switch Timed ACW: 

Agent/Desktop/WrapUpEnabled = No 

Agent/Desktop/Voice/SwitchTimedACWEnabled = Yes 

Agent/Desktop/Voice/AutoIn - Yes 

Note: 
ACW button remains disabled on communication toolbar. 

 
B. Client Side Selective ACW: 

Agent/Desktop/WrapUpEnabled = Yes 

Agent/Desktop/WrapUpType = Siebel 

Agent/Desktop/Voice/AutoIn = Yes 

Agent/Desktop/Voice - SwitchTimedACWEnabled = No 

 
 

Functionalities of ACW 

ACW functionality is divided into three sections: 

● When the agent has no contact on page 228 
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● When the agent has non voice contact on page 228 

● When the agent has voice contact on page 228 

 
When the agent has no contact 

1. ACW button functionality and the appearance do not depend on the following IC 

properties, when not in call: 

Agent/Desktop/WrapUp/EnterWhen and 

Agent/Desktop/WrapUp/SelectiveDefault 

2. The ACW States must reset for the Agent when the Agent logs out or logs in. This reset is 

needed because the states are maintained at the Agent level. 

3. ACW button state must reflect the state on the hard phone. 

● When the Agent changes from AUX to ACW on hard phone, the ACW button changes 

to checked/pressed state. 

● When the Agent changes from Avail to ACW on hard phone, the ACW button changes 

to checked/pressed state. 

● When the Agent changes from ACW to Available on hard phone, the ACW button 

changes from checked/pressed state to normal state. 

● When the Agent changes from ACW to AUX on hard phone, the ACW button changes 

from checked/pressed state to normal state. 

4. When Agent selects ACW, Agent can switch from AUX to Avail or Avail to AUX. 

5. Reset ACW button must restore the same state that the Agent was in before going into the 

ACW state. 

● If Agent is in AUX and then clicks the Set ACW to go into ACW mode, then Agent must 

get back into the AUX mode when reset ACW is done. 

● If an Agent is in Available mode and then clicks the SetACW to go into ACW state, 
then the agent must get back to Available mode when ACW is done. 

 
When the agent has non voice contact 

When an Agent is handling a non voice contact then the ACW button on Siebel toolbar must be 

disabled. 

 
When the agent has voice contact 

The Agent can selectively enter the ACW state, depending on the choice. The agent can 
choose to enter the ACW state or the Ready state after the call disconnects, while handling the 

voice contact. 
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ACW button state, that is, enable, disable, pressed, and unpressed, depends on the activity of 

the agent and IC group manager properties as follows: 

1. Agent/Desktop/WrapUp/EnterWhen = Always/Selective 

Selecting the Always option puts the Agent in the Selective ACW mode after the 

disconnection of every voice contact. Selecting the Selective option, the agent can choose 

to enter the Selective ACW mode or not while handling the voice contact. 

2. Agent/Desktop/WrapUp/SelectiveDefault = Requested/Not Requested 

This property governs the default behavior of the ACW button on the Siebel toolbar. If set 

as Requested then, when in a call, the ACW button is pressed, by default. If not requested, 

by default the ACW button is in normal unpressed state. 

The following tables shows ACW button states on toolbar after voice call disconnection: 

 

Agent/Desktop/ 

WrapUp/ 

EnterWhen 

Agent/ 

Desktop/ 

WrapUp/ 

SelectiveDefa 

ult 

ACW button 

state on 

toolbar 

Description 

Always Requested Disabled Agent is forced to go to ACW 
after the voice call disconnects 

Always Not Requested Disabled Agent is forced to go to ACW 
after the voice call disconnects 

Selective Requested Enabled and 
Pressed 

By default, the agent goes to 
ACW after voice call disconnects 

Selective Not Requested Enabled and 
Unpressed 

By default, the agent does not go 
to ACW after the voice call 
disconnects 

 
Note: 

When call is hung up and agent is in ACW state, reset ACW button must be 

disabled. The button must be disabled until the work item is there in the work item 

drop-down list of the agent. 

When call is hung up and agent is in ACW/Wrap-up state select to go to AUX. The 
phone continues to show ACW. This state is a preset-aux state. 

a. The ACW states must reset when the call is released. This state is needed because 

the ACW states are maintained at the WI level and not Agent level. 

Agent must request ACW when call is on HOLD. 
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Using ACW for localized language 

For ACW to work with languages apart from English and Japanese, you must add the following 
commands in the AICD.def file located at: /sba80/siebsrv/bin/<language> 

 

 

 

 

 
 

Logout In Wrapup Feature 

The Logout In Wrapup feature (available since IC 7.3.9) allows agents to log out while they 
have work items in wrapup state. In this case, the wrapup will be completed automatically prior 

to logout. 
 
 

 

Enabling Logout In Wrapup feature 

The feature is disabled by default. Perform the following steps via the Siebel thin client to enable it. 

1. Log in to the Siebel thin client as a Siebel administrator. 

2. Navigate to Site Map > Administration - Communications > Communications Drivers 
and Profiles > Driver Parameters. 

3. Select the appropriate Communications Driver. 

4. In the Driver Parameters tab, add the following parameter: Name: 
Service:LogoutInWrapup, Default Value: true. 

5. Press Ctrl+S to save the changes. 

6. Restart the Communications Session Manager. 

Note: If the agent has work items in different states, then the ability to logout depends on the 

<START> 

 

;///////////////////////////////////////////////////////////////// 

;use acw command group to send set and reset acw request to aicd driver 

[Command:ACWGroup] 

SubCommand_1 = "SetACW" 

SubCommand_2 = "ResetACW" 

Hidden = "TRUE" 

[Command:SetACW] 

DeviceCommand = "SetACW" 

Hidden  = "TRUE" 

[Command:ResetACW] 

DeviceCommand = "ResetACW" 

<END> 
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values of Service:LogoutWithCalls, Service:LogoutWithEmails and Service:LogoutWithChats driver 
parameters. For example, if the Logout In Wrapup feature is enabled, Service:LogoutWithCalls is 
false and Service:LogoutWithEmails is true, and the agent has a voice work item in wrapup state 
and an active email work item, then the agent will be able to logout. But if 
Service:LogoutWithEmails is false, the agent will not be allowed to log out. 

 
 
 

Switch To Caller (STC) Feature 

The Switch to Caller/Destination feature (available since IC 7.3.9) can be used during a 
consultation call, when an agent, which handles a call from a customer, needs assistance 

from other agent. This feature lets the agent switch between talking to the other agent and 

talking to the caller (the customer). 

Note: the STC feature is only available for IC-Siebel Native configuration and not for Hybrid 
configuration. 

 
 

 

Enabling STC feature 

Note: the following procedure is applicable to Siebel 17. If you use a different Siebel version, 
please refer to the appropriate Siebel documentation.  

 
Import the STC.sif file 

Perform the following steps on the Siebel Server machine to import the STC.sif file: 

1. Extract the STC.sif file from the Integration73xAllPlatforms.zip. 

2. Start Siebel Tools and connect to the server as SADMIN. 

3. Create a new workspace: 

a. Select Workspace > Create. 

b. Do not check the Integration Workspace checkbox. 

c. Provide the proper values for Workspace Name, Parent Workspace and Parent 
Workspace Version. 

d. Click OK to close the Create Workspace window. 

4. Import the STC.sif file: 

a. Select Tools > Import from Archive…. 

b. In the Select Archive to Import window, browse to the STC.sif file and click Open. 

c. Ensure that Merge the object definition from the archive file with the definition 
in the repository is selected and click Next. 

d. In the Review Conflicts and Actions window, click Next. 

e. When the message informing about the modifications appears, click Yes. 

f. In the Summary window, click Finish. 
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5. Check in the changes to the workspace: 

a. Select Workspace > Checkpoint. 

b. Enter some comment. 

c. Click OK. 

6. Make the workspace ready for delivering the changes to the MAIN workspace: 

a. Select Workspace > Submit for Delivery. 

b. Click Yes to confirm the operation. 

7. Deliver the changes to the MAIN workspace: 

a. Workspace > Deliver 

b. Enter some comment. 

c. Click OK. 

d. In the Deliver Workspace window, click Start Merge. 

e. Wait until the delivery process has completed and click Done. 

 

Modify AICD Configuration 

1. Log in to the Siebel thin client as a Siebel administrator. 

2. Navigate to Site Map > Administration - Communications > Communications Drivers and 
Profiles > Driver Parameters. 

3. Select the appropriate Configuration. 

4. In the Commands tab, add the following commands: 

a. STCGroup 

b. SwitchToCaller 

c. SwitchToDestination 

Press Ctrl+S to save the changes. 

5. Click STCGroup command and configure its Subcommands: 

a. SwitchToCaller (Order: 1) 

b. SwitchToDestination (Order: 2) 

Press Ctrl+S to save the changes. 

Then configure its Command Parameters: Name: Hidden, Value: TRUE. 

Press Ctrl+S to save the changes. 

6. Return to the list of commands, click SwitchToCaller command and configure its Command 
Parameters: 

a. Name: DeviceCommand, Value: SwitchToCaller. 

b. Name: Hidden, Value: TRUE. 

Press Ctrl+S to save the changes. 

7. Return to the list of commands, click SwitchToDestination command and configure its 
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Command Parameters: Name: DeviceCommand, Value: SwitchToDestination. 

Press Ctrl+S to save the changes. 

 

Copy the icon_stc_disabled.gif and icon_stc_enabled.gif files 

Copy the icon_stc_disabled.gif and icon_stc_enabled.gif files from the 

Integration73xAllPlatforms.zip to the images folder for the Siebel thin client. See 

Appendix H on page 405 to determine the location of the images folder. 

 

Restart the Siebel Server system service and the application containers 

1. Shut down the Siebel Server system service. 

2. Shut down the application containers. 

3. Start the application containers. 

4. Start the Siebel Server system service. 

 
 

 

Example scenario 

1. Agent1 logs in to Siebel and enters the Ready state. The Switch to Caller button is inactive. 

2. Agent1 makes a call to a customer (or accepts a call from a customer). 

3. Agent1 is connected to the customer. The Switch to Caller button is still inactive. 

4. Agent1 initiates a consult call to Agent2. The call between the customer and Agent1 is put on 
hold automatically. The Switch to Caller button becomes active. 

5. Agent2 answers the consult call. The Switch to Caller button is still active. 

6. Agent1 uses the Switch to Caller button and gets connected to the customer (Line1). The call 
between Agent1 and Agent2 is put on hold automatically. The Switch to Caller button is 
replaced with the Switch to Destination button. The Switch to Destination button becomes 
active and starts blinking. 

7. Agent1 uses the Switch to Destination button to connect back to Agent2. The call between the 
customer and Agent1 is put on hold automatically. The Switch to Destination button is replaced 
with the Switch to Caller button. The Switch to Caller button becomes active. 

8. Agent1 completes the consult transfer. The Switch to Caller button is disabled. 
 

 

Virtual Free Seating (VFS) Feature 

When VFS is enabled, the agent can login to another extension without logging out from the 

agent application. 

You can enable Virtual Free Seating in Native Siebel Integration. You can enable or disable this 
feature for each requirement. 

To enable Virtual Free Seating: 
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1. Open the Siebel Browser. 

2. Select Site Map > Administration - Communications > Communications Drivers and 

Profiles > Driver Parameters. 

3. In the Driver Parameters tab, click New to add the following parameter. 

Add Driver:VFSEnabled as Name. Set the default value to true. 

4. Select Site Map > Administration - Communications > All configurations > 

Parameters. 

5. In the Parameters tab, Update AutoLogin value to FALSE. 

6. Search for the command SignOnGroup 

7. In Command data parameter tab, click New to add a new parameter with name 

’Param.Destination’ and value ’{@Phone:PhoneTypeLookup}’. 

Add property name logout_on_deassign with value as false, in the configuration tab of TS 

server, in the IC Manager. 

Note: 
This property does not have an agent logging in using Virtual Free Seating, to 

another extension which is already logged in with a Phone Id. 
 
 
 
 

Configure Siebel Browser to view Status text messages 

This integration enables you to view Status text messages for corresponding TS events (Login/ 

Logout/AuxWork/Wrapup) on the Siebel Communication toolbar. You can enable or disable this 

feature for each requirement. 

To enable viewing Status text messages: 

1. Open the Siebel Browser. 

2. Select Site Map > Administration - Communications > Communications Drivers and 

Profiles > Driver Parameters. 

3. In the Driver Parameters tab, click New to add the following parameter. 

Add Driver:TSLogout as Name. Set the default value to True. 

 
 

 

Configure Siebel Browser to enable sound on incoming 

work item 

This integration can enable sound on an incoming work item. 

To enable sound on an incoming work item: 

1. Login through the Siebel Browser as SADMIN. 
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2. Select Site Map > User Preferences > Communications. 

3. Select the Enable Sound check box. 

4. Click OK. 
 

Note: 
By default, the sound plays on the desktop of an agent only when the WIDL 

(WorkItem Dropdown List) of the agent is empty. This happens when the IC 

property, Agent Desktop/ScreenPopup/PopOnAllArrivingContacts is set to No. 

To play sound for each incoming workitems thereon, the workitems must be displayed 

on WIDL of the agent. This happens when the IC property, Agent Desktop/ 

ScreenPopup/PopOnAllArrivingContacts is set to Yes. 
 
 
 
 

Configure the IC-Siebel integration Workflows for 

Japanese Language 

IC 7.3.x contains the basic out of the box workflows and AICD.def file modified to support 
Japanese language for IC 7.3.x and Siebel 8.1.1.x and Siebel 8.2.2.x integration. 

Perform the following steps to upload the modified workflows: 

● Check the correct values from LOVs in Siebel on page 232 

● Modify and Upload the workflows on page 233 

● Importing the AICD Siebel configuration on page 153 

 
Check the correct values from LOVs in Siebel 

To check the correct values from LOVs in Siebel: 

1. Open the Siebel Thin Client call center application from the web browser. 

Login as Siebel Administrator. 

2. Navigate to the AICD profile within Siebel. 

3. Go to Site Map > Administration-Data. 

4. Click List of Values from the submenu. 

5. Click Query and search for Call - Inbound as Language-Independent Code. 

The query results are displayed. 

6. Select the row with Type TODO_TYPE from the results. 

7. Note down the Display Value from the selected row. 

8. Repeat steps 4, 5, and 6 for Call - Outbound, Email - Inbound and Web - Inbound as 

Language-Independent Code. 
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Modify and Upload the workflows 

The following table lists the details of the OOTB workflows that are required to be changed. 
 

Project file Workflow Block Name String to change 

Advocate 

Advocate_sbl.prj qualifychat_adv_sbl Buid Activity Web - Inbound 

qualifyvoice_adv_sbl Buid Activity Call - Inbound 

ICEmail 

icemail_sbl.prj preanalyzeca_sbl PutEmailtoSiebel Email - Inbound 

preanalyzenoca_sbl PutEmailtoSiebel Email - Inbound 

ICM 

icm_sbl.prj transcriptadded_sbl Buid Activity (2 
blocks) 

Web - Inbound 

TS 

ts_sbl.prj incomingcall_sbl Buid Activity Call - Inbound 

WACD 

wacd_sbl.prj qualifychat_sbl Buid Activity Web - Inbound 

 
Note: 

Only the workflows that are being used need to be changed. 

To change and upload the workflows: 

1. Open the workflow project in the Avaya Work Flow Designer. 

2. Open a workflow from the Project sheet. Refer the previous table for OOTB workflows. 

3. Select the desired block. Refer the previous table for Block Names for OOTB workflows. 

4. In the Property, select the Basic tab. 

5. Select the String Value, that is, 'Call - Inbound', 'Email - Inbound' or 'Web - Inbound' and 

replace it with the corresponding value noted in the step Check the correct values from 

LOVs in Siebel on page 232. 

Note: 
Recommendation is laid to copy and paste the strings instead of typing them. 

After pasting the strings, you might see unexpected characters, but the correct 

string must be uploaded. This process is a known issue with the Avaya Workflow 

Designer. 
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6. Save the project and build the flow set. To build the flow set, select Build > Build Flow 

Set. 

7. Enter the IC Admin username and password. 

8. Ensure that no errors exist. 

9. When all the required workflows, mentioned in the previous table, are modified and the 
projects are built, restart all the workflows that use these projects. 

 
 
 
 

Configure minimum log out delay for Siebel Agent 

You must enter a new driver parameter to the driver profile to avoid the race condition 
happening when an agent logs out and logs in rapidly. 

To configure the minimum log out delay: 

1. Open the Siebel Browser. 

2. Select Site Map > Administration - Communications > Communications Drivers and 

Profiles > Driver Parameters. 

3. In the Driver Parameters tab, click New to add the following parameter. 

Service:MinLogoutDelay = 500 (Value in Milliseconds) 

Adding this parameter delays sending the logout message from AICD to ASIS/ICA. This 

delay is for each Agent basis. 

You can change this value for each environment. 
 
 
 
 

Enabling Siebel Open UI in IC 7.3.3 or later 

Open UI enables users to use the Siebel agent interface in any browser. From IC Release 7.3.3 

the Siebel Open UI is supported from Siebel 8.1.1.11, 8.2.2.x, and 15. To enable Siebel Open UI 

for an Application Object Manager component: 

1. Log in to the Siebel client with administrator privileges. 

2. Navigate to the Administration - Server Configuration screen, and then the Servers 
view. 

3. Select the Siebel Server for which you want to configure an Application Object Manager. 

4. (Optional) Create a new Application Object Manager component that you must deploy 
using Siebel Open UI. 
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5. In the Components list, query the Component field for the Application Object Manager 

component for which you are enabling Siebel Open UI. For example, locate the 

component Call Center Object Manager (JPN) for Japanese. 

6. Click the Parameters view tab. 

7. In the Component Parameters list, query the Parameter field for EnableOpenUI. 

8. If the EnableOpenUI parameter is set to False, then change the Value on Restart field to 

True. 

Note: 
The HighInteractivity parameter also must be set to True for Siebel Open UI. For 

applications that are currently enabled for high interactivity, this parameter is 

already set to True. 

9. Log out of the client and close the browser. 

10. Restart the Siebel Server for which you configured the Application Object Manager for 

Siebel Open UI. 

11. Log in to the application that you configured and verify that it opens the Siebel Open UI 
client. 
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Chapter 16: Synchronization between Siebel 
toolbar and hard phone 

 

Siebel client is enhanced to for the agents to login back through Siebel browser even if the 

agents are already logged into the hard phone. The agent client toolbar and hard phone must 

be synchronized on agent login. The scenarios that are handled in this enhancement are as 

follows: 

● Scenario 1 on page 236 

● Scenario 2 on page 237 
 
 
 
 

Scenario 1 

Enabling an agent to remain logged in to the hard phone on Siebel browser normal/abnormal 
exit. 

Note: 
Do not perform these steps if this feature is disabled. 

The following are the limitations for scenario 1: 

● The feature is intended for ACD/CM based routing. In Advocate based routing, if an agent 

exits from Siebel browser, the agent remains logged in into the hard phone, but might not 

receive any queue calls, when this feature is enabled. 

● Agents have to log out of hard phone manually, when this feature is enabled. 

● When the agents exit from Siebel, the IC side reporting is not effective and the call related 

information is not available. 

● When the agents exit from Siebel, the email channel does not work and the agents remain 

logged in to the hard phone. 
 

 

Siebel configuration for Hard phone-browser synchronization 

To enable an agent to remain logged in to the hard phone on Siebel browser exit shown in 
Scenario 1, perform steps as follows: 
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Changes to be made on Siebel 

1. Login to Siebel as Siebel Administrator. 

2. Go to Site map > Administration - Communications > Communications Drivers and 

Profiles > Driver Parameter. 

3. Select Appropriate Profile from Communication Driver Window. 

4. In Driver Parameter window set the following parameter: 

Driver:TSLogout = false 

 

Changes to be made on IC 

1. Start IC Manager. 

2. Select configured TS server > Right Click > Edit. 

3. Go to Configuration tab. 

4. Add following parameter in configuration tab as a Couple: 

logout_on_deassign = false 

5. Restart TS. 
 
 
 
 

Scenario 2 

Agents can login through Siebel browser even if the agents are already logged-in to the hard 
phone and have the toolbar in synchronization with the hard phone. 

Note: 
Do not perform these steps if this feature is disabled. 

Following are the system limitations in scenario 2. 

When feature for Scenario 2 is enabled and if hard phone is busy or agent is working on a call 

using hard phone then the agent must not try to login to Siebel. Communication Manager does 

not login to hard phone if phone is busy for the agents. Therefore login fails. AICD continues to 

monitor the extension. 

Note: 
This enhancement is specific for Avaya CM/Definity Switches. 

 
Changes to be made on IC 

1. Start IC Manager. 

2. Right-click the configured TS server and select Edit. 
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3. Click the Configuration tab. 

4. Add following parameter in configuration tab as a Couple: 

logout_on_deassign = false 

5. Add following parameter in configuration tab as a Couple: 

force_logout_for_login = true 

6. Restart TS. 
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Chapter 17: Customizing open data and 
events 

 

This section includes the following topics: 

● Event parameters vs. open data on page 240 

● About open data on page 240 

● How open data is passed on page 242 

● Assigning a workflow to monitor AICD open data changes on page 246 

● Customizing events on page 247 
 
 
 
 

Event parameters vs. open data 

You can use either custom Siebel event parameters or open data to configure your system. 

Custom Siebel event parameters have an advantage over open data. Siebel event parameters 

can pass any EDU data that was previously written to the EDU by an Avaya IC server or Avaya 

IC workflow. Whereas open data can pass only data contained in the siebel.data.attachments 

EDU container. 

Open data has the following advantages over custom Siebel event parameters: 

● The Siebel definition file can write open data to the EDU. 

● The NewOpenData command can pass data after the agent receives the work item. 

 
Related topics 

For more information, see the following topics: 

● About open data on page 240 

● About events on page 371 
 
 
 
 

About open data 

This section includes the following topics: 
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● Definition of open data on page 241 

● Open data example on page 241 

● Open data and the EDU container on page 241 

● Open data requirements on page 242 
 

 

Definition of open data 

The AICD can pass data between Avaya IC workflows and the Siebel Communications Server 

without using or analyzing the content of the data being passed. The AICD is only a conduit 

through which the data passes. This type of data is known as open data. Open data stays 

associated with the work item as the system moves the work item between agents and Avaya 

IC workflows. 

Open data can have any command that causes work to be delivered to an agent. 

MuteTransferWork, InitConferenceCall, and MakeCall are examples of this type of command. 

Open data can be delivered with events that indicate that an agent is receiving new work. 
OnNewWorkItem and OnCallIncoming are examples of this type of event. 

 

 

Open data example 

The Siebel Bookmark is a Siebel mechanism that transfers a Siebel view from one Siebel agent 

to another agent so that both agents can see the same customer information. This work item 

transfer works as follows: 

1. The Siebel Bookmark is passed to the AICD as open data, with the driver command used 

to transfer the work item. 

2. The AICD passes the open data, or the bookmark, to the Siebel event handler for the 
receiving agent. 

3. The event handler uses the bookmark to pop the Siebel screen. 
 

 

Open data and the EDU container 

Whatever is in the siebel.data.attachments EDU container is passed to the Siebel 

Communication server when certain events are triggered. Likewise, any unrecognized 

parameters are copied to siebel.data.attachments when certain commands are called. 

To accommodate specific customer needs, you can use the siebel.data.attachments EDU 
container with a custom definition file. For example, the container can provide an Avaya IC 

workflow with special processing instructions. 
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Open data requirements 

Open data requirements are shown in the following table. 

 

Key-value 

parameter 

Requirements 

Key ● Must be an ASCII string 

● Must be a string containing between 1 to 34 characters 

● Might contain any lowercase letters, uppercase letters, digits, or the 
underscore (_) character 

● Names are case-sensitive 

● Must conform to EDU container syntax restrictions 

● Cannot contain the following parameter names because the 
parameters conflict with standard command parameters: 

- ActivityID 

- AgentExtension 

- AgentID 

- Destination 

- TrackingID 

- SuppressUAD 

Value ● Must be any string. The string size is limited only by the memory 
restrictions of the servers. 

● Any character except the null character (’\0’) is legal 

 

Related topic 

For information about EDU container syntax restrictions, see the Avaya IC Electronic Data Unit 

Server Programmer Guide. 
 
 
 
 

How open data is passed 

Open data passes data: 

● From Avaya IC workflows to the Siebel Communication server on page 243 

● From the Siebel Communications Server to the Avaya IC workflows on page 245 

● Between agent desktops on page 245 
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From Avaya IC workflows to the Siebel Communication server 

The Avaya IC workflows might put any key-value pair in the siebel-data-attachments EDU 

container and pass it as open data on certain AICD events. This data can be passed on to other 

events also. 

For example, Avaya IC workflows can specify what Siebel screen is popped to the Siebel agent. 

The workflow might specify the following EDU names with the appropriate values: 

● siebel.data.attachments.viewID 

● siebel.data.attachments.rowID 

When the work is delivered to the Siebel agent, the OnNewWorkItem event includes the 

following parameters: 

● name: viewID value: <value> 

● name: rowID value: <value> 

Notice that these parameters are not standard with the OnNewWorkItem event, and were only 

included because the parameters were in the siebel.data.attachments EDU container. You must 

customize the definition file to expect this data and to interact with Siebel to get the intended 

result. 

 

Example scenario: Siebel screen pop controlled by Avaya IC workflow 

This example describes how open data is used for an Avaya IC workflow to control the Siebel 

screen pop. However, you might configure your Siebel screen pops differently. This example 

only describes a Siebel single view screen pop and does not show a Siebel multiview screen 

pop. 

You can hard code all necessary combinations of Siebel View Name, Siebel BusObj Name, and 

Siebel BusComp Name under separate event responses in the definition file. After which select 

one of the event responses for a particular screen pop based on an open data parameter such 

as viewID. 

Before the contact is routed, an Avaya IC workflow puts the following names into the EDU Open 
Data container with appropriate values: 

● siebel.data.attachments.viewID 

● siebel.data.attachments.rowID 
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Example parameters 

If the EDU contains the name siebel.data.attachments.viewID with the value 

ContactRecordPop, the following key-value parameter is passed to the Siebel Communication 

server in the OnNewWorkItem event. 

 

Key-value parameter 

Key viewID 

Value ContactRecordPop 

 

Example definition file excerpt 

An example of a definition file with hard-coded example parameters is as follows. 
 

; Event Handler for Contact Record Pop 

[EventHandler:XXXX] 

DeviceEvent="OnNewWorkItem" 

Filter.viewID="ContactRecordPop" 

Filter.rowID="?*" 

Response="OnNewWorkItem_ContactRecordPop" 

 

EventResponse:OnNewWorkItem_ContactRecordPop] 

QueryBusObj = "Contact" 

QueryBusComp = "Contact" 

QuerySpec = "Id = '{rowID}'" 

SingleView = "Contact Detail View" 

 

; Event Handler for Email Pop 

[EventHandler:YYYY] 

DeviceEvent="OnNewWorkItem" 

Filter.viewID="EmailPop" 

Filter.rowID="?*" 

Response="OnNewWorkItem_EmailPop" 

 

EventResponse:OnNewWorkItem_EmailPop] 

QueryBusComp = "Action" 

QueryBusObj = "eMail Response" 

QuerySpec = "Id = '{rowID}'" 

SingleView = "Communication Detail - Response View" 

 

This technique requires careful coordination between the Avaya IC workflow that might find or 

create the Siebel record using EAI, and the definition file that does a screen pop of the Siebel 

record. The viewID is used to select the correct event handler and the rowID is used to select 

the particular Siebel record. Also, the Avaya IC workflow must detect and resolve instances 

when multiple records are in Siebel. For example, when multiple records are in Siebel, you 

might do a multiview screen pop and the agent can select the correct record. 
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Related topics 

● For more information about the OnNewWorkItem event, see OnNewWorkItem on 

page 388. 

● Also see, Assigning a workflow to monitor AICD open data changes on page 246 

● For more information about the Siebel definition file, see the Communications Server 

Administration Guide in the Siebel documentation. 
 

 

From the Siebel Communications Server to the Avaya IC 

workflows 

The Siebel Communications server can pass any key-value parameter on selected commands 
and the AICD populates the EDU container, siebel.data.attachments, with that key and value. 

 
Example 

The Siebel Communications server can pass any key-value parameter on selected commands 

and the AICD populates the EDU container, siebel.data.attachments, with that key and value. 

 

Key-value parameters Then the AICD creates the following EDU field: 

Key agentname siebel.data.attachments.agentname 

Value SYDNEY SYDNEY 

 

 

Between agent desktops 

The Siebel Communications Server can pass open data from one agent to another using AICD 

commands and events. The Siebel event handler for the agent receiving the data might use this 

open data to pop a different screen or to activate a control. 

The out-of-the-box Siebel definition file, AICD.def, contains an example of a NewOpenData 
command that sends open data between Siebel agents. In this example, when agent 1 transfers 

a call to agent 2, agent 1 uses the NewOpenData command to pass the wrap-up code to agent 

2. 
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Assigning a workflow to monitor AICD open data changes 

To assign a workflow to monitor AICD open data changes: 

1. Create a workflow that processes the EDU event. This workflow inspects the input 

parameters, which is the modified fields on the AICD Open Data container, and processes 

this data. 

Example: test.aicd_open_data 

Reference: For information about creating a workflow, see Avaya Workflow Designer User 

Guide. 

2. Choose a workflow server to handle the processing. Create a separate workflow server if 

this causes too much processing. Create a workflow server for per Media EDU server by 

putting the workflow server into the same domain as each of the Media EDU servers. 

3. Navigate to Start > Programs > Avaya Interaction Center 7.3 > IC Manager. 

4. Log in to IC Manager. 

5. Double-click the Workflow server in IC Manager. 

6. Select the Channels tab of the appropriate Workflow server. 

7. Select New Channel. 

8. In the Channel Editor dialog box, select the values shown in the following table. 

 

Field Value 

Service VDU 

Criteria siebel.data.attachments 

 
Note: 

Criteria is: siebel.data.attachments.*=*{siebel.data.attachments.*} 

9. Click Ok. 

10. Select New Association. 

11. In the Channel Association dialog box, type the values shown in the following table. 

 

Field Value 

Event VDU.change 

Flow test.aicd_open_data 
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Note: 
These fields are case-sensitive. 

12. Click Ok. 

13. Select New Association. 

14. In the Channel Association dialog box, type the values shown in the following table. 

 

Field Value 

Event VDU.watch 

Flow test.aicd_open_data 

15. Click Ok. 

16. Click Ok again. 

Result: The test.aicd_open_data workflow runs when any field changes within the 

siebel.data.attachments container. 
 
 
 
 

Customizing events 

In the out-of-the-box configuration, many EDU fields that the AICD does not pass to the Siebel 

server exist. You can customize your integration to use these fields. 

You can customize the following Siebel events: 

● OnNewWorkItem 

● OnWorkItemRemove 

● OnCallIncoming 

● OnCallConnect 

The AICD passes EDU fields that are written before the agent receives the work item. Do not 

customize parameters that are written to the EDU after the agent receives the work item. If the 

EDU field is written after the work item arrives, the EDU data does not get passed. 
 

 

About customizing Siebel event parameters 

Use the AICDStrings.txt file to customize the Siebel event parameters. The AICDStrings.txt 

file is read by the AICD during driver initialization and contains entries such as: 

DEFINE_INTL_STRING(ON_NEW_WORK_ITEM_EDU_FIELD_1, "") 

Each entry determines: 
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● The event that passes the custom Siebel event parameter 

● The EDU field value that passes on to the event. 

● The key name of the custom Siebel event parameter 

For each entry you can add one key-value parameter to an AICD > Siebel event. Modify an 

entry to contain an EDU field name, and the AICD attempts to find that EDU field and pass the 

value on the event. If a custom Siebel event parameter is not in the EDU, then the parameter is 

not passed on the event. 

The key-name is the same as the EDU field name. For example, if you specify EDU field name, 

calltype, the key-name is calltype. If you specify an EDU field name such as, 

currentemail.header.XWF_ReplyType, the key-name is, 

currentemail.header.XWF_ReplyType. 

 

Example 

Here is how you customize the OnNewWorkItem event: 

DEFINE_INTL_STRING(ON_NEW_WORK_ITEM_EDU_FIELD_1, "calltype") 

● The AICD looks for the EDU field name, calltype. If found, the AICD adds this EDU field 

name and the value the key-event parameters passed to Siebel on the OnNewWorkItem 

event. 
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Chapter 18: Installing and configuring 
Siebel on Linux 

 

To support IC 7.3.4 or later with Siebel 8.1.1.14 and Siebel 15 on Red Hat® Enterprise Linux® 
Release 6.5 you must install the following Packages on the Siebel Communication Server. 

ICSide73xLinux: For installing AIC Secondary ORB server and dependent tools and libraries 
on Siebel Communication Server 

SiebelSide73xLinux: For installing of Avaya AICD driver on Siebel Enterprise Server 
 
 
 
 

Installing Avaya IC Secondary ORB Server on Siebel 

Communication Server 

Prerequisites 

● Avaya IC 7.3.4 or later Server must be already installed and configured on any of the 

supporting platform i.e. either on Windows or Solaris 

● Siebel Communication Server is already installed and configured on RHEL 6.5 

To install Avaya IC Secondary ORB server on every Siebel Communication Server on RHEL 

platform: 

1. Log in to the Siebel server with an account that has the required Administrator privileges. 

For example, the user using which the Siebel Application is installed. 

2. Copy and extract the ICSide73xLinux package on the Siebel Communication Server. 

3. For installing IC Core server required as Secondary ORB, browse to the location where 

you have extracted the ICSide73xLinux package. For example: 

$ cd ../ICSide73xLinux/InstData/Linux/VM 

4. Execute the following command to install the Avaya IC Secondary ORB server: 

$ ./AICLinux.bin 

5. In the Introduction screen, click Next. 

6. In the License Agreement screen, review the license agreement and click I accept the 

terms of the License Agreement. 

7. Click Next. 
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8. In the Choose Install Folder screen, select the location where you want to install IC 7.3.4 

or later Package. The default location is /opt/Avaya/ 

9. In the Pre-Installation Summary screen, review the information and click Install. 

10. The system displays the Install Complete screen after a successful installation. 

11. Click Done. 

 
 

 

Verifying the installation of ICSide73xLinux package using 

tool 

Prerequisites 

● Ensure that the Avaya IC ICSide73xLinux package is installed. 

To verify the installation of ICSide73xLinux package using tool: 

1. Login to the Siebel System on which the Avaya IC Core Server (ICSide73xLinux package) 

is installed. 

2. Open the Terminal window and change to the Avaya IC73 Home directory. For example: 

$ cd $AVAYA_IC73_HOME 

3. Run the installer verification tool to identify ICSide73xLinux package installation is 

completed properly. Execute the following command and look for any error messages: 

$ ./AICLinuxIVT.sh -q <AVAYA_IC73_HOME> 

For Example: 

$ ./AICLinuxIVT.sh -q /opt/Avaya/IC73 

To get more help, use the command as follows: 

$ ./AICLinuxIVT.sh -h 

 

 

 
 

Configuring the Avaya IC Secondary ORB Server on Siebel 

Communication Server 

Prerequisites 

● Ensure that the Avaya IC ICSide73xLinux package is installed. 

To configure the Avaya IC Secondary ORB Server: 
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1. Login to the Siebel System on which the Avaya IC Core Server (ICSide73xLinux package) 

is installed. 

2. Open the Terminal window and change the directory to Avaya IC Home bin directory. For 

example: 

$ cd /opt/Avaya/IC73/bin 

3. Set the IC Environment which includes setting up environment variable 

AVAYA_IC73_HOME and updating LD_LIBRARY_PATH to add Avaya IC libraries. 

$ . ./icenv 

4. Add the Secondary ORB using the createSecondaryORB.sh command: 

$ createSecondaryORB.sh [-h | -u userid -p password -o 

hostname:port -d dsport -q IC_HOME -l hostname] 

where: 

-h : Print this help message 

*** All are required parameters *** 

-u userid: IC administrator loginID 

-p password: IC administrator password 

-o hostname:port: Hostname and port of parent ORB 

-dsport: Port of parent DS, if not default 

-q AVAYA_IC73_HOME: Specifies AVAYA_IC73_HOME (overrides environment variable 

AVAYA_IC73_HOME) 

-l hostname: Use specified host when generating vesp.imp 

Example-1: To print this help: 

createSecondaryORB.sh -h 

Example-2: To create a secondary ORB server and fetch vesp.imp: 

$ createSecondaryORB.sh -u Admin -p admin1 -o IC73WinServer:9001 -d 9002 -q /opt/ 

Avaya/IC73 -l SiebelLinuxHostname 

5. Run the Secondary ORB server 

$ ./icadmin so 

 

 

 
 

Installing Avaya AICD driver on Siebel Communication 

Server 

To install an Avaya AICD Driver on the Siebel Communication Server: 
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1. Log in to the server with an account that has the required Administrator privileges. 

For example: The user using which Siebel Application is installed. 

2. Copy and extract the SiebelSide73xLinux package on the Siebel Communication Server. 

3. For installing Avaya AICD Driver, browse to the SiebelSide73xLinux installer package and 

execute the installer 

$ cd ../SiebelSide73xLinux/InstData/Linux/VM 

$ ./SiebelLinux.bin 

4. In the Introduction screen, click Next. 

5. In the License Agreement screen, review the license agreement and select I accept the 

terms of the License Agreement. 

6. Click Next. 

7. In the Select Siebel Location screen, provide the path where the Siebel is installed. 

For Example: /opt/siebel/8.1.1.14.0/ses/siebsrvr 

8. In the Select Siebel version screen, select Siebel 8.1.x. 

9. In the Pre-installation Summary screen, review the information and click Install. 

The system displays the Install Complete screen after a successful installation. 

10. Click Done. 
 
 
 
 

Verifying the installation of SiebelSide73xLinux package 

using tool 

Prerequisites 

● Ensure that the Avaya SiebelSide73xLinux package is installed. 

To verify the installation of SiebelSide73xLinux package using tool: 

1. Login to the Siebel System on which the Avaya AICD Driver (SiebelSide73xLinux 

package) is installed. 

2. Open the Terminal window and change the directory to Siebel Home directory. 

For example: 

$ cd $SIEBEL_HOME 
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3. Run the installer verification tool to identify SieblLinux package installation is completed 

properly. Execute the following command and look for any error messages: 

$ ./SiebelLinuxIVT.sh -q <SIEBEL_HOME> 

For Example: 

$ ./SiebelLinuxIVT.sh -q /u01/siebel/8.1.1.14.0/ses/siebsrvr 

To get more help, use the command as follows: 

$ ./SiebelLinuxIVT.sh -h 

 

 

 
 

Verifying the Avaya AICD driver on Siebel Communication 

Server 

To verify the Avaya AICD Driver on the Siebel Communication Server: 

1. Ensure that libaicd.so is available in the $SIEBEL_HOME/lib 

2. Ensure that $AVAYA_IC73_HOME/lib is added in the LD_LIBRARY_PATH so that using 

ldd command the dynamic dependency libraries can be resolved for libaicd.so. 

For Example, navigate to Siebel Home lib directory and run ldd command: 

$ ldd libaicd.so 

For Example: 

$ cd $SIEBEL_HOME/lib 

$ ldd libaicd.so 

linux-gate.so.1 => (0x00e13000) 

libmttoolkit.so => /opt/Avaya/IC73/lib/libmttoolkit.so 

(0x00a88000) 

libmttlogger.so => /opt/Avaya/IC73/lib/libmttlogger.so 

(0x00dc2000) 

libcrypt.so.1 => /lib/libcrypt.so.1 (0x0096d000) 

libpthread.so.0 => /lib/libpthread.so.0 (0x00917000) 

libstdc++.so.6 => /usr/lib/libstdc++.so.6 (0x00157000) 

libm.so.6 => /lib/libm.so.6 (0x00ee7000) 

libgcc_s.so.1 => /lib/libgcc_s.so.1 (0x00a16000) 

libc.so.6 => /lib/libc.so.6 (0x00324000) 

libssllib.so => /opt/Avaya/IC73/lib/libssllib.so (0x00f13000) 

libicdmp.so => /opt/Avaya/IC73/lib/libicdmp.so (0x00dab000) 
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libfreebl3.so => /lib/libfreebl3.so (0x00242000) 

/lib/ld-linux.so.2 (0x00304000) 

libdl.so.2 => /lib/libdl.so.2 (0x0094a000) 

 

 

 
 

Uninstalling the package 

You can uninstall the package from the server if you no longer use the package. 
 

 

Uninstalling Avaya IC Secondary ORB Server from Siebel 

To uninstall an Avaya IC Secondary ORB from the Siebel Communication Server: 
 

1. Log in to the server with an account that has the required Administrator privileges. 

For example: The user using which Avaya IC secondary ORB server is installed. 

2. Stop the Secondary ORB Server using the following command: 

./icadmin tv loginid password 

3. Go to the $AVAYA_IC73_HOME/Uninstall_AICLinux7.3 directory. 

4. Type the following command and press Enter: 

./Uninstall_AICLinux7.3 

5. In the Uninstall AICLinux 7.3 screen, click Uninstall. 

After successful uninstallation, the Uninstall Complete window is displayed. 

6. Click Done. 
 

 

Uninstalling the Avaya AICD Driver from Siebel 

To uninstall an Avaya AICD Driver from the Siebel Communication Server: 

1. Log in to the server with an account that has the required Administrator privileges. 

For example, the user using which Avaya AICD Driver is installed. 

2. Stop the Siebel Communication Server. 

3. Go to $SIEBEL_HOME/Uninstall_SiebelLinux7.3 directory. 

4. Type the following command and press Enter. 

./Uninstall_SiebelLinux7.3 

5. In the Uninstall SiebelLinux 7.3 screen, click Uninstall. 

6. After successful uninstallation, the Uninstall Complete window is displayed. 
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7. Click Done. 
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Chapter 19: Overview of deployment options 

 

This section explains the relationship between your Siebel administration and Avaya IC 

administration. If certain administration parameters do not match, the Siebel tool bars for some 

agents are disabled. 

This section also provides examples for how to deploy integration components on Siebel 

machines. For more information about the architecture of an integration, including components 

installed on Avaya IC machines, see Architecture overview on page 32. 

 
Important: 

The information, examples, and procedures in this section apply to both the 
Hybrid Siebel integration and the Native Siebel integration. 

The section includes the following topics: 

● Siebel driver configurations on page 259 

● The AICD library and the SiebelAICD server on page 260 

● Siebel configuration parameters and settings on page 262 

● Calculating the number of AICD servers on page 265 

● List of configuration examples on page 265 

● Example 1 on page 266 

● Example 2 on page 267 

● Example 3 on page 268 

● Example 4 on page 269 

● Example 5 on page 270 

● Example 6 on page 271 

! 
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Siebel driver configurations 

Starting with the 7.3.x integration release, Avaya IC supports Siebel driver configurations that is 
not previously supported. 

Because of these configurations you can closely tailor your integration to customer needs. You 

can now perform the following actions with the new AICD. 

Set Maximum MT Servers to a value greater than one: You can set the Maximum MT 

Servers parameter for the Communications Session Manager to a value greater than one. This 

Siebel parameter controls the number of Communications Session Managers that can run on a 

host. The AICD is loaded separately up to the value specified for Maximum MT Servers. For 

earlier AICD releases, Avaya Alert 611 stated that the Maximum MT Servers setting must 

remain at the default value of one. 

For more information, see Maximum MT Servers parameter on page 262. 

Specify multiple Siebel configurations that use the AICD library: You can specify multiple 

Siebel configurations that use the AICD library using the new AICD parameter, 

ConfigurationName. The AICD creates a new SiebelAICD server for each uniquely identified 

Siebel configuration. In earlier AICD releases, you can create only one SiebelAICD server for 

each Siebel Communication Server. When you can create more than one SiebelAICD server for 

each Siebel Communication Server, you can partition your agents by Avaya IC domains using 

separate Siebel Computer Telephony Integration (CTI) configurations. You can also use this 

capability to optimize network usage and failover strategies for your system. 

For more information, see: 

● ConfigurationName parameter on page 263 

● AICD driver parameters on page 421 

Restrict a Siebel communications configuration to run under a specified Avaya IC 

domain: With the new AICD parameter, ServerDomain, you can restrict a Siebel 

communications configuration to run under a specified Avaya IC domain. This parameter can 

optimize your network communication by ensuring that all agents in a Siebel configuration run 

under a particular Avaya IC domain. 

For more information about the ServerDomain parameter, see AICD driver parameters on 
page 421. 
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The AICD library and the SiebelAICD server 

The Siebel Communications Server uses the AICD library to support the Siebel toolbar. By 
default, each loaded AICD library creates one or more SiebelAICD servers. 

This section includes the following topics: 

● SiebelAICD selection criteria on page 260 

● SiebelAICD server administration on page 261 

● AICDs and multihomed hosts on page 261 
 

 

SiebelAICD selection criteria 

When the AICD library starts each SiebelAICD server, the AICD library looks for any Avaya IC 
server configured by Avaya IC Manager in the IC_INSTALL_DIR\IC73\etc\vesp.imp file 

that meets the following criteria: 

● The Avaya IC server type is SiebelAICD. 

● The SiebelAICD server IP address configured using Avaya IC Manager matches the host 

IP address. If the host is multihomed, the AICD library compares all host IP addresses. 

● If the Siebel ServerDomain driver parameter is specified, the AICD library compares the 

domain of the SiebelAICD server configured using Avaya IC Manager with the value of the 

ServerDomain parameter configured by Siebel. Both values must match exactly, including 

the letter case. 

● The network TCP port address configured using Avaya IC Manager must not be in use by 

another SiebelAICD server nor by any other host process. 

If these criteria are not met, the AICD library returns an error to Siebel and some Siebel agents 

must have disabled Siebel tool bars when the agents login. These errors are logged in the 

IC_INSTALL_DIR\IC73\logs\SiebelAICD.log file. 

Note: 
If you are running a multihomed server, ensure that the Port values configured 

using Avaya IC Manager for all SiebelAICD servers on the host are unique. 

Otherwise, the AICD library cannot use some SiebelAICD servers. Avaya IC 

Manager cannot do this for you. 
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SiebelAICD server administration 

To control the communication paths among the SiebelAICD servers and the Avaya IC servers, 
you must perform the following administrative tasks: 

● Use Avaya IC Manager to administer each SiebelAICD server as Avaya IC server-type 

SiebelAICD. 

● Assign the Siebel Communication Server host's IP address to each SiebelAICD server. 

● Configure the Avaya IC domain on each SiebelAICD server. 
 

 

AICDs and multihomed hosts 

A multihomed host is a computer with two or more IP addresses. Usually, this host is with two or 

more Network Interface Cards (NICs), or a single NIC configured for multiple IP addresses. The 

AICD library supports multihomed hosts by monitoring all host IP addresses. 

 
IP assignment and performance 

If your Siebel Communications Server host is multihomed, how you assign IP addresses during 

SiebelAICD server configuration can affect performance. Consider the following network 

performance criteria to determine the best IP address: 

● Network topology 

● Network bandwidth 

● Number of network hops between your Avaya IC servers and Siebel Communications 

server host 

 
Port assignment 

Normally, Avaya IC Manager ensures that the specified SiebelAICD port entries are unique. 

However, Avaya IC Manager does not provide safeguards when specifying SiebelAICD port 

entries for a multihomed server. 

When creating SiebelAICD servers for the same host and different IP addresses, you must 

ensure that the port entries are unique for all Avaya IC servers that run on the same host. In 

some special situations you must ensure that the port entries are unique for all Avaya IC 

servers across multiple hosts. If you pay attention to how you specify unique port addresses, 

you save troubleshooting steps later. 
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Siebel configuration parameters and settings 

This section describes the Siebel configuration parameters and the settings that affect the 

number of SiebelAICD servers. Some configurations require you to administer more than one 

SiebelAICD server using Avaya IC Manager. This parameter is controlled by the following 

Siebel and driver configuration parameters and the settings as the configurations apply to the 

AICD: 

● AgentPassword parameter on page 262 

● Maximum MT Servers parameter on page 262 

● ConfigurationName parameter on page 263 

● ServerMode parameter on page 264 

● Siebel Communications Server host setting on page 264 
 

 

AgentPassword parameter 

This parameter provides a password that agents can use to log in to Avaya IC for Native Siebel 

configurations only. This parameter is a service parameter (Service:AgentPassword) not a 

driver parameter. 
 

 

Maximum MT Servers parameter 

Maximum MT Servers is a Siebel configuration parameter on the Siebel Communication 

Session Manager that determines the maximum number of Communications Session Managers 

that run on a host. Each session manager runs a new copy of the AICD. For each AICD, at least 

one SiebelAICD server is created. This parameter defaults to a value of one, but you can 

change the value using the Siebel Server Component Administration screen. 

 

Example setting for Maximum MT Servers 

If you specify the Maximum MT Servers parameter as 2, you can load the AICD library under 

two separate processes on the Communications Server host. This loading totals to two 

SiebelAICD servers. For all SiebelAICD servers to work, your administration of Avaya IC 

Manager must specify two Avaya IC SiebelAICD servers, all configured for the IP address of the 

Siebel Communications Server host. If you do not specify enough Avaya IC servers with the 

correct IP addresses, some SiebelAICD servers fail to initialize and some Siebel agents have 

disabled Siebel tool bars. 

Note: 
This example assumes you are running one Siebel Communications Server host. 
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Considerations for setting Maximum MT Servers 

Consider the following items: 

● You can set the Maximum MT Servers differently for each Siebel Communication Session 

Manager. 

● Siebel can also configure the number of Minimum MT Servers for the Communication 

Session Manager for you. Set the number to a value greater than 0 and less than or equal 

to the Maximum MT Servers setting. If the value of Minimum MT Servers is less than the 

value of Maximum MT Servers, not all AICD library instances or SiebelAICD server 

instances loads during startup. Instead, loading occurs only on an as needed basis, as 

load increases and more agents log in. 

 

Related topic 

For more information and for the recommended settings for Minimum MT Servers, Maximum 

MT Servers, and Maximum Tasks for the Siebel Communication Session Manager, see Siebel 

FAQ 2091: How do you use the MaxMTServers, MinMTServers, and MaxTasks parameters to 

improve stability of the Communications Session Manager and to manage multiple 

CommSessionMgr processes. 
 

 

ConfigurationName parameter 

The Siebel communications configuration associates the Siebel agents, AICD library, AICD 
parameters, and more. The AICD parameter, ConfigurationName, has the AICD library to 

distinguish the configurations and create a new SiebelAICD server for each. 

 
About setting the ConfigurationName parameter 

Consider the following items when setting the ConfigurationName parameter: 

● Use the Siebel Communications screens to specify each Siebel configuration. 

● In each Siebel communications configuration, specify a unique value for the 

ConfigurationName parameter. The AICD library recognizes a new configuration by a 

change in this value and creates a new SiebelAICD server. 

● You can use the ConfigurationName parameter and the AICD parameter, ServerDomain, 

to associate unique groups of Siebel agents with an Avaya IC domain. This parameter can 

optimize the communication paths for the agents in the Siebel configuration. 

● You must administer the correct number of SiebelAICD servers using Avaya IC Manager. 

mailto:infodev@avaya.com


August 2022 250 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

Siebel configuration parameters and settings  
 

 

 

Example setting for ConfigurationName 

If you specify two Siebel communications configurations and give each a unique 

ConfigurationName value, the AICD library creates two SiebelAICD servers. You must specify 

two Avaya IC SiebelAICD servers using Avaya IC Manager. If you do not specify the correct 

number of Avaya IC servers, some SiebelAICD servers fails to initialize and some Siebel agents 

has disabled Siebel tool bars. 

Note: 
This example assumes you are running one Siebel Communications Server host 

and the Maximum MT Servers parameter is set to the default value of 1. 

 
Related topic 

For more information, see AICD driver parameters on page 421. 
 

 

ServerMode parameter 

The Siebel communications configuration associates the Siebel agents, AICD library, AICD 

parameters. The AICD parameter, ServerMode, sends a signal to the AICD library if the 

parameter is communicating with Avaya Agent for Hybrid Siebel or with the Agent Server for 

Integration with Siebel (ASIS) for Native Siebel. 

 
Example setting the ServerMode parameter 

Hybrid Siebel integration: Set the ServerMode parameter value to Hybrid. All agents who 

belong to that Siebel driver configuration is logged in hybrid mode. 

Native Siebel integration: Set the ServerMode parameter value to Native. All agents who 

belong to that Siebel driver configuration is logged in native mode. 

 

Related topic 

For more information, see Selecting an integration between Avaya IC and Siebel on page 27. 
 

 

Siebel Communications Server host setting 

During the installation of your Siebel enterprise, you can specify more than one Siebel 

Communications Server host. Each host can load the AICD library, and at least one SiebelAICD 

server is created for each Siebel Communications Server host. You must administer the correct 

number of SiebelAICD servers using Avaya IC Manager. The two valid values for this parameter 

are Hybrid and Native. If this parameter is not specified, the AICD defaults to a Hybrid Siebel 

configuration. 
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Example 

If you administered two Siebel Communications Server hosts, you must specify two Avaya IC 

SiebelAICD servers using Avaya IC Manager. If you do not specify the correct number of Avaya 

IC servers, some SiebelAICD servers fail to initialize and some Siebel agents has disabled 

Siebel tool bars. 

Note: 
This example assumes you are running one Siebel configuration and the 

Maximum MT Servers parameter is set to the default value of 1. 
 
 
 
 

Calculating the number of AICD servers 

This section describes the formula that you can use to determine the number of AICDs that you 

must administer. 

 

A = C(M1 + M2 +  + Mn) 
 

A = C multiplied by (sum of the values of M for each n). 

 

Variable Definition 

A Number of AICDs that must be administered using IC Manager for each Siebel 
enterprise. 

C Number of AICD configurations in Siebel for each Siebel enterprise 

n Number of hosts that can run Siebel Communication Servers 

M Value of Maximum MT Servers for each Siebel Communication Server 

 
 
 
 

List of configuration examples 

You can use the following examples to help you configure Siebel and Avaya IC to ensure 
compatibility: 

● Example 1 on page 266 provides an example of one Siebel configuration with one 

Communication Server. 

● Example 2 on page 267 provides an example of two Siebel configurations with one 

Communication Server 
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● Example 3 on page 268 provides an example of one Siebel configuration with one 

Communication Server, and the Maximum MT Servers parameter set to 2. 

● Example 4 on page 269 provides an example of two Siebel configurations with one 

Communication Server, and the Maximum MT Servers parameter set to 2. 

● Example 5 on page 270 provides an example of a multihomed host with two Siebel 

configurations, one Siebel Communication Server, and the Maximum MT Server 

parameter set to 2. 

● Example 6 on page 271 provides an example of two Siebel configurations with two 
Communication Server hosts and the Maximum MT Servers parameter set to 2. 

 
 
 
 

Example 1 

One Siebel configuration with one Siebel Communication Server 

The simplest type of configuration consists of one Siebel configuration with one Siebel 

Communication Server. To set up this type of configuration: 

1. Create one SiebelAICD server under the AICD library. 

2. Using Avaya IC Manager, create only one Avaya IC server of type SiebelAICD. 

When the AICD loads, it determines the host IP address and use the only available SiebelAICD 
server that matches the IP address for the Siebel host. 

 

 

Figure of example 1 

The following figure shows a configuration that consists of one Siebel configuration with one 

Siebel Communication Server. 
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Example 2 

Two Siebel configurations with one Communication Server 

This example shows how to use two Siebel communications configurations. Each configuration 
uses a different Avaya IC domain. Consider the following items: 

● Although not shown in Figure of example 2 on page 268, each configuration contains a 

separate group of Siebel agents. 

● Agents in Siebel configuration C1 use Avaya IC domain, User1. 

● Agents in Siebel configuration C2 use Avaya IC domain, User2. 

This technique optimizes the network communications between the SiebelAICD server and the 
other Avaya IC servers in the same Avaya IC domain. This technique is useful when the Avaya 

IC servers are distributed across a Wide Area Network (WAN). 
 

 

About setting up example 2 

To set up this type of configuration: 

● Administer two Siebel configurations. 

● Use the driver configuration parameter, ConfigurationName, to distinguish the 

configurations to the AICD. To use this parameter effectively, supply unique values for this 

configuration parameter. Otherwise, the Siebel configurations is indistinguishable and only 

one SiebelAICD server is created. 

● Use the ServerDomain driver parameter to ensure that the driver creates a SiebelAICD 
server that is in the specified Avaya IC domain. This parameter value must match the 

Avaya IC domain name exactly. Otherwise, the server does not start. 
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Figure of example 2 

The following figure shows two Siebel communications configurations with one Siebel 
Communication Server. 

 
 

 
 
 

 

Example 3 

One Siebel configuration with one Communication Server and the Maximum MT 
Servers parameter set to 2 

The Siebel Communication Session Manager configuration parameter, Maximum MT Servers, 

determines the number of Communications Session Managers that run on a host. Each 

manager can run a new copy of the AICD library. This example shows the effect of the 

parameter on the number of SiebelAICD servers. 
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Figure of example 3 

The following figure shows one Siebel communications configuration with one Siebel 
Communication Server and the Maximum MT Servers parameter set to 2. 

 
 

 
 
 
 

Example 4 

Two Siebel configurations with one Communication Server, and the Maximum MT 
Servers parameter set to 2 

This example combines the previous two examples and shows the effect on the number of 

SiebelAICD servers. You can use this configuration to provide redundancy for the Siebel agents 

in each configuration. If a server process were to fail, an alternate server process is available for 

the Siebel agents when the agents relogin. 
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Figure of example 4 

The following figure shows two Siebel communications configurations with one Siebel 
Communication Server and the Maximum MT Servers parameter set to 2. 

 

 
 
 
 

Example 5 

Multihomed host with two Siebel configurations, one Siebel Communication 
Server, and the Maximum MT Server parameter set to 2. 

The multihomed host in this example has two IP addresses that are associated with the same 

host. In this example, Siebel agents in communications configuration 1 use Avaya IC domain 

User1, and IP address 111.111.111.1. Agents in configuration 2 use User2, and IP address 

222.222.222.2. As the previous example, you can use this configuration to provide redundancy 

for the Siebel agents in each configuration. If a server process fails, an alternate server process 

is available for the Siebel agents when the agents relogin. 

Ensure that the port you specified in IC Manager is unique for all SiebelAICD servers on the 

host. Otherwise, the AICD library cannot use some of the SiebelAICD servers. Avaya IC 

Manager cannot determine whether the port is unique or not. 
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Figure for example 5 

The following figure shows a multihomed host that consists of two Siebel communications 

configurations with one Siebel Communication Server and the Maximum MT Servers parameter 

set to 2. 
 
 

 
 
 
 

Example 6 

Two Siebel configurations with two Siebel Communication Server hosts, and the 
Maximum MT Servers parameter set to 2 

You can use this type of configuration to provide server redundancy and process redundancy 

for the Siebel agents in each system. If a server process or server host fails, an alternate server 

process is available for the Siebel agents when the agents relogin. Notice how quickly the 

number of SiebelAICD servers grows when you: 

● Combine multiple Siebel Communications configurations 

● Combine multiple Siebel Communication Server hosts 

● Use the Siebel Communication Session Manager configuration parameter, Maximum MT 
Servers 

Note: 
This example assumes you have set the Maximum MT Server configuration 

parameter for the Siebel Communication Session Manager the same for each 

host. However, you can set this parameter differently for each host. 
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Figure for example 6 

The following figure shows a two Siebel communications configuration with two Siebel 
Communication Servers and the Maximum MT Servers parameter set to 2. 
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Chapter 20: Errors, logs, and 
troubleshooting 

 

This chapter describes troubleshooting procedures for common problems, error messages, and 
the information about log files. 

All the procedures in this section apply to both Hybrid and Native Siebel configurations unless 

otherwise noted. 

This section includes the following topics: 

● Error messages on page 274 

● Log files on page 277 

● Troubleshooting on page 282 
 
 
 
 

Error messages 

This section describes the common error messages you might see and includes the following 

topics: 

● Agent.Desktop.Webclient.WorkingDirectory messages on page 274 

● Cannot logout with active calls on page 275 

● CheckForADUValues messages on page 275 

● Communication with Core Servers failed on page 276 

● CTI - Not Logged In on page 276 

● CTI - Server Failure on page 276 

● Request failed due to internal error on page 277 

● Siebel Communication Failure Notification on page 277 
 

 

Agent.Desktop.Webclient.WorkingDirectory messages 

If you have a Native Siebel configuration, you may see 

Agent.Desktop.Webclient.WorkingDirectory messages. For more information, see Media 

channels are not enabled on page 295. 
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Cannot logout with active calls 

You might see the following error message. 
 

You can not logout with active Calls. Please complete all Calls before logging out. 

 

Remedy 

1. Complete all active voice contacts. 

2. Do one of the following steps: 

 

For Hybrid Siebel For Native Siebel 

From the Avaya Agent pop-up menu, select 
Softphone > Reset. 

Select Reset Voice Channel from the Siebel 
menu. 

 

 

CheckForADUValues messages 

You might see the following messages in the Avaya IC or Avaya ASIS logs. These error 

messages are valid only when the MakeCall button is disabled. Ignore these messages if your 

MakeCall button is enabled. 
 

|DEBUG|com.avaya.ic.integrations.siebel.asis.services.AsisServiceConnection.agent10| 

agent10|||CheckForADUValues - Blenderwatch - true|[] 

 
|WARN|com.avaya.ic.integrations.siebel.asis.services.AsisServiceConnection.agent10| 

agent10|||CheckForADUValues - VespException Did not find privilege: null|[] 

 
|ERROR|com.avaya.ic.integrations.siebel.asis.services.AsisServiceConnection.agent10| 

agent10|||CheckForADUValues - VespException Did not find voice.connector: null|[] 

 
|ERROR|com.avaya.ic.integrations.siebel.asis.services.AsisServiceConnection.agent10| 

agent10|||CheckForADUValues - VespException Did not find voice.device: null|[] 

Remedy 

Contact your system administrator. 
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Communication with Core Servers failed 

You might see the following error message. 
 

Communication with one of the Core Servers Failed. Please complete any active calls 

then press Retry. 

 

Remedy 1 

1. Complete any active voice call work. 

 
Important: 

If you click Retry before completing voice work, the Siebel Communications 

Toolbar does not function for voice call work. 

2. Click Retry. 

 
Remedy 2 

Log out of Siebel and log back in. 
 

 

CTI - Not Logged In 

You might see the following error message. 
 

CTI - Not Logged In 

 

Remedy 

Log out of Avaya IC and Siebel and log back in. 
 

 

CTI - Server Failure 

You might see the following error message. 
 

CTI - Server Failure 

 

Remedy 

If your system displays this message in the Phone task list with no other instructions, 

contact your system administrator. 

! 
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JNDI Naming Exception message 

For Native Siebel configurations, you might see the following error message. 
 

|WARN |com.avaya.util.ConfigParams||||JNDI Naming Exception 

You can ignore this message as it does not affect ASIS functionality. 
 

 

Request failed due to internal error 

You might see the following error message. 
 

Error: Request failed due to internal error. 

 

Remedy 

Contact your system administrator. 
 

 

Siebel Communication Failure Notification 

You might see the following error message. 
 

Siebel Communication Failure Notification 

 

Remedy 

1. Click Retry. 

2. Try to reconnect to Siebel. 

3. If the problem still exists, log out of Siebel and log back in. 
 
 
 
 

Log files 

Errors, warnings, and trace messages are logged into log files at runtime. You can enable 
additional logging in to get more information when troubleshooting the AICD, the EAI, or the 

ASIS servers. For the AICD, you can create log files and files for each agent on the server 

where the AICD resides. For the EAI and ASIS servers, you can create only server log files. 
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This section includes the following topics: 

● Server log files for AICD and EAI servers on page 278 

● Agent log files for the AICD and EAI servers on page 279 

● Log files for ASIS on page 280 

● Siebel log files on page 282 
 

 

Server log files for AICD and EAI servers 

You can create server log files for the AICD and for the EAI servers. 

 
Related topic 

For more information about setting log files through IC Manager, see IC Administration Guide. 

 
Server log names 

Each AICD and EAI server logs into a file that has the same name as the interface suffixed with 

.log. Examples of log file names are in the following table. 

 

Interface name Path and filename examples 

SiebelAICD <AVAYA_IC73_HOME>/logs/SiebelAICD.log 

EAI <AVAYA_IC73_HOME>/logs/EAI.log 

EAIWorkflow <AVAYA_IC73_HOME>/logs/EAIWorkflow.log 

During startup, each AICD and EAI server logs into the Avaya IC system, finds the server name, 
and begins logging into a file that has the same name as the server name suffixed with .log. For 

example, if your EAI server name is xyz, when that is suffixed with .log, the new log name is 

xyz.log. All log files are logged into <AVAYA_IC73_HOME>logs. 
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AICD and EAI logging levels 

For the AICD and EAI servers, set these Debug Trace Levels using the IC Manager Server 
Administration Dialogs. 

 

Server 

logging level 

Description 

usr1 Errors 

usr2 Warnings 

usr3 Information 

usr4 Debugging 

flush Causes every statement to flush. Use this level sparingly as it slows down 
processes. 

 

 

Agent log files for the AICD and EAI servers 

The AICD and EAI servers create log files. Log files are enabled for each agent basis using 
Siebel driver parameters. 

 
Agent log names 

The name of the log file is a combination of the agent name and the name of the server agent is 

logged into. For example, if the AICD server for the agent is xyz and the name of the agent is 

abc, the log file for the agent is xyz_abc.log. 

 
Agent logging levels 

For the AICD, use the service logging levels when setting up logging for each agent. 

 

Service logging level Description 

TraceLevelUsr1 Errors 

TraceLevelUsr2 Warnings 

TraceLevelUsr3 Information 

TraceLevelUsr4 Debugging 

TraceLevelFlush Causes every statement to flush. Use this level sparingly as it 
slows down processes. 
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Facts about setting up agent log files 

While the details of setting up driver-specific parameters and the profiles are described in the 
Siebel documentation, consider the following items when performing those procedures: 

● If you use TraceLevelFlush, you must first set a trace level between 1 to 4 so that logging 

occurs in a separate file for that agent. 

● Do not set up log files for 50 or more agents as this setting up might affect the performance 

of your Siebel Communication Server. On some systems, you might have performance 

degradation with less than 50 agent log files. 

● You can set driver parameters in one of two ways: 

- Set a default value for a Siebel driver parameter. 

- Specify an override value for the parameter in each profile you create for the Siebel 

driver. 

● The setting for each agent overrides the common setting that was specified through IC 

Manager. 

● If you used override values to set driver parameters, create a special Siebel profile that 

sets these override values for the AICD Siebel logging parameters. 

● Associate this special profile with the agents that has log files. 

 
Related topics 

For more information, see the following topics: 

● For the AICD parameters used for logging, see AICD driver parameters on page 421. 

● For a description on how to configure the Siebel service parameters for agent log files, see 

the Siebel documentation. 
 

 

Log files for ASIS 

This section includes the following topics: 

● ASIS log names on page 280 

● Logging levels for ASIS on page 281 

● Media channels are not enabled on page 295 

 
ASIS log names 

The ASIS server logs are located in the logs folder under IC73\logs and include the following 
files: 

● AvayaIC.log 
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● AvayaUOM.log 

● AvayaVesp.log 

● AvayaAsis.log 

 
Logging levels for ASIS 

Consider the following facts about ASIS logging levels: 

● You can set the ASIS logging levels from the log4j.xml file. 

● The log4j.xml file is located under the IC73\etc folder. 

● You can set the following logging levels from the log4j.xml file: 

- trace 

- debug 

- info 

- warn (default) 

- error 

- fatal 

Note: 
While specifying a log file path on a network share in the appender for 

com.avaya.ic.integrations.siebel.asis in log4j.xml, ensure that remote file path is 

accessible. If the network share path is incorrect, no alarm is seen in the 

ICManager nor any log is available. 

 
Changing ASIS logging levels 

To change the ASIS logging levels: 

1. Open the log4j.xml file in a text editor such as Notepad. 
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2. Change the logging level values in the log4j.xml file. 

Example: 
 

3. Save your changes and exit the log4j.xml file. 
 

 

Siebel log files 

Siebel also provides log files to help you track down a problem. Increase the level of logging for 

the Siebel Communications Server to get more information in the Siebel log files. You can use 

this information to see what commands and events have passed between the AICD and Siebel. 

Siebel describes how to enable logging on the support website at 

http://ebusiness.siebel.com/supportweb. 
 
 
 
 

Troubleshooting 

This section includes the following topics: 

● A reply cannot be sent with the Outbound Message applet right after a new email popped up 
on page 268 

● ASIS fails to start on page 283 

● Avaya Agent Rich Client (AARC) fails to open Internet Explorer: 
"WebBrowser_GetDocument error -2147467259: Application-defined or object-defined error" 
is displayed (Hybrid Siebel only) on page 269 

● Avaya Agent taskbar fails on page 284 

● All buttons on the Siebel toolbar are disabled on page 285 

● Diagnosing and clearing AICD loading problems on page 286 

● Directory Server SSL Handshake Error (Initialize/Connect Failed) on AIX Platform on 

a. <logger name="com.avaya" additivity="false"> 

<level value="debug" /> 

b. <logger name="com.avaya.ic.uom" additivity="false"> 

<level value="debug" /> 

c. <logger name="com.avaya.ic.vesp" additivity="false"> 

<level value="debug" /> 

d. <logger name="com.avaya.ic.integrations.siebel.asis" additivity="false"> 

<level value="debug" /> 
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page 293 

● EAI server errors on page 294 

● EAI server cannot read a file attachment on page 294 

● EAI Server fails to start with the error “TrustAnchor with subject "CN=<FQDN>" is not a CA 
certificate” on page 282 

● EAI.PutData fails with error 2 on page 281 

● EDU information is lost on page 295 

● Media channels are not enabled on page 295 

● Replacing English with Thai text in toolbar on page 296 

● Siebel GUI is unresponsive on page 298 

● Siebel toolbar is not visible on page 298 

● Softphone stops responding on page 298 

● Some of the Avaya IC services do not start on page 299 

● The popup for a new outbound mail is not shown when the agent presses the ‘Send email’ 
button on the Siebel toolbar on page 286 

● Workflow server crashes when transcriptadded_sbl.qfd workflow processes huge chat 
transcript on page 288 

 

 

A reply cannot be sent with the Outbound Message applet right 
after a new email popped up 

When a Siebel agent receives a new e-mail which popped up, it is impossible to send a reply 
immediately as the Outbound Message applet is in the read only state and cannot be updated with 
the reply message. 

 
Remedy 1 

1. Go to Communications screen > Communications List. 

2. Find the e-mail which previously popped up in any list. 

3. Select the e-mail and press the ‘Reply’ button. 

4. Enter a reply message in the opened view. 

 
Remedy 2 

1. Log into the Siebel as a user with administration privileges. 

2. Go to Navigation > Site Map > Administration - Communications > All Event Responses 

3. Search for the Event Response with Name = OnNewWorkItem_WithEmailActivityID 

4. Change the following parameter values on the Event Response Parameter tab: 

QueryBusComp - replace "Action" with "Comm Outbound Email" 
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SingleView - replace "Communication Detail - Response View" with "Communication Detail 
View" 

 

The OnNewWorkItem_EmailActivityID_contactid Event Response also uses the “Communication 
Detail - Response View” and thus should be changed the same way. 

 

 

ASIS fails to start 

For Native Siebel configurations, use the following remedies if ASIS fails to start. 

 
Remedy 1 

You can start ASIS from the cmd prompt if you cannot start from IC Manager. 

1. Ensure that no instance of jloader runs by performing the following steps: 

a. Go to Windows Task Manager > Processes and see if the jloader.exe is running. 

b. If this executable is running, end the process. 

2. Go to the directory where the jloader is located. 

 

Windows environments UNIX environments (Solaris or AIX) 

AVAYA_IC73_HOME\bin /opt/Avaya/73/bin 

3. Start jloader using the following command: 

jloader <asis uuid> 

To get the ASIS UUID, go to IC Manager and double-click ASIS server > Advance Tab > 

Server Status. 

 
Remedy 2 

To start ASIS from IC Manager, you must add the java.class.path using the ASIS server 

configuration tab. 

For more information, see Adding ASIS to IC Manager on page 163. 

 

 

Avaya Agent Rich Client (AARC) fails to open Internet Explorer: 
"WebBrowser_GetDocument error -2147467259: Application-
defined or object-defined error" is displayed (Hybrid Siebel only) 

In the hybrid mode, when you have set the AutoLoginEnabled property as Yes in IC Manager 
using group manager from the Agent/Desktop/Siebel path, AARC fails to open Internet Explorer, 
displaying the error "WebBrowser_GetDocument error -2147467259. This is an application-defined 
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or object-defined error". This occurs when UAC is enabled on the system, and a standard Windows 
user without administrator privileges (due to security policy) tries to launch AARC. In this situation, 
AARC cannot be set to run as an administrator, because UAC is displayed requesting the user to 
specify administrator credentials, which (as a rule) are not known by a Standard user. 

Remedy 

1. Log in to the system as an administrator and perform Steps 2-3 

2. Make sure AARC is not set to run as an administrator: 

• Right-click the qui.exe file in the AARC and select Properties. 

• Click the Compatibility tab. 

• Click Change settings for all users. 

• On the Compatibility for all users dialog box, in the Privilege Level section, unset 
Run this program as an administrator. 

• Click OK. 

• Click OK. 

3. Set the security settings to Full Control for the AARC installation folder: 

• Right-click the AARC installation folder (e.g. C:\Avaya\RichClient) and select 
Properties. 

• Click the Security tab. 

• To change permissions click Edit. 

• The system displays the Permissions for the AARC installation folder dialog box. 

• In the Group or user names section, click Add. 

• In the Enter the object names to select text field, type the name of the Standard 
user. 

• Click OK. 

• In the Group or user names section, select the name of the Standard user. 

• In the Full control row, click Allow. 

• Click Apply. 

• Click OK. 

• Click OK. 

4. Log in to the system as the Standard user and perform Steps 5-6. 

5. Add the Siebel URL to Trusted sites zone in Internet Explorer: 

• Launch Internet Explorer. 

• Open the Internet Options dialog box. 

• Click the Security tab. 

• Select Trusted sites zone and click Sites. 
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• On the Trusted sites dialog box, in the Add this website to the zone text box, type 
the Siebel URL. 

• Click Add. 

• Click Close. 

• Click OK. 

• Close Internet Explorer. 

6. Edit the Windows Registry: 

• Open Windows Registry Editor: press Win+R, type regedit and click OK. 

• Option 1 (recommended). Enable Protected Mode for both Trusted sites and Internet 
zones: 

- Open 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Inter
net Settings\Zones\2 registry key and set the value of DWORD 2500 to 0 to 
enable Protected Mode for Trusted sites zone (add DWORD 2500, if it 
does not exist). 

- Open 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Inter
net Settings\Zones\3 registry key and set the value of DWORD 2500 to 0 to 
enable Protected Mode for Internet zone (add DWORD 2500, if it does not 
exist). 

• Option 2 (not recommended). Disable Protected Mode for both Trusted sites and Internet 
zones: 

- Open 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Inter
net Settings\Zones\2 registry key and set the value of DWORD 2500 to 3 to 
disable Protected Mode for Trusted sites zone (add DWORD 2500, if it 
does not exist). 

- Open 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Inter
net Settings\Zones\3 registry key and set the value of DWORD 2500 to 3 to 
disable Protected Mode for Internet zone (add DWORD 2500, if it does not 
exist). 

• Close Windows Registry Editor. 

 
 

 

Avaya Agent taskbar fails 

This section applies only to Hybrid Siebel configurations. 

One of the following events occurs if the Avaya Agent taskbar software fails: 

● The Siebel login window takes up the entire screen and the Avaya Agent taskbar does not 

appear. 

● Avaya IC stops processing new or existing work for an agent. 
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Agents can continue to work using only the Siebel window, but Avaya IC does not track the 

work. To resynchronize Avaya IC with Siebel, the agent has to start another Avaya Agent 

session and Siebel session. The new Siebel session overrides the old Siebel session. 

 

Remedy 1 

1. Minimize the browser window and you look for a message box that might contain one of 
the following messages: 

● Invalid state 

● Link is Down 

● Your configuration has changed 

2. Click the retry button to try the login again. Selecting your login information again is not 

necessary. 

 

Remedy 2 

1. Close the internet browser window. 

2. Verify that your telephone is not off the hook, and that you have no active calls. 

3. Log out of the telephone if you are using Softphone. 

4. Log in to Avaya Agent and Siebel. 

 
Remedy 3 

1. Use the ping command to determine connectivity to Avaya IC servers. 

2. When connectivity to the other servers is established, log in to Avaya Agent and the Siebel 

thin client. 
 
 

 

All buttons on the Siebel toolbar are disabled 

The Siebel toolbar becomes inactive when Siebel cannot successfully load the Adaptive 

Interaction Center Driver (AICD) or the AICD instance fails. All agents who were getting toolbar 

support through the failed AICD cannot use the Siebel toolbar. Any requests that display a 

Siebel window or process a Siebel toolbar command stop functioning. Agents can continue to 

use the Siebel windows to complete data entry, but this work is not tracked by Avaya IC. 

 

Remedy 1 

Have the agent log out of Siebel and log back in. 

 
Remedy 2 

The AICD might not be able to communicate with the Avaya IC servers because the vesp.imp 

file on the Siebel server contains old Avaya IC server or old Avaya IC domain information. 

1. Update the copy of the <AVAYA_IC73_HOME>/etc/vesp.imp file on each Siebel 

Communications Server that runs the AICD. Use Avaya IC Manager to force the update of 

all ORB servers by selecting Manager > Update All. This propagates all server additions, 
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deletions, and changes to the Avaya IC ORB servers. 

2. Restart the AICD. Use the Siebel Server Administration screens to shut down, then start 
the Siebel Communications Server that is running the AICD. 

3. Log the agent into Siebel. This loads the AICD with the newest vesp.imp file. 

 
Remedy 3 

1. Relaunch the Siebel thin client, and carefully monitor the Siebel Message Area for 
messages. 

The Siebel Message Area is located above the Siebel toolbar. Messages sometimes 
appear for only 5 seconds, so watch carefully. 

2. If you see the following message: 
 

Follow the procedures in Diagnosing and clearing AICD loading problems on page 286. 

This procedure provides an ordered approach to troubleshoot AICD loading problems. 

 

Remedy 4 

Enable Siebel Communications Server logging. Siebel provides information on how to enable 

Communications Server Logging on the support website. With logging enabled, you can use the 

Siebel log files to find where a problem might have occurred and determine how to fix the 

problem. 
 

Remedy 5 (Hybrid Siebel only) 

You might have logged into Siebel and Avaya IC with different agent login IDs. The login IDs 

must be identical. Although the character case of the Siebel login ID might be different, the 

character case of the Avaya Agent login ID must all be in lowercase. 

1. Log the agent out of Siebel. 

2. Check the Avaya Agent login ID using the Avaya Agent taskbar feature, About Avaya 

Agent. 

3. Log the agent into Siebel using a correct agent login id. You might have to account for 
Agent Login ID case differences for Siebel. 

4. Ensure that the Avaya Agent login ID does not have any uppercase characters. 

 
Related topic 

For more information about agent login IDs, see Avaya IC for Siebel User Guide. 
 

 

Diagnosing and clearing AICD loading problems 

Configuration dependencies that must be fulfilled before Siebel can load the AICD exist. 

Normally, Siebel loads the AICD when the first Siebel agent logs into Siebel. However, there 

might be AICD, Siebel, and OS platform configuration issues that prevent the AICD from being 

Unable to load aicd with Media Type String = Avaya 
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loaded. When these configuration problems are settled, the AICD operates smoothly. 

This section includes the following topics: 

● For Solaris, AIX, or Linux platforms on page 286 

● For Windows platforms on page 290 

 
For Solaris, AIX, or Linux platforms 

To troubleshoot and fix configuration issues on a Solaris, AIX, or Linux platform: 

1. Check the dependent library files: 

a. Look for the libmttlogger.so and libmttoolkit.so files in your <AVAYA_IC7x_HOME>/ 

lib directory on the Siebel Server. 

These files must be present on the Siebel Server when you install the secondary ORB 

on Siebel Server. 

b. Look for the libaicd.so file in your <SIEBEL_HOME>/lib directory on the Siebel 

Server. 

This file must be put on the Siebel Server when you install the Siebel side Avaya IC 

components on your Siebel Server. 

c. All Avaya IC executable files, that is, libmttloggger.so, libmttoolkit.so, libaicd.so 

must be present on the Siebel Server for the AICD to load. 

2. Check that the Siebel environment file, siebenv.sh, has the correct settings: 

a. Look for the siebenv.sh file in the <SIEBEL_HOME> directory or located in a different 

directory if you have customized your Siebel installation. 

b. Ensure that siebenv.sh has the correct path of Avaya IC home directory and the library 
path. See the following section where /opt/Avaya/IC73 is the path in which Avaya 

IC secondary ORB is installed. 

● For Solaris: 
 

● For AIX: 
 

 
Note: 

These settings must be adapted for your Siebel Server environment. 

 
Important: 

Ensure that no extra spaces nor other extra characters in the path including 
immediately before or after the ; separator is there. 

3. Check your current environment with the following statements on the UNIX command line 

! 

AVAYA_IC73_HOME=/opt/Avaya/IC73 ; export AVAYA_IC73_HOME 

 

LD_LIBRARY_PATH=${AVAYA_IC73_HOME}/lib:${LD_LIBRARY_PATH} ; export LD_LIBRARY_PATH 

AVAYA_IC73_HOME=/opt/Avaya/IC73 ; export AVAYA_IC73_HOME 

LIBPATH=${AVAYA_IC73_HOME}/lib:${LIBPATH} ; export LIBPATH 
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before starting Siebel. 

 

Solaris AIX 

set | grep AVAYA_IC73_HOME 

set | grep LD_LIBRARY_PATH 

set | grep AVAYA_IC73_HOME 

set | grep LIBPATH 

Checking your environment is often worth because of conditional statements in your Siebel 
environment file. 

4. Ensure that the AICD library file, libaicd.so, is in the Siebel lib directory. 

● Use the following command to verify that the file has UNIX file execute permissions: 

ls -l libaicd.so 

● If you must add the file execute permissions, use the following command: 

chmod +x libaicd.so 

 

5. Ensure the AICD server was correctly configured using IC Manager. Check the following 

items under the Avaya IC Manager Server tab. 

 

Field Description 

AICD Server 
Type 

SiebelAICD 

Host Ensure that this value is the IP address of the Siebel Server that runs the 
AICD. 

Port Ensure that the port number does not conflict with an existing TCP/IP port 
on the Siebel Server. See Step 7. 

Directory and 
Executable 

These settings do not matter because the AICD is loaded by Siebel and 
not by the Avaya IC ORB Server. However, you must select a valid 
directory name to satisfy IC Manager. 

Domain The preferred Avaya IC domain is one of the Avaya IC Agent domains or 
the default domain. 

For more information, see Avaya IC domain deployment guidelines on 
page 50. 

6. Ensure that the vesp.imp file on your Siebel Server is current. 

On UNIX, this file is located under ${AVAYA_IC73_HOME}/etc. 

If the IC ORB Server is installed and running on your Siebel Server, you can do one of the 

following tasks to force the update: 

● Use Update All on IC Manager. 

● Copy the vesp.imp file from your Avaya IC server to your Siebel Server. 

7. Ensure the TCP/IP port for the AICD on the Siebel Server does not conflict with another 
application on the Siebel Server. 
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Do one of the following tasks to detect a port conflict: 

● Go to the Siebel Server and view the SiebelAICD.log file under directory, 

<AVAYA_IC73_HOME>/logs. If you see the following message in the AICD log file, 
you have a port conflict. 

 

● View the ports in use on your Siebel Server by using the following command: 

netstat -a 

If the netstat results show that the TCP/IP port number assigned to the AICD using 

Avaya IC Manager is in use, a port conflict is likely. 

8. If you have a TCP/IP port conflict, use Avaya IC Manager to change the TCP/IP port. In IC 

Manager you cannot directly change the port setting. If you change the AICD Server port 

assignment, first delete the old IC Manager AICD Server and create a new server of type 

SiebelAICD. 

Make the same IC Manager changes on all servers. Use Update All on IC Manager. 

For more information, see Creating a Siebel AICD server on page 144. 

9. Check the status of the Avaya IC servers using Avaya IC Manager. 

The AICD and Avaya Agent depend on a running Avaya IC system. If the Avaya IC is not 
running, the AICD does not start. 

10. Look for the following log file: 

<AVAYA_IC73_HOME>/logs/SiebelAICD.log 

11. If your Siebel Server contains more than one network board, you must provide additional 

AICD configuration information. Perform the following steps: 

a. Look for the following message in the log file: 
 

b. If you see this message, your Siebel Server contains more than one network board 

and you must define the AICD parameter, ServerUUID. 

For more information, see AICD driver parameters on page 421. 

12. Perform the following steps to ensure that the Siebel agent login name is associated with 

the AICD, and the Siebel agent is assigned to a teleset: 

a. Login to Siebel as SADMIN and navigate to the Siebel Communications 

Administration screen. 

b. Under All Configurations, check that the Siebel login name for the agent is 
associated with the AICD configuration. 

c. Select the AICD configuration, and select the Agents tab. The agent name must be 

listed here. 

d. Navigate to All Telesets and check that the agent is assigned a teleset. 

Cannot get port XXXX - is this server already running? 

Cannot login() to eContact. ServerUUID = and ORBServerUUID = and ORBServer UUID= 

Check the vesp.imp file on this server and the Siebel Driver Configuration. 
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The AICD does not use this teleset information, but Siebel checks for a teleset. You 

need only one teleset extension for all Avaya IC agents. All AICD agents might be 

assigned to the same teleset extension - extension type S. 

13. The configured user for Siebel must have Write permissions for directories and files under 

<AVAYA_IC_HOME> directory. Best practice is to have both Siebel and IC installed by 

same user account. 

14. Your AICD must now be able to start and be able to log any remaining problems in the 

AICD log files. Examine the AICD log file for any further errors and warnings. 

For more information about log files, see Log files on page 277. 

For Windows platforms 

To troubleshoot and fix configuration issues on a Windows platform: 

1. Look for the mttlogger.dll and mttoolkit.dll files in your <AVAYA_IC73_HOME>\bin 

directory on the Siebel Server. 

These Avaya IC executable files must be present on the Siebel Server for the AICD to 

load. These files must be put on the Siebel Server when you installed the Avaya IC 

components. 

2. Check your Windows system environment variables by doing the following steps: 

a. Navigate to Start > Settings > Control Panel > System. 

b. Select the Advanced tab. 

c. Click Environment Variables. 

d. Ensure the following system variables are set correctly. 

 

System variable 

name 

System variable value 

AVAYA_IC73_HOME Ensure that this value is the Windows directory path to where Avaya 
IC was installed. 

Example: c:\AvayaIC73. 

Path Ensure that the path contains an entry similar to the one as follows: 

%AVAYA_IC73_HOME%\bin 

Use ; to separate the entries. 

IMPORTANT: Ensure no extra spaces nor other extra characters in 
the path including immediately before or after the ; separator are put. 

 
CAUTION: 

Restarted a server is service affecting. Follow your company procedures for 
restarting a server. 

e. If you changed any system variable settings, restart your server for the new settings to 

take effect for all processes on your Siebel Server. 

f. Open a command prompt window to check your current environment. 
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g. Open a Windows command prompt, enter the following statements, and examine the 

output to ensure that your environment is correctly set: 

set AVAYA_IC73_HOME 

set PATH 

Checking the previous statements if you have accidently altered your current 
environment is often worth. 

 
3. Ensure that the AICD executable file, aicd.dll, is in the Siebel bin directory. 

This file must be installed on your Siebel Server when you installed the Avaya IC Siebel 
integration. 

4. Ensure the AICD server was correctly configured using IC Manager. Check the following 

items under the Avaya IC Manager Server tab. 

 

Field Description 

AICD Server 
Type 

SiebelAICD 

Host Ensure that this value is the IP address of the Siebel Server that runs the 
AICD. 

Port Ensure that the port number does not conflict with an existing TCP/IP port on 
the Siebel Server. See Step 7. 

Directory 
and 
Executable 

These settings do not matter because the AICD is loaded by Siebel and not by 
the Avaya IC ORB Server. However, you must select a valid directory name to 
satisfy IC Manager. 

Domain The preferred Avaya IC domain is one of the Avaya IC Agent domains or the 
default domain. 

For more information, see Avaya IC domain deployment guidelines on 
page 50. 

5. Ensure that the vesp.imp file on your Siebel Server is current. On Windows, this file is 

located under ${AVAYA_IC73_HOME}\etc. 

If the IC ORB Server is installed and running on your Siebel Server, you can do one of the 

following tasks to force the update: 

● Use Update All on IC Manager. 

● Copy the vesp.imp file from your Avaya IC server to your Siebel Server. 

6. Ensure the TCP/IP port for the AICD on the Siebel Server does not conflict with another 

application on the Siebel Server. 

Do one of the following tasks to detect a port conflict: 

● Go to the Siebel Server and view the SiebelAICD.log file under directory, 

<AVAYA_IC73_HOME>\log. If you see the following message in the AICD log file, you 
have a port conflict. 

 

Cannot get port XXXX - is this server already running? 
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● View the ports in use on your Siebel Server by using the following command: 

netstat -a 

If the netstat results show that the TCP/IP port number assigned to the AICD using 

Avaya IC Manager is in use, a port conflict is likely. 

7. If you have a TCP/IP port conflict, use Avaya IC Manager to change the TCP/IP port. With 

IC Manager you cannot directly change the Port setting. If you change the AICD Server 

port assignment, first delete the old IC Manager AICD Server and create a new server of 

type SiebelAICD. 

Make the same IC Manager changes on all servers. Use Update All on IC Manager. 

For more information, see Creating a Siebel AICD server on page 144. 

8. Check the status of the Avaya IC servers using Avaya IC Manager. 

The AICD and Avaya Agent depend on a running Avaya IC system. If Avaya IC is not 

running, the AICD does not start. 

9. Check if the AICD can log in to Avaya IC by doing the following steps: 

a. Look for the following log file: 

<AVAYA_IC73_HOME>\logs\SiebelAICD.log 

b. Look for the following message in the log file: 
 

c. If you see this message, your Siebel Server contains more than one network board 
and you must define the AICD parameter, ServerUUID. 

For more information, see AICD driver parameters on page 421. 

10. Check the Siebel configuration for the AICD by doing the following steps: 

a. Login to Siebel as SADMIN and navigate to the Siebel Communications 

Administration screen. 

b. Under All Configurations, check that the Siebel login name for the agent is 

associated with the AICD configuration. 

11. Select the AICD configuration, and select the Agents tab. The agent name must be listed 
here. 

12. Navigate to All Telesets and check that the agent is assigned a teleset. 

The AICD does not use this the teleset information, but Siebel checks for a teleset. You 

need only one teleset extension for all Avaya IC agents. All AICD agents might be 

assigned to the same teleset extension - extension type S. 

 
13. Your AICD must now be able to start and be able to log any remaining problems in the 

AICD log files. Examine the AICD log file for any further errors and warnings. 

For more information about log files, see Log files on page 277. 

Cannot login() to eContact. ServerUUID = and ORBServerUUID = and ORBServer 

UUID= Check the vesp.imp file on this server and the Siebel Driver 

Configuration. 
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Directory Server SSL Handshake Error (Initialize/Connect Failed) 

on AIX Platform 

1. Ensure that the OpenSSL library version is upgraded to 1.0.x. 

2. Ensure that IC SSL/TLS enabled severs have the TLSProtocol set to TLSv1.0 or later. The 

IC SSL/TLS enabled severs such as Directory Server (DS) and HTTPConnector Server 

now accept only TLSv1.0 or later during TLS handshake. 

3. Ensure that IC SSL/TLS clients have the TLSProtocol set to TLSv1.0 or later. IC SSL/TLS 
clients, for example, AARC, AAWC now use TLSv1.0 or later during TLS handshake. 

4. To enable a client from an older version of IC (IC 7.3.3 and IC 7.3.4) to communicate with 

an upgraded 7.3.5 DS for 'Login' or 'Authenticate' requests during upgrade scenarios, you 

must set the new hidden configuration parameters TLSProtocol and CipherList as follows: 

a. Login to IC Manager with Admin privileges. 

b. Edit the DS. 

c. Go to the Configuration tab. 

d. Click New to open the 'CTI Type Editor'. 

e. Provide the values for this new couple as: 

● TLSProtocol: TLS 1.0 

● CipherList: 

ALL:!aNULL:!eNULL:!ADH:!EXP:!MD5:!RC4:+HIGH:+MEDIUM:-LOW:-SSLv2 

f. Click OK. 

g. Click OK in the DS Editor. 

h. Restart the DS in IC Manager. 

i. Repeat steps a to h for all DSs configured in the IC system. 

 
Important: 

Note the following important points: 

● You must upgrade atleast one IC Manager system to release 7.3.5 before you 

configure the TLSProtocol and CipherList parameters are mentioned in this 

procedure. 

● You must remove the added parameters when ALL the clients are upgraded to IC 

7.3.5. 

● Remove the allow_sslv3 configuration parameter after IC is upgraded to 7.3.5. The 

allow_sslv3 parameter is obsolete and is used only in pre IC7.3.5 configurations. 

● Versions of IC Clients such as AARC, that are prior to 7.3.3 FP will not work with 

IC release 7.3.5. 
 
 

! 
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EAI server errors 

The Enterprise Application Integration (EAI) server provides different tools that can be used for 

troubleshooting. The EAI server can: 

● Create alarms for fatal errors with Siebel connectivity or errors returned from Siebel using 
the Alarm server. Any error information provided by Siebel is stored in the Siebel server 

log file, not the Alarm server. 

● Support a server log file for improved diagnostics. 

 
How the EAI server indicates errors 

The EAI server indicates errors using the following different methods: 

● Generates alarms to the alarm server based on the current condition. These errors are 

usually saved for severe errors such as connectivity problems or fatal server errors. 

● Returns a code at the completion of each task. The calling workflow determines if there 

was an error and what that error was by this code. If available, the EAI server returns a text 

string that provides a detailed description of the problem. 

● Maintains a complete and comprehensive log of all work within. This log is named after the 
alias name of the server. This logging functionality follows all the standard conventions for 

interaction servers. 
 

 

EAI server cannot read a file attachment 

When adding a file attachment, you can run into permission problems if the workflow is trying to 
attach a file that exists on a different machine. The filename is passed to the EAI server as a 

Universal Naming Convention (UNC) filename. If the EAI server cannot read the file, the Put 

Data block returns an error code of 2, and an alarm is raised stating that the EAI server was 

unable to read the file. This error is caused by permission issues between the remote machine 

and the user account that started the EAI server. By default, when the ORB Server starts the 

EAI server, the EAI server inherits the user account and the permissions from the ORB server. 

 

Remedy 

1. Start the Avaya IC ORB service using a Windows domain account that has permission to 
view the remote directory. 

2. If the permission is not possible, map the remote directory to a driver letter on the local 

machine. Use the fully qualified domain name of the remote machine. Example: 

machine.usae.avaya.com/share/filename and not machine/share/filename or ipaddress/ 

share/filename. 

To avoid this situation, always find file attachments on the same machine as the EAI server. 
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EAI Server fails to start with the error “TrustAnchor with subject 
"CN=<FQDN>" is not a CA certificate” 

 

Remedy 

1. Open %AVAYA_IC73_HOME%\Java\lib\security\java.security in a text editor 

on the machine hosting the EAI server. 

2. Uncomment the following line: 

#jdk.security.allowNonCaAnchor=true 

3. Save and close the java.security file. 

4. Start the EAI server. 
 

 

EAI.PutData fails with error 2  

If Siebel 17.0 or some newer version is used, EAI.PutData can fail with error 2. This happens 

because of the issue in Apache used by Siebel: sometimes it returns the truncated response. 

As a result, IC EAI server is not able to parse it. 

 

Remedy 

Oracle support recommends installing the latest Siebel patchset or at least version 19.6, 

where this issue is not present. 

 

 

EDU information is lost 

Avaya IC telephony supports the tracking of calls when calls are transferred between Avaya IC 

agents. If a call is transferred from an Avaya IC agent to a non-Avaya IC agent telephone, 

Avaya IC stops tracking the call and retires the EDU. If this call is later transferred to an Avaya 

IC agent, the call seems to be a new call and a new EDU is created. 

Note: 
The original EDU information that provided the Siebel screen pop to the first 

Avaya IC agent is retired and not available when the call is transferred from the 

non-Avaya IC agent telephone. 
 

 

Media channels are not enabled 

For Native Siebel integrations, if the media channels are not enabled, look in the Avaya IC log 
file for any of the following error messages: 
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|ERROR|com.avaya.ic.uom.core.persistence.FileHandler|agent10|||initPath(): Specified 

Agent.Desktop.Webclient.WorkingDirectory ICManager [<change-me>] is inaccessible or is 

not writable, path that will be used: [../working_dir] 

 
|ERROR|com.avaya.ic.uom.core.persistence.FileHandler|agent10|||Please check property 

Agent.Desktop.Webclient.WorkingDirectory. Shared root file: C:\Avaya\IC73\etc\ 

<change-me> is not accessible. 

 
|ERROR|alarm.logging.aspect|Agent.Desktop.WebClient.WorkingDirectory setting [C:\ 

Avaya\IC73\etc\<change-me>] for agent10 is not accessible/writable. Chat/Email 

channels will be disabled. Defaulting to [../working_dir] for Data storage 

 
 

Remedy 

 
From IC Manager, go to Tools > Groups and set the Agent/Desktop/WebClient - 

WorkingDirectory property to where your Avaya IC is installed. 

 

Windows environments UNIX environments (Solaris or AIX) 

Example: 

C:\Avaya\IC73\working_dir 

Example: 

/opt/Avaya/IC73/working_dir 

Ensure that the working_dir folder has write permission. 
 

 

Replacing English with Thai text in toolbar 

If your system is translated into Thai, you might get a mixture of English and Thai in the toolbar. 

This mixture happens because Siebel does not currently support a language pack for Thai. If 

Thai language support for the toolbar is needed, install Siebel in English, or another 

Siebel-supported language, and configure Avaya IC for Thai. You must now modify the toolbar 

so that the agent sees only Thai text in the tool tips. 

Note: 
Windows and Solaris operating systems only supports Thai. 

 
Modifying tool tip text for disabled buttons 

 

Important: 

Test all changes to the Siebel object repository in a non production environment 

before deploying them in your production environment. Create a backup copy of 

the Siebel server object repository before making any changes using Siebel 

Tools. 

For more information, see Working with Siebel Tools on page 127. 

To modify the tool tip text for disabled buttons: 

1. Log in to Siebel Tools. 

! 
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2. In the Object Explorer navigation pane, select Toolbar. 

The Object Explorer navigation pane is located in the upper-left corner of the window. 

If you do not see the Toolbar object, enable it in View > Options > Object Explorer. 

3. Navigate to Toolbar > Communication > Toolbar Item. 

4. Modify the tool tip text by selecting one of the following toolbar items: 

● Accepting Work 

● Release Work 

● Retrieve Work 

● Hold Work 

● Resume Work 

● Forward Work 

● SignOff 

● InQueue Time 

5. In the command associated with that toolbar item, navigate to the Tooltip Text property 

and modify the text. 

Note: 
For InQueue Time, change the Dynamic Tooltip value to FALSE. 

6. Stop the Siebel Server. 

7. Compile the SRF. 

8. Start the Siebel Server. 

 
Modifying tool tip text for enabled buttons 

The tool tip specified in Siebel Tools is only visible for disabled buttons. The tool tip text for the 

enabled messages are derived either from the command parameter descriptions in the Siebel 

definition file, or from defaults provided by the AICD. The latter are changeable by editing the 

applicable AICDStrings.txt file that was installed with the AICD. 

To modify the tool tip text for enabled buttons: 

1. Decide where your tool tip text must be located. 

● In the command descriptions of the Siebel definition file 

● In the defaults provided by the AICD 

2. Open the file and modify the text in one of the following files: 

● AICD definition file. Modify the command descriptions. 

● AICDStrings.txt file. Modify the out-of-the-box file that was installed with the AICD. 

3. Import the new AICD definition file or you can restart one of the following files: 

● AICD definition file. Re-import the AICD definition file into Siebel. 

● AICDStrings.txt file. Shutdown and restart the Siebel Comm. Session Manager to 
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reload the AICD and have it reread the AICDStrings.txt file. 
 
 

 

Siebel GUI is unresponsive 

Sometimes the Siebel GUI is unresponsive after the agent selects the Reply, Reply All, or 

Forward buttons. When these buttons are selected, Siebel invokes the eMail Response - 

Response Workflow. Siebel becomes unresponsive at the Expand Template step. When this 

happens, you must restart the Siebel GUI. 

Contact Siebel support if you need help troubleshooting this workflow. 
 

 

Siebel toolbar is not visible 

If your Hybrid Siebel or Native Siebel toolbar is not visible, use the following remedy. 

 
Remedy 

1. In the Siebel Application window, go to Navigate > Communications > Reset Active 
Session Count. 

Note: 
You can also press Ctrl+F8 

2. Have the agent log out of Siebel and log back in. 
 

 

Softphone stops responding 

Softphone might not be able to perform a telephone operation or it might appear to be locked up 

for a certain length of time. If you use both your physical telephone and Softphone, the problem 

might be that your Softphone and your physical telephone are set differently. 

 

Remedy 1 (for both Hybrid and Native Siebel) 

Ask your administrator to confirm that the preset state settings for your physical telephone and 

Softphone are identical. 

 

Remedy 2 (for Hybrid Siebel) 

Synchronize the connection between Softphone and your physical telephone. 

1. If you are in a voice contact, complete your voice contact with the physical telephone. 

2. Set your agent state to Unavailable. 

Note: 
The Softphone - Reset option clears all current activity from the Softphone and 

ends all calls. You must complete Steps 1 and 2 before using Softphone - Reset. 
 

3. Right-click in an empty part of the Avaya Agent. 
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4. In the pop-up menu, click Softphone - Reset. 

5. Click OK. 

6. If this does not resolve the problem, contact your administrator. 

 
Remedy 2 (for Native Siebel) 

Synchronize the connection between Softphone and your physical telephone. 

1. If you are in a voice contact, complete your voice contact with the physical telephone. 

2. Set your agent state to Unavailable. 

3. From the Siebel menu, run the Reset Voice Channel command. If this command is not in 

the Siebel menu, you must configure Siebel appropriately using the out-of-the-box 

AICD.def file. 

4. If this does not resolve the problem, contact your administrator. 
 

 

Some of the Avaya IC services do not start 

You cannot start or stop the AICD using Interaction Center (IC) Manager. These components 

are started and stopped only by Siebel. Siebel starts the AICD on the first agent login. Siebel 

stops the AICD when the Siebel Communications Session Manager is shutdown. 

 

Native Siebel remedy 

For Native Siebel, if the ASIS server fails to start, verify the following steps: 

1. Under the ASIS tab, verify the password for the avaya.ic.sysuser.pwd property. 

2. Under the configuration tab, verify that the avaya.ic.webclient.url parameter is set to: 

http://127.0.0.1 

 

 

 

 

The popup for a new outbound mail is not shown when the agent 

presses the ‘Send email’ button on the Siebel toolbar 

When a Siebel agent receives a new contact, handles it and then presses the ‘Send 

email’ button there can be a situation that the new outbound email popup is not shown or 

the ‘Method ShowPopup is not allowed here’ error is shown by Siebel. 

This issue happens because the focus on an applet is lost or it is currently on an applet 

which is in the read only state. 

 

Remedy 1 

The agent manually clicks on any Siebel applet to make it be in focus. 
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Remedy 2 

Do not call the "Persistent Customer Dashboard" Business Service from Siebel event 
logs. 

If this workaround is applied, the Customer Dashboard will not be cleaned or updated 
with the information when an email or a chat is received to allow the user to use the 
‘Send email’ button. If the Customer Dashboard is not used, this is a suitable 
workaround. 

The steps below show how to avoid the issue during the Chat scenario: 

1. Log into the Siebel as a user with administration privileges. 

2. Go to Navigation > Site Map > Administration - Communications > All Event Logs 

3. Search for the Event Log with Name = 
OnNewWorkItem_LogWebCollabWorkStarted 

4. Remove the ServiceMethod parameter with Value = "Persistent Customer 
Dashboard.CleanDashBoard_UI" 

5. Press Ctrl + S to save the changes. 

6. Go to Navigation > Site Map > Administration - Communications > All Event 
Responses 

7. Search for the Event Response with Name = OnNewWorkItem_activityid 

8. Go to the Associated Event Logs tab and remove the Event Log association. That 
is, delete the record with Name = LogCleanDashBoard_UI 

9. Press Ctrl + S to save the changes. 

 

Steps similar to steps 3 - 5 need to be performed for other Event Logs which use the 
"Persistent Customer Dashboard" Business Service, for example: 

• LogOutboundCallContactFound_OutboundCallNumber 

• LogOutboundCallContactNotFound_OutboundCallNumber 

• LogOutboundCallMultiContactFound_OutboundCallNumber 

• LogIncomingCallContactFound_PrimaryANI 

• LogIncomingCallContactNotFound_PrimaryANI 

• LogIncomingCallMultiContactFound_PrimaryANI 

• LogUpdateDashboardFromCTI_contactid 

 

The steps below show how to avoid the issue during the Email scenario: 

1. Log into the Siebel as a user with administration privileges. 

2. Go to Navigation > Site Map > Administration - Communications > All Event 
Responses 

3. Search for the Event Response with Name = 
OnNewWorkItem_WithEmailActivityID 
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4. Go to the Associated Event Logs tab and remove the record with Name = 
LogCleanDashBoard_UI 

5. Press Ctrl + S to save the changes. 

 

Steps similar to steps 3 - 5 need to be performed for other Event Responses which have 
LogCleanDashBoard_UI in their Associated Event Logs. 

 

 

Workflow server crashes when transcriptadded_sbl.qfd workflow 

processes huge chat transcript 

The Workflow server crashes when transcriptadded_sbl.qfd workflow is processing a chat 

transcript of length greater than 32000 bytes. 

 

Remedy 1 

1. Take a backup copy of <AVAYA_IC73_HOME>\design\IC\Flows\Siebel\ICM\ 

transcriptadded_sbl.qfd workflow. 

2. Open <AVAYA_IC73_HOME>\design\IC\Flows\Siebel\ICM\icm_sbl.prj in Avaya Workflow 

Designer and then open transcriptadded_sbl.qfd workflow. 

3. Choose Process Transcript block on the flow. 

4. In the Property Sheet, click the Advanced tab. 

5. Select GenericCode from the drop-down list. 

6. In the Start Property, click ProcessTranscript. 

7. Click Yes for the warning message. 

The system displays IC Script Editor. 

8. Locate the following line in the script: 

nReturn = iXMLTransformer.TransformStringToFile(sTranscript, sXSLFileName, sOutputFile) 

9. Replace with the following lines: 

If len(sTranscript) > 0 AND len(sTranscript) < 32000 Then 

nReturn = iXMLTransformer.TransformStringToFile(sTranscript, sXSLFileName, 

sOutputFile) 

End If 

10. Click Compile and then OK. 

11. Click OK again to close the IC Script Editor window. 

12. On the menu, click File > Save All. 

13. Click Build > Build Flow Set. 

Reload the updated workflow to Workflow server using Avaya IC Manager. 
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Important: 

Use this chapter only if you have a Native Siebel configuration. 

This section describes the integration components that you can customize for Native Siebel and 

includes the following topics: 

● Customizing Siebel AUX reason codes on page 302 

● Native Siebel agent properties on page 302 
 
 
 
 

Customizing Siebel AUX reason codes 

If you must prompt for AUX reason codes in Siebel using an applet and pass them to Avaya IC, 

customize the AICD.def file. You must also either build a custom Siebel reason code applet or 

you can use a predefined applet, such as the Transfer Multiple LOV Popup Applet. 

An AUX reason code can be passed from Siebel to Avaya IC using the Reason parameter to 
the AgentUnavailable of the AICD or ChangeAuxReasonCode driver commands. 

Out-of-the-box, the AICD.def file does not pass a Reason parameter on the AgentUnavailable 

command. However, the Siebel NotReadyWithPopup menu brings up the Siebel Transfer 

Multiple LOV Popup Applet and passes the selected Reason value to Avaya IC using the 

sReasonCode parameter in the ChangeAuxReasonCode command. 

You might also need to modify the AICD.def to associate the correct buttons and the menus with 
your Siebel reason code applet. 

 
 
 
 

Native Siebel agent properties 

The following tables list the Native Siebel integration properties. The properties are organized 
by property paths - for example, Admin/Agent. 

 
Related topic 

For more detailed conceptual information, see IC Administration Guide. 

! 
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This section includes the following topics: 

● Admin/Agent on page 303 

● Admin/Agent/Email on page 304 

● Admin/Agent/Voice on page 305 

● Admin/General on page 305 

● Admin/Server on page 306 

● Agent/Desktop on page 306 

● Agent/Desktop/Voice on page 308 

● Agent/Desktop/Email on page 309 

● Agent/Desktop/ScreenPop on page 309 

● Agent/Desktop/Webclient/ServiceConnections on page 309 

● Agent/Security on page 310 

● System/Configuration on page 310 
 

 

Admin/Agent 

The following table describes properties that are used for agent-related administrative 

properties. 

 

Property name Description 

EnableDisplayNameField Enables the Display Name field in the Agent Editor. You can 
use this field in a localized environment when IC Manager 
cannot reliably build the full name of an agent from the 
standard name fields. 

ForeignTextEntry Lets agents enter international text into certain server, agent, 
and DS Table configuration fields. 

TaskCeilingDefault Sets the default agent level task ceiling for a newly created 
agent. This value is used to restrict the task load value for an 
agent. 

TaskLoadDefault Sets the default agent level task load for a newly created 
agent. This value is used to restrict the total number of 
contacts that an agent can receive. 
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Property name Description 

EnableMonitor Enables IC Manager to monitor agent state changes. 

EnablePrefixSuffixVisible Enables the extended name fields prefix, suffix, and salutation 
in the Agent Editor. With EnableDisplayNameField, this 
property is used for localized environments if IC Manager 
cannot build this information from other fields in the system. If 
you enable this property, you might need to change the default 
IC Script. 

ForeignTextEntry Lets agents enter international text into certain server, agent, 
and DS Table configuration fields. 

TaskCeilingDefault Sets the default agent level task ceiling for a newly created 
agent. This value is used to restrict the task load value for an 
agent. 

TaskLoadDefault Sets the default agent level task load for a newly created 
agent. This value is used to restrict the total number of 
contacts that an agent can receive. 

 

 

Admin/Agent/Email 

The following table describes the properties used for the agent email channel. 

 

Property name Description 

ChannelEnabled Defines if a newly created agent must have access to the 
email channel. 

TaskCeilingDefault Sets the default agent level task ceiling for a newly created 
agent. This value is used to restrict the task load value for an 
agent. 

TaskLoadDefault Sets the default agent level task load for a newly created 
agent. This value is used to restrict the total number of 
contacts that an agent can receive. 
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Admin/Agent/Voice 

The following table describes the properties used for the agent voice channel. 

 

Property name Description 

ChannelEnabled Defines if a newly created agent must have access to the 
voice channel. 

TaskCeilingDefault Sets the default agent level task ceiling for a newly created 
agent. This value is used to restrict the task load value for an 
agent. 

TaskLoadDefault Sets the default agent level task load for a newly created 
agent. This value is used to restrict the total number of 
contacts that an agent can receive. 

 

 

Admin/General 

The following table describes the properties that you can use by the administration tool for 
configuration data. 

 

Property name Description 

CcqEnabled Enables or disables support for the CCQ database. Always 
set this property to No. 

ChatChannelEnabled Enables or disables chat channel support. Always set this 
property to No. 

EmailChannelEnabled Enables or disables email channel support. 

VoiceChannelEnabled Enables or disables voice channel support. 

mailto:infodev@avaya.com


293 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

August 2022 

Appendix A: Customizing Native Siebel 
 

 

 
 
 

 

Admin/Server 

The following table describes properties used for server administration. 

 

Property name Description 

EnableDebuggingDefault Enables or disables debug level logging for any server 
instantiated. 

EnableVoiceServerNotification Enables or disables voice server notification. 

 

 

Agent/Desktop 

 
The following table describes the properties that affect the behavior and appearance of the 

agent interface. 

 

Property name Description 

AllowVoiceTrailing Enables or disables Voice Trailing. Voice Trailing gives an 
agent the capability to work on nonvoice contacts and voice 
contacts simultaneously. Always set this property to Allow. 

AutoAvailableForInbound Sets the agent status so that the agent is always available for 
inbound work items. 

AuxGroup Sets the name of the AuxGroup used for returning the 
Auxiliary and Logout Reason codes for an agent. This 
property is used with AuxGroupTenant for locating the set of 
codes to load from the IC system. 

AuxLoginReasonCode Assigns the code when the agent is automatically put into 
Aux mode when logging in. 

AuxNotAvailableReasonCode Assigns the code when the agent is automatically put into 
Aux mode when not available. 

AuxReasonCodesEnabled Determines if reason codes are accepted during a call when 
the agent is unavailable. 

AuxReasonRequired Tells an agent that a reason is required when the agent goes 
into AuxWork mode. 

AuxRonaReasonCode Automatically assigns a code when the agent is put into Aux 
mode because of Redirection on No Answer (RONA). 
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Property name Description 

AuxWorkOnLogin Puts the agent in AuxWork mode when the agent logs in so 
that the agent does not receive any work items. 

BlendingMode Determines what type of blending is enabled at the agent 
desktop. Automatic mode sets the maximum number of 
allowable tasks for each channel that is set by the system, 
and any change an agent makes to the availability affects all 
channels. Always set this property to Auto. 

ChannelThrottleTime Sets the time between making channels available when an 
agent comes out of AuxWork mode. 

CheckAuxWorkOnLogout Verifies that the agent is in AuxWork mode before logging 
out. If the agent is not in AuxWork, the agent sees a warning 
dialog that describes potential problems when exiting without 
being in AuxWork. 

IntegratedApplication Determines which third-party application is integrated with 
Avaya IC. Always set this property to Siebel. 

LogoutReasonCodesEnabled Determines if reason codes are accepted when the agent is 
logging out. 

LogoutReasonRequired Tells the agent that a reason is required when the agent logs 
out of Avaya IC. 

MaxLoginRetryCount Determines the number of times the agent can try logging in 
to an Avaya IC component. 

MultimediaEnabled The agent can receive and start multimedia contacts. Always 
set this property to No. 

ReportServerName  
 
Ensures that the regular failover definition for an agent is 
used when an Avaya IC component must communicate with 
the Report server. If you have a business need to make 
agent requests go to a specific Report server, then enter the 
name of a specific Report server. 

ScreenPopEnabled Turns screen pops on and off for an agent. 

SystemAuxGroup Specifies the AuxGroup that contains the 
AuxLoginReasonCode and the 
AuxNotAvailableReasonCode. 

SystemAuxGroupTenant Specifies the tenant containing the SystemAuxGroup. 

VirtualQueueTransferFlow- 
Name 

Specifies the flow that is used by the system when an agent 
starts a collaboration with a Virtual Queue. Use caution when 
customizing this flow. 
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Property name Description 

WrapUpEnabled Turns wrap-up on and off. 

WrapUpType If wrap-up is enabled, determines the type of wrap-up. 
Always set this property to Siebel. 

 

 

Agent/Desktop/Voice 

The following table describes the properties that affect the behavior of telephone calls in the 

agent interface. 

 

Property name Description 

AutoAcceptACD The system can automatically accept Automatic Call 
Distribution (ACD) calls on arrival. This property is 
supported in the User Object Model (UOM). 

AutoAcceptDirect The system can automatically accept direct calls on 
arrival. This property is supported in the User Object 
Model (UOM). 

AutoIn Enables AutoIn behavior for the voice channel. When a 
call is disconnected, the agent is immediately available 
for the next call. 

ConferenceEnabled The agent can conference a call. Always set this 
property to Yes. 

DTMFEnabled The system can send numbers as Dual Tone 
Multi-Frequency (DTMF) tones. Always set this property 
to Yes. 

PromptForLogin This setting allows free-seating for other agent client. 
Always set this property to No. For Native IC-Siebel see 
Virtual Free Seating (VFS) Feature on page 230. 

RONATimeout  
 
Specifies the time in seconds before the system 
redirects work. 

TransferEnabled The agent can transfer a call. Always set this property to 
Yes. 
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Agent/Desktop/Email 

The following table describes the properties that affect the behavior of email in the agent 
interface. 

 

Property name Description 

AllowDecline  
 
An agent can decline work when it arrives. Always set 
this property to No. 

AllowLogoutWithEmail Agents can logout even if the agents have emails waiting 
in the email queue. Always set this property to Yes. 

RONATimeout  
 
Specifies the time in seconds before the system 
redirects work. 

 

 

Agent/Desktop/ScreenPop 

The following table describes the properties that affect how screen pops are handled by the 

agent interface. 

 

Property name Description 

PopOnAllArrivingContacts A screen pop for all incoming contacts is available. 

PopOnContactActivation A screen pop when a work item is activated in Avaya IC 
is available. 

PopOnFirstArrivingContact A screen pop is available only when an agent has no 
other active work on the desktop when the contact 
arrives. 

 

 

Agent/Desktop/Webclient/ServiceConnections 

The following table describes the properties for defining the behavior of the Avaya Agent Web 

Client connection to the application servers. 
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Property name Description 

ServiceConnection_1 Sets the Avaya IC configuration required by ASIS before agents can 
log in. To set this value, open the group manager window and add the 
property. Always set this value to 
com.avaya.ic.integrations.siebel.asis.services.AsisServiceConnection. 

 

 

Agent/Security 

The following table describes the properties that contain agent password and the security 

settings. Always ensure that the parameters in this section match the password parameters set 

in Siebel. You must have unlimited logins and passwords that do not expire. 

 

Property name Description 

AutoAcceptACD The system can automatically accept Automatic Call 
Distribution (ACD) calls on arrival. 

AutoAcceptDirect The system can automatically accept direct calls on 
arrival. 

AutoIn Enables AutoIn behavior for the voice channel. When a 
call is disconnected, the agent is immediately available 
for the next call. 

ForcePasswordChange Forces agents to change the password when logged in 
after a password change is made in IC Manager. Always 
set this property to No. 

MaxLoginAttemptsAllowed Sets the maximum number of times an agent can 
attempt to log in with incorrect passwords before Avaya 
IC disables the agent account. 

PasswordChange Determines whether agents can change the password at 
runtime. Always set this property to No. 

PasswordChangeDuration Determines the number of days before a password 
expires. Always set this property to 0. 

PasswordReuseCycles Determines the number of unique passwords that must 
be used before an agent can reuse a previous 
password. 

 

 

System/Configuration 

The following table describes the system settings for Avaya IC. 
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Property name Description 

EmailLoginServer Specifies the server that hosts the login page for the 
Email Template Administration Web site. For IC Manager 
and website integration to work, you must change the 
default value. 

EmailLoginServerPort Specifies the port number used by the server that hosts 
the login page for the Email Template Administration 
Web site. Usually, you use 80 for non secure HTTP and 
443 for HTTPS. 

EmailLoginServerProtocol Specifies the protocol used by the server that hosts the 
login page for the Email Template Administration Web 
site. Usually, you use HTTP or HTTPS. 

EmailLoginServerWebsite Specifies the virtual directory of the Email Template 
Administration Web site. 

EmailServer Specifies the hostname of the Email Management 
server. For IC Manager and website integration to work, 
you must change the default value. 

EmailServerPort The port number used by the Email Management server 
for Mail Template Administration. 

EnableContentAnalysis Alerts the system that Content Analysis must be used 
when processing email. Always set this property to No. 

mailto:infodev@avaya.com


299 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

August 2022 

Appendix B: AICD commands 

 

 

Appendix B: AICD commands 

 

This section includes the following topics: 
 

● Command definition on page 313 

● Key-value parameters on page 313 

● Selected vs. current work item on 
page 313 

● Commands and media types on 

page 314 

● How to access the buttons on 
page 314 

● Overview of buttons and AICD 
commands on page 317 

● AcceptEmail on page 320 

● AcceptWeb on page 321 

● AgentAvailable on page 322 

● AgentUnavailable on page 323 

● AnswerCall on page 323 

● AvayaAgentCommand on page 324 

● CancelConferenceCall on page 325 

● CancelConferenceWork on page 326 

● CancelConsultTransferCall on 

page 327 

● CancelConsultTransferWork on 
page 329 

● CancelEmail on page 330 

● ChangeAuxReasonCode on 
page 331 

● 

CompleteConferenceCall on 

page 331 

● CompleteConferenceWork on 
page 332 

● CompleteConsultTransferCall on 
page 334 

● CompleteConsultTransferWork on 

page 335 

● DeferEmail on page 336 

● DisconnectWork on page 337 

● EmailAvailable on page 338 

● EmailUnavailable on page 339 

● ForceLogout on page 339 

● ForwardEmail on page 340 

● GetEDUData on page 341 

● HangupCall on page 343 

● HoldCall on page 344 

● HoldReconnectCall on page 345 

● InitConferenceCall on page 346 

● InitConferenceWork on page 347 

● InitConsultTransferCall on page 349 

● InitConsultTransferWork on 

page 351 

● Login on page 352 

● Logout on page 353 
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Command definition 

The system uses commands to send requests and data to the Adaptive Interaction Center 

Driver (AICD). When an agent presses a button on the Siebel toolbar, a command is sent to the 

AICD. The Siebel definition file defines the association of the Siebel toolbar buttons and the 

commands. Another way to call a command is through an event response. 

Commands always flow from the Siebel Communications Server to the AICD. 

 
Related topics 

For more information, see any of the following topics: 

● For a description of an event response, see AICD events on page 370. 
 

● For a detailed description of the Siebel toolbar, see the Avaya IC for Siebel User Guide. 

● Siebel definition file on page 93 

● Customizing the definition file on page 94 
 
 
 
 

Key-value parameters 

Key-value parameters represent input data to AICD commands. Most commands sent to the 

AICD have parameters. Each parameter consists of a parameter key and a parameter value. 

These parameters can be either mandatory or optional. If optional, the AICD assumes the 

default parameter value when the command is called. The default values for the optional 

parameters are specified in this appendix. 

 

Related topic 

For similar information, see Differences in terminology on page 26. 
 
 
 
 

Selected vs. current work item 

This section describes the difference between selected work items and current work items. 

Selected work item: A selected work item is always highlighted in the appropriate Avaya Agent 

task list and in the EDU Viewer. The Accept Work Item button is always associated with the 

selected work item. 

The following commands default to the selected work item if no Tracking ID is provided: 
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● AcceptEmail 

● AcceptWeb 

● AnswerCall 

Current work item: The Work Item drop-down list always displays the current work item. 

All remaining commands that are not associated with a selected work item defaults to the 

current work item if no Tracking ID is provided. 

The Tracking ID and work items: If the Tracking ID is provided, the Tracking ID is used to find 

the work item. The Tracking ID overrides the default of current or selected work item. For 

example, the current work item can be a call, but someone can issue a ReleaseWork command 

on an email by specifying the Tracking ID of the email work item. 

 

Related topic 

For more information, see Avaya Agent User Guide. 
 
 
 
 

Commands and media types 

In general, AICD commands are restricted to act on work items of a particular media type. For 

example, the DeferEmail command acts only on work items with an email media type. Also, a 

work item must be in the correct state for a command to act on it. For example, the 

HoldReconnectCCall command is permitted for work items with the voice media type, but only if 

the voice work item is currently on hold. 

 

Related topic 

For more information, see Media types on page 398. 
 
 
 
 

How to access the buttons 

This section includes the following topics: 

● Siebel Communications Toolbar on page 315 

● Change Ready State submenu on page 315 

● Send Email window on page 316 

● Communication Detail - Response View on page 317 
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Siebel Communications Toolbar 

Most of the buttons described in this chapter are accessed from the Siebel toolbar which is 
located near the top of the Siebel Application window. 

 
Siebel Communications Toolbar for Hybrid Siebel 

 
 

 
Related topic 

For more information about the Hybrid Siebel toolbar, see the Avaya IC for Siebel User Guide. 

 
Siebel Communications Toolbar for Native Siebel 

 
 

 
Related topic 

For more information about the Native Siebel toolbar, see the Avaya IC for Native Siebel User 
Guide. 

 

 

Change Ready State submenu 

Use the Change Ready State submenu to access the Change Ready State Email, Change 

Ready State Phone, and Change Ready State Web buttons. 

Note: 
The Ready/NotReady button is disabled if agent is not logged in to any channel. 

The button is enabled when the connection resets and agent can log in to any 

channel. 
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To display the Change Ready State submenu: 

1. From the Siebel toolbar, click the arrow to the right of the Change Ready State button. 

Example: 

 
 

Result: 

 

 

 

Send Email window 

The Send Email window opens when the agent presses the F9 key or selects the Initiate Email 

button. The agent uses this window to compose email messages. 
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Communication Detail - Response View 

Use the Communication Detail - Response View to access the Cancel Email, Forward Email, 

Reply Email, Reply All Email, and Send Email buttons. This view is located in the middle of the 

Siebel Application window and is used for outgoing email messages. 
 
 
 

 

Communication 
Detail - Response View 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Overview of buttons and AICD commands 

The following table shows the buttons, button names, button locations, and corresponding AICD 

commands. 

 

Button Button name Button location Commands Hybrid/ 

Native 

 

 

Accept Work 
Item 

Siebel 
Communications 
Toolbar 

AcceptEmail Both 

AcceptWeb Hybrid 

AnswerCall Both 
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Button Button name Button location Commands Hybrid/ 
Native 

 

 

Blind Transfer Siebel 
Communications 
Toolbar 

MuteTransferCall Both 

MuteTransferWork Hybrid 

 

 

Cancel Email Communication Detail 
- Response View 

CancelEmail Both 

 

 

● Change 
Ready 
State - 
Hybrid 

● Agent 
Ready - 
Native 

Siebel 
Communications 
Toolbar 

AgentAvailable Both 

AgentUnavailable Both 

 

 

● Change 
Ready 
State Email 
- Hybrid 

● Agent 
Ready 
Email - 
Native 

Change Ready State 
submenu 

EmailAvailable Both 

EmailUnavailable Both 

 

 

● Change 
Ready 
State 
Phone - 
Hybrid 

● Agent 
Ready 
Phone - 
Native 

Change Ready State 
submenu 

VoiceAvailable Both 

VoiceUnavailable Both 

 

 

Change Ready 
State Web 

Change Ready State 
submenu 

WebAvailable Hybrid 

WebUnavailable Hybrid 

 

 

Conference 
Work Item 

Siebel 
Communications 
Toolbar 

CompleteConferenceCall Both 

CompleteConferenceWork Hybrid 

InitConferenceCall Both 

InitConferenceWork Hybrid 
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Button Button name Button location Commands Hybrid/ 

Native 

 

 

Consultative 
Transfer 

Siebel 
Communications 
Toolbar 

InitConsultTransferCall Both 

InitConsultTransferWork Hybrid 

CompleteConsultTransferCall Both 

CompleteConsultTransferWork Hybrid 

 

 

Forward Email Communication Detail 
- Response View 

ForwardEmail Both 

 

 

Initiate Work 
Item Email 

Siebel 
Communications 
Toolbar 

This button does not generate 
an AICD command. Instead, 
the Send Email window pops 
up so that the agent can 
compose an email. This 
window includes a Send button 
that calls the SendNewEmail 
command. 

Both 

 

 

Initiate Work 
Item Phone 

Siebel 
Communications 
Toolbar 

MakeCall Both 

 

 

Pause Work 
Item 

Siebel 
Communications 
Toolbar 

DeferEmail Both 

HoldCall Both 

 

 

Release Work 
Item 

Siebel 
Communications 
Toolbar 

DisconnectWork Both 

HangupCall Both 

CancelEmail Both 

ReleaseWork Both 

 

 

Reply Email Communication Detail 
- Response View 

ReplyEmail Both 

 

 

Reply All Email Communication Detail 
- Response View 

ReplyEmail Both 
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AcceptEmail 

When the agent selects the blinking Accept Work Item button and the selected work item is an 

offered email work item, the following actions occur: 

● The email work item is accepted. 

● The email work item is popped if not already popped. 

● The email work item is now the current work item. 

● If the TrackingID is passed, the email specified by the TrackingID is accepted instead of 

the selected work item. 
 

 
 

Parameter 

The AcceptEmail command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and 
was supplied in the OnNewWorkItem event. 

Yes Both 

Button Button name Button location Commands Hybrid/ 

Native 

 

 

Resume Work 
Item 

Siebel 
Communications 
Toolbar 

HoldReconnectCall Both 

ResumeEmail Both 

 

 

Cancel Work 
Item 

Siebel 
Communications 
Toolbar 

CancelConsultTransferCall Both 

CancelConsultTransferWork Hybrid 

CancelConferenceCall Both 

CancelConferenceWork Both 

 

 

Send Email Send Email window SendNewEmail Both 

 

 

● Sign On - 
Hybrid 

● Login - 
Native 

Siebel 
Communications 
Toolbar 

Login Both 
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Media type 

The AcceptEmail command is permitted on work items with only the email media type when 

offered. 

 

Related topic 

For more information, see Media types on page 398. 
 
 

AcceptWeb 

When the agent selects the blinking Accept Work Item button and the selected work item is an 

offered Web chat work item, the following actions occur: 

● The Web chat work item is accepted and the call is placed. 

● The Web chat work item is popped if not already popped. 

● The Web chat work item is now the current work item. 

● The Avaya Web Agent is brought to the foreground. 

● If the TrackingID is passed, the Web chat specified by the TrackingID is accepted instead 

of the selected work item. 
 

 

 
 

Parameter 

The AcceptWeb command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and 
was supplied in the OnNewWorkItem event. 

Yes Hybrid 

 
  

Media types 

The AcceptWeb command permits work items with the following media types when offered: 

● web 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
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AgentAvailable 

The AgentAvailable command makes the agent available for incoming customer contacts. The 
agent is available only on channels that the agent is logged into and the channel load is greater 

than zero. The agent does not receive outbound work while the agent is available for inbound 

work. If the agent is available for inbound work and is configured for outbound work and an 

outbound job is running, the agent can be drafted into receiving the outbound work item. 

This command is permitted when the agent is unavailable for incoming work, and not in 
outbound mode. 

 

 

Parameters 

The AgentAvailable command has no parameters. The command is available for both Hybrid 

and Native Siebel configurations. 
 

 
 

AgentUnavailable 

The AgentUnavailable command makes the agent unavailable for incoming customer contacts. 
The agent receives neither inbound nor outbound work while the agent is unavailable. 

This command is permitted when the agent is available for incoming work, and not in outbound 

mode. 
 

 

Parameter 

The AgentUnavailable command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

Reason A reason code for the agent being 
unavailable. 

Yes. If not supplied, the 
reason code is set to “”. 

Both 

 
 
 
 

AnswerCall 

When the agent selects the blinking Accept Work Item button and the selected work item is an 
offered call, the following actions occur: 

● The call is answered. 
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● The call work item is popped if not already popped. 

● The call work item is now the current work item. 

● If another call was previously active, the previously active call is put on hold. 

● If the TrackingID is passed, the call specified by the TrackingID is answered instead of the 

selected work item. 
 

 

Parameter 

The AnswerCall command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media types 

The AnswerCall command is permitted on work items with the following media types when 

offered: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

AvayaAgentCommand 

The AvayaAgentCommand enables the implementation of a custom driver command that can 
be associated with a toolbar button and does the following actions: 

● Sends a request from the Siebel agent to a hook within Avaya Agent. 

● Functions as a placeholder. The actual custom command name can be passed as one of 
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the parameters. All key-value parameters are delivered to Avaya Agent. The parameters 

are transferred to the custom script within Avaya Agent. 

● Enabled if Avaya Agent is successfully assigned to the AICD. 
 

This command is not used for Native Siebel configurations. For Native Siebel customizations, 

see any of the following commands: 

● GetEDUData on page 341 

● NewOpenData on page 356 

● SetEDUData on page 365 

 
Related topic 

For more information, see OnAvayaAgentEvent on page 374. 
 

 

Parameters 

The AvayaAgentCommand accepts all parameters. 
 
 
 
 

CancelConferenceCall 

The CancelConferenceCall command cancels a conference call while the call is in the consult 

stage. If the TrackingID is passed, the conference call in progress for the work item specified by 

the TrackingID is canceled. Otherwise, the current work item conference call is canceled. 

The CancelConferenceCall works as follows: 

1. The InitConferenceCall command initiates a conference call. 

2. The InitConferenceCall command puts the contact on hold while a consult call is attempted 
between the original agent and the conference-to agent. 

3. The original agent cancels the conference call from the Siebel toolbar. 

4. The CancelConferenceCall command is generated. 

5. The consult call is dropped and the original call is reconnected. 

 
Related topics 

 
For more information, see the following topics: 

● InitConferenceCall on page 317 

● CompleteConferenceCall on page 312 
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Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media types 

This command is permitted on work items with the following media types when a conference 

call is in the consult stage: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

CancelConferenceWork 

The CancelConferenceWork command cancels the conference of a multimedia work item such 

as a webVoice or webIVChat while the work item is in the consult stage. If the TrackingID is 

passed, the conference in progress for the work item specified by the TrackingID is canceled. 

Otherwise, the current work item conference is canceled. 

The CancelConferenceWork command works as follows: 

1. The InitConferenceWork command initiates a multimedia conference call. 

2. The InitConference command conferences the call part of the multimedia item. 

3. The contact phone call is put on hold while a consult call is attempted between the original 

agent and the conference-to agent. 

4. The original agent cancels the multimedia conference call from the Siebel toolbar. 
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5. The CancelConferenceWork command is generated. 

6. The consult call is dropped and the original call reconnected. 

 
Related topics 

 
For more information, see the following topics: 

● InitConferenceWork on page 318 

● CompleteConferenceWork on page 313 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media types 

This command is permitted on work items with the following media types when the voice part of 

the work item is in the consult stage of a conference call: 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

CancelConsultTransferCall 

The CancelConsultTransferCall command cancels a consult transfer call while the call is in the 
consult stage. If the TrackingID is passed, the consult transfer call in progress for the work item 

specified by the TrackingID is canceled. Otherwise, the current work item consult transfer call is 

canceled. 
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The CancelConsultTransferCall command works as follows: 

1. The InitConsultTransferCall command initiates a consult transfer call. 

2. The InitConsultTransferCall command puts the contact on hold while a consult call is 

attempted between the original agent and the conference-to agent. 

3. The original agent cancels the consult transfer call from the Siebel toolbar. 

4. The CancelConsultTransferCall command is generated. 

5. The consult call is dropped and the original call is reconnected. 

 
Related topics 

 
For more information, see the following topics: 

● InitConsultTransferCall on page 321 

● CompleteConsultTransferCall on page 315 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media types 

This command is permitted on work items with the following media types when the consult 
transfer call is in the consult stage: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

 
Related topic 

For more information, see Media types on page 398. 
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CancelConsultTransferWork 

The CancelConsultTransferWork command cancels the consult transfer of a multimedia work 

item such as a webVoice or webIVChat while the work item is in the consult stage. If the 

TrackingID is passed, the consult transfer in progress for the work item specified by the 

TrackingID is canceled. Otherwise, the current work item consult transfer is canceled. 

The CancelConsultTransferWork command works as follows: 

1. The InitConsultTransferWork command starts a multimedia consult transfer call. 

2. The InitConsultTransferWork command consult transfers the call part of the multimedia 

work item. 

3. The contact phone call is put on hold while a consult call is attempted between the original 

agent and the consult transfer-to agent. 

4. The original agent cancels the multimedia consult transfer call from the Siebel toolbar. 

5. The CancelConsultTransferWork command is generated. 

6. The consult call is dropped and the original call is reconnected. 

 
Related topics 

 
For more information, see the following topics: 

● InitConsultTransferWork on page 322 

● CompleteConsultTransferWork on page 315 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Hybrid 

 

 

Media types 

This command is permitted on work items when the voice part of the multimedia work item is in 

the consult stage of a consult transfer call: 

● webIVChat 
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● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

CancelEmail 

The CancelEmail command cancels the composition of an email reply or forward message. If 
the TrackingID is passed, the email reply or forward message in progress for the work item 

specified by the TrackingID is canceled. Otherwise, the current work item email reply or forward 

message is canceled. 

The CancelEmail command works as follows: 

1. The Communication Detail - Response View is popped when the agent receives email. 

2. When the agent selects the Reply, Reply to All, or Forward buttons, the Communication 

Detail - Response View is enabled. 

3. The agent replies to or forwards the email. While the agent is composing the email 
message, the agent cannot dismiss, transfer, or defer the original email. 

4. The agent cancels the email by selecting the Cancel button from the Siebel toolbar. 

5. The CancelEmail command cancels the composition of the email message. 

6. The Communication Detail - Response View is cleared and disabled. 

7. The agent can now dismiss, transfer, or defer the original email. 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media type 

This command is permitted on work items with the email media type when the email is being 

replied to or forwarded. 
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Related topic 

For more information, see Media types on page 398. 
 
 
 
 

ChangeAuxReasonCode 

The ChangeAuxReasonCode command changes the Aux Reason Code while the agent is 
unavailable. The agent can use this command if the reason of the agent for being unavailable 

changes. For example, the agent is at lunch, then attends a meeting directly afterwards. 

The ChangeAuxReasonCode command is permitted when the agent is unavailable. 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

Reason A reason code for the agent being 
unavailable. 

Yes. If not supplied, the 
reason code is set to “”. 

Both 

 
 
 
 

CompleteConferenceCall 

The CompleteConferenceCall command completes a conference call while the call is in the 

consult stage. If the TrackingID is passed, the conference call in progress for the work item 

specified by the TrackingID is completed. Otherwise, the current work item conference call is 

completed. 

The CompleteConferenceCall command works as follows: 

1. The agent selects the Conference Work Item button from the Siebel toolbar. 

2. The InitConferenceCall command generates a conference call and puts the contact on 

hold while a consult call is attempted between the original agent and the conference-to 

agent. 

3. The original agent completes the conference call by selecting the Conference Work Item 

button from the Siebel toolbar. 

4. The CompleteConferenceCall command is generated. 

5. The consult call and the original call are merged, resulting in a conference call. 
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Related topics 

For more information, see the following topics: 

● InitConferenceCall on page 346 

● CancelConferenceCall on page 325 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item 
and was supplied in the OnNewWorkItem 
event. 

Yes Both 

 

 

Media types 

This command is permitted on work items with the following media types when the work item is 

in the consult stage of a conference call: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

CompleteConferenceWork 

The CompleteConferenceWork command completes the conference of a multimedia work item 

such as a combined chat&PSTN call or chat&VOIP call while the call is in the consult stage. If 

the TrackingID is passed, the conference in progress for the work item specified by the 

TrackingID is completed. Otherwise, the current work item conference is completed. 
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The CompleteConferenceWork command works as follows: 

1. The agent selects the Conference Work Item button from the Siebel toolbar. 

2. The InitConferenceWork command starts a multimedia conference call and conferences 

the call part of the multimedia item. 

3. The contact phone call is put on hold while a consult call is attempted between the original 
agent and the conference-to agent. 

4. When the consult call is connected, the original agent completes the multimedia 

conference call by selecting the Conference Work Item button from the Siebel toolbar. 

5. The CompleteConferenceWork command is generated. 

6. All parties are conferenced together, including the Web chat. 

 
Related topics 

For more information, see the following topics: 

● InitConferenceWork on page 347 

● CancelConferenceWork on page 326 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item 
and was supplied in the OnNewWorkItem 
event. 

Yes Hybrid 

 

 

Media types 

This command is permitted on work items with the following media types when the voice part of 

the multimedia work item is in the consult stage of a conference call: 

● web 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
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CompleteConsultTransferCall 

The CompleteConsultTransferCall command completes a consult transfer call while the call is in 

the consult stage. If the TrackingID is passed, the consult transfer call in progress for the work 

item specified by the TrackingID is completed. Otherwise, the current work item consult transfer 

call is completed. 

The CompleteConsultTransferCall command works as follows: 

1. The agent selects the Consultative Transfer button from the Siebel toolbar and starts the 

InitConsultTransferCall command. 

2. The contact is put on hold while a consult call is attempted between the original agent and 

the conference-to agent. 

3. While the consult call is connected, the original agent completes the consult transfer call 
by selecting the Consultative Transfer button from the Siebel toolbar. 

4. The CompleteConsultTransferCall command is generated. 

5. The customer and the transfer-to agent are connected into one call and the original agent 

is dropped. 

 

Related topics 

For more information, see the following topics: 

● InitConsultTransferCall on page 349 

● CancelConsultTransferCall on page 327 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item 
and was supplied in the OnNewWorkItem 
event. 

Yes Both 

 

 

Media types 

This command is permitted on work items with the following media types when the work item is 

in the consult stage of a consult transfer call: 
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● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

CompleteConsultTransferWork 

The CompleteConsultTransferWork command completes the consult transfer of a multimedia 

item such as a webVoice or webIVChat, while the item is in the consult stage. If the TrackingID 

is passed, the consult transfer in progress for the work item specified by the TrackingID is 

completed. Otherwise, the current work item consult transfer is completed. 

The CompleteConsultTransferWork command works as follows: 

1. The agent selects the Consultative Transfer button from the Siebel toolbar. 

2. The InitConsultTransferWork command generates a multimedia consult transfer call. 

3. The InitConsultTransferWork command performs a consult transfer on the call part of the 
multimedia work item. 

4. The contact phone call is put on hold while a consult call is attempted between the original 
agent and the consult transfer-to agent. 

5. The original agent completes the multimedia consult transfer call by selecting the 

Consultative Transfer button from the Siebel toolbar. 

6. The CompleteConsultTransferWork command is generated. 

7. The original agent is dropped from all calls and the consult-to agent is put on an active call 

with the customer contact. 

8. The Web chat is briefly conferenced between all parties before the original agent is 
dropped from the chat. 

 
Related topics 

For more information, see the following topics: 

● InitConsultTransferWork on page 351 

● CancelConsultTransferWork on page 329 
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Parameter 

This command has the following parameter. 

 

Media types 

This command is permitted on work items with the following media types when the voice part of 

the multimedia work item is in the consult stage of a consult transfer call: 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

DeferEmail 

The DeferEmail command postpones the sending of an email. If the TrackingID is passed, the 

email work item specified by the TrackingID is deferred. Otherwise, the current work item is 

deferred. 

 

Related topics 

For more information, see ResumeEmail on page 360. 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and 
was supplied in the OnNewWorkItem event. 

Yes Hybrid 
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Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and 
was supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media type 

This command is permitted on work items with the email media type when the work item is 

active. 

 

Related topic 

For more information, see Media types on page 398. 
 
 
 
 

DisconnectWork 

The DisconnectWork command stops work on a customer interaction phase of an email, Web 
chat, or multimedia work item. Conceptually, this process is equivalent to hanging up on a 

phone call. For multimedia items, this disconnects the Web chat, but leaves the phone call 

active. The HangupCall command disconnects the phone call. Depending on the system 

configuration, a work item can go into wrap-up immediately after the DisconnectWork 

command. If the TrackingID is passed, the work item specified by the TrackingID is 

disconnected. Otherwise, the current work item is disconnected. 

 

Related topics 

For more information, see the following topics: 

● HangupCall on page 343 

● ReleaseWork on page 358 
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Parameter 

This command has the following parameter. 
 
 
 
 
 
 

 

Media types 

This command is permitted on work items with the following media types when the work item is 

connected: 

● email 

● web 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

EmailAvailable 

The EmailAvailable command makes the agent available for email work. If making the agent 

available for email also makes the agent available for all logged-in channels, the agent is also 

put in automatic mode. 

The EmailAvailable command is permitted when the agent is: 

● Available for incoming work 

● Unavailable for email 

● Logged into the email channel 

● Not in outbound mode 

This command is used for both Hybrid and Native Siebel configurations. 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 
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Parameters 

The EmailAvailable command has no parameters. 
 
 
 
 

EmailUnavailable 

The EmailUnavailable command makes the agent unavailable for email work. The agent is also 
put in manual mode. 

This command is permitted when the agent is: 

● Available for incoming work 

● Available for email 

● Logged into the email channel 

● Not in outbound mode 

This command is used for both Hybrid and Native Siebel configurations. 
 

 

Parameters 

The EmailUnavailable command has no parameters. 
 
 
 
 

ForceLogout 

The ForceLogout command logs out the agent. This command disables the association 
between the Siebel agent session and the Avaya agent. This command does not log the agent 

out of an Automatic Call Distribution (ACD) split. 

 

Related topics 

For more information about conditional logouts, see Logout on page 353. 
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Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

AgentID <UserName> 

Use the @UserName macro to get this value. 

Yes Both 

 
 
 
 

ForwardEmail 

The ForwardEmail command begins the process of forwarding an email message. If the 

TrackingID is passed, an email for the work item specified by the TrackingID is forwarded. 

Otherwise, the current work item is forwarded. 

The ForwardEmail command works as follows: 

1. The Communication Detail - Response View is popped when the agent receives an email 

message. 

2. The agent selects the Forward button on the Communication Detail - Response View. 

3. The ForwardEmail command is generated. 

4. The Communication Detail - Response View is enabled, and the agent can then edit the 

email. 

5. When the agent is finished composing the email, the agent selects the Send button in the 

Communication Detail - Response View. 

6. The SendEmail command forwards the email message. 

7. The Communication Detail - Response View is cleared and disabled. 

8. The agent is permitted to dismiss, transfer, or defer the original email, and can also 
compose a reply, or forward the email again. 

 
Related topics 

For more information, see the following topics: 

● SendEmail on page 362 

● ReplyEmail on page 359 

● CancelEmail on page 330 
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Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media type 

This command is permitted on work items with the email media type when the work item is 

active. 

 

Related topic 

For more information, see Media types on page 398. 
 
 
 
 

GetEDUData 

This command can have Siebel retrieve the contents of an EDU. This command 

● Is not run by the out-of-the-box AICD.def, but you can easily add it to a custom 
configuration. 

● The caller can specify an EDU by passing the EDUID or by passing the type of EDU 

wanted. 

● Looks only at the EDUs that are already associated with work items in the pull-down menu 
of the agent. 

● Can specify a specific container if you do not want the entire EDU. 

When the data is collected, it returns to Siebel using the OnGetEDUData event. 
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Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/ 
Native 

CommandID An arbitrary value used for reference when the 
OnGetEDUData event is sent to Siebel. This 
parameter must be generated and passed by the 
Siebel application. 

Yes Both 

Container Used when a specific container is requested 
instead of the entire contents of the EDU. This 
parameter is a string value. 

EDUID Tells the AICD which EDU to access for data. 
This parameter can contain one of the following 
values: 

● <EDUID> - The ID of the EDU 

● chat - Tells the AICD to retrieve the data for 
the EDU that is associated with a chat 
interaction. If the agent does not have a chat 
work item, the command returns an error. 

● email - Tells the AICD to retrieve the data for 
the EDU that is associated with an email 
interaction. If the agent does not have an 
email, the command returns an error. 

● work - Tells the AICD to retrieve the data for 
an EDU that is either chat or email. If none is 
there, the command returns an error. 

● voice - Tells the AICD to retrieve the data for 
an EDU that is associated with a voice 
interaction. If the agent does not have a call, 
the command returns an error. 

● hub - Used if the agent has a multimedia 
interaction. If no hub EDU is there, the 
command returns an error. 

 

Related topics 

For more information, see OnGetEDUData on page 386. 
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HangupCall 

The HangupCall command hangs up a call. If the TrackingID is passed, the work item specified 
by the TrackingID is hung up. Otherwise, the current work item is hung up. 

 
Related topics 

For more information, see the following topics: 

● DisconnectWork on page 337 

● ReleaseWork on page 358 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and 
was supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media types 

This command is permitted on work items with the following media types when the call is active: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
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HoldCall 

The HoldCall command puts a call on hold. For multimedia work items, the Web chat part of the 

work item is still active even when the call is on hold. If the TrackingID is passed, the call work 

item specified by the TrackingID is put on hold. Otherwise, the current work item is put on hold. 

 

Related topics 

For more information, see the following topics: 

● DeferEmail on page 336 

● HoldReconnectCall on page 345 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the supplied in the OnNewWorkItem 
event. 

Yes Both 

 

 

Media types 

This command is permitted on work items with the following media types when the call is active 

and no consult call is ringing: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
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HoldReconnectCall 

The HoldReconnectCall command takes a call off hold. For multimedia work items, the Web 

chat part of the work item is still active even when the call is on hold, so this command affects 

only the call. If the TrackingID is passed, the call work item specified by the TrackingID is taken 

off hold. Otherwise, the current work item is taken off hold. 

 

Related topics 

For more information, see the following topics: 

● DeferEmail on page 336 

● HoldCall on page 344 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the supplied in the OnNewWorkItem 
event. 

Yes Both 

 

 

Media types 

This command is permitted on work items with the following media types when the call is on 
hold: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
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InitConferenceCall 

The InitConferenceCall command starts a conference call. If the TrackingID is passed, the 

conference call for the work item specified by the TrackingID is initiated. Otherwise, a 

conference call on the current work item is initiated. 

The InitConferenceCall command works as follows: 

1. The agent selects the Conference Work Item button from the Siebel toolbar. 

2. The InitConferenceCall command starts a conference call by putting the contact on hold 

while a consult call is attempted between the original agent and the conference-to agent. 

3. The original agent does one of the following tasks: 

● Completes the conference call by selecting the Conference Work Item button. This 
button generates the CompleteConferenceCall command. 

● Cancels the conference call by selecting the Cancel Work Item button. This button 

generates the CancelConferenceCall command. 

 

Related topics 

For more information, see the following topics: 

● CompleteConferenceCall on page 331 

● CancelConferenceCall on page 325 
 

 

Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/ 
Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 

Destination An extension, phone number, agent ID, or queue Yes 

SuppressUAD Can be true or false. 

If true, and a destination is supplied, the 
presentation of the UAD is suppressed. 

Yes. If not 
supplied, the 
default is 
false. 

<Open> - Yes 
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Related topics 

For more information, see the following topics: 

● About open data on page 240 

● OnNewWorkItem on page 388 
 

 

Media types 

This command is permitted on work items with the following media types when the call is active 

and not on hold: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

InitConferenceWork 

The InitConferenceWork command starts the conference of a Web chat or the multimedia work 

item such as a webVoice or webIVchat. If the TrackingID is passed, a conference for the work 

item specified by the TrackingID is initiated. Otherwise, a conference for the current work item is 

initiated. 

The InitConferenceWork command works as follows: 

1. The agent selects the Conference Work Item button on the Siebel toolbar to start a 

multimedia conference. 

2. The InitConference command conferences the call part of the multimedia work item. The 

contact phone call is put on hold while a consult call is attempted between the original 

agent and the conference-to agent. 

3. When the consult call is connected, the original agent completes the multimedia 

conference call by selecting the Conference Work Item button on the Siebel toolbar. 

4. The CompleteConferenceWork command is generated. 
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Note: 
The agent can also cancel the multimedia conference call by selecting the Cancel 

Work Item button and generating the CancelConferenceWork command. 

You can also use the InitConferenceWork command to initiate a Web chat conference. Chat 

conferences are one-step conferences. That is, the conferences do not have a consult stage 

and the conferences are completed automatically when the other agent is connected. No further 

commands are needed to complete the chat conference, and the conference is not possible to 

cancel a chat conference. 

 

Related topics 

For more information, see the following topics: 

● CompleteConferenceWork on page 332 

● CancelConferenceWork on page 326 
 

 

Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item 
and was supplied in the 
OnNewWorkItem event. 

Yes Hybrid 

Destination An extension, phone number, agent ID, 
or queue 

Yes 

SuppressUAD Can be true or false. 

If true, and a destination is supplied, the 
presentation of the UAD is suppressed. 

Yes. If not 
supplied, the 
default is false. 

<Open> - Yes 

 

Related topic 

For more information, see About open data on page 240. 
 

 

Media types 

This command is permitted on work items with the following media types when a web chat is 

connected: 

● web 
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● webIVChat 

● webVoice 

For webIVchat and webVoice, the call must be active and cannot be on hold. 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

InitConsultTransferCall 

The InitConsultTransferCall command initiates a consult transfer call. If the TrackingID is 

passed, a consult transfer call for the work item specified by the TrackingID is initialized. 

Otherwise, a consult transfer call for the current work item is initialized. 

The InitConsultTransferCall command works as follows: 

1. The agent selects the Consultative Transfer button from the Siebel toolbar. 

2. The InitConsultTransferCall command starts a consult transfer call by putting the contact 

on hold while a consult call is attempted between the original agent and the conference-to 

agent. 

3. While the consult call is connected, the original agent does one of the following tasks: 

● Completes the consult transfer call by selecting the Consultative Transfer button. This 
button generates the CompleteConsultTransferCall command. 

● Cancels the consult transfer call by selecting the Cancel Work Item button. This button 

generates the CancelConsultTransferCall command. 

 

Related topics 

For more information, see the following topics: 

● CompleteConsultTransferCall on page 334 

● CancelConsultTransferCall on page 327 
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InitConsultTransferCall  
 

 

Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work item 
and was supplied in the 
OnNewWorkItem event. 

Yes Both 

Destination An extension, phone number, agent ID, 
or queue 

Yes 

SuppressUAD Can be true or false. 

If true, and a destination is supplied, the 
presentation of the UAD is suppressed. 

Yes. If not 
supplied, the 
default is false. 

<Open> - Yes 

 

Related topic 

For more information, see About open data on page 240. 
 

 

Media types 

This command is permitted on work items with the following media types when the call is active 
and not on hold: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

 
Related topic 

For more information, see Media types on page 398. 
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InitConsultTransferWork 

The InitConsultTransferWork command initiates the consult transfer of a multimedia item such 

as a webVoice or webIVChat. If the TrackingID is passed, a consult transfer for the work item 

specified by the TrackingID is initiated. Otherwise, a consult transfer of the current work item is 

initiated. 

The InitConsultTransferWork command works as follows: 

1. The agent selects Consultative Transfer button from the Siebel toolbar. 

2. The InitConsultTransferWork command starts a multimedia consult transfer call by 

performing a consult transfer of the call part of the multimedia work item. 

3. The contact phone call is put on hold while a consult call is attempted between the original 

agent and the consult transfer-to agent. 

4. The original agent does one of the following tasks: 

● Completes the multimedia consult transfer call by selecting the Consultative Transfer 

button. This button generates the CompleteConsultTransferWork command. 

● Cancels the multimedia consult transfer by selecting the Cancel Work Item button. 
This button generates the CancelConsultTransferWork command. 

 
Related topics 

For more information, see the following topics: 

● CompleteConsultTransferWork on page 335 

● CancelConsultTransferWork on page 329 
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Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid 

/Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Hybrid 

Destination An extension, phone number, agent ID, or queue Yes 

SuppressUAD Can be true or false. 

If true, and a destination is supplied, the 
presentation of the UAD is suppressed. 

Yes. If not 
supplied, 
the default is 
false. 

<Open> - Yes 

 

Related topics 

For more information, see About open data on page 240. 
 

 

Media types 

This command is permitted on work items with the following media types when the voice part of 

the multimedia work item is active and not on hold: 

● webIVChat 

● webVoice 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

Login 

The Login command logs the agent into the Interaction Center. This command is permitted 
when the agent is logged out. 

The Login command forms the necessary association between the Siebel agent session and 

Avaya Agent. This command does not log the agent into an Automatic Call Distribution (ACD) 

split. 
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Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

AgentID <UserName> 

Use the @UserName macro to get the Siebel 
agent login name that is passed as the value of 
the AgentID parameter. 

No Both 

AgentPassword Defaults to empty string """" 

If specified, this parameter overrides the AICD 
configuration parameter 
Service:AgentPassword to allow per agent 
passwords. 

Yes Native 

 
 
 
 

Logout 

The Logout command logs the agent out of the Interaction Center. The Logout command is 

permitted when the agent is logged in. 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/Native 

AgentID <UserName> 

Use the @UserName macro to get this value. 

No Both 

 
 
 
 

MakeCall 

The MakeCall command puts an outgoing call. MakeCall creates a voiceOut work item. 
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This command is permitted when the agent is connected to telephony services and is not 

already active on another call. 
 

 

Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/Native 

Destination An extension, phone number, agent ID, or 
queue 

Yes Both 

SuppressUAD Can be true or false. 

If true, and a destination is supplied, the 
presentation of the UAD is suppressed. 

Yes. If not 
supplied, the 
default is false. 

<Open> - Yes 

 

Related topic 

For more information, see About open data on page 240. 
 
 
 
 

MuteTransferCall 

The MuteTransferCall command performs a one-step transfer of a call, also called a blind 

transfer. If the TrackingID is passed, a blind transfer for the work item specified by the 

TrackingID is performed. Otherwise, a blind transfer of the current work item is performed. 
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Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/Native 

Destination An extension, phone number, agent ID, 
or queue 

Yes Both 

SuppressUAD Can be true or false. 

If true, and a destination is supplied, the 
presentation of the UAD is suppressed. 

Yes. If not 
supplied, the 
default is false. 

<Open> - Yes 

 

Related topic 

For more information, see About open data on page 240. 
 

 

Media types 

This command is permitted on work items with the following media types when the call is active 

and not on hold: 

● voice 

● voiceAutoDial 

● voiceOut 

● voicePredictive 

● voicePreview 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

MuteTransferWork 

The MuteTransferWork command transfers an email to another agent. If the TrackingID is 

passed, a one-step, or blind transfer, is performed for the email work item specified by the 

TrackingID. Otherwise, a blind transfer of the current work item is performed. 
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Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/Native 

Destination An extension, phone number, agent ID, or 
queue 

Yes Hybrid 

SuppressUAD Can be true or false. 

If true, and a destination is supplied, the 
presentation of the UAD is suppressed. 

Yes. If not 
supplied, the 
default is false. 

<Open> - Yes 

 

Related topic 

For more information, see About open data on page 240. 
 

 

Media type 

This command is permitted on work items with the email media type when the email is active. 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

NewOpenData 

The NewOpenData command copies new open data to the open data container in the work item 
EDU. The TrackingID of the work item must be specified. 

In addition to copying new data to the open data container in the EDU, the NewOpenData 
command can alert other components of the system that NewOpenData is available. For 

example, other agents on a conference call can be notified of the presence of the new open 

data, and can re-read the open data container in the EDU. This behavior is controlled by the 

SendEvent parameter. 
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The SendEvent parameter can be used to specify which parties must receive an event when the 

new open data is copied to the EDU. The following table describes the possible choices. 

 

All All agents monitoring the EDU receive the OnNewOpenData event. 

JustIC No agents receive the OnNewOpenData event, but the IC Agent Scripts for this 
agent receive notification. This event can be a useful customization hook. 

JustMe Only the agent who originated the NewOpenData command can receive the 
OnNewOpenData event. 

None Nobody receives the OnNewOpenData event, and the Avaya IC agent is not 
notified. 

NotMe All agents receive the OnNewOpenData event, except for the agent who 
originated the NewOpenData command. 

 

Related topic 

For more information about the OnNewOpenData event, see OnNewOpenData on page 358. 
 

 

Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/Native 

TrackingID Tracking ID that identifies the work 
item and was supplied in the 
OnNewWorkItem event. 

Yes Both 

SendEvent One of the following values: 

● All 

● JustMe 

● NotMe 

● JustIC 

● None 

Yes. If not specified, the 
default is None. 

<Open> - No 

 

Related topic 

For more information, see About open data on page 240. 
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RecoveryPop  
 

 

Media types 

This command is permitted on work items with all media types in any state. 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

RecoveryPop 

The RecoveryPop command is provided in the out-of-the-box definition file in the form of a 

menu item in the Siebel menu. You can access this function by selecting View > 

Communications > Recovery Pop from the Siebel menu. Siebel performs a screen pop when 

the AICD presents the data for the current work item to Siebel. 

This command is available for both Hybrid and Native Siebel configurations. 
 

 

Parameters 

The RecoveryPop command has no parameters. 
 
 
 
 

ReleaseWork 

The ReleaseWork command signals that the agent has completed Siebel wrap-up. This 
command removes the work item from the agent work list. 

 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/ 

Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 
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Media types 

This command is permitted on work items with all media types when the work items are in 
Siebel wrap-up. 

 
Related topics 

For more information, see the following topics: 

● Media types on page 398 

● Wrap-up on page 80 
 
 
 
 

ReplyEmail 

The ReplyEmail command begins the process of replying to an email. If the TrackingID is 

passed, an email for the work item specified by the TrackingID is sent a reply. Otherwise, the 

current work item is sent a reply. 

The ReplyEmail command works as follows: 

1. The Communication Detail - Response View is popped when the agent receives email. 

2. The agent selects either the Reply or Reply to All button. 

3. The ReplyEmail command is generated. 

4. The Communication Detail - Response View is enabled. 

5. The agent composes a reply email. 

6. When the agent is finished composing the reply email, the agent selects the Send button in 

the Communication Detail - Response View. 

7. The SendEmail command sends the email message. 

8. The Communication Detail - Response View is cleared and disabled. 

9. The agent can again dismiss, transfer, or defer the original email, and can also choose to 

compose another reply or forward the email. 

 

Related topics 

For more information, see the following topics: 

● SendEmail on page 362 

● ForwardEmail on page 340 

● CancelEmail on page 330 
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ResumeEmail  
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/ 
Native 

TrackingID Tracking ID that identifies the work item and was 
supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media type 

This command is permitted on work items with the email media type when the email is active. 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

ResumeEmail 

The ResumeEmail command removes an email from the deferred status. Conceptually, this 
command is similar to taking a call off hold. If the TrackingID is passed, the email work item 

specified by the TrackingID is resumed. Otherwise, the current work item is resumed. 

 

Related topic 

For more information, see DeferEmail on page 336. 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/ 

Native 

TrackingID Tracking ID that identifies the work item and 
was supplied in the OnNewWorkItem event. 

No Both 
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Media type 

This command is permitted on work items with the email media type when the work item is 
deferred. 

 
Related topic 

For more information, see Media types on page 398. 
 
 
 
 

ResetEmailChannel 

The ResetEmailChannel command is used to recover from an Email server or Blender server 

failure. You can access this function from the Siebel menu. 

This command is available only for Native Siebel configurations. 
 

 

Parameters 

The ResetEmailChannel command has no parameters. 
 
 
 
 

ResetVoiceChannel 

The ResetVoiceChannel command is used to recover from a Telephony Server (TS) failure. You 
can access this function from the Siebel menu. 

This command is available only for Native Siebel configurations. 
 

 

Parameters 

The ResetVoiceChannel command has no parameters. 
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SendDTMF 

The SendDTMF command sends numbers as Dual Tone Multi-Frequency (DTMF) tones. 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/ 
Native 

<device ID> Sends DTMF tones using numeric values 0-9. Yes Both 

 
 
 
 

SendEmail 

The SendEmail command completes the process of replying to or forwarding an email. If the 

TrackingID is passed, an email for the work item specified by the TrackingID is used. Otherwise, 

the current work item is used. 

The SendEmail command works as follows: 

1. The Communication Detail - Response View is popped when the agent receives email. 

2. The agent selects the Reply, Reply to All, or Forward button. 

3. The Communication Detail - Response View becomes enabled. 

4. The agent edits the email. 

5. When the agent is finished composing the email, the agent selects the Send button in the 

Communication Detail - Response View. 

6. The SendEmail command sends the email message. 

7. The Communication Detail - Response View is cleared and disabled. 

8. The agent is again permitted to dismiss, transfer, or defer the original email, and can also 

choose to compose another reply or forward the email again. 

 

Related topics 

For more information, see the following topics: 

● ReplyEmail on page 359 
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● ForwardEmail on page 340 

● CancelEmail on page 330 
 

 

Parameter 

This command has the following parameter if you are using the Siebel-first email method. 

 

Name Value Optional? Hybrid/ 
Native 

TrackingID Tracking ID that identifies the work item and 
was supplied in the OnNewWorkItem event. 

Yes Both 

 

 

Media type 

This command is permitted on work items with the email media type when the agent is 

forwarding email or sending a reply. 

 

Related topic 

For more information, see Media types on page 398. 
 
 
 
 

SendNewEmail 

The SendNewEmail command sends an email. 

The SendNewEmail command works as follows: 

1. The agent presses the F9 key or selects the Initiate Email button to open the Send Email 

window. 

2. The agent composes the email message and selects the Send button. 

3. The Send button creates an activity record in Siebel and calls the SendNewEmail 

command. 

4. The SendNewEmail command retrieves the activity record from Siebel and sends the 

email. 

5. The SendNewEmail command creates a new EDU. Neither the selected nor the current 
work item is used, and no work item is specified using a TrackingID. 

This command is permitted when the agent is logged into the email channel. 
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SetCurrentWorkItem  
 

 

 
 
 

 

Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/ 

Native 

ActivityID Siebel ActivityID of the email being sent. No Both 

<Open> - Yes 

 

Related topic 

For more information, see About open data on page 265. 
 
 
 
 

SetCurrentWorkItem 

The SetCurrentWorkItem command sets the current work item to the work item that is specified 
by the TrackingID. 

The agent chooses a work item from the Work Item drop-down list. This results in a 

SetCurrentWorkItem command that changes the current work item to the new work item the 

agent has chosen and pops the screen accordingly. 

The SetCurrentWorkItem command is always permitted. 
 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid/ 

Native 

TrackingID Tracking ID that identifies the work item and 
was supplied in the OnNewWorkItem event. 

No Both 
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SetEDUData 

The SetEDUData command can have the Siebel application to set data into a specified EDU. 

This command is not included with the out-of-the-box configuration, but can be easily added 

into a custom configuration. 
 

 

Parameters 

This command has the following parameters. 

 

Name Value Optional? Hybrid/ 
Native 

EDUID Tells the AICD which EDU to access for data. This 
parameter can contain one of the following values: 

● <EDUID> - The ID of the EDU 

● chat - Tells the AICD to retrieve the data for the EDU 
that is associated with a chat interaction. If the 
agent does not have a chat work item, the 
command returns an error. 

● email - Tells the AICD to retrieve the data for the 
EDU that is associated with an email interaction. If 
the agent does not have an email, the command 
returns an error. 

● work - Tells the AICD to retrieve the data for an EDU 
that is either chat or email. If none is there, the 
command returns an error. 

● voice - Tells the AICD to retrieve the data for an 
EDU that is associated with a voice interaction. If 
the agent does not have a call, the command 
returns an error. 

● hub - Used if the agent has a multimedia interaction. 
If no hub EDU is there, the command returns an 
error. 

Yes Both 

<Open> The data written to the EDU. This data must be in the 
form of name-value pairs. You can specify multiple 
name-value pairs. <Open> can include field names in 
sub containers of the EDU - for example, 
container1.subcontainer2.field1. 

Yes 
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ShowStatusText 

The ShowStatusText command displays the specified text string in the Siebel thin client status 
line. 

The ShowStatusText command is always permitted. 

Note: 
Indiscriminate use of this command can overwrite other useful status line data. 

 

 

Parameter 

This command has the following parameter. 

 

Name Value Optional? Hybrid 

/Native 

StatusText Status text string that is displayed No Both 

 
 
 
 

VoiceAvailable 

The VoiceAvailable command makes the agent available for voice work. If making the agent 

available for voice causes the agent to become available for all logged-in channels, the agent is 

also put in automatic mode. 

The VoiceAvailable command is permitted when the agent is: 

● Available for incoming work 

● Unavailable for voice work 

● Logged into the voice channel 

● Not in outbound mode 
 

 

Parameters 

The VoiceAvailable command has no parameters. 
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VoiceUnavailable 

The VoiceUnavailable command makes the agent unavailable for voice work and puts the agent 
in manual mode. 

The VoiceUnavailable command is permitted when the agent is: 

● Available for incoming work 

● Available for voice work 

● Logged into the voice channel 

● Not in outbound mode 

This command is available for both Hybrid and Native Siebel configurations. 
 

 

Parameters 

The VoiceUnavailable command has no parameters. 
 
 
 
 

WebAvailable 

The WebAvailable command makes the agent available for Web work. If making the agent 

available for the Web causes the agent to become available for all logged-in channels, the 

agent is also put in automatic mode. 

The WebAvailable command is permitted when the agent is: 

● Available for incoming work 

● Unavailable for Web work 

● Logged into the chat channel 

● Not in outbound mode 

This command is available only for Hybrid Siebel configurations. 
 

 

Parameters 

The WebAvailable command has no parameters. 
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WebUnavailable  
 

 

 
 

 
 

WebUnavailable 

The WebUnavailable command makes the agent unavailable for Web work and puts the agent 
in manual mode. 

The WebUnavailable command is permitted when the agent is available for incoming work, 

available for Web work, logged into the chat channel, and not in outbound mode. 

This command is available only for Hybrid Siebel configurations. 
 

 

Parameters 

The WebUnavailable command has no parameters. 
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Appendix C: AICD events 

 

This section includes the following topics: 
 

● About events on page 371 

● Event parameter groups on 

page 371 

- Common event parameters on 

page 372 

- Common call event 
parameters on page 372 

- Common email event 
parameters on page 373 

- Common Web event 

parameters on page 373 

- Open event parameters on 
page 373 

● Events 

- OnAvayaAgentEvent on 

page 374 

- OnCallAbandoned on page 375 

- OnCallBusy on page 375 

- OnCallConference on page 376 

- OnCallConnect on page 376 

- OnCallDisconnect on page 377 

- OnCallDrop on page 377 

- OnCallIncoming on page 378 

- OnCallHold on page 378 

- OnCallHoldReconnect on 
page 379 

- 

OnCallQueued on page 380 

- OnCallRinging on page 380 

- OnCallTransfer on page 381 

- OnChangeCurrentWorkItem on 

page 381 

- OnEmailCancel on page 382 

- OnEmailDeferred on page 383 

- OnEmailForward on page 384 

- OnEmailReply on page 384 

- OnEmailSend on page 385 

- OnGetEDUData on page 386 

- OnLoginAgent on page 386 

- OnLogoutAgent on page 387 

- OnNewOpenData on page 387 

- OnNewWorkItem on page 388 

- OnSiebelWrapUp on page 389 

- OnWorkConference on page 390 

- OnWorkConnect on page 390 

- OnWorkDisconnect on page 391 

- OnWorkItemRemove on 

page 392 

- OnWorkTransfer on page 393 
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About events  
 

 

 
 

 
 

About events 

An event notifies the Siebel Communications Server about a specific occurrence, so that the 

Siebel Communications Server can take the appropriate action. As a general rule, events are 

generated by occurrences that are controlled by Avaya IC. 

Examples of the occurrences that can generate events are as follows: 

● The agent sends email or puts a voice call. 

● A customer sends an inbound Web chat message, email, or voice call. 

Event handlers in the Siebel definition file evaluate each event. Event responses provide the 

instructions to act on the evaluated event. The typical event response is to pop a Siebel screen 

- although many other event responses are possible, such as sending an Adaptive Interaction 

Center Driver (AICD) command. 

Events always flow from the AICD to the Siebel Communications Server. 

 
Related topics 

For more information, see any of the following topics: 

● Media types on page 398 

● Siebel definition file on page 93 

● Customizing the definition file on page 94 

● Customizing events on page 247 

● AICD commands on page 312 

● For a description of the Avaya IC events described in this appendix, for example TS.Hold, 

see Telephony Connectors Programmer Guide. 
 
 
 
 

Event parameter groups 

This section includes the following topics: 

● Common event parameters on page 372 

● Common call event parameters on page 372 

● Common email event parameters on page 373 

● Common Web event parameters on page 373 

● Open event parameters on page 373 
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Common event parameters 

The following event parameters are common to most of the events described in this appendix. 

 

Field Description 

AgentID The login ID for the Siebel agent. 

AgentExtension The extension for the agent, if the agent has one. 

EDUID The EDU ID of the work item. 

TrackingID The TrackingID is a string that is generated by the AICD. The 
Tracking ID uniquely identifies the work item. 

 

 

Common call event parameters 

The following event parameters are common to some of the call-related events described in this 

appendix. 

 

Field Description 

ANI The ANI supplied by the TS event. 

CallID The call_ref_id supplied by the TS event. 

DNIS The DNIS supplied by the TS event. 

OutboundCallNumber The outboundcallnumber put in the EDU by the dialing kernel, if 
available. 

PrimaryANI The PrimaryANI obtained from the EDU. 

PrimaryDNIS The PrimaryDNIS obtained from the EDU. 

VoiceDirection Indicates where the call originated. This value does not change 
during the life of the call, including during transfers and 
conferences. VoiceDirection can have the following values: 

● inbound 

● outbound 
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Common email event parameters 

The following event parameters are common to most of the email-related events described in 
this appendix. 

 

Field Description 

EmailActivityID A Siebel activity ID that identifies the row ID of the Siebel record for the 
email. 

Recipient The email address of the recipient. This value is not supplied if the 
recipient is not available. 

Sender The email address of the sender. This value is not supplied if the sender 
is not available. 

Subject The email subject line. This value is not supplied if the subject line is not 
available. 

 

 

Common Web event parameters 

The following event parameters are common to most of the Web-related events described in 

this appendix. 

 

Field Description 

UserName Login ID for the customer. If the user logged in as a guest, the format of 
this parameter is: 

guest_<UserNameDisplay>_<SomeUniqueString> 

For example: 

guest_Alice_23771953 

UserNameDisplay The Login ID for the customer, or the name the guest supplied. If the 
user supplied the name, Alice, the value is Alice. 

 

 

Open event parameters 

Events that have the <Open> parameter have data attachments. In general, the <Open> 

parameters are on most events that indicate that work is delivered to the agent. For example, 

OnNewWorkItem and OnCallIncoming. 
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Related topic 

For more information, see About open data on page 240. 
 
 
 
 

OnAvayaAgentEvent 

The OnAvayaAgentEvent is generated in response to a request by the Avaya Agent. The 
parameters are supplied in the request from Avaya Agent. 

The OnAvayaAgentEvent can have you to implement a custom driver event sent from Avaya 
Agent to the AICD and to the Siebel agent. This event is a placeholder. The actual event name 

can be passed as one of the event parameters. An arbitrary number of parameters can be 

passed from Avaya Agent to Siebel. The Avaya Agent script constructs and defines the 

contents of the event. This event can be used to call the event handler defined in the AICD.def 

file and cause some action within Siebel. 

 

Related topic 

For more information, see AvayaAgentCommand on page 324. 
 

 

Parameter 

OnAvayaAgentEvent accepts all parameters. 
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OnCallAbandoned  
 

 

 
 

 
 

OnCallAbandoned 

This event is sent when a call is abandoned before the call can be connected to an agent. The 
AICD sends OnCallAbandoned when it receives the TS.Abandoned event. 

 

 

Parameters 

The following parameters are supplied with the OnCallAbandoned event. 

 

Field Description 

NoInQueue The number_in_queue parameter from the TS.Abandoned event, 
if present. 

Common event parameters on page 372 

Common call event parameters on page 372 

 
 
 
 

OnCallBusy 

This event is sent when a call receives a busy signal. The AICD sends OnCallBusy when it 

receives the TS.Busy event. 
 

 

Parameters 

The following parameters are supplied with the OnCalBusy event. 

 

Field 

Common event parameters on page 372 

Common call event parameters on page 372 
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OnCallConference 

This event is sent when a conference call is successfully completed. The AICD sends 
OnCallConference when it receives the TS.Conference event. 

 

 

Parameters 

The following parameters are supplied with the OnCallConference event. 

 

Field Description 

OldCallID The CallID of the original call. 

Common event parameters on page 372 

Common call event parameters on page 372 

 
 
 
 

OnCallConnect 

This event is sent when a call is answered. The AICD sends OnCallConnect when it receives 
the TS.Connect event. 

 

 

Parameters 

The following parameters are supplied with the OnCallConnect event. 
 

Field Description 

ucid The ucid parameter supplied by the TS.Connect event. 

Common event parameters on page 372 

Common call event parameters on page 372 
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OnCallDisconnect  
 

 

 
 

 
 

OnCallDisconnect 

This event is sent when a call ends. The AICD sends OnCallDisconnect when it receives the 
TS.Disconnect event. 

 

 

Parameters 
 
 

Field Description 

NoInQueue The number_in_queue parameter from the TS.Disconnect event, if 
present. 

OldCallID The call_ref_id supplied by the TS.Disconnect event. 

Common event parameters on page 372 

Common call event parameters on page 372 

 
 
 
 

OnCallDrop 

This event is sent when a party is dropped from a call involving two or more parties. The AICD 
sends OnCallDrop when it receives the TS.Drop event. 

 

 

Parameters 

The following parameters are supplied with the OnCallDrop event. 

 

Field Description 

CallID The call_ref_id supplied by the TS.Disconnect event. 

DestinationNumber The dest parameter that is supplied with the TS.Drop event. 

NoInQueue The number_in_queue parameter from the TS.Drop event, if present. 

OriginatingNumber The orig parameter that is supplied with the TS.Drop event. 

Common event parameters on page 372 
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OnCallIncoming 

This event is sent when an agent receives a call. The AICD sends OnCallIncoming when it 
receives the TS.IncomingCall event. 

 

 

Parameters 

The following parameters are supplied with the OnCallIncoming event. 

 

Field Description 

CalledNumber The called parameter that is supplied by the TS.IncomingCall event. 

DestinationNumber The dest parameter that is supplied with the TS.IncomingCall event. 

NoInQueue The number_in_queue parameter from the TS.IncomingCall event, 
if present. 

OriginatingNumber The orig parameter that is supplied with the TS.IncomingCall event. 

ucid The ucid parameter supplied by the TS.IncomingCall event. 

Common event parameters on page 372 

Common call event parameters on page 372 

Up to 10 custom event parameters. For more information, see Customizing events on 
page 247. 

 
 
 
 

OnCallHold 

This event is sent when an agent puts a call on hold. The AICD sends OnCallHold when it 

receives the TS.Hold event. 
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OnCallHoldReconnect  
 

 

 
 
 

 

Parameters 

The following parameters are supplied with the OnCallHold event. 

 

Field Description 

CallID The call_ref_id supplied by the TS.Hold event. 

DestinationNumber The dest parameter that is supplied with the TS.Hold event. 

Common event parameters on page 372 

 
 
 
 

OnCallHoldReconnect 

This event is sent when an agent takes a call off hold. The AICD sends OnCallHoldReconnect 

when it receives the TS.HoldReconnect event. 
 

 

Parameters 

The following parameters are supplied with the OnCallReconnect event. 

 

Field Description 

CallID The call_ref_id supplied by the TS.HoldReconnect event. 

Common event parameters on page 372 
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OnCallQueued 

This event is sent when a call is put into a queue. The AICD sends OnCallQueued when it 
receives the TS.Queued event. 

 

 

Parameters 

The following parameters are supplied with the OnCallQueued event. 

 

Field Description 

CallID The call_ref_id supplied by the TS.Queued event. 

NoInQueue The number_in_queue parameter from the TS.Queued event, if present. 

Queue The queue parameter from the TS.Queued event. 

Common event parameters on page 372 

 
 
 
 

OnCallRinging 

This event is sent when a call is delivered to the destination, but not yet answered. The AICD 
sends OnCallRinging when it receives the TS.Ring event. 

 

 

Parameters 

The following parameters are supplied with the OnCallRinging event. 

 

Field Description 

DestinationNumber The dest parameter that is supplied with the TS.Ring event. 

OriginatingNumber The orig parameter that is supplied with the TS.Ring event. 

Common event parameters on page 372 

Common call event parameters on page 372 
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OnCallTransfer 

This event is sent when an agent successfully transfers a call. The AICD sends OnCallTransfer 
when it receives the TS.Transfer event. 

 

 

Parameters 

The following parameters are supplied with the OnCallTransfer event. 

 

Field Description 

DestinationNumber The dest parameter that is supplied with the TS.Transfer event. 

NoInQueue The number_in_queue parameter from the TS.Transfer event, if 
present. 

OldCallID The CallID of the original call. 

OriginatingNumber The orig parameter that is supplied with the TS.Transfer event. 

Common event parameters on page 372 

Common call event parameters on page 372 

 
 
 
 

OnChangeCurrentWorkItem 

This event is sent when an agent changes the current work item. The current work item might 

be changed when: 

● The agent selects another work item from the Work Item drop-down list. 

● The agent double-clicks an item in the Call list, Email list, or Chat list. 

● New work arrives and is automatically accepted. 
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Parameters 

The following parameters are supplied with the OnChangeCurrentWorkItem event, and see the 
new current work item. 

 

Field Description 

Media Type Indicates the media type of the new current work item. 

Common event parameters on page 372 

Common call event parameters on page 372 for media types webVoice and webIVChat. 

Common email event parameters on page 373 

Common Web event parameters on page 373 for media types webVoice and webIVChat. 

 

Related topic 

For more information, see Media types on page 398. 
 
 
 
 

OnEmailCancel 

When an agent cancels the composition of an email reply or forwarding message, the 

OnEmailCancel event is generated. 

To generate an OnEmailCancel event, the following actions occur: 

1. The Communication Detail - Response View is popped when the agent receives email. 

2. When the agent selects the Reply, Reply to All, or Forward buttons, the Communication 

Detail - Response View is enabled. 

3. Depending on which button was selected, either the OnEmailReply, or the 

OnEmailForward events are generated. 

4. The agent can compose a reply or forward an email. While the email message is being 

composed, the agent cannot dismiss, transfer, or defer the original email. 

5. The agent cancels the message by selecting the Cancel button from the Siebel toolbar. 

6. The CancelEmail command cancels the message. 

7. The Communication Detail - Response View is cleared and disabled. 

8. The OnEmailCancel event is generated. 

9. The agent can dismiss, transfer, or defer the original email. 
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OnEmailDeferred  
 

 

 
 
 

 

Parameters 

The following parameters are supplied with the OnEmailCancel event. 

 

Field 

<Open> All values that are in the open data container of the EDU. 

Common event parameters on page 372 

Common call event parameters on page 372 

 
 
 
 

OnEmailDeferred 

When an agent suspends work on an email message, the following actions occur: 

1. A DeferEmail command is generated 

2. The DeferEmail command defers the email and generates the OnEmailDeferred event. 

 
Related topic 

For more information, see DeferEmail on page 336. 
 

 

Parameters 

The following parameters are supplied with the OnEmailDeferred event. 

 

Field 

Common event parameters on page 372 

Common email event parameters on page 373 
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OnEmailForward 

When the agent begins composing an email message the agent wants forwarded, the 
OnEmailForward event is generated. 

To generate an OnEmailForward event, the following actions occur: 

1. The Communication Detail - Response View is popped when the agent receives an email 
message. 

2. The agent selects the Forward button on the Communication Detail - Response View. 

3. The ForwardEmail command is generated. 

4. The Communication Detail - Response View is enabled. 

5. The OnEmailForward event is generated. 

6. The agent can edit the email the agent wants forwarded. 
 

 

Parameters 

The following parameters are supplied with the OnEmailForward event. 

 

Field 

Common event parameters on page 372 

Common email event parameters on page 373 

 
 
 
 

OnEmailReply 

When the agent begins composing a reply email message, the OnEmailReply event is 

generated. 

To generate an OnEmailReply event, the following actions occur: 

1. The Communication Detail - Response View is popped when the agent receives an email. 

2. If the agent selects the Reply or the Reply to All buttons, the ReplyEmail command is 

called. 

3. The Communication Detail - Response View is enabled. 

4. The OnEmailReply event is generated. 
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OnEmailSend  
 

 

 

 
5. The agent can compose a reply email message. 

 

 

Parameters 

The following parameters are supplied with the OnEmailReply event. 

 

Field 

Common event parameters on page 372 

Common email event parameters on page 373 

 
 
 
 

OnEmailSend 

When either an email reply or an email forward message is sent, the OnEmailSend event is 

generated. 

To generate an OnEmailSend event, the following actions occur: 

1. The Communication Detail - Response View is popped when the agent receives email. 

2. When the agent selects the Reply, Reply to All, or Forward buttons, the Communication 

Detail - Response View is enabled. 

3. Depending on which button was selected, either the OnEmailReply, or the 
OnEmailForward events are generated. 

4. The agent can edit the email. 

5. When the agent has finished composing the email, the agent selects the Send button. 

6. The SendEmail command is called. 

7. The Communication Detail - Response View is cleared and disabled. 

8. The OnEmailSend event is generated. 

9. The agent is now permitted to do any of the following tasks: 

● Dismiss, transfer, or defer the original email. 

● Compose another reply or forward the email again. 
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Parameters 

The following parameters are supplied with the OnEmailSend event. 

 

Field Description 

NewEmailActivityID The Siebel Activity ID of the new reply or forward email. 

Common event parameters on page 372 

<Open> All values that are in the open data container for the EDU. 

 
 
 
 

OnGetEDUData 

This event is the result of a successful call to GetEDUData. This event returns the data from the 

EDU in name-value pairs. 
 

 

Parameters 

The following parameters are supplied with the OnGetEDUData event. 

 

Field Description 

CommandID The value is passed in the GetEDUData command. 

Common event parameters on page 372 

 
 
 
 

OnLoginAgent 

When the Siebel agent has successfully logged into Avaya IC, the OnLoginAgent event is 

generated. 
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OnLogoutAgent  
 

 

 
 

 

Parameters 

The following parameters are supplied with the OnLoginAgent event. 

 

Field Description 

AgentID The login ID for the Siebel agent. 

AgentExtension The extension for the agent, if the agent has one. 

 
 
 
 

OnLogoutAgent 

When the Siebel agent has logged out of Avaya IC, the OnLogoutAgent event is generated. 
 

 

Parameters 

The following parameters are supplied with the OnLogoutAgent event. 

 

Name Value 

AgentID The login ID for the Siebel agent. 

AgentExtension The extension for the agent, if the agent has one. 

 
 
 
 

OnNewOpenData 

When a request is there to generate an OnNewOpenData event, the OnNewOpenData event is 
generated. This request originates with the NewOpenData command. 

 

Related topics 

For more information, see the following topics: 

● NewOpenData on page 356 

● About open data on page 240 
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Parameters 

The following parameters are supplied with the OnNewOpenData event. 

 

Field Description 

TrackingID A string generated by the AICD that uniquely identifies the work item. 

<Open> All values that are in the open data container of the EDU. 

 
 
 
 

OnNewWorkItem 

When the agent receives a new work item and indicates that the work item must be popped, the 

OnNewWorkItem event is generated. 

The open data parameters with the MediaType are usually used to determine which screen to 

pop. For example, SiebelViewBmk can be passed as an open data parameter. If the 

SiebelViewBmk parameter is included, the bookmark screen is popped. The AICD.def file 

contains many examples of popping the screen based on parameters that are available through 

open data with the MediaType. 
 

 

Parameters 

The following parameters are supplied with the OnNewWorkItem event. 

 

Field Description 

Cause Indicates the source of this work item. Can be one of the following values: 

● NEW 

● TRANSFER 

● CONFERENCE 

Also see, Information about the cause parameter on page 389. 

InitialPop Indicates whether this value is the first time this work item is being popped. 
Can be one of the following values: 

● Yes 

● No 

Media Type Indicates the Media types of the new current work item. 
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Field Description 

ucid The ucid parameter supplied by the TS.IncomingCall event. 

Common event parameters on page 372 

Common call event parameters on page 372 for media types webVoice and webIVChat. 

Common email event parameters on page 373 

Common Web event parameters on page 373 for media types webVoice and webIVChat. 

Up to 10 custom event parameters. For more information, see Customizing events on 
page 247. 

<Open> All values that are in the open data container of the EDU. 

 

Information about the cause parameter 

The cause parameter is accurate for all consultative transfers on Avaya communication servers. 

This includes transfer to queue, if the transferring agent remains on the call until the call arrives 

at the transferred-to agent. 

However, in some blind transfers on Avaya communication servers, the cause field has a NEW 

value even for the transferred call. This value might occur on blind transfer to queue scenarios 

where the transferred-to agent is not available until after the blind transfer completes. 

The cause field can also be inaccurate on non-Avaya communication servers. For example, 
cause might be NEW for a transferred call. 

 
 
 
 

OnSiebelWrapUp 

When the work item is going into Siebel wrap-up, the OnSiebelWrapUp event is generated. 
OnSiebelWrapUp events are generated only if the wrap-up type for the agent is administered as 

Siebel and wrap-up is enabled for the agent. 

Example: For a work item of media type voice, the following commands and the events can 

occur if Siebel wrap-up was enabled and the customer contact hung up the call: 

1. The OnCallDrop event indicates that the customer hung up. 

2. The OnCallDisconnect event is generated. 

3. The agent receives the OnSiebelWrapUp event. At this point, only the ReleaseWork 

command is permitted. The agent can perform any final actions related to the work item. 

4. When the agent has completed all final actions, the agent sends the ReleaseWork 

command to release the work item. 
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Related topics 

For more information, see the following topics: 

● Wrap-up on page 80 

● ReleaseWork on page 358 

● OnCallDisconnect on page 377 

● OnCallDrop on page 377 
 

 

Parameters 

The Common event parameters on page 372 are supplied with the OnSiebelWrapUp event. 
 
 
 
 

OnWorkConference 

When another agent is conferenced into a web chat, the OnWorkConference event is 
generated. The chat can be a combined voice-chat interaction. 

 

 

Parameters 

The following parameters are supplied with the OnWorkConference event. 

 

Field 

Common event parameters on page 372 

Common Web event parameters on page 373 

 
 
 
 

OnWorkConnect 

When either an email or a Web chat is connected, the OnWorkConnect event is generated. This 
event can occur when an agent does the following tasks: 

● Accepts the work item 

● Removes an email work item from the deferred status 
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OnWorkDisconnect  
 

 

 

 
● Cancels an email reply or a message about to be forwarded 

This event is similar to OnCallConnect, and indicates that both the agents and the customer 
contact are active on the work item. 

 
Related topic 

For more information, see OnCallConnect on page 376. 
 

 

Parameters 

The following parameters are supplied with the OnWorkConnect event. 

 

Field 

Common event parameters on page 372 

Common email event parameters on page 373 

Common Web event parameters on page 373 

<Open> All values that are in the open data container of the EDU. 

 
 
 
 

OnWorkDisconnect 

When either an email or a web chat is disconnected, the OnWorkDisconnect event is 
generated. This event is similar to OnCallDisconnect, and indicates that neither the agents nor 

the customer contact are connected on the work item. Although the event is disconnected, the 

work item is still present at the agent desktop until the agent gets an OnWorkItemRemove 

event. The OnWorkDisconnect event occurs before the agent entering wrap-up, if wrap-up is 

enabled. 

 

Related topics 

For more information, see the following topics: 

● OnCallDisconnect on page 377 

● OnWorkItemRemove on page 392 
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Parameters 

The following parameters are supplied with the OnWorkDisconnect event. 

 

Field 

Common event parameters on page 372 

Common email event parameters on page 373 

Common Web event parameters on page 373 

<Open> All values that are in the open data container of the EDU. 

 
 
 
 

OnWorkItemRemove 

When the work item is removed from the Siebel toolbar, the OnWorkItemRemove event is 

generated. This event is the final event for the work item, and is preceded by an 

OnWorkDisconnect event, and optionally an OnSiebelWrapUp event. 

The parameters that were passed when the OnNewWorkItem event was generated are passed 

when the OnWorkItemRemove event is generated. Additional parameters can be passed if the 

original work item was of MediaType=web and it transitioned to MediaType=webVoice or 

MediaType=webIVChat while it was active at the agent desktop. 

 

Related topics 

For more information, see the following topics: 

● OnWorkDisconnect on page 391 

● OnNewWorkItem on page 388 
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Parameters 

The following parameters are supplied with the OnWorkItemRemove event. 

 

Field Description 

Cause Indicates the source of this work item. Can be one of the following values: 

● NEW 

● TRANSFER 

● CONFERENCE 

Also see, Information about the cause parameter on page 389. 

InitialPop Indicates whether this value is the first time this work item is being popped. 
Can be one of the following values: 

● Yes 

● No 

Media Type Indicates the Media types of the new current work item. 

ucid The ucid parameter supplied by the TS.Disconnect event. 

Common event parameters on page 372 

Common call event parameters on page 372 for media types webVoice and webIVChat. 

Common email event parameters on page 373 

Common Web event parameters on page 373 for media types webVoice and webIVChat. 

Up to 10 custom event parameters. For more information, see Customizing events on 
page 247. 

<Open> All values that are in the open data container of the EDU. 

 
 
 
 

OnWorkTransfer 

When an email is transferred, the OnWorkTransfer event is generated. 

Although a webVoice or webIVChat work item can be transferred, doing so does not generate 

an OnWorkTransfer event. When a webVoice or webIVChat is transferred, the voice part of the 

work item is transferred first. Web chat transfers are not supported by Avaya IC, so the chat 

transfer is simulated. To simulate the chat transfer, the Web part of the work item is conferenced 

and the original agent is dropped from the conference. An OnWorkConference event is there 

when the chat is conferenced, but there cannot be an OnWorkTransfer event. 
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Related topic 

For more information, see OnWorkConference on page 390. 
 

 

Parameters 

The following parameters are supplied with the OnWorkTransfer event. 

 

Field 

Common event parameters on page 372 

Common email event parameters on page 373 

Common Web event parameters on page 373 
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Appendix D: TS call events 

 

The following table lists the call events that are generated as Siebel events and the 

corresponding Telephony Server (TS) event names. 

 

Voice connector event AICD event 

TS.Abandoned OnCallAbandoned 

TS.AgentOtherWork Not supported 

TS.AuxWork Not supported 

TS.Busy OnCallBusy 

TS.Conference OnCallConference 

TS.Connect OnCallConnect 

TS.Disconnect OnCallDisconnect 

TS.Diverted Not Supported 

TS.Drop OnCallDrop 

TS.Hold OnCallHold 

TS.HoldReconnect OnCallHoldReconnect 

TS.IncomingCall OnCallIncoming 

TS.Login Not Supported 

TS.Logout Not Supported 

TS.Ready Not Supported 

TS.Ring OnCallRinging 

TS.SessionFailed Not Supported 

TS.Transfer OnCallTransfer 
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Appendix E: Media types 

 

The following table describes the supported media types. 

 

Media type Definition Hybrid/Native 

email An inbound email. Both 

voice An inbound PBX call originated by a customer. Both 

voiceAutoDial  
 
An outbound contact auto dial mode. The PBX calls 
the customer and notifies the agent about the call as 
the call is dialing. The agent reviews the customer 
information simultaneously that the PBX is placing 
the outbound call to the customer. 

Hybrid 

voiceOut An outbound PBX call originated by an agent. Hybrid 

voicePredictive An outbound contact predictive mode call. The PBX 
automatically initiates an outgoing call. If the 
customer answers, the call is routed to an available 
agent. 

Hybrid 

voicePreview An outbound contact preview mode call. The agent is 
notified before the PBX makes the call. This alerts the 
agent giving the opportunity to review customer data 
before the PBX places the call. 

Hybrid 

web An inbound chat. Hybrid 

webIVChat Multimedia with inbound Chat & VoIP call. Hybrid 

webVoice Multimedia with inbound chat and Public Switched 
Telephone Network (PSTN) call. 

Hybrid 
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Appendix F: EAI Get and Put operations 

 

This section describes the integration objects contained within the Get Data and Put Data 

blocks. Each integration object has a unique format written in eXtensible Markup Language 

(XML) that conforms to a Document Type Definition (DTD). Each integration object contains a 

pair of messages: one for the request from Avaya IC to Siebel, and one for the response from 

Siebel to Avaya IC. You can customize your system by changing the content passed in the 

messages without changing the DTD. 

This section includes the following topics: 

● About customizing Get operations on page 400 

● About customizing Put operations on page 401 

● About attachments on page 402 

● Get and Put Data on page 404 

 
Related topics 

For more information, see the following topics: 

● EAI server on page 64 

● Siebel palette blocks on page 99 

● Integration objects on page 90 

 
Before you begin 

This appendix assumes that you have installed the Avaya IC EAI Objects.sif. 

 
Related topics 

For more information, see the following topics: 

● Installing a custom integration object on page 173 

● For more information about Avaya IC EAI Objects, see the Siebel documentation. 
 
 
 
 

About customizing Get operations 

To customize Get operations, you need the following information. 
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Integration object name: Always type the integration object name accurately. Spaces, 

capitalization, and spelling must match exactly or the request returns an error. 

Query key name : For Get operations, this name is the exact name you must specify when 

making the Get request. These names are the names described in the Get structure figures in 

this appendix. For example, Contact.HomePhone is a query key name for the Get Contact 

integration object. A telephone number is passed as data with this query key name. The data 

type and the number of digits must agree with what Siebel is expecting. 

The data when returned by Siebel has the form shown in the structure figures. 

No required fields are there for Get operations. 

 
 

 

About customizing Put operations 

This section includes the following topics: 

● Names on page 401 

● Required fields on page 401 
 

 

Names 

To customize Put operations, you need the following information. 

Integration object name: Always type the integration object name accurately. Spaces, 

capitalization, and spelling must match exactly or the request returns an error. 

Name : For Put operations, this name is the name of the field that populates with data. These 

names are the names described in the Put structure figures in this appendix. For example, 

Action.Description is a name for the Put Action integration object. 

The data when returned by Siebel has the form shown in the structure figures. 
 

 

Required fields 

The required fields for each Siebel integration object shows in the structure figures, marked with 

a star. In general, these fields must be supplied and contain data that conforms to what Siebel 

expects. For example, the Avaya IC - Put Action integration object contains the following 

required primary fields: 
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Id : Siebel validates that this field was supplied. However, a different Id will actually be created 

for the activity record. Supply the data <new> as a placeholder so that the Siebel validation 

works. 

Description : Siebel validates that this field was supplied and populate the Description field of 
the activity. Remember that Siebel has restrictions on the length of the Description field data. 

Type: Siebel validates that this field was supplied and also validate that the text of this field 

conforms to a valid Siebel activity type. The Avaya IC - Put Action integration object also 

contains other required fields. However, the fields are required only when passing a 

ListOfActionAttachment or ListOfAction_Contact. Use Siebel Tools to examine the field mapping 

for the integration object and Siebel business component requirements for the data. 
 
 
 
 

About attachments 

With the integration object figures in this appendix, you also see a chart stating whether the 

integration object can have attachments. Integration objects can sometimes pass documents as 

attachments to and from Siebel, with the Get and Put requests. 
 
 
 
 

Creating an integration object to query on a multivalue 

field 

Out-of-the-box Integration Objects have Multi Value Groups (MVGs). Each of these MVGs 
needs a separate integration component definition. Each field defined for an integration 

component maps to a field in the MVG. When you have a requirement to execute a query on a 

multivalue field, you must create another business object and an integration object based on the 

business object. The integration object must have the MVG as a root component, and the 

parent as the child component. 

This section includes the following topics: 

● Example on page 403 

● Procedure on page 403 
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Example 

A query on Account State using the Avaya IC - Get Account integration object does not return 

all accounts that fall under that state. You can query for all accounts that fall under that state by 

creating an integration object. 
 

 

Procedure 

To create an integration object to query on a multivalue field: 

1. Create a business object with BusinessAddress as the parent business component. 

Reference: For more information about creating a business object, see the Siebel 
documentation. 

2. Create a link with BusinessAddress as the parent business component and Account as 
the child business component. 

3. Associate the link with the business object. 

4. Create the integration object using the business object you created in Step 1. 

Reference: For more information about creating an integration object, see the Siebel 

documentation. 

5. Activate or inactivate the fields in the integration object for each requirement. 

6. Change the Avaya IC workflow to send the right parameters to the EAI server. 

Reference: For more information, see Roadmap for creating integration objects in the 

Avaya IC for Siebel Integration guide. 

Result: The integration object hierarchy must look as the following figure. 
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Get and Put Data 

Get Data and Put Data blocks contain the following integration objects: 

● Get Action on page 404 

● Put Action on page 406 

● Get Account on page 407 

● Get Contact and Put Contact on page 409 

● Get Service Request on page 411 

● Put Service Request on page 413 

● Get Order Entry on page 414 

● Put Order Entry on page 415 

● Put Opportunity on page 416 

● Get Quote on page 417 

● Put Quote on page 419 
 

 

Get Action 

The Get Action integration object retrieves information from the Siebel database about actions 

that agents took in response to previous contacts with this customer. 

This section includes the following topics: 

● Get Action query keys from Avaya IC to Siebel on page 404 

● Get Action responses from Siebel to Avaya IC on page 405 

 
Get Action query keys from Avaya IC to Siebel 

The following figure shows the out-of-the-box query keys that Avaya IC requests from Siebel for 

data transfers using the Avaya IC - Get Action integration object. 
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* Required field 

 

Get Action responses from Siebel to Avaya IC 

The following figure shows the out-of-the-box fields that Avaya IC receives from Siebel for data 
transfers using the Avaya IC - Get Action integration object. 
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Put Action 

The Put Action integration object requests Siebel to store information in the Siebel database 
about the current actions that an agent took in response to a customer contact. 

The following figure shows the out-of-the-box fields that Siebel receives from Avaya IC for data 

transfers using the Avaya IC - Put Action integration object. 
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Get Account 

The Get Account integration object retrieves customer billing information from the Siebel 
database. 

This section includes the following topics: 

● Get Account query keys from Avaya IC to Siebel on page 407 

● Get Account responses from Siebel to Avaya IC on page 408 

 
Get Account query keys from Avaya IC to Siebel 

The following figure shows the out-of-the-box query keys that Avaya IC requests from Siebel for 

data transfers using the Avaya IC - Get Account integration object. 
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Get Account responses from Siebel to Avaya IC 

The following figure shows the out-of-the-box fields that Avaya IC receives from Siebel for data 
transfers using the Avaya IC - Get Account integration object. 
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Get Contact and Put Contact 

The Avaya IC - Get Contact integration object retrieves the identification and the communication 
information for the current contact from the Siebel database. 

The Avaya IC - Put Contact integration object requests Siebel to store the identification and the 

communication information into the Siebel database. 

This section includes the following topics: 

● Get Contact query keys from Avaya IC to Siebel on page 409 

● Get and Put Contact responses from Siebel to Avaya IC on page 410 

 
Get Contact query keys from Avaya IC to Siebel 

The following figure shows the out-of-the-box query keys that Avaya IC requests from Siebel for 

data transfers using the Avaya IC - Get Contact integration object. 
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Get and Put Contact responses from Siebel to Avaya IC 

The following figure shows the out-of-the-box fields that Avaya IC receives from Siebel for data 
transfers using the Avaya IC - Get and Put Contact integration objects. 
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Get Service Request 

The Avaya IC - Get Service Request integration object retrieves information from the Siebel 
database about services that the company of the agent provided to the customer. 

This section includes the following topics: 

● Get Service Request query requests from Avaya IC to Siebel on page 411 

● Get Service Request responses from Siebel to Avaya IC on page 412 

 
Get Service Request query requests from Avaya IC to Siebel 

The following figure shows the out-of-the-box query keys that Avaya IC requests from Siebel for 

data transfers using the Avaya IC - Get Service Request integration object. 
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Get Service Request responses from Siebel to Avaya IC 

The following figure shows the out-of-the-box fields that Avaya IC receives from Siebel for data 
transfers using the Avaya IC - Get Service Request integration object. 
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Put Service Request 

The Put Service Request integration object requests Siebel to store information in the Siebel 
database about services that the agent provided to the customer. 

The following figure shows the out-of-the-box fields that Avaya IC requests to Siebel for data 

transfers using the Avaya IC - Get Service Request integration object. 
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Get Order Entry 

The Get Order Entry integration object retrieves information from the Siebel database about 
customer purchases. 

This section includes the following topics: 

● Get Order Entry query requests from Avaya IC to Siebel on page 414 

● Get Order Entry responses from Siebel to Avaya IC on page 415 

 
Get Order Entry query requests from Avaya IC to Siebel 

The following figure shows the out-of-the-box query keys that Avaya IC requests from Siebel for 

data transfers using the Avaya IC - Get Order Entry integration object. 
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Get Order Entry responses from Siebel to Avaya IC 

The following figure shows the out-of-the-box fields that Avaya IC receives from Siebel for data 
transfers using the Avaya IC - Get Order Entry integration object. 

 

 

 

Put Order Entry 

The Put Order Entry integration object requests Siebel to store customer purchase information 
in the Siebel database. 
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The following figure shows the out-of-the-box fields that Avaya IC requests to Siebel for data 

transfers using the Avaya IC - Put Order Entry integration object. 

 

 
 
 

Put Opportunity 

The Put Opportunity integration object requests Siebel to store sales contact information in the 
Siebel database. 
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The following figure shows the out-of-the-box fields that Avaya IC requests to Siebel for data 

transfers using the Avaya IC - Put Opportunity integration object. 

 

 

 

Get Quote 

The Get Quote integration object retrieves price-quote information from the Siebel database. 

This section includes the following topics: 

● Get Quote query requests from Avaya IC to Siebel on page 417 

● Get Quote responses from Siebel to Avaya IC on page 418 

 
Get Quote query requests from Avaya IC to Siebel 

The following figure shows the out-of-the-box query keys that Avaya IC requests from Siebel for 

data transfers using the Avaya IC - Get Quote integration object. 
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Get Quote responses from Siebel to Avaya IC 

The following figure shows the out-of-the-box fields that Avaya IC receives from Siebel for data 
transfers using Get Quote integration object. 
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Put Quote 

The Put Quote integration object requests Siebel to store price-quote information in the Siebel 
database. 

The following figure shows the out-of-the-box fields that Avaya IC requests to Siebel for data 

transfers using the Avaya IC - Put Quote integration object. 
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Appendix G: Driver parameters 

 

This section includes the following topics: 

● About driver parameters on page 420 

● AICD driver parameters on page 421 
 
 
 
 

About driver parameters 

This section contains the AICD driver parameters that you must set for a successful integration. 

 

Use To set the following driver parameters 

IC Manager ● Error logging levels 

● Server name 

The Communications Drivers and Profiles 
view in the Siebel Communications 
Administration window 

Error logging levels for the agent log files 

Size of Thread Pool 

Siebel Configuration Name 

IC Domain 

IC UUID 

ServerMode 

 

Related topics 

For information about setting driver parameters, see: 

● IC Administration Guide 

● The Siebel documentation 
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AICD driver parameters 

The supported AICD driver parameters for the Siebel Communications Server are described in 

the following table. When setting up log files for agents, the only driver parameters you can set 

are the parameters with the name Service: as a prefix. All AICD driver parameters are optional, 

but might be required based on your specific needs. 

 

Driver parameter name Default 

value 

Description 

Driver:ConfigurationName N/A The ConfigurationName is any string unique to the 
Siebel configuration and connected to the AICD. 
This driver parameter makes it possible for a single 
AICD library instance within a single Siebel 
Communications Server to support multiple 
configurations if multiple AICD servers are 
configured in Avaya IC Manager. 

To use this parameter correctly, you must have 
multiple AICD configurations in Siebel. Perform the 
following steps: 

1. Import the AICD.def file excluding the Drivers and 
Profiles into all, but the first configuration. 

2. Create multiple profiles for that AICD driver and 
correspondingly associate them with the AICD 
configurations. 

You can now use this parameter as an AICD driver 
parameter and. override the parameter with unique 
values in various AICD profiles 

Driver:InitialThreadCount 8 The InitialThreadCount is the number of threads 
created at driver start-up to process agent requests. 
Usually, the more agents that you have serviced by 
this AICD, the higher you get the number. However, 
having excess threads increases your server CPU 
overhead. On all platforms, this has a minimum 
value of 8 and a maximum value of 64. 

Driver:ServerDomain N/A The ServerDomain establishes a filter for the identity 
of the AICD to the Avaya IC server. Normally, the 
driver automatically gets the server UUID from the 
vesp.imp file. However, if this parameter is 
specified, only those UUIDs that match the specified 
domain are chosen as a possible identity. 

Driver:ServerMode Hybrid Specifies whether the AICD runs in Hybrid Siebel 
(Hybrid) or Native Siebel (Native) mode. 
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Driver parameter name Default 
value 

Description 

Driver:ServerUUID N/A The ServerUUID explicitly establishes the identity of 
the AICD to the Avaya IC server. Normally, the driver 
automatically gets the server UUID from the 
vesp.imp file. However, if this parameter is given, 
the specified UUID overrides any other UUID that 
the AICD has automatically chosen. Use this 
parameter with caution. 

Service:AgentPassword <Empty 
String> 

Specifies the Avaya IC agent password used during 
the ASIS.Login request. This parameter applies only 
when Driver:ServerMode = Native. The value 
specified here can be overwritten by the Login 
command parameter AgentPassword. 

Service:TraceLevelFlush false If true, the agent-specific file is flushed from memory 
to the disk for every log statement. Setting this to 
true is likely to slow down the performance of the 
AICD. 

Service:TraceLevelUsr1 false If true, errors are logged to an agent-specific file. 

Service:TraceLevelUsr2 false If true, warnings are logged to an agent-specific file. 

Service:TraceLevelUsr3 false If true, information messages are logged to an 
agent-specific file. 

Service:TraceLevelUsr4 false If true, debugging information is logged to an 
agent-specific file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:infodev@avaya.com


405 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

August 2022 

Appendix H: The location of the Siebel images folder 

 

 

 

Appendix H: The location of the Siebel 
images folder 

 
 

The location of the images folder depends on the Siebel version. 

Siebel version images folder location 

Before Siebel IP 2016 SWSE_ROOT/public/lang_code/images 

Siebel IP 2016 SWSE_ROOT/public/images 

Siebel IP 2017 - IP 21.1 SIEBEL_AI_ROOT/applicationcontainer/webapps/siebel/images 

Since Siebel IP 21.2 SIEBEL_AI_ROOT/applicationcontainer_external/siebelwebroot/images 

 
Where SWSE_ROOT is the directory into which the Siebel Web Server Extension (SWSE) is 
installed. For example, C:/siebel/8.1.1.14.0/sweapp (Windows) or /siebel/8.1.1.14.0/sweapp (Linux) 

lang_code is a Siebel installed language. For example, ENU for U.S. English 

SIEBEL_AI_ROOT is the directory into which Siebel Application Interface is installed. For example, 
C:/Siebel_AI (Windows) or /Siebel_AI (Linux) 
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Glossary 
 
 
 
 

Adaptive Interaction 
Center Driver 

Avaya-provided driver that runs under the Siebel Communications Server. The 
Adaptive Interaction Center Driver (AICD) coordinates the delivery of work 

between Avaya IC and Siebel agents, and is also responsible for managing 

some aspects of the Siebel Communications Toolbar user interface. 

ADU See Agent Data Unit. 

agent An individual who handles inbound or outbound customer contacts through 

phone calls, e-mails, or Web chats. Each agent is associated with one or more 

media channels through their login IDs, and can be a member of one or more 

workgroups. 

Agent Data Unit A record created each time an agent logs into Avaya IC. The record contains 

information about agent activities during the Avaya Agent session, including 

information about each media channel and any active contacts assigned to the 

agent. 

AICD See Adaptive Interaction Center Driver. 

Agent Server for 

Integration with 

Siebel 

A Siebel-specific component of Avaya IC that Is used in place of the Avaya 

Agent application in a Native integration with Siebel. ASIS handles requests 

and event communication for all agents. 

ASIS See Agent Server for Integration with Siebel. 

auto-acknowledge- 
ment 

An e-mail automatically sent in response to e-mail from a customer that 
acknowledges the receipt of the message. 

auto-response An e-mail automatically sent in response to e-mail from a customer that is 

based on the Content Analysis of the e-mail. 

available state The agent state in which the agent is ready to receive another contact through 

the media channels. 

Avaya Agent The client application that enables agents to handle customer contacts via 
incoming and outgoing phone calls, e-mails, and chat sessions. The Avaya 

Agent is displayed on agent desktops as a framework containing tabs and 

panes and their controls, such as task lists. Also called Avaya Agent Desktop. 

Avaya Agent 
Desktop 

See Avaya Agent. 

Avaya IC See Avaya Interaction Center. 

Avaya Interaction 

Center 

A complete software system for contact centers that routes and manages 

inbound and outbound agent-customer interactions. These interactions can 

occur across multiple media channels including voice, e-mail, and Web chat. 
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Avaya Web Agent The GUI desktop application used by agents to interact with customers using 

Web management features. Fully integrated into the Avaya Agent, the Web 

Agent provides the interface that agents use to handle their chat contacts after 

selecting them from either the Avaya Agent chat task list or the Siebel work item 

list. 

For this integration, Avaya Web Agent supports only chat contacts. 

Blender server A server on the Avaya IC system that controls agent availability across different 
channel types, and monitors ADU change events. The Blender server is 

pre-configured to run workflows when any agent state changes. The Blender 

server can also be configured to raise alarms or run flows when agent or queue 

ADU thresholds are exceeded. 

blind transfer A one-step transfer of a work item. There is no consult phase for this type of 

transfer. 

block See workflow. 

CDL See Console Design Layout file. 

chat A system in which users can exchange typed messages in real-time over a 

computer network or the internet. 

Common Object 

Request Broker 

Architecture 

 
Communications 

server 

Console Design 

Layout file 

An architecture that enables servers to communicate with one another 

regardless of the programming language in which they were written or the 

operating system on which they run. VESP (Voice Enhanced Services Platform) 

is the CORBA implementation used in Avaya IC. 

See Siebel Communications server. 

 
A file that specifies the Avaya Agent screen layout. 

consultative transfer A two-step transfer of a work item. This type of transfer allows the transferring 

agent to communicate with the person receiving the work item before 

completing the transfer. 

contact (1) In Avaya IC, an event consisting of an interaction between a customer and 

an agent, or a request for such interaction. The interaction can occur by phone, 

e-mail, or chat. 

(2) In Siebel applications, the term contact refers to a business object or 

component that typically represents a customer. 

contact center  A single site or multiple sites at which contacts are received and answered on 

voice, e-mail, and chat media channels for the purpose of communicating with 

customers, vendors, or employees. 

Content Analysis An automated analysis of e-mail that determines the topic and language of the e-

mail. Based on this analysis, automated responses are sent to customers, or to 

agents for final approval. 
For this integration, the actual Content Analysis is performed by Siebel. 

CORBA See Common Object Request Broker Architecture. 



August 2022 408 Avaya IC for Siebel Integration Guide 

Comments on this document? infodev@avaya.com 

 

 

 

 

definition file See Siebel definition file. 

EAI server See Enterprise Application Integration server. 

Enterprise 

Application 

Integration server 

A new Siebel component located within Avaya IC that accepts workflow blocks 

on Avaya IC to perform operations that read and write data to and from the 

Siebel database. 

EDU See Electronic Data Unit. 

Electronic Data Unit A record maintained by Avaya IC about a contact from a customer. Avaya IC 

stores all information related to a particular contact in the Electronic Data Unit 

(EDU). Similar to the Agent Data Unit, which represent agents rather than 

customers. 

e-mail Content 

Analysis 

See Content Analysis. 

flow See workflow. 

Hybrid Siebel 

configuration 

In an Avaya IC Siebel integration, the desktop user interface consists of a 
Siebel call center internet browser window and an Avaya Agent task bar 
window. The integration of Avaya IC with Siebel allows you to use the customer 
management features in the Siebel software and the features in Avaya IC that 
automate the processing of customer contacts. All channels, including voice, 
e-mail, and chat are supported in this type of integration. 

IC Email server A server that integrates with SMTP and POP3 servers. The IC Email server 

also manages all polling and forwarding, from the customer to the agent, of 

e-mails that come into the Avaya IC system. Through workflows, this server 

also handles the filtering of spam, the delivery of automatic replies, and the 

management of traffic flow to external agents and approval agents. 

incoming call A call offered to a route or service from an external carrier. 

media channel The method by which contacts enter Avaya IC - voice, e-mail, and Web chat. 

multihomed host A computer with two or more IP addresses. 

mute transfer A term previously used by Siebel that is synonymous with blind transfer. See 

blind transfer. 

Native Siebel 
configuration 

Thin-client Siebel provides the entire desktop user interface for an Avaya IC 
Siebel integration. Avaya IC provides voice and e-mail work item routing and 
data collection reporting that occurs in the background. 

on hold A caller is placed in a wait state. 

ORB Server An Avaya IC server that controls and maintains other servers. Every machine 

that runs servers must have an ORB Server running. The ORB Server can 

start, stop, and monitor the status of any server on its machine. 

outbound Calls or e-mail sent to a prospect or customer from a contact center. 

queue A group of agents, often with similar skills or knowledge, to which customer 

contacts are routed in a contact center. For example, there may be a Hardware 

Sales queue, a Hardware Support queue, a Software Sales queue, and a 

Software Support queue, each containing agents who handle a particular type 

of issue. 
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ready state See available state. 

SCAPI See Siebel Adaptive Communications API. 

screen pop A term used to describe how contact information is displayed in the Siebel 

Application Window in response to either new work being delivered to the 

agent or work being accepted by the agent. Typically a new screen or view that 

is associated with the incoming contact is presented, or popped, to the agent. In 

Siebel, screen pops are usually driven from driver events and the associated 

rules in the Siebel definition file that define the Siebel views to present to the 

agent, and the data items that should be queried from the Siebel database. 

shared browsing A set of features used during a chat session that enable the browsers for 

agents and customers to be synchronized so that they display the same Web 

pages simultaneously. 

Siebel Adaptive 

Communications 

API 

 
 

Siebel 

Communications 

server 

A Siebel driver interface that the Adaptive Interaction Center Driver (AICD) use 

to communicate to Siebel. The Siebel Adaptive Communications API (SCAPI) 

interface is a C-Language function call interface that passes work item events 

from the AICD to Siebel, and work item commands from Siebel to the AICD. 

The SCAPI interface is located on the Siebel system. 

A Siebel server that supports communication-related functions between the 

Siebel client PCs and application-specific drivers, such as the Adaptive 

Interaction Center Driver (AICD). Also called Siebel Comm. server. 

Siebel definition file A Siebel proprietary language that describes the rules associated with how 

events and commands are processed and passed between Siebel and the 

Adaptive Interaction Center Driver (AICD). The definition file determines Siebel 

desktop behavior, such as what Siebel screen to pop. The definition file also 

controls the commands passed from Siebel to the AICD. Also called .def file. 

Siebel Desktop A customizable graphical user interface (GUI) that hosts the Siebel application 

and runs in a browser. The agent also uses the Siebel Desktop to control the 

media through the Siebel Communications Toolbar. 

Siebel integration 

servers 

Servers that were created specifically for the Avaya IC Siebel integration. The 

following servers and drivers are considered Siebel integration servers: 

● Adaptive Interaction Center Driver (AICD) 

● Enterprise Application Integration (EAI) server 

suggested response E-mail responses that are generated automatically, after Content Analysis. 

When an agent receives an e-mail contact for which a set of suggested 

responses have been generated, the agent selects the most appropriate 

response and sends it to the customer. 

Telephony Server A server on Avaya IC that monitors calls, including abandoned calls, and 
controls the routing of telephony requests. The TS uses the Electronic Data 

Unit to record information on incoming or outgoing calls. 

TS See Telephony Server. 

UAD See Unified Agent Directory. 
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Unified Agent 

Directory 

 
 
 

 
Universal Call 

Identifier 

An internal directory that provides lists of contact center resources, which may 

include agents, queues, and custom contact lists. Agents use the Unified Agent 

Directory graphical user interface to select a destination for a transfer, 

conference, or make call operations, such as a queue, another agent, an 

external agent, a supervisor, or a person with a specified proficiency in a 

particular skill. 

The Universal Call Identifier (UCID) is an Avaya-proprietary call identifier used 

to help correlate call records between different systems. 

work item (1) In Avaya IC, every contact a customer makes to an agent and vice versa is 

represented by a work item. If a customer calls, then sends e-mail, and then 

participates in a Web chat, each of these contacts is considered a separate 

work item. However, multi-media contacts are combined into one work item. For 

example, a Web chat + call is one work item. 

(2) In Siebel, every entry in the Siebel Communications Toolbar Work Item 
Drop-Down List represents a unique work item. 

workflow A script that defines a sequence of steps the system performs when handling 

voice, e-mail, and Web chat contacts. Workflows are flowcharts that consist of a 

series of connected blocks. Each block defines a step in the workflow. The 

order of the blocks in the workflow determines the order in which the steps are 

performed. Out-of-the-box workflows are provided during installation. 

Integrators can use the Avaya IC Workflow Designer to modify the 

out-of-the-box workflows. Also called flows. 

workgroup A set of agents and queues. Workgroups enable the pooling of agents and 
queues by their related responsibilities and skills, resulting in better use of 

resources and more efficient management. Each workgroup can contain one or 

more agents and queues as well as other workgroups, structured hierarchically. 

A workgroup can contain supervisors, who are agents assigned the role of 

supervisor. 

wrap-up State the agent enters after contact with a customer ends. During wrap-up, an 

agent can complete the transaction and may be required to enter reason codes 

or complete a script. 
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